SAP BusinessObjects Web Intelligence User's Guide
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introducing Web Intelligence.</td>
<td>10</td>
</tr>
<tr>
<td>1.1</td>
<td>Documentation for SAP BusinessObjects Web Intelligence.</td>
<td>10</td>
</tr>
<tr>
<td>1.1.1</td>
<td>Document History: Web Intelligence.</td>
<td>10</td>
</tr>
<tr>
<td>1.1.2</td>
<td>To access online help.</td>
<td>12</td>
</tr>
<tr>
<td>1.2</td>
<td>About Web Intelligence.</td>
<td>12</td>
</tr>
<tr>
<td>1.3</td>
<td>About the Web Intelligence interfaces.</td>
<td>14</td>
</tr>
<tr>
<td>1.4</td>
<td>Application components.</td>
<td>18</td>
</tr>
<tr>
<td>1.4.1</td>
<td>Side Panel tabs in Web Intelligence.</td>
<td>20</td>
</tr>
<tr>
<td>1.5</td>
<td>Understanding the BI launch pad.</td>
<td>21</td>
</tr>
<tr>
<td>1.5.1</td>
<td>To log into the BI launch pad.</td>
<td>22</td>
</tr>
<tr>
<td>1.5.2</td>
<td>To log out of the BI launch pad.</td>
<td>22</td>
</tr>
<tr>
<td>1.5.3</td>
<td>To start Web Intelligence in the BI launch pad.</td>
<td>22</td>
</tr>
<tr>
<td>1.5.4</td>
<td>To open a document from the repository.</td>
<td>23</td>
</tr>
<tr>
<td>1.5.5</td>
<td>To delete a document from the repository.</td>
<td>24</td>
</tr>
<tr>
<td>1.5.6</td>
<td>About setting Web Intelligence preferences.</td>
<td>24</td>
</tr>
<tr>
<td>1.6</td>
<td>Setting up and using Web Intelligence Rich Client.</td>
<td>28</td>
</tr>
<tr>
<td>1.6.1</td>
<td>To install Web Intelligence Rich Client from the BI launch pad.</td>
<td>28</td>
</tr>
<tr>
<td>1.6.2</td>
<td>To install Web Intelligence Rich Client from the SAP BusinessObjects Enterprise CD.</td>
<td>29</td>
</tr>
<tr>
<td>1.6.3</td>
<td>Online help in a Web Intelligence Rich Client installation.</td>
<td>29</td>
</tr>
<tr>
<td>1.6.4</td>
<td>Web Intelligence Rich Client notification icon.</td>
<td>30</td>
</tr>
<tr>
<td>1.6.5</td>
<td>Connection modes.</td>
<td>30</td>
</tr>
<tr>
<td>1.6.6</td>
<td>Working with universes in Web Intelligence Rich Client.</td>
<td>36</td>
</tr>
<tr>
<td>1.6.7</td>
<td>To set viewing preferences.</td>
<td>37</td>
</tr>
<tr>
<td>1.6.8</td>
<td>To change your password.</td>
<td>38</td>
</tr>
<tr>
<td>1.7</td>
<td>Interface and document locales.</td>
<td>38</td>
</tr>
<tr>
<td>1.7.1</td>
<td>The Product locale.</td>
<td>40</td>
</tr>
<tr>
<td>1.7.2</td>
<td>The document locale in documents.</td>
<td>41</td>
</tr>
<tr>
<td>1.7.3</td>
<td>The Preferred viewing locale.</td>
<td>42</td>
</tr>
<tr>
<td>1.8</td>
<td>Increasing or decreasing the display size of a report in Web Intelligence.</td>
<td>43</td>
</tr>
<tr>
<td>2</td>
<td>Working with queries.</td>
<td>44</td>
</tr>
<tr>
<td>2.1</td>
<td>Building queries.</td>
<td>44</td>
</tr>
<tr>
<td>2.1.1</td>
<td>About queries.</td>
<td>44</td>
</tr>
<tr>
<td>2.1.2</td>
<td>To create a document without a data source.</td>
<td>52</td>
</tr>
<tr>
<td>2.1.3</td>
<td>Building queries on universes.</td>
<td>53</td>
</tr>
<tr>
<td>2.1.4</td>
<td>Building queries on data files.</td>
<td>75</td>
</tr>
<tr>
<td>2.1.5</td>
<td>Building queries based on BEx queries.</td>
<td>79</td>
</tr>
<tr>
<td>2.1.6</td>
<td>Building queries on Advanced Analysis views.</td>
<td>110</td>
</tr>
<tr>
<td>2.1.7</td>
<td>Building queries on web service data sources.</td>
<td>111</td>
</tr>
</tbody>
</table>
2.1.8 To create a query on a different data source in an existing document ........................................ 115
2.2 Managing queries .......................................................... 116
  2.2.1 To switch to Data mode ............................................. 116
  2.2.2 To open for edit the data provider of an existing query .................................................. 116
  2.2.3 The Data mode in Web Intelligence ................................ 116
  2.2.4 To manage queries using the Data Manager ............................................................... 118
  2.2.5 To set the keydates of queries ........................................... 118
  2.2.6 To preview query results ............................................. 119
  2.2.7 To sort query results ................................................ 119
  2.2.8 To interrupt a query .................................................. 120
  2.2.9 To remove a query .................................................. 120
  2.2.10 To duplicate a query ................................................ 121
  2.2.11 Changing the data source of a query ........................................ 121
  2.3 Working with multiple queries and data providers ......................................................... 123
    2.3.1 Multiple queries, combined queries and synchronized queries compared ...................... 124
    2.3.2 To add a query to an existing document ................................................................. 124
  2.4 Using combined queries .................................................. 125
    2.4.1 An example of a combined queries .......................................................... 126
    2.4.2 How combined queries are generated ............................................................... 127
    2.4.3 To build a combined query ............................................................... 127
    2.4.4 Combined query structure ............................................................... 128
    2.4.5 Combined query precedence ................................................................. 129
  2.5 Filtering data in the queries .................................................. 132
    2.5.1 Filtering data using query filters ............................................................. 132
    2.5.2 Filtering data with query prompts ............................................................... 150
    2.5.3 Filtering data using subqueries ................................................................. 161
  3 Working with reports .......................................................... 166
    3.1 Creating reports .............................................................. 166
      3.1.1 To create a blank document .......................................................... 166
      3.1.2 Web Intelligence features that are supported in reports for mobile devices ............... 166
    3.2 Viewing document properties .................................................. 169
      3.2.1 To configure document properties ............................................................. 173
      3.2.2 To select default folders for local documents and universes ..................................... 173
      3.2.3 Query stripping in documents ................................................................. 173
    3.3 Hierarchical and non-hierarchical data .................................................. 174
      3.3.1 Working with non-hierarchical data .......................................................... 175
      3.3.2 Working with hierarchical data ............................................................... 175
    3.4 Finding text in a report page .................................................. 188
    3.5 Viewing modes .............................................................. 188
      3.5.1 Page view mode ............................................................. 188
      3.5.2 Quick Display view mode ................................................................. 189
3.5.3 To switch between viewing modes ........................................ 190
3.6 Folding and unfolding report data ........................................ 191
  3.6.1 To fold and unfold report data ........................................ 191
3.7 To redisplay all hidden content in a report ................................ 191
3.8 Formatting the report layout ............................................. 192
  3.8.1 To format the appearance of reports and their headers, footers, sections, tables, and table cells ........................................ 194
3.9 Printing reports ............................................................. 195
  3.9.1 To print reports in Web Intelligence ................................. 196
3.10 Tracking changes in data ................................................ 196
  3.10.1 Types of data change ................................................ 197
  3.10.2 Automatic update tracking mode .................................... 198
  3.10.3 Absolute reference data tracking mode ............................ 198
  3.10.4 To activate data tracking ........................................... 198
  3.10.5 Displaying changed data ........................................... 199
  3.10.6 Data tracking restrictions .......................................... 204
  3.10.7 Using formulas to track changed data ............................ 206
  3.10.8 Changed data and the calculation context ........................ 207
3.11 Highlighting data using conditional formatting ...................... 208
  3.11.1 Conditions in conditional formatting .............................. 209
  3.11.2 To build a conditional formatting rule ............................ 209
  3.11.3 To set the format displayed by a conditional formatting rule ........................................ 210
  3.11.4 To apply conditional formatting .................................... 211
  3.11.5 To manage conditional formats ..................................... 211
  3.11.6 Using formulas to create advanced conditional formatting rules ........................................ 212
3.12 Ranking report data ....................................................... 213
  3.12.1 Rankings and sorts .................................................. 213
  3.12.2 Tied rankings ....................................................... 214
  3.12.3 Ranking and data order ............................................. 214
  3.12.4 Ranking parameters ................................................ 215
  3.12.5 Ranking workflows ................................................ 216
  3.12.6 Ranking examples .................................................. 217
3.13 Merging data from dimensions and hierarches ...................... 220
  3.13.1 Merging data providers based on keys ........................................ 221
  3.13.2 Choosing which data to merge .................................... 221
  3.13.3 Merged dimension example ....................................... 221
  3.13.4 Merging hierarchies ................................................ 222
  3.13.5 Merging different types of objects .................................. 224
  3.13.6 Forcing merged calculations with the ForceMerge function ........................................ 225
  3.13.7 To merge details, dimensions, or hierarchies .................. 226
  3.13.8 To merge dimensions automatically ................................ 227
3.13.9 To edit merged objects. ................................................................................. 228
3.13.10 To unmerge objects. .................................................................................. 228
3.13.11 Synchronizing data providers with different aggregation levels. .......... 228
3.13.12 Attributes and merged dimensions. .......................................................... 230
3.13.13 Incompatible objects and merged dimensions. ....................................... 231
3.13.14 Filtering and drilling on merged dimensions. ........................................ 232
3.13.15 Extending the values returned by merged dimensions. ......................... 233

3.14 Drilling on report data. .................................................................................. 234
3.14.1 Setting the scope of analysis. .................................................................... 235
3.14.2 Drill paths and hierarchies. ....................................................................... 237
3.14.3 Prompt when drill requires additional data option. .............................. 238
3.14.4 Setting drill options. .................................................................................. 238
3.14.5 To switch to drill mode. ............................................................................. 241
3.14.6 To choose a drill path when more than one is available. ...................... 242
3.14.7 To take a snapshot of report drill results. ................................................ 242
3.14.8 Drilling on measures in tables and sections. ........................................... 242
3.14.9 Drilling on dimensions in tables and sections. ........................................ 243
3.14.10 Drilling on charts. ..................................................................................... 248
3.14.11 Using filters when you drill. .................................................................... 251
3.14.12 Saving reports with drill filters. ............................................................... 252
3.14.13 Refreshing data in a drilled report with prompts. ................................. 253
3.14.14 Drilling with query drill. .......................................................................... 253

3.15 Formatting your reports using Cascading Style Sheets. ............................. 256
3.15.1 Using a Cascading Style Sheet in documents. ......................................... 257
3.15.2 Modifying the document default style. .................................................. 257
3.15.3 Modifying and using the standard default style. ..................................... 258
3.15.4 Web Intelligence CSS syntax .................................................................. 258
3.15.5 Style and 3.x documents. ........................................................................ 266

3.16 Filtering report data. .................................................................................... 267
3.16.1 Filtering report data. ................................................................................ 267
3.16.2 Filtering data using input controls. ............................................................ 280

3.17 Enhancing reports with calculations, formulas and variables. ................... 287
3.17.1 Working with standard calculations. ....................................................... 288
3.17.2 Working with formulas. .......................................................................... 288
3.17.3 Working with variables. ........................................................................ 290

3.18 To rename a report. ....................................................................................... 291
3.19 To duplicate a report. .................................................................................... 291
3.20 To delete a report. ......................................................................................... 291
3.21 To change the order of reports. .................................................................... 292
3.22 To add a report. ............................................................................................ 292

4 Working with tables in reports. ................................................................. 293
4.1 Displaying data in tables. .......................................................... 293
  4.1.1 Table types. ........................................................................ 293
  4.1.2 Creating and editing tables. .................................................. 296
  4.1.3 Formatting tables and table cells. ......................................... 299
  4.1.4 Controlling the display of tables. ......................................... 314
  4.1.5 Transforming a dimension in a table using dimension value groups. .......................................................... 317
4.2 Displaying data in free-standing cells. ...................................... 327
  4.2.1 To insert a free-standing cell in a report. ............................. 328
  4.2.2 To hide free-standing cells. .................................................. 329
  4.2.3 To copy a free-standing cell. ................................................ 329
4.3 Organizing data with sections, breaks and sorts. ....................... 330
  4.3.1 Using sections to group data. .............................................. 330
  4.3.2 Using breaks. ..................................................................... 335
  4.3.3 Using sorts to organize data in reports. ................................. 339
4.4 Formatting numbers and dates. ................................................. 343
  4.4.1 Predefined formats. .......................................................... 343
  4.4.2 Custom formats. ............................................................... 344
  4.4.3 To format a number as a currency in a table cell. ................. 348
  4.4.4 To apply a percentage format to a cell number .................... 349
5 Working with charts in reports. .................................................. 350
  5.1 Opening charts created with XI Web Intelligence 3.x. ............... 350
  5.2 Chart types. ........................................................................... 350
    5.2.1 Choosing the correct Web Intelligence chart for your data. 351
    5.2.2 Bar charts. ....................................................................... 353
    5.2.3 Box plot charts. ............................................................. 353
    5.2.4 Column charts. ............................................................... 354
    5.2.5 Line charts. .................................................................... 355
    5.2.6 Map charts. ..................................................................... 356
    5.2.7 Pie charts. ....................................................................... 356
    5.2.8 Point charts. ................................................................. 357
    5.2.9 Radar charts. ................................................................. 358
    5.2.10 Tag cloud charts. .......................................................... 359
    5.2.11 Waterfall charts. ............................................................ 359
  5.3 Adding, copying and removing charts. ................................... 360
    5.3.1 To add a chart to a report. ............................................... 360
    5.3.2 Assigning data to a chart. .................................................. 361
    5.3.3 To apply a chart style. ...................................................... 362
    5.3.4 To copy a chart. ............................................................. 362
    5.3.5 To remove a chart. .......................................................... 363
  5.4 Changing the chart type. ....................................................... 364
    5.4.1 To change the chart type by using Turn Into. .................... 364
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.4.2 Turning hierarchical queries into charts</td>
<td>364</td>
</tr>
<tr>
<td>5.4.3 To switch between bars, lines and surfaces</td>
<td>365</td>
</tr>
<tr>
<td>5.5 Positioning and sizing charts</td>
<td>365</td>
</tr>
<tr>
<td>5.5.1 To set the position of a table or chart on the report page</td>
<td>365</td>
</tr>
<tr>
<td>5.5.2 To position a chart in relation to another chart or table</td>
<td>366</td>
</tr>
<tr>
<td>5.5.3 To resize a chart</td>
<td>367</td>
</tr>
<tr>
<td>5.6 Formatting charts</td>
<td>367</td>
</tr>
<tr>
<td>5.6.1 To format a chart</td>
<td>367</td>
</tr>
<tr>
<td>5.6.2 Formulas in chart elements</td>
<td>368</td>
</tr>
<tr>
<td>5.6.3 Data intervals in Tree Maps, Heat Maps and Tag Cloud charts</td>
<td>368</td>
</tr>
<tr>
<td>5.6.4 Warning icons in charts</td>
<td>374</td>
</tr>
<tr>
<td>5.6.5 To insert and format a chart title</td>
<td>375</td>
</tr>
<tr>
<td>5.6.6 To display a chart with a 3D look</td>
<td>375</td>
</tr>
<tr>
<td>5.6.7 Assigning colors to charts</td>
<td>376</td>
</tr>
<tr>
<td>5.6.8 To modify chart borders</td>
<td>383</td>
</tr>
<tr>
<td>5.6.9 To format the chart background</td>
<td>384</td>
</tr>
<tr>
<td>5.6.10 To modify plot area settings in Waterfall charts</td>
<td>385</td>
</tr>
<tr>
<td>5.6.11 To show and format chart legend</td>
<td>385</td>
</tr>
<tr>
<td>5.6.12 To avoid page breaks in charts</td>
<td>386</td>
</tr>
<tr>
<td>5.6.13 To configure a stacked bar or column chart</td>
<td>386</td>
</tr>
<tr>
<td>5.6.14 To assign axis labels to data values</td>
<td>387</td>
</tr>
<tr>
<td>5.6.15 To format the category or value axis title</td>
<td>388</td>
</tr>
<tr>
<td>5.6.16 To format axis grid values, numbers and text</td>
<td>388</td>
</tr>
<tr>
<td>5.6.17 To show a specific range of axis values</td>
<td>390</td>
</tr>
<tr>
<td>5.6.18 To unlock a value axis in a dual axis chart</td>
<td>390</td>
</tr>
<tr>
<td>5.6.19 Linear and logarithmic axis scales</td>
<td>391</td>
</tr>
<tr>
<td>5.6.20 Displaying and formatting chart data</td>
<td>392</td>
</tr>
<tr>
<td>5.6.21 Making data available for filtering in a web service</td>
<td>405</td>
</tr>
<tr>
<td>5.6.22 To publish a report block as a web service</td>
<td>406</td>
</tr>
<tr>
<td>5.6.23 Viewing and managing published content</td>
<td>408</td>
</tr>
<tr>
<td>5.6.24 Importing and using QaaWS queries as a BI service</td>
<td>409</td>
</tr>
</tbody>
</table>
8.6.3 To switch between viewing modes ........................................... 456
8.7 Tracking changes in data .......................................................... 457
8.8 Drilling on report data in Reading mode ...................................... 458
  8.8.1 Setting drill options ............................................................ 458
  8.8.2 Drilling on measures in tables and sections .............................. 459
  8.8.3 Drilling on dimensions in tables and sections ............................ 459
  8.8.4 Drilling by other dimensions in a report .................................. 460
  8.8.5 Drilling on charts ............................................................... 461
  8.8.6 To take a snapshot of report drill results ................................ 462
8.9 Freezing table headers, columns and rows ..................................... 462
  8.9.1 To freeze table headers ....................................................... 463
  8.9.2 To freeze top rows in a horizontal table .................................. 463
  8.9.3 To freeze left columns in a vertical table ................................ 463
8.10 Unfreezing table headers, columns and rows ................................. 464
  8.10.1 To unfreeze table headers .................................................... 464
  8.10.2 To unfreeze table rows and columns in vertical and horizontal tables 464
8.11 Using simple report filters ....................................................... 465
  8.11.1 To create simple report filters .............................................. 465
8.12 Folding and unfolding report data ............................................. 466
  8.12.1 To fold and unfold report data .............................................. 467
8.13 Warning icons in charts .......................................................... 467

9 Web Intelligence error messages .................................................. 469
9.1 About Web Intelligence Error Messages ...................................... 469
9.2 Web Intelligence module error messages ..................................... 469
  9.2.1 Web Intelligence (WIJ) Error Messages .................................. 469
  9.2.2 Web Intelligence Desktop HTML Interface (WIH) Error Messages 479
  9.2.3 Web Intelligence Desktop (WIO) Error Messages ...................... 480
  9.2.4 Web Intelligence Server (WIS) Error Messages ....................... 482
  9.2.5 Information Engine Services (IES) Error Messages ................... 495
9.3 Report Engine error messages .................................................... 547
  9.3.1 ReportEngine Web Intelligence (RWI) Error Messages ............... 547
9.4 Custom Data Source error messages ............................................ 569
  9.4.1 Custom Data Source (CDS) Framework Error Messages ............. 569
1 Introducing Web Intelligence

1.1 Documentation for SAP BusinessObjects Web Intelligence

The Web Intelligence documentation provides complete instructions for performing interactive analysis on data from the BI launch pad using the SAP BusinessObjects Web Intelligence HTML or Applet interfaces, or using SAP BusinessObjects Web Intelligence Rich Client which can be launched and installed from the BI launch pad.

1.1.1 Document History: Web Intelligence

The following lists provide an overview of the most important document changes.

BusinessObjects Web Intelligence 4.1 Support Package 05

November 2014

- In the BEx query section in the user guide:
  - For an explanation of runtime configuration options, please see the following topic: Runtime Configuration [page 104].
  - For an explanation of manual entry in prompts in the case of a Characteristic Value variable of type Selection Option, please see the following topic: Manual entry of values in prompts on BEx variables [page 97].
- The Web Intelligence Rich Client User’s Guide and Building SAP BusinessObjects Web Intelligence queries based on BEx queries have been merged into the Web Intelligence User’s Guide and are no longer available as separate guides.
- To understand how to select values in the Prompts dialog box, please see the following topic: Selecting prompt values in the Prompts dialog box [page 278].
- To learn about increasing and decreasing the display size of Web Intelligence reports, please see the following topic: Increasing or decreasing the display size of a report in Web Intelligence [page 43].
- To see tips on how to choose a chart for your data, please see the following topic: Choosing the correct Web Intelligence chart for your data [page 351].
- To learn about the input controls you can use to filter data in your reports, please see the following topic: Available input controls [page 280].
- To learn about some of the Web Intelligence report elements supported by SAP BusinessObjects Mobile on mobile devices, please see the following topic: Web Intelligence features that are supported in reports for mobile devices [page 166].
Using the **Hierarchical Navigation** option, you can set the default hierarchy member levels that are visible in a hierarchy table so that they will remain visible to the preferred level or fixed at the root level, even after refresh and data purge actions. For more information see: [Setting default hierarchy levels in a report table](page 187).

Using the **Flatten zero values** option in the **Plot Area** Design chart area of the **Format Chart** dialog box, you can have bars or columns with zero values to be flat against the value axis in a 100% stacked chart. For more information see: [To configure a stacked bar or column chart](page 386).

Using the **Unlock the Axis** option in the **Value Axis 2** Design chart area of the **Format Chart** dialog box, you can unlock the axes in a dual axis chart so that each has its own grid and origin, and the minimum and maximum values share one axis, each according to its data context. For more information see: [To unlock a value axis in a dual axis chart](page 390).

---

Updated information related to the right to left effect on the interface and document locales in Web Intelligence. For more information see: [Interface and document locales](page 38).

In the **Query Properties** side pane of the Web Intelligence Rich Client and Applet interfaces, you can choose to make refreshable a query based on an Excel data source. For more information see: [To build a query on an Excel file](page 77).

A section has been added to the Web Intelligence user documentation, **Feature differences between the Web Intelligence interfaces**, that offers an overview of the main functional differences that exist between all the Web Intelligence interfaces as of BI 4.1 Support Package 03. For more information see: [About the Web Intelligence interfaces](page 14).

In Line charts, you can adjust the thickness of the line in the Format Data Series dialog box as part of custom data series settings. For more information see: [To format a series of data in a chart](page 395).

In Waterfall charts, you can activate or deactivate a reference line and set the spacing between objects in the Waterfall chart plot area. For more information see: [To modify plot area settings in Waterfall charts](page 385).

In all charts, you can use the **Force to Display** option to force the display of a long chart title when “No wrap” has been selected as the Text Policy and the title is longer than the chart width. For more information see: [To format axis grid values, numbers and text](page 388).

The Web Intelligence user guides explain data intervals in charts. Data intervals are based on colors in Tree Map, Heat Map, and Tag Cloud charts that use intervals. The user guides also now explain the Custom Range Coloring, Gradient-based Palette Coloring, Gradient-based Palette Coloring Using Measure Polarity, and Palette Coloring methods. For more information see: [Data intervals in Tree Maps, Heat Maps and Tag Cloud charts](page 368).

The **Allow selection of all values** property in the **Choose Control Type** dialog box for an input control allows a report designer to show or hide the **All Values** option in that input control. For example, the report designer may want to force users to make a value selection instead of having all values displayed. For more information see: [To add an input control](page 282).
November 2013

- You can use the **Use BEx query defined default values at runtime** option in the **BEx Variable Manager** of the Query Panel to choose how to manage the default value a the prompt created from the variable at the first execution or at **Refresh** after a **Purge** prompt action. For more information see: **Managing mandatory variables that do not have a default value** [page 96].

- You can add prompts in the Formula Editor. For more information see: **To build a formula in the Formula Editor** [page 289].

- The Numbers icon in the Standard Actions Group toolbar has been enhanced to offer better access to percentage, currency and decimal formatting.

- You can create a dynamic background image for a report, or its headers, footers, sections, tables and even specific cells in tables using a complex formula in the format dialog box, and format its appearance and location. For more information see: **To format the appearance of reports and their headers, footers, sections, tables, and table cells** [page 194].

- A pre-defined cell based on a query prompt displays the user prompt selections at the last refresh or **Run Query** action. The name of each query prompt is listed in the Prompt list. When you insert a free-standing cell in a report, you can select a pre-defined cell. For more information see: **Displaying data in free-standing cells** [page 327].

- In Waterfall charts, you can assign specific colors to initial values, totals, subtotals or positive/negative variations. For more information see: **To configure the value colors in a waterfall chart** [page 380].

- In the **Result Objects** pane of the Query Panel, there is a specific dialog box containing a description, and in the Web Intelligence Rich Client and Web Intelligence Applet interfaces, you can press Control + C to copy the text to the clipboard. This content can be pasted into other applications.

- In a table in a Web Intelligence report, you can collect the values of a dimension into aggregated groups. A variable object for this aggregated group is created in the **Available Objects** tab on the Side Panel and allows you to manage the group configuration. For more information see: **Transforming a dimension in a table using dimension value groups** [page 317].

### 1.1.2 To access online help

1. Open Web Intelligence.
2. From the **Help** button dropdown list in the application toolbar, select **Help Contents**.

### 1.2 About Web Intelligence

Get instant answers to your business questions and take action on the fly – with fast, decision-ready insights from any data source.

Web intelligence provides business users with flexible, intuitive ad hoc reporting tools and interactive analytics – on the Web, desktop, or mobile device.
You can also:

- Deliver personalized business intelligence to your colleagues, customers, and partners
- Improve productivity by giving users an intuitive tool and clearing IT backlogs
- Get the insights you need, when you need them, no matter where you are

Security rights

Depending on your license, user, and security rights, you can analyze the data in reports. For example, you can perform the following actions:

- Filter data
- Drill down on data to reveal more details
- Merge data from multiple data sources
- Display and view data in charts

Customized interface

The CMC administrator can customize the user interface by hiding elements, such as panels, panes, toolboxes, menus, and menu items. If a user interface element that you need is not available, contact your CMC administrator.

Data sources

Data in Web Intelligence documents can come from:

- Universes, which organize data from relational or OLAP databases into objects or hierarchies
- Personal data providers (such as Microsoft Excel or .csv files), BEx queries based on SAP Info Cubes, web services, or Advanced Analysis workspaces
- You can connect to the HANA (High-Performance Analytical Appliance) data source to use in-memory computing. HANA universes based on HANA views with variables are supported in Web Intelligence.

Note

Web Intelligence supports Hadoop data sources, but Custom SQL is not supported.

You build data providers to retrieve data from data sources and create reports from the data in data providers.
1.3 About the Web Intelligence interfaces

Three interfaces are available for Web Intelligence documents.

You select the interface you prefer in BI launch pad Web Intelligence preferences.

Via the BI launch pad, you can use the Web Intelligence HTML interface and Web Intelligence Applet interface to create documents that analyze data. You can also use Web Intelligence Rich Client to perform data analysis, however Web Intelligence Rich Client allows you to work locally without a connection to a repository.

The interface launched when you open a document to View or Modify in the BI launch pad depends on your Web Intelligence BI launch pad Preferences settings.

Table 1: Web Intelligence interfaces

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Intelligence HTML</td>
<td>Also sometimes referred to as the DHTML interface.</td>
</tr>
<tr>
<td></td>
<td>You launch this interface in the BI launch pad. Depending in your rights,</td>
</tr>
<tr>
<td></td>
<td>you can do the following:</td>
</tr>
<tr>
<td></td>
<td>- Create and edit queries based on No data source, .unx, and .unv universes</td>
</tr>
<tr>
<td></td>
<td>but not on BEx queries.</td>
</tr>
<tr>
<td></td>
<td>- View, create, edit and refresh all types of reports.</td>
</tr>
<tr>
<td>Web Intelligence Applet interface</td>
<td>Also sometimes referred to as the Java applet.</td>
</tr>
<tr>
<td></td>
<td>You launch this interface in the BI launch pad. Depending on your permissi</td>
</tr>
<tr>
<td></td>
<td>ons, you can do the following:</td>
</tr>
<tr>
<td></td>
<td>- Create and edit queries based on No data source, .unx, and .unv universes</td>
</tr>
<tr>
<td></td>
<td>, BEx queries, Analysis views (Advanced Analysis workspaces), and text sources</td>
</tr>
<tr>
<td></td>
<td>- View, create, edit and refresh all types of reports.</td>
</tr>
</tbody>
</table>
Web Intelligence Rich Client, also referred to as Desktop, is a version of Web Intelligence that is installed on your computer and allows you to create and edit queries, and view, create, edit and refresh reports. There are two ways to have Web Intelligence Rich Client installed on your computer:

- From BI launch pad.
- As part of a BI platform installation.

**Note**

Depending on your version of Windows, when you have launched Web Intelligence Rich Client once and closed it, the quick start icon is available in the toolbar. This quick start icon allows you to launch the interface rapidly.

Both versions of Web Intelligence Rich Client can be used to create and edit queries based on no data source, .unx and .unv universes, and Excel and text files.

### Table 2: Data sources you can access depend on the connection mode

<table>
<thead>
<tr>
<th>Data source</th>
<th>Standalone</th>
<th>Offline</th>
<th>Standard (CORBA)</th>
<th>HTTP</th>
</tr>
</thead>
<tbody>
<tr>
<td>.unv universe</td>
<td>Yes*</td>
<td>Yes*</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>.unx dimensional universe</td>
<td>Yes*</td>
<td>No</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>.unx relational universe</td>
<td>Yes*</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>.unx multi-source universe</td>
<td>No</td>
<td>No</td>
<td>Yes*</td>
<td>Yes</td>
</tr>
<tr>
<td>Personal data provider</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>BEx query</td>
<td>No</td>
<td>No</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Views and MSAS2005</td>
<td>No</td>
<td>No</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>Excel file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>text file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Tip**

In the BI launch pad preferences, you can choose in which Web Intelligence interface to open documents when you right-click a document and select View. When you right-click a document and Modify, a different Web Intelligence user interface appears. For example, you can link cells to documents in the Web Intelligence HTML.
interface only, but you can work with queries based on QaaWS (Query as a Web Service) data sources only in the Web Intelligence applet or rich client interface.

You may need to use two Web Intelligence interfaces—one for viewing and one for modifying documents. In that case, use the Web Intelligence HTML interface to view documents and the Web Intelligence applet or rich client interface to modify documents.

Feature differences between the Web Intelligence interfaces

This section provides you with an overview of the main functional differences that exist between all the Web Intelligence interfaces as of BI 4.1 Support Package 03. The availability of certain features depends on which interface you are using.

Table 3: Setting up and using Web Intelligence

<table>
<thead>
<tr>
<th>Feature</th>
<th>HTML interface</th>
<th>Applet interface</th>
<th>Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Web Intelligence locally and offline</td>
<td></td>
<td>Yes *</td>
<td></td>
</tr>
<tr>
<td>Use Right To Left (RTL) alignment based on the Preferred viewing locale setting</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>User Prompt Input appears in the side panel</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

* You can install Web Intelligence Rich Client from the BI launch pad or from a BusinessObjects BI platform 4.1 CD.

Creating and working with documents

<table>
<thead>
<tr>
<th>Feature</th>
<th>HTML interface</th>
<th>Applet interface</th>
<th>Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a folder in which local documents and universes are stored by default on your local machine</td>
<td>Refresh only</td>
<td>Yes *</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit and refresh a document using a BEx query</td>
<td>Refresh only **</td>
<td>Refresh only **</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit and refresh a document using an Advanced Analysis View</td>
<td>Refresh only **</td>
<td>Refresh only **</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit and refresh a document using a text source</td>
<td>Refresh only **</td>
<td>Refresh only **</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit and refresh a document using a web service data source</td>
<td>Refresh only</td>
<td>Refresh only</td>
<td>Yes</td>
</tr>
<tr>
<td>Send a Web Intelligence document to another user in the CMS</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Send a Web Intelligence document by FTP</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Export a document as a CSV file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
# Exporting and Saving Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>HTML interface</th>
<th>Applet interface</th>
<th>Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export a document as a CSV archive file</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save a document as a CSV archive file</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Export a document as a PDF, text, Excel or Excel 2007 file</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Save a document as a PDF, text, Excel or Excel 2007 file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Save a document to the corporate repository</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Autosave documents to My Favorites folder</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* You can only use the Web Intelligence Rich Client version that is installed from the SAP Business Objects suite to build and edit queries based on BEx queries.

** If the text file has previously been copied into the BusinessObjects Enterprise Platform.

---

## Building queries

<table>
<thead>
<tr>
<th>Feature</th>
<th>HTML interface</th>
<th>Applet interface</th>
<th>Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select all the members at a level in a hierarchy that is organized into levels</td>
<td>Yes only for OLAP .unx</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Build queries on Advanced Analysis Views</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Build queries on Excel files saved locally</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Build queries on Excel files saved to the CMS *</td>
<td>Yes</td>
<td>Yes **</td>
<td></td>
</tr>
<tr>
<td>Build queries on BEx queries</td>
<td>Yes</td>
<td>Yes ***</td>
<td></td>
</tr>
<tr>
<td>Build queries on text files</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Access Data mode</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Access the Change Source options in the Data Access table</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Change the data source of queries based on text and Excel files.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>For OLAP .unx universes, when filtering on measures, you can only type a constant.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

* Excel files have to be exported first into the BI launch pad for Life Cycle management.

** The Web Intelligence Rich Client can perform a Change Source on Excel files being stored locally and in the CMS.

*** You can only use the Web Intelligence Rich Client version that is installed from the SAP Business Objects suite to build and edit queries based on BEx queries.
Creating reports

<table>
<thead>
<tr>
<th>Feature</th>
<th>HTML interface</th>
<th>Applet interface</th>
<th>Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access a “Highlight All” button in the “Find” box to highlight all occurrences of a text string in a report page.</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply custom formats to numbers in tables</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Create and edit conditional formatting</td>
<td>(View only)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View the alignment grid from the report editor</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>View the “More on this function” button in the formula editor</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Publishing, formatting and sharing reports

<table>
<thead>
<tr>
<th>Feature</th>
<th>HTML interface</th>
<th>Applet interface</th>
<th>Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set a hyperlink to another document in the CMS</td>
<td>Yes, with a wizard</td>
<td>Yes, no wizard</td>
<td>Yes, no wizard</td>
</tr>
<tr>
<td>Publish content as a web service</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Print documents directly from the interface</td>
<td>Export to PDF first</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

1.4 Application components

Web Intelligence offers several components that you can use to create, edit and navigate documents.

The application has the following components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The main toolbar</td>
<td>You use the main toolbar to open, save and print documents, track data changes and display the report outline. The main toolbar appears in the <strong>File</strong> tab when the application is in <strong>Design</strong> mode.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Toolbars</td>
<td>You work with data providers and perform report design and analysis tasks using the toolbars. Toolbars appear at the top of the application in Data and Design mode only. In Data mode, only those toolbars related to working with data providers are active.</td>
</tr>
<tr>
<td>Side Panel</td>
<td>The Side Panel groups several panes that provide different views of the current document.</td>
</tr>
</tbody>
</table>
| **File** and **Properties** tabs | The File and Properties tabs are only available in Design and Data mode.  
The File tab contains the main file menu tools.  
The Properties tab allows you to set View, Document, and Application properties. |
| Status Bar      | The Status Bar appears beneath the Report Panel and allows you to perform actions such as activating data tracking or changing the display mode. It can be activated and deactivated in the View menu of the Properties tab. |
| **Report Filter** toolbar | This toolbar is used to add simple filters to reports.                                                                                     |
| **Drill** toolbar | When Drill is activated in a document, this toolbar appears. It shows the active drill objects.                                               |

**Related Information**

To create simple report filters [page 274]  
You can filter a report on the object value you select. For example, if you select "US" from the list of values of the Country object, the report is filtered to exclude all rows where Country does not have the value "US".

Side Panel tabs in Web Intelligence [page 20]  
The tabs available in the Side Panel depend on the Web Intelligence interface you are using and the mode in which you are viewing the document.

Drilling down on report data [page 243]  
You can drill down to see the lower-level data that makes up the summary results displayed on reports. This helps explain why high or low results occurred.
1.4.1 Side Panel tabs in Web Intelligence

The tabs available in the Side Panel depend on the Web Intelligence interface you are using and the mode in which you are viewing the document.

Table 4: Web Intelligence interfaces and document modes

<table>
<thead>
<tr>
<th>Mode &gt; Pane tab V</th>
<th>Web Intelligence Applet Interface</th>
<th>Web Intelligence HTML Interface</th>
<th>Web Intelligence Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Data</td>
<td>Design</td>
<td>Reading</td>
</tr>
<tr>
<td>Document Summary</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigation Map</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Report Map</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input Controls</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>User Prompt Input</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Available Objects</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Service Publisher</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The tabs allow you to access to panes in which you can view and configure document information and objects.

- **The Document Summary** pane provides an overview of the document properties.
- (Web Intelligence Applet interface) The **Navigation Map** pane lists all the reports in a document. This pane is the same as the **Report Map** in the Web Intelligence HTML interface.
- (Web Intelligence HTML interface and Web Intelligence Rich Client) The **Report Map** pane lists all the reports in a document. This pane is the same as the **Navigation Map** in the Web Intelligence Applet interface.
- **The Input Controls** pane allows you to add and edit input controls applied to the document.
- **The Web Service Publisher** pane lists the BI services published from the document.
- **The Available Objects** pane lists the data providers and objects available for inclusion in reports.

**Note**

The Web Intelligence HTML interface does not display formulas in this panel.

- **The Document Structure and Filters** pane displays the structure of the document in a tree view, and displays filters applied to different report elements.
- **The Data** pane appears only in **Data** mode and allows you to navigate the data providers in a document.
- **The User Prompt Input** pane lists the default values for a prompt. You can also enter text in the values text box. Multiple items are separated by a semi-colon (;).
1.5 Understanding the BI launch pad

The BI launch pad consists of the following areas:

- Toolbar
- Home and Documents tabs
- My Applications Icons

Toolbar

The Applications menu allows you to start Web Intelligence.

The Preferences menu allows you to set the following application preferences:

- General preferences
- Password
- Locale and time zone preferences
- The Web Intelligence preferences

BI launch pad panes

The BI launch pad consists of the following objects:

The main tabs: Home, Documents, and any open documents.

Table 5: BI launch pad panes

<table>
<thead>
<tr>
<th>Tab pane</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Shows recently viewed documents, unread messages, unread alerts, and recently run documents.</td>
</tr>
<tr>
<td>Documents</td>
<td>Allows you to navigate through the available folders and documents. Click on a folder tab to display any documents in that folder. You can view, organize, and manage documents in this pane.</td>
</tr>
<tr>
<td>Web Intelligence documents</td>
<td>One tab for each open document.</td>
</tr>
</tbody>
</table>

Related Information

About setting Web Intelligence preferences [page 24]
1.5.1 To log into the BI launch pad

To access Web Intelligence via the BI launch pad, you need to log in. Before you can perform interactive analysis from the BI launch pad, you need the following information:

- a URL to the BI launch pad (for example http://arcachon:8080/BOE/BI).
- your user name and password
- your authentication, which controls the resources available to you

Contact your administrator for these details if you do not already know them.

**Note**

By default the server name and authentication method are not displayed on the BI launch pad logon page. You need to supply this information only if your administrator has made these options visible.

To launch SAP BusinessObjects Web Intelligence:

1. Launch a web browser.
2. Point your browser to the BI launch pad bookmark or URL. The login page appears.
3. If the *System* box is blank, type the name of the server followed by a colon (:), and then type the port number.
4. In the *Username* box, type your user name.
5. In the *Password* box, type your password.
6. In the *Authentication* box, select the authentication provided to you by your administrator.
7. Click *Log On*. The BI launch pad home page appears.

1.5.2 To log out of the BI launch pad

You need to log out when you have finished working in the BI launch pad instead of simply closing your web browser.

Logging out ensures that any preferences you modified during your session are saved.

BI administrators can track how many users are logged into the system at any given time and use this information to optimize system performance.

Click *Log Off* on the BI launch pad toolbar.

1.5.3 To start Web Intelligence in the BI launch pad

You can launch Web Intelligence in more than one way.

To start Web Intelligence, in the BI launch pad, do one of the following:
○ Click **Applications ➤ Web Intelligence Application**.

○ Select **Web Intelligence Application** in the application shortcuts.

○ Open a Web Intelligence document.

Web Intelligence starts. The **Web Intelligence** tab is active in the main pane. To check which interface has started (Web Intelligence HTML, Web Intelligence Applet, or Web Intelligence Rich Client), click **Preferences** and select **Web Intelligence**.

---

**Related Information**

About queries [page 44]

You build queries using the Web Intelligence Query Panel.

Choosing the viewing and design interfaces [page 25]

You can set options to determine how you view and explore existing documents and how you create documents or edit and analyze existing documents.

---

1.5.4 **To open a document from the repository**

You can open a document from the corporate repository.

1. In the BI launch pad, click the **Documents** tab to show the documents available in the repository.

2. Click the **Folders** tab, and navigate to the folder containing your document.

3. Select the document, right-click and select **View** to open the document in **Reading** mode, or **Modify** to open the document in **Design** mode.

The version of Web Intelligence that opens depends on the **View** and **Modify** settings in the BI launch pad Web Intelligence preferences.

---

**i Note**

When a document is set to refresh its data on opening (when the **Refresh on open** document property is selected in the document properties), the document displays the latest information. The **Refresh on open** option is dependent on the following CMS settings:

- In **CMC ➤ Application ➤ Web Intelligence ➤ Properties**, the property **Automatic Refresh** security setting is enabled by the BI administrator.

- In **CMC ➤ Application ➤ Web Intelligence ➤ User security**, the security right **Document - disable automatic refresh on open** is disabled for this user by the BI administrator.

---

**Related Information**

Choosing the viewing and design interfaces [page 25]
You can set options to determine how you view and explore existing documents and how you create documents or edit and analyze existing documents.

### 1.5.5 To delete a document from the repository

You can delete a document from the corporate repository, if you have been granted the permission to do so.

1. Log into the BI launch pad
2. Click the **Documents** tab to show the documents available in the repository.
3. Navigate to the folder that contains the document you want to delete.
4. Right-click the document that you want to delete and click **Organize**.
5. Click **Delete**.

### 1.5.6 About setting Web Intelligence preferences

Use the **Preferences** tab of the BI launch pad to do the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Set the user default settings. These are Administrator defined.</td>
</tr>
<tr>
<td>Change Password</td>
<td>Change your password. Enter your old password, then enter the new password twice.</td>
</tr>
<tr>
<td>Locales and Time Zone</td>
<td>Set the <strong>Product Locale</strong>, <strong>Preferred Viewing Locale</strong>, and <strong>Current Time Zone</strong>.</td>
</tr>
<tr>
<td>Analysis edition for OLAP</td>
<td>Set the <strong>Accessibility</strong> mode. (Not described here.)</td>
</tr>
<tr>
<td>Web Intelligence</td>
<td>Choose the interfaces you want to use for <strong>View</strong> and <strong>Modify</strong> modes.</td>
</tr>
<tr>
<td></td>
<td>Select a default universe.</td>
</tr>
<tr>
<td></td>
<td>Set the drill options.</td>
</tr>
<tr>
<td></td>
<td>Set the saving priorities when saving as Excel.</td>
</tr>
<tr>
<td>BI workspaces</td>
<td>Set a default style. (Not described here.)</td>
</tr>
<tr>
<td>Crystal Reports</td>
<td>Set Crystal Reports options. (Not described here.)</td>
</tr>
</tbody>
</table>

### Related Information

*Understanding the BI launch pad* [page 21]
1.5.6.1 Choosing the viewing and design interfaces

You can set options to determine how you view and explore existing documents and how you create documents or edit and analyze existing documents.

You set these options in the Preferences panel in the BI launch pad.

Depending on your permissions, you have a choice of Reading mode, Design mode, and Data mode.

Your choice of interface can be further restricted by your security profile.

When you right-click the title of existing document from the list of corporate documents and select View from the shortcut menu, the document opens in Reading mode. When you create a document, or right-click the title of an existing document and select Modify, the document opens in Design mode.

In the BI launch pad, you have the following choice of View interfaces:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML (no download required)</td>
<td>You view documents using the Web Intelligence HTML interface within the BI launch pad.</td>
</tr>
<tr>
<td>Applet (download required)</td>
<td>You view documents using the Web Intelligence Applet interface, also known as the Java applet, within the BI launch pad.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This interface requires the download of a Java applet.</td>
</tr>
<tr>
<td>Desktop (Rich Client, Windows only, installation required)</td>
<td>You view documents using Web Intelligence Rich Client, a standalone interface that works outside the BI launch pad and allows you to work with documents without being connected to a corporate repository.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Web Intelligence Rich Client must be installed on your local machine.</td>
</tr>
<tr>
<td>PDF</td>
<td>You view documents statically in PDF format.</td>
</tr>
</tbody>
</table>

In the BI launch pad, you have the following choice of Modify interfaces:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML (no download required)</td>
<td>You create, edit and analyze documents using the Web Intelligence HTML interface within the BI launch pad.</td>
</tr>
<tr>
<td>Applet (download required)</td>
<td>You create, edit and analyze documents using the Web Intelligence Applet interface within the BI launch pad. You can select Design or Data mode.</td>
</tr>
</tbody>
</table>
### Interface Description

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
</table>
| Desktop (Rich Client, Windows only, installation required) | You create and edit documents using Web Intelligence Rich Client, also known as Desktop, a standalone interface that works outside the BI launch pad and allows you to work with documents without being connected to a corporate repository. You can select Design or Data mode.  
**Note**  
Web Intelligence Rich Client must be installed on your local machine. |

Once you open a document in a specific interface, you remain in that interface for the rest of your session. For example, if you select **HTML** as your **Read** interface and Web Intelligence Applet as your **Modify** interface, you remain in the Web Intelligence HTML interface even if you switch to Design mode (which uses the Modify interface) within the application.

Also, if you open a document using the **Modify** command with a specific interface chosen, the document will continue to open in that interface, even if you change the modify selection. This is important if you are using a feature that is available in one version of Web Intelligence but not another, as in the case of documents based on BEx queries.

---

**Related Information**

*About Web Intelligence [page 12]*

Get instant answers to your business questions and take action on the fly – with fast, decision-ready insights from any data source.

---

**1.5.6.1.1 To change the document view settings in the BI launch pad**

In the BI launch pad preferences, you can select the type of document view and the Web Intelligence version that appears when you open a document to read or modify.

1. Click **Preferences** in the BI launch pad to open the **Preferences** dialog box.  
2. Click **Web Intelligence** in the **Preferences** list.  
3. Select the viewing interface from the **View** options.  
   - This setting determines which version of Web Intelligence opens your document in Reading mode.  
4. Select the design interface from the **Modify** options.  
   - This setting determines which version of Web Intelligence opens your document in Design modes.
5. Click **Save and Close**.
These changes take effect the next time you open a Web Intelligence document.

### 1.5.6.2 Setting application modes

Depending on the Web Intelligence application mode you are in, you can build queries, documents and reports and analyze the data in reports.

#### Table 7: Application modes described

<table>
<thead>
<tr>
<th>Application Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Data**         | In *Data* mode, you can do the following:  
  - Create, edit and manage queries that supply data to reports.  
  - Add and rename data providers.  
  - Change the source from which a data provider draws its data.  
  All the data providers used by the current document appear in a list in *Data* mode, and all toolboxes not related to working with data providers are disabled.  
  **Restriction**  
  The *Data* mode is not available in the Web Intelligence HTML interface. |
| **Reading**      | *Reading* mode allows you to do the following:  
  - View reports.  
  - Track changes in and drill down on report data.  
  The main application toolbar and the Side Panel are available in *Reading* mode. Toolboxes are not available. |
| **Design**       | *Design* mode allows you to do the following:  
  - Perform a wide range of analysis tasks.  
  - Add and delete report elements such as tables or charts.  
  - Apply conditional formatting rules.  
  - Enhance reports with formulas and variables.  
  - Work with the report structure or with the report populated with data. Working with the report structure only allows you to make modifications without accessing the server. When you work with reports populated with data, each change you make is applied on the server.  
  **Tip**  
  If you are making numerous modifications, we recommend that you work with the report structure, and to populate the report with data when you have finished your modifications. |
1.5.6.2.1  To switch between application modes

Depending on the mode you choose, the toolboxes and toolbars relevant to the mode are made available and other toolboxes and toolbars are either invisible or disabled.

In a Web Intelligence document, do one of the following:

- To work in **Data** mode, click **Data**.

  **Note**
  
  *Data* mode is only available in Web Intelligence Applet interface and Web Intelligence Rich Client.

- To work in **Reading** mode, click **Reading** in the top corner of the toolbar.

- To work in **Design** mode with only the report structure showing, click the arrow on the **Design** button and select **Structure Only** from the dropdown list.

- To work in **Design** mode with report data, click the arrow on the **Design** button and select **With Data** from the dropdown list.

1.6  Setting up and using Web Intelligence Rich Client

1.6.1  To install Web Intelligence Rich Client from the BI launch pad

You can download Web Intelligence Rich Client to your computer from the BI launch pad.

1. Log into the BI launch pad.
2. Click **Preferences**.
3. Click **Web Intelligence**.
4. In the **Modify** section, click *(installation required) after Desktop (Rich Client, Windows only, installation required).*
   A panel appears asking you if you want to run or save **WebSetup.exe** on your computer.
5. Click **Run**.
   Web Intelligence Rich Client is downloaded to your computer and launched when you launch the application from the BI launch pad. Due to the file size, this process might take a few minutes.
6. Click **Save & Close**.
7. You need to manually set up in the Windows registry the ResolveHTTPUrl value in the BlobManager sub-key of the WebIntelligence key. Contact your IT administrator for help with this task.

**Note**
If you install Web Intelligence Rich Client from the BI launch pad, the online help system is not installed to your local computer. If you work in **Connected** mode, Web Intelligence Rich Client displays help pages stored on the server. If you work in **Offline** or **Standalone** mode, help pages are not available.
1.6.2 To install Web Intelligence Rich Client from the SAP BusinessObjects Enterprise CD

You have access to the SAP Business Objects Enterprise CD and have administrator rights to install applications on your computer.

1. See the UNIX or Windows version of the *Business Intelligence Platform Installation Guide* for SAP BusinessObjects Business Intelligence platform 4.1 for full installation instructions. This guide is available on the SAP Help Portal (http://help.sap.com/).

2. Refer to the *Web Intelligence Rich Client Installation Guide* for information on installing and configuring Web Intelligence Rich Client on your computer.

1.6.3 Online help in a Web Intelligence Rich Client installation

If you install Web Intelligence Rich Client from the BI launch pad, the online help system is installed to your computer.

Every time you open Web Intelligence Rich Client, and regardless of which work mode you are in, the help that appears when you click the Help icon is that which was installed on your computer.

**Note**

If the local version of Web Intelligence Rich Client is different from the BI launch pad and the Web Intelligence HTML and Applet interfaces on the BI launch pad, then the Web Intelligence Rich Client help will not correspond with the help of the interfaces accessed in the BI launch pads. To update the Web Intelligence Rich Client interface and its help, you need to re-install this interface from the latest SAP BusinessObjects Enterprise CD or from the BI launch pad preferences.

You can make help available by specifying a local folder or a URL where Web Intelligence Rich Client can access the help.

Related Information

*Connection modes* [page 30]

*Web Intelligence Rich Client uses different connection modes.*

*About the Web Intelligence interfaces* [page 14]

*Three interfaces are available for Web Intelligence documents.*
Web Intelligence Rich Client uses different connection modes.

1.6.3.1 To specify the folder or URL for online help

You can select either select a folder for Web Intelligence online help or enter a URL.

1. Launch Web Intelligence Rich Client.
2. In the Properties tab, click Application.
3. In the Web Intelligence Options dialog box, select the General tab.
4. Click Browse next to Help and select a folder.
   You can also type a URL as the location of the online help.
5. Click Open, then OK.

1.6.4 Web Intelligence Rich Client notification icon

Any time you open a .wid Web Intelligence document in Web Intelligence Rich Client, a Web Intelligence Rich Client notification icon appears in the Windows system tray and remains during a Windows session.

You use the Web Intelligence Rich Client notification icon to do the following:

- Launch the application in a new window.
- Exit Web Intelligence Rich Client.

Tip

In Windows 7, when you open Web Intelligence Rich Client, an icon appears in the Windows taskbar that vanishes when you close a Web Intelligence Rich Client window. To have the Web Intelligence Rich Client icon remain in the taskbar, right-click the icon and select Pin this program to taskbar.

1.6.5 Connection modes

Web Intelligence Rich Client uses different connection modes.

You can use Web Intelligence Rich Client in the following connection modes: Connected, Offline, or Standalone.

1.6.5.1 About connection security rights and working locally

BI administrators can use the Download connection locally security right in the CMS to control connection security rights in Web Intelligence Rich Client.

When the Download connection locally security right is granted to connection objects a local refresh is performed if the middleware is correctly installed and configured. When the security right is denied, no local refresh is
executed. The refresh is delegated to the server side. Query creation and modification is possible only for queries not using secured connection.

When working with a document from BusinessObjects XI 4.0 or earlier, save the document and reopen it. The security right will be correctly applied.

**Note**
The BI administrator must define the security associated with the connection, for example the sensitive connection information that can be downloaded locally and by which users.

When the security option has been activated:

- No connection information transit is allowed to the client side (extra secure mode).
- In a limited offline mode, it is not possible to refresh locally.
- In a fully offline mode, reports can be opened, viewed and modified, but not refreshed, and the query cannot be modified.

**Note**
When working with multiple queries in a document, the refresh action works only for non-secured connections. A warning is displayed when at least one query is using a secured connection.

### 1.6.5.2 Connected mode

In *Connected* mode, you work while connected to a SAP BI BusinessObjects CMS (Central Management Server). You can work with documents on the CMS or with local secured or unsecured documents. According to your security rights in the CMS, you can do the following:

- import documents and universes from the CMS
- open, create, edit, and refresh local documents
- save documents locally
- export documents to the CMS

**Security in Connected mode**

When you work with documents in *Connected* mode, the security rights of your user account are applied by the CMS.

**Connecting to the CMS in Connected mode**

There are two ways of launching Web Intelligence Rich Client, and each connects to the CMS differently:
When you launch Web Intelligence Rich Client from the BI launch pad, it connects to the CMS within the same BI launch pad session, so no login is required. Communication with the CMS goes through HTTP to an application server, which reroutes the calls to the CMS and repository. No local middleware is required.

When you launch Web Intelligence Rich Client locally via the Windows Start menu or by double-clicking a .wid document, Web Intelligence Rich Client connects to the CMS in client-server mode using the OCA/CORBA framework of the Enterprise SDK. You need the appropriate database middleware on your local machine.

**Note**

In order to connect to an Essbase OLAP data source from SAP BusinessObjects OLAP products including universe design tool, Web Intelligence Rich Client and Web Intelligence, ensure that Essbase Client middleware is properly installed and configured on machines hosting those SAP BusinessObjects OLAP products. Specifically, ensure that Essbase Client environment variables ARBORPATH and ESSBASEPATH are created and set as Windows system environment variables instead of Windows user environment variables.

### Related Information

- **To work on an existing document locally in Connected mode** [page 33]
  - You can launched Web Intelligence Rich Client in Connected mode.

- **To work in Connected mode from the BI launch pad** [page 32]
  - In Connected mode, security is handled by the CMS. You work with documents as you do when working in the BI launch pad.

### 1.6.5.2.1 To work in Connected mode from the BI launch pad

In Connected mode, security is handled by the CMS. You work with documents as you do when working in the BI launch pad.

You do not need database middleware on your local machine when you launch Web Intelligence Rich Client from the BI launch pad.

1. Log into the BI launch pad.
2. Click Preferences at the top of the BI portal.
3. In the Preferences dialog box, select Web Intelligence.
4. In the Modify section, select Desktop.
5. Click Save & Close to close the Preferences dialog box.
6. In the BI launch pad, click the Documents tab.
7. Right-click a document and select Modify.

Web Intelligence Rich Client is launched on your computer in the Connected mode. If it is not yet installed on your computer, it is installed from the BI launch pad.

If Web Intelligence Rich Client was already running on your computer, launching from the BI launch pad opens a new instance of the application. The document is not opened in the application instance that was already open.
1.6.5.2.2 To work on an existing document locally in Connected mode

You can launched Web Intelligence Rich Client in Connected mode.

To launch Web Intelligence Rich Client in Connected mode locally, it must be installed on your computer. You must have already connected at least once to the CMS you want to work with using Web Intelligence Rich Client from the BI launch pad.

You need to have the middleware required to connect to the CMS installed on your computer. In the Connected mode, security is handled by the CMS.

1. Launch the Web Intelligence Rich Client from the Windows Start menu.
2. Select a document from the Recent Documents dialog box.
3. In the User Identification dialog box, enter a valid user name and password.
4. Select an authentication mode from the list.

   Do not choose Standalone from the System dropdown list if you want to work in Connected mode. When you choose standalone authentication you work in Standalone mode, with no CMS connection.

   CAUTION

   Make sure the Use in Offline mode option is not selected.

5. Click Log in.

If Web Intelligence Rich Client was already running on your computer, launching it again opens a new instance of the application.

1.6.5.3 Offline mode

In Offline mode, you are not connected to a CMS but CMS security still applies.

You can work with local documents and universes that are secured by the CMS you select at login, or with unsecured local documents and universes. You can do the following:
• open local documents
• create documents (requires local universe and local connection server)
• edit documents
• refresh documents (requires local universe and local connection server)
• save documents locally

In Offline mode, you cannot import documents from or export documents to a CMS.

### Security in Offline mode

When you connect to a CMS in Connected mode, your security rights in that CMS are downloaded to your computer. Each document and universe downloaded from a CMS contains within it an access control list identifying groups and users that have access rights to the document. In Offline mode, CMS security rights are applied by matching the access rights for the document or universe against the locally stored security file. For example, if a document was downloaded from a CMS to your local machine, and you do not have the right to open the document in the CMS from which it was downloaded, you cannot open the document on your local machine. If the security settings on objects do not allow working in offline mode, those objects cannot be included when the document is used later.

Before you can work in Offline mode with documents or universes secured by a CMS, you must first have connected to that CMS at least once in Connected mode. This causes in the CMS security information to be downloaded to your local machine and the CMS appears as a choice in the System dropdown list on the User Identification page. You can then log in in Offline mode and work with no CMS connection because the CMS security information is readable from the local file.

The security information for a CMS is stored in a local security information file with the LSI extension. One computer can store LSI files for multiple CMSs.

### 1.6.5.3.1 To work in Offline mode

There are a few ways you can work in Web Intelligence Rich Client in offline mode.

You must have already connected at least once to the CMS from which the document you want to work was exported, by launching Web Intelligence Rich Client from within the BI launch pad and opening the document in it.

1. Launch Web Intelligence Rich Client.
2. Do one of the following to open a document:
   ○ In the Recent Documents list of the Open Document pane, select a document exported from the CMS whose security details are stored on your local machine.
   ○ Click Open in the toolbar, then browse to and double-click a .wid file.
3. In the User Identification dialog box, select the CMS from the System dropdown list.
4. Type your username and password.
5. Select the authentication method from the Authentification dropdown list.
6. Select Use in Offline mode.
7. Click Log On.

1.6.5.3.2 To select default folders for local documents and universes

In Web Intelligence Rich Client and the Web Intelligence Applet interface, you can select a folder where local documents and universes are stored by default on your local machine.

1. In a Web Intelligence document in Design mode, click Application in the Properties tab.
2. In the Web Intelligence Options dialog box, select the General tab.
3. Next to User documents, click Browse, and select a folder for documents.
4. Next to Universes, click Browse, and select a folder for universes.
5. Click OK to close the Web Intelligence Options dialog box.

1.6.5.4 Standalone mode

In Standalone mode, you are not connected to a CMS and no security is enforced.

You can work with local, unsecured documents and universes only. You can do the following:

- open, create, edit, and refresh documents
- save documents locally

You cannot import documents from or export documents to a CMS.

The middleware required to create and refresh local, unsecured documents with local, unsecured universes must be installed on the computer on which you run Web Intelligence Rich Client.

1.6.5.4.1 To work in Standalone mode

You can work on documents in Web Intelligence Rich Client in Standalone mode.

Any middleware required to work with unsecured documents and universes must be installed on your computer.

1. Launch Web Intelligence Rich Client.
2. Select Open from the menu, navigate to and double-click a .wid document.
3. In the User Identification dialog box, select Standalone from the System dropdown list.
4. Click Log On.
1.6.5.5 Defining the Proxy Settings in Web Intelligence Rich Client

You define the proxy settings when you use an internet proxy server to access any URLs or images in your reports.

You do not need to define these settings for images that are embedded in a report. Check the settings on your internet browser or contact your BI administrator to obtain the information required to define your proxy settings.

To define the proxy settings, perform the steps below:

1. Launch Web Intelligence Rich Client.
2. In the Properties tab, click Application.
3. In the Web Intelligence Options dialog box, click the Proxy tab.
4. Define your Http Proxy Host.
5. Define the Http Proxy Port.
6. Define your Https Host and Port Settings, or select same as Http Proxy.
7. Click OK to save the settings and close the Web Intelligence Options dialog box.

1.6.6 Working with universes in Web Intelligence Rich Client

1.6.6.1 Working with universes in Connected mode

When you perform desktop data analysis in Connected mode, you access CMS universes remotely. The CMS applies the security rights directly, exactly as if you were performing data analysis from the BI launch pad.

1.6.6.2 Working with universes in Offline mode

You cannot access universes on the CMS remotely, because in Offline mode you are working without a CMS connection.

To create or refresh a report in Offline mode, you must have first connected to the CMS in Connected mode so that a local security information (LSI) file containing your security rights to the resources in the CMS is downloaded to your computer.

When you create or refresh a report in Offline mode, you can use:

- locally installed universes that are not secured by the CMS
- locally installed universes which you are authorized to access, as verified by the LSI file

Note: You need to have a connection server installed on the computer where you perform desktop data analysis in order to create or refresh documents in Offline mode.
1.6.6.3 Working with universes in Standalone mode

In Standalone mode in Web Intelligence Rich Client, you can work with a local universe, without need of a connection to the CMS.

In Standalone mode, you cannot access local, CMS-secured universes. You must access the CMS universes remotely. You can only work with unsecured, locally installed universes.

The middleware required to create and refresh local, unsecured documents with local, unsecured universes must be installed on the computer where you perform desktop analysis.

When you copy the universe file locally, it should be saved in the following folder:

<install_path>\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.1\Universes.

1.6.6.4 To set the default universe for a document

You can set the default universe in the Web Intelligence Options dialog box.

1. Open a Web Intelligence document in Design mode.
2. In the Properties tab, click Application.
3. In the Web Intelligence Options dialog box, select the General tab.
4. In the Select default universe section, click Select a universe.
5. Click Browse.
6. In the Universe dialog box, select a universe and click Select.
7. Click OK to close the Web Intelligence Options dialog box.

1.6.7 To set viewing preferences

You can set Web Intelligence Rich Client viewing preferences in the Web Intelligence Options dialog box.

1. Launch Web Intelligence Rich Client.
2. In a Web Intelligence document open in Design mode, click Application on the Properties tab.
3. In the Web Intelligence Options dialog box, select the Viewing tab.
4. Select a measurement unit for report display in the Measurement unit section.
5. To display a grid for the alignment of report elements, select Show grid.
6. To align report elements to the grid automatically, select Snap to grid.
7. To set the amount of space between the lines in the grid, set the value in Grid spacing.
8. Click OK to close the Web Intelligence Options dialog box.
1.6.8   To change your password

You can change your password in the BI launch pad preferences.

1. Launch Web Intelligence Rich Client from the Windows Start menu and connect to the server so that you are in Connected mode.
2. Select Preferences from the BI launch pad toolbar.
3. Select Change Password.

   **Note**
   If this option is grayed out, then your ability to change your password has been disabled by the BI Administrator.

4. Type your current password in the Old Password box.
5. Type your new password in the New Password box.
6. Type your new password again in the Confirm New Password box.

Your password is changed to the new password.

Related Information

To work on an existing document locally in Connected mode [page 33]
You can launched Web Intelligence Rich Client in Connected mode.

1.7   Interface and document locales

Locales determine the appearance of the application interface (for example, menu items and button text) and data (for example, date and number formatting) in relation to local preferences.

The locales used by Web Intelligence are:

<table>
<thead>
<tr>
<th>Locale</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product locale</strong></td>
<td>The language and interface alignment control of the Web Intelligence application interface. This locale can be selected in the following locations:</td>
</tr>
<tr>
<td></td>
<td>● In the Web Intelligence HTML or Web Intelligence Applet interface, the setting is in the BI launch pad preferences.</td>
</tr>
<tr>
<td></td>
<td>● In the Web Intelligence Rich Client, the setting is in the Application Properties.</td>
</tr>
</tbody>
</table>
### Locale

<table>
<thead>
<tr>
<th>Locale</th>
<th>Description</th>
</tr>
</thead>
</table>
| Preferred viewing locale      | The preferred locale for displaying document data. This locale can be selected in the following locations:                                                                                           ● In the Web Intelligence HTML or Web Intelligence Applet interface, the setting is in the BI launch pad preferences.  
  ● In the Web Intelligence Rich Client, the setting is in the Application Properties.                                                                                                                                      |
| Document locale               | The date and number locale in the document.                                                                                                                                                                                                                       ● In the Web Intelligence HTML or Web Intelligence Applet interface, this locale cannot be selected.                                                                 |
|                               | ● In the Web Intelligence Rich Client, the Permanent regional formatting setting is available in the Document Properties.                                                                                                                                                               |

### Right to left alignment in Web Intelligence

In the Web Intelligence Applet interface and Web Intelligence Rich Client, the alignment of the application interface is from right to left (RTL) when you select Arabic or Hebrew. The alignment of the document content may be RTL, depending on the system settings selected by the BI administrator.

**Note**

RTL alignment is not available in the Web Intelligence HTML interface.

### Product locale and Right to Left interface alignment

When you choose Arabic or Hebrew for the **Product locale**, the Web Intelligence application interface elements are always right to left (RTL), in effect mirroring the left to right (LTR) alignment. For example, the side panel for an RTL locale is on the right, whereas in an LTR locale, the side panel is on the left.

### Preferred viewing locale and Right to Left alignment

As of XI 4.1 Support Package 3, the document content alignment is specified by the BI administrator in the CMC Web Intelligence system configuration, and cannot be changed for individual users.

When you choose Arabic, Hebrew, Farsi, Urdu or Divehi for the **Preferred viewing locale**, depending on the system settings selected by the BI administrator, the elements and data in documents created in this locale may be right to left (RTL). For example, in a cross table, in an LTR locale the side header column is on the left. In an RTL locale, the side header column is on the right.
Caution

- In the Web Intelligence HTML interface, documents created in an RTL content alignment cannot be viewed or modified.
- Documents created in an RTL Preferred viewing locale cannot be converted to an LTR document format.
- Documents created in an LTR format, can be edited with RTL settings, but cannot be converted to RTL.
- Charts are LTR, per the SAP Globalization product standards.

Related Information

To set the Product locale in the BI launch pad [page 41]
In the BI launch pad preferences, you can choose the product locale.

To link the current document locale to a document in the BI launch pad [page 42]
In the BI launch pad preferences, you can choose the locale language for open documents in Web Intelligence.

To set the Preferred viewing locale in the BI launch pad [page 43]
In the BI launch pad preferences, you can choose a Preferred Viewing Locale language for Web Intelligence.

To set the Product locale in Web Intelligence Rich Client [page 40]
You can set the Product locale for Web Intelligence Rich Client in the Web Intelligence Options dialog box.

To associate a locale with a document in Web Intelligence Rich Client [page 41]
You can associate a locale with a document in Web Intelligence Rich Client.

To set the Preferred viewing locale in Web Intelligence Rich Client [page 43]
You can set the Preferred viewing locale for Web Intelligence Rich Client in the Web Intelligence Options dialog box.

1.7.1 The Product locale

The Product locale controls the user interface.

For example, the Product locale determines the menu items and button text.

1.7.1.1 To set the Product locale in Web Intelligence Rich Client

You can set the Product locale for Web Intelligence Rich Client in the Web Intelligence Options dialog box.

1. Open a Web Intelligence document in Design mode.
2. In the Properties tab, click Application.
3. In the Web Intelligence Options dialog box, select the Locale tab.
4. Choose a locale from the Product locale list.
5. Click OK to close the Web Intelligence Options dialog box.

1.7.1.2 To set the Product locale in the BI launch pad

In the BI launch pad preferences, you can choose the product locale.

1. Click Preferences on the BI launch pad toolbar to open the Preferences dialog box.
2. Click Locales and Time Zone in the Preferences list to display the available options.
3. Select the product locale from the Product Locale list.
4. Click Save and Close.

1.7.2 The document locale in documents

The document locale, generated by Web Intelligence, formats the data in documents.

For example, the document locale determines the display of dates and numbers.

By default, the browser locale is used. You can permanently associate the current document locale with a document by saving the document with the Permanent regional formatting option selected in the Document Summary dialog box. When you select this option the document data is always formatted using the document locale you have set. This applies to all users who view the document, not just the user who activates Permanent regional formatting.

In Web Intelligence Rich Client, if the Use the document locale to format the data setting is selected in the application properties, the document locale determines how date and number formats.

Related Information

To associate a locale with a document in Web Intelligence Rich Client [page 41]

You can associate a locale with a document in Web Intelligence Rich Client.

1.7.2.1 To associate a locale with a document in Web Intelligence Rich Client

You can associate a locale with a document in Web Intelligence Rich Client.

This task does not work in the Web Intelligence HTML interface or Web Intelligence Applet interface.

1. In a Web Intelligence document in Design mode, click Document on the Properties tab.
2. In the Document Summary dialog box, select Permanent regional formatting.
3. Click **OK** to close the *Document Summary* dialog box.
4. Save the document.

### 1.7.2.2  To link the current document locale to a document in the BI launch pad

In the BI launch pad preferences, you can choose the locale language for open documents in Web Intelligence.

1. Click **Preferences** on the BI launch pad toolbar to open the *Preferences* dialog box.
2. Click **Web Intelligence** in the *Preferences* list.
3. In the section *When viewing a document*, select one of the following:
   - **Use the document locale to format the data**
   - **Use my preferred viewing locale to format the data**
4. Click **Save and close**.

### Related Information

*The Preferred viewing locale* [page 42]

The Preferred viewing locale is the locale you select that affects the display of document data.

*To set the Preferred viewing locale in the BI launch pad* [page 43]

In the BI launch pad preferences, you can choose a Preferred Viewing Locale language for Web Intelligence.

### 1.7.3  The Preferred viewing locale

The *Preferred viewing locale* is the locale you select that affects the display of document data.

When you create a document, your Preferred viewing locale is always assigned as the initial document locale, whether or not the locale settings give the Preferred viewing locale priority.

**Note**

If the settings do not give your Preferred viewing locale priority, the data is formatted according to the document locale saved with the document.

In Web Intelligence Rich Client, if the locale settings give your Preferred viewing locale priority through the Use the Preferred viewing locale to format the data setting in the application properties, the document locale is set to the Preferred viewing locale when you open a document. When you save the document, this document locale is saved with the document.
1.7.3.1 To set the Preferred viewing locale in Web Intelligence Rich Client

You can set the Preferred viewing locale for Web Intelligence Rich Client in the Web Intelligence Options dialog box.

1. Open a Web Intelligence document in Design mode.
2. In the Properties tab, click Application.
3. In the Web Intelligence Options dialog box, select the Locale tab.
4. Select a locale from the Preferred viewing locale dropdown list.
5. Click OK to close the Web Intelligence Options dialog box.
6. Close and reopen any open documents so that the locale setting is changed in the documents.

1.7.3.2 To set the Preferred viewing locale in the BI launch pad

In the BI launch pad preferences, you can choose a Preferred Viewing Locale language for Web Intelligence.

1. Click Preferences on the BI launch pad toolbar to display the Preferences dialog box.
2. Click Locales and Time Zone in the Preferences list to display the available options.
3. Select the preferred viewing locale from the Preferred Viewing Locale list.
4. Click Web Intelligence to display the Web Intelligence options.
5. If you want data to be formatted using the preferred viewing locale, click Use my Preferred Viewing Locale to format the data beneath When viewing a document.
6. Click Save and Close.

1.8 Increasing or decreasing the display size of a report in Web Intelligence

You can zoom in and out in Web Intelligence reports using the zoom percentage list box on the bottom toolbar.

You can decrease and enlarge the report size from 10% to 500%.

In the Web Intelligence HTML interface, you can use the browser zoom feature to increase or decrease the display size. However, the text size setting within a browser does not change the size of text in a Web Intelligence report.

Restriction
Microsoft Windows allows users to change the display size of text and other items on the computer screen using a magnifier tool. This tool is not supported in the Web Intelligence interfaces.
2 Working with queries

2.1 Building queries

2.1.1 About queries

You build queries using the Web Intelligence Query Panel.

The data sources you can use for a query depend on the interface you are using.

Table 8: Available data sources

<table>
<thead>
<tr>
<th>Data source</th>
<th>HTML interface</th>
<th>Applet interface</th>
<th>Web Intelligence Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>No data source</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Universe (.unx or .unv)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>BEx query</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis View</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Text source</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

You run the query to return data in a report which you can then analyze further by, for example, filtering or ranking its data.

Measures are common to all queries. Measures return data, often numeric, that is calculated based on the other objects in the query (dimensions or hierarchies). For more information on measures, see Measures [page 49].

Queries based on universes can be hierarchical or non-hierarchical. Non-hierarchical queries organize data in dimensions which have no hierarchical relationship. For example, a query containing a customer dimension and a revenue measure calculates revenue per customer. For more information on universe queries, see Building queries on universes [page 53].

Hierarchies organize data into hierarchical relationships. For example, a geographical hierarchy can contain data about countries, states and cities (different levels of the hierarchy). A query containing a geographical hierarchy and a revenue measure calculates revenue at the different levels of the hierarchy (country, state, city). For more information on hierarchies, see Hierarchies [page 47].

Whether a universe query is hierarchical or non-hierarchical depends on the database from which the universe retrieves its data.

Note

- You can create a blank document that does not use a data source.
- To connect to an Essbase OLAP data source from SAP BusinessObjects OLAP products including universe design tool, Web Intelligence Rich Client and Web Intelligence via the BI launch pad, the BI administrator must ensure that Essbase client environment variables ARBORPATH and ESSBASEPATH are created and set as Windows system environment variables on machines hosting those SAP BusinessObjects OLAP products.
2.1.1.1  Objects available in queries

You can use a variety of objects in Web Intelligence queries.

The following objects can be used in Web Intelligence queries:

- classes and subclasses
- dimensions
- attributes
- hierarchies
- level objects
- members
- named sets
- calculated members
- measures

2.1.1.1.1  Classes and subclasses

Objects are grouped into folders called classes.

Each class can also contain one or more subclasses. Subclasses contain objects that are a further subcategory of the objects in the upper level of the class.

The role of classes is to organize the objects into logical groups. When you create queries on the universe, classes help you to find the objects that represent the information that you want to use in a query.

Related Information

About queries [page 44]

You build queries using the Web Intelligence Query Panel.

2.1.1.1.2  Analysis dimensions

An analysis dimension contains a collection of related hierarchies.

Analysis dimensions do not appear as result objects in queries. If you select an analysis dimension, its default hierarchy appears in the query.

Analysis dimensions use the following icon:
Related Information

Hierarchies [page 47]
A hierarchy is a set of data members arranged in levels or parent-child relationships.

2.1.1.3 Dimensions

A dimension can represent non-hierarchical data in a report.

For example, in a query containing a non-hierarchical [Customer] dimension and the [Revenue] measure, the results show the revenue generated by each customer in non-hierarchical columns.

In hierarchical data sources, hierarchies appear beneath the dimensions on which they are based in the list of available objects. When you include the dimension in a query hierarchical data is returned.

Related Information

Hierarchies [page 47]
A hierarchy is a set of data members arranged in levels or parent-child relationships.

2.1.1.4 Attributes

An attribute provides descriptive data about a dimension or hierarchy. For example, Age can be an attribute of the Customer dimension.

Attributes must have a one-to-one relationship with their associated dimension. Each value of a dimension object can have only one associated value of any attribute. Using the example in the Dimension topic, each Customer value can have only one associated value in the Age detail object.

If, due to incorrect universe design, a detail object tries to return multiple values for one dimension value, its cell displays the #MULTIVALUE error message.

Attributes use the following icon:

Note
For .unv universes, created with the universe design tool, attributes are referred to as details, and apply to relational data sources.
Related Information

*Dimensions* [page 46]

A dimension can represent non-hierarchical data in a report.

### 2.1.1.5 Hierarchies

A hierarchy is a set of data members arranged in levels or parent-child relationships.

For example, a [Geography] hierarchy might contain the [Country], [State] and [City] levels. Hierarchical objects are used in BEx, OLAP and relational data sources.

Hierarchies produce hierarchical columns in the result set produced by the query. You can expand the items in the hierarchy to explore its data. For example, you can expand the [California] level in a [Geography] hierarchy to explore data related to California.

You can select which members appear in the result set by using the *Member Selector* dialog box accessed via the *Query Panel*.

In hierarchical data sources, hierarchies are associated with a dimension and appear beneath the dimension with which they are associated in the list of available objects. The following information is also displayed with the hierarchy objects:

<table>
<thead>
<tr>
<th>Display object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This is the Web Intelligence default hierarchy, it is the placeholder for the retrieved hierarchy.</td>
</tr>
<tr>
<td><img src="checkmark.png" alt="White checkmark" /></td>
<td>A white checkmark (V) in a black circle. This is the validation or toggle, and indicates that this object is the ‘active’ hierarchy in BEx, MSAS, and Essbase (in MSAS, the term default is used to describe the active hierarchy).</td>
</tr>
<tr>
<td><img src="version.png" alt="Version number" /></td>
<td>This applies to BEx queries. This is the version number of the SAP BW hierarchy that was used at design time. For these hierarchies, Web Intelligence now displays the version of the hierarchy after the hierarchy name. For example: Country hierarchy [2]. The BEx query designer can prepend a string before the version number for clarity, for example: [version 2]. This version is also displayed in the report table header.</td>
</tr>
</tbody>
</table>

Related Information

*Dimensions* [page 46]

A dimension can represent non-hierarchical data in a report.

*Hierarchical queries* [page 51]

A hierarchical query contains at least one hierarchy object.
2.1.1.6 Level objects

A level is a set of members in a hierarchy at the same distance from the root of the hierarchy.

For example, [City] might be a level in a [Geography] hierarchy which contains members such as [Los Angeles] and [San Francisco]. The level names are prepended by their depth. The numbers are contiguous, and always start from the root with the number 1 as follows:

1 - Level a
2 - Level b
3 - Level c

Levels produce flat columns in the result set generated by the query. For example, a query containing the [Country] level and [Revenue] objects produces a result such as the following:

<table>
<thead>
<tr>
<th>Country</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>10,123,121</td>
</tr>
<tr>
<td>France</td>
<td>8,232,231</td>
</tr>
<tr>
<td>Germany</td>
<td>7,342,342</td>
</tr>
<tr>
<td>UK</td>
<td>9,343,092</td>
</tr>
</tbody>
</table>

Not all hierarchies contain levels. Levels are not available in hierarchies in BEx queries.

Levels use the following icon:

Related Information

Building queries based on BEx queries [page 79]

BEx queries (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).

Hierarchies [page 47]

A hierarchy is a set of data members arranged in levels or parent-child relationships.

2.1.1.7 Members

A member is an individual data item in a hierarchy.

For example, the [Geography] hierarchy can contain members such as [France] at the [Country] level, or [Las Vegas] at the [City] level.

You select individual members from a hierarchy for inclusion in the query result if you do not want to include all members in the hierarchy. You can also define a named set containing a set of members.
2.1.1.8 Named sets

A named set is a named expression that returns a set of members.

Named sets can be defined in OLAP databases, or in universes based on relational or OLAP databases.

2.1.1.9 Calculated members

Calculated members are members returned by an MDX expression. MDX is the language used to access hierarchical data in OLAP databases.

The administrator of an OLAP database can create calculated members that are available to MDX queries that access the database.

Calculated members use the following icon:

2.1.1.10 Measures

Measures retrieve data, usually numeric, that is the result of calculations on data in the database.

For example, Revenue is the calculation of the number of items sold multiplied by item price. Measures are often located in a Measures class.

By default, measures are calculated by aggregating detailed values returned from the database.

Smart measures are a special kind of measure that are calculated by the database itself and returned by the query already aggregated. In certain situations, smart measures impact the way in which calculations are displayed. For more information on smart measures, see the Using functions, formulas and calculations in Web Intelligence guide.

Measures return results based on the objects with which they are associated in a query. For example, a query containing the [Customer] dimension and [Revenue] measure returns revenue by customer. A query containing the [Geography] hierarchy and [Revenue] measure returns revenue calculated for all the different aggregations possible in the hierarchy.

Measure objects use the following icon:
Related Information

Hierarchies [page 47]
A hierarchy is a set of data members arranged in levels or parent-child relationships.

2.1.1.2 About query and document user rights

Rights are defined by BI administrators.

BI administrators can view and edit queries even when the access rights have been limited to a restricted sub-set of users. Whether you can view, create, modify, or delete queries and their related objects, documents or reports, depends on your assigned user rights.

2.1.1.3 Non-hierarchical queries

You build a non-hierarchical query using dimensions, attributes and measures.

Dimensions represent business objects such as customers or cities. Measures derive results, usually numerical, from the dimensions you include in the query. For example, a query containing the [Customer] dimension and the [Revenue] measure returns revenue by customer.

Non-hierarchical queries produce result sets in which dimensions are not related. Each object in the query produces one flat column in the result set.

Non-hierarchical queries do not include the following objects: hierarchies, levels, members or named sets.

Related Information

To build a query on a universe [page 54]
You can build a query using a universe as a data source.

Measures [page 49]
Measures retrieve data, usually numeric, that is the result of calculations on data in the database.

Hierarchies [page 47]
A hierarchy is a set of data members arranged in levels or parent-child relationships.

Hierarchical member selection and query filters [page 56]
When you filter members in a query filter, you also impact measure aggregation.
2.1.1.4 Hierarchical queries

A hierarchical query contains at least one hierarchy object.

You can build hierarchical queries on universes that support hierarchical data, or on BEx queries which access SAP Info Queries directly. Hierarchical data can come from relational or OLAP databases, depending on how the data is structured in the universe.

**Note**
A relational data source is not a true hierarchy; it is a defined path between attributes.

You can include hierarchies either as result or filter objects. When you build a hierarchical query, the Web Intelligence Query Panel provides you with additional features for working with hierarchical data. For example, if you include a hierarchy as a result object, you have the ability to choose members from the hierarchy to appear in the result. The features available in the hierarchical query panel also depend on the source of the hierarchical data you are accessing.

The result set generated by a hierarchical query allows you to perform hierarchical data analysis. Each hierarchy object in the query produces a hierarchical column in the report. You can expand members to reveal their child members; for example, you can expand the [US] member to reveal US states in a [Geography] hierarchy.

Measures in the block are aggregated depending on the member with which they are associated. For example, a hierarchical query containing the [Customers] hierarchy and the [Unit Sales] and [Store Cost] measures gives the following result set:

<table>
<thead>
<tr>
<th>Customers</th>
<th>Unit Sales</th>
<th>Store Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>364,707</td>
<td>371,579</td>
</tr>
<tr>
<td>US</td>
<td>276,773</td>
<td>234,555</td>
</tr>
<tr>
<td>CA</td>
<td>45,506</td>
<td>67,999</td>
</tr>
<tr>
<td>OR</td>
<td>32,104</td>
<td>56,700</td>
</tr>
<tr>
<td>Albany</td>
<td>10,324</td>
<td>12,325</td>
</tr>
</tbody>
</table>

**Related Information**

- **Hierarchical member selection in BEx queries** [page 59]
  You use the Member Selector dialog box, available from a hierarchy object in the Query Panel, to select members of a hierarchy for your query.

- **Measures** [page 49]
  Measures retrieve data, usually numeric, that is the result of calculations on data in the database.

- **Hierarchies** [page 47]
  A hierarchy is a set of data members arranged in levels or parent-child relationships.

- **Hierarchical member selection and query filters** [page 56]
  When you filter members in a query filter, you also impact measure aggregation.

- **Selecting members of a hierarchy** [page 56]
When you have hierarchical members in a query, you use the Member Selector dialog box to select members of the hierarchy to appear in the report generated from the query result set.

### 2.1.1.4.1 Including multiple hierarchies in a query

When you combine multiple hierarchies in a query, the results for all the combinations of members in the different hierarchies appear in the resulting document.

#### Example

**Including two hierarchies in a query**

You have two hierarchies, [Gender] (containing the members [All], [Male] and [Female]) and [Customer Geography]. Combined in a query with a measure, the two hierarchies give the following result:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>All Gender</td>
<td>$29,358,677</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>$10,000,000</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>$19,358,677</td>
</tr>
<tr>
<td>France</td>
<td>All Gender</td>
<td>$2,644,017</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>$1,058,677</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>$1,285,340</td>
</tr>
<tr>
<td>Pierre</td>
<td>All Gender</td>
<td>$1,249</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>$1,249</td>
</tr>
<tr>
<td>Alain</td>
<td>All Gender</td>
<td>$1,155</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>$1,155</td>
</tr>
</tbody>
</table>

### 2.1.2 To create a document without a data source

One reason you might want to create a document with no data source is if you want to create a "template" document that contains the standard title page as the first report, standard copyright text as the second report, and so on. You can set the header and footer layouts, and even include empty tables and charts that are formatted. Later on a query or report designer can connect the document to a data source using a query.

#### Note

The rights set for you by the BI administrator determine your access to data sources and ability to create documents in Web Intelligence.

1. Open Web Intelligence in any mode.
2. Do one of the following:
   ○ In **Reading** mode, click the **New** icon in the toolbar.
   ○ In **Design** or **Data** mode, in the **File** tab, click the **New** icon.

3. Select **No data source**, and click **OK**.

A blank document opens. The **Available Objects** pane contains no objects.

### Related Information

**Building queries on universes** [page 53]

*Universes present data from relational or OLAP data sources as collections of related objects.*

**Building queries based on BEx queries** [page 79]

*BEx queries (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).*

**Building queries on data files** [page 75]

*You can build queries on data files, such as, depending on your version of Web Intelligence, locally installed text files and Excel spreadsheets and Excel files on the CMS.*

**Building queries on web service data sources** [page 111]

*In the Web Intelligence Rich Client, the Web Services plug-in enables you to create a document using “Document as a Web Service” (DaaS) as a data source.*

**Building queries on Advanced Analysis views** [page 110]

*SAP BusinessObjects Analysis is an OLAP analysis tool that allows users to interactively define analyses to explore data in OLAP data sources.*

### 2.1.3 Building queries on universes

Universes present data from relational or OLAP data sources as collections of related objects.

Universes contain two types of data:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relational</td>
<td>Relational data is organized as a collection of related objects (dimensions, details and measures). You combine universe objects in a query which you run to generate a report. For example, a query containing the Customer dimension and the Revenue measure generates a report showing revenue generated by customer.</td>
</tr>
<tr>
<td>Hierarchical</td>
<td>Hierarchical data is organized as members in related hierarchies. For example, a Geography hierarchy can contain levels showing countries, states and cities. A query built on the Geography hierarchy and Revenue measure generates a report showing revenue generated at different levels of the hierarchy (revenue by country, by state and by city).</td>
</tr>
</tbody>
</table>
### Data Type

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>query automatically calculates the revenue values at different levels of the hierarchy.</td>
</tr>
</tbody>
</table>

### Note

Restrictions regarding .unv and .unx universe display properties defined with the information design tool:

- .unx format universes: Properties defined in the Data tab only are supported.
- .unv format universes: Properties defined in the Number tab only are supported.

## Related Information

*Hierarchies* [page 47]

A hierarchy is a set of data members arranged in levels or parent-child relationships.

### 2.1.3.1 To select a default universe

You can set the default universe for Web Intelligence documents in the BI launch pad preferences.

You can select a default universe for universe-based queries so that when you create a document, the Select a universe dialog box shows the default universe.

1. In the BI launch pad, click Preferences.
2. Select Web Intelligence from the Preferences list.
3. Click Browse beneath Select a default Universe and browse to the universe you want to select as the default.
4. Select a universe and click Save and Close.
5. You must Log Off and then Log On for the change to take effect.

When you create a document based on a universe and choose the data source, the new default data source is selected. You can select a different data source if required.

### 2.1.3.2 To build a query on a universe

You can build a query using a universe as a data source.

1. Open Web Intelligence and click the New icon in the File toolbar.
2. Select the universe on which you want to create a document.
   - If you are using the Web Intelligence Rich Client, click Select.
   - The Query Panel opens.
3. Select and drag the objects you want to include in the query into the Result Objects pane.

   Tip
   To add all the objects in the class, drag the class to the Result Objects pane.

   Tip
   To view the details of an object, move your mouse over the object in the Result Objects. A tooltip shows the object details. To copy the content for reuse in another application, right-click the object and select Object Description. The Object Description dialog box displays all of the details. You can also select the text in the text box and paste it in another application.

4. Repeat the previous step until the query contains all the objects you want to include.

5. Select the objects on which you want to define query filters and drag them to the Query Filters pane. To create a quick filter on an object, select the object in the Result Objects pane then click the Add a quick filter icon in the Result Objects toolbar.

   Note
   If the query is based on a HANA universe, and if the views contain HANA variables or input parameters or both, there will be query prompts. If you add prompts in the Quick Filters pane, there could be a duplication of prompts. We recommend that you run the query prior to defining any query prompts to know what prompts may already exist.

6. Set the scope of analysis and other query properties.

7. To remove an object from the Result Objects or Query Filters panes, click the Remove icon in the top corner of the pane.

8. To remove all objects from the Result Objects or Query Filters panes, click the Remove All icon in the top corner of the pane.

9. Click Run Query. When you have more than one query and you want to run just one query, click Run Queries and select the query that you want to run.

   Note
   If a document is created with two data providers (queries) based on same data source (universe) and you change the source of one of the queries, the source of the other data provider is not changed.

Related Information

To preview query results [page 119]
You can activate a preview pane in the Query Panel.

Non-hierarchical queries [page 50]
You build a non-hierarchical query using dimensions, attributes and measures.

HANA query prompts in Web Intelligence [page 151]
In Web Intelligence, HANA universes behave like any other relational UNX universe; variables and input parameters in SAP HANA information models are associated with the corresponding tables in the data foundation.

### 2.1.3.3 Selecting members of a hierarchy

When you have hierarchical members in a query, you use the Member Selector dialog box to select members of the hierarchy to appear in the report generated from the query result set.

After you have selected members, they appear below the hierarchy object in the Query Panel.

You can select members explicitly, or implicitly through functions. For example, you can explicitly select the [California] and [Los Angeles] members of the [Geography] hierarchy. You can select the child members of the [US] member (to give US states). You can also select the members included in a named set, for example Top Cities by Revenue to include the cities that generate the most revenue.

Related Information

[Overview of the Member Selector dialog box](page 57)  
You use the Member Selector dialog box, accessed via the Query Panel to visualize and select members in a hierarchy.

[Hierarchical member selection and query filters](page 56)  
When you filter members in a query filter, you also impact measure aggregation.

#### 2.1.3.3.1 Hierarchical member selection and query filters

When you filter members in a query filter, you also impact measure aggregation.

This is different from hierarchy member selection in the Member Selector dialog box, which does not impact measures.

**Example**

**Member selection and hierarchical filtering**

In this example you have the following data:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
</tbody>
</table>
If you select only the France-related members in the Member Selector dialog box, the measure value for All Customers is not impacted:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
</tbody>
</table>

If you filter Germany and its child members using a query filter, the All Customers measure is affected because the German figures no longer appear in the aggregation:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$26,464,364.08</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
</tbody>
</table>

### Related Information

**Selecting members of a hierarchy** [page 56]

When you have hierarchical members in a query, you use the Member Selector dialog box to select members of the hierarchy to appear in the report generated from the query result set.

**Hierarchies** [page 47]

A hierarchy is a set of data members arranged in levels or parent-child relationships.

### 2.1.3.3.2 Overview of the Member Selector dialog box

You use the Member Selector dialog box, accessed via the Query Panel to visualize and select members in a hierarchy.

You can work with members explicitly, or with sets of members given, for example, by functions, named sets or hierarchy levels.

You can also use the Member Selector dialog box to define prompts, which allow users to select which members they wish to include in a hierarchy when they run the query.
You launch the **Member Selector** dialog box from hierarchy objects that you add to the query in the **Query Panel**.

The following table describes the tabs available in the **Member Selector** dialog box.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Members</strong></td>
<td>The <strong>Members</strong> tab displays the members arranged hierarchically. Calculated members appear at the position in the hierarchy defined by the BI administrator.</td>
</tr>
<tr>
<td><strong>Levels</strong></td>
<td>The <strong>Levels</strong> tab shows the hierarchy levels (if the hierarchy supports levels), named sets and calculated members.</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>The <strong>Prompts</strong> allows you to defer member selection until the query is run, whereupon a prompt appears that allows the users to select members.</td>
</tr>
</tbody>
</table>

**Note**

In the **Member Selector** dialog box, you can select the display of the technical and business names of objects or hierarchy objects. The Technical Name is the name that identifies the object in addition to its Business Name. Technical Names are not localized whereas Business Names are. For example, a Business Name would be 'Customer', and the Technical Name could be Z_CUSTOMER.

**Related Information**

*Selecting members of a hierarchy* [page 56]

When you have hierarchical members in a query, you use the **Member Selector** dialog box to select members of the hierarchy to appear in the report generated from the query result set.

### 2.1.3.3 To select hierarchy members

You select hierarchy members for your query via the **Query Panel**.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**. The **Query Panel** appears.
3. Add a hierarchy object to the **Result Objects** pane in the **Query Panel**.
4. Click the arrow next to the hierarchy object to launch the **Member Selector** dialog box.
5. In the **Members** tab, select members for inclusion in the query.
6. Click **OK** to close the **Member Selector** dialog box. The selected members appear below the hierarchy object in the **Result Objects** pane. When you run the query, only those members are included in the query result.

If you do not select members, the default member for the hierarchy as defined in the database is used in the query result. If no default member is defined, the top-level member is used.
2.1.3.3.4 To select hierarchy members explicitly

You select members from hierarchies for your query via the Query Panel.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. In the Members tab, select the members by clicking the checkbox next to the member in the hierarchy display.
   The members appear in the list of selected members in the Member Selector dialog box.
4. Do one of the following for a member:
   ○ To select all members in the hierarchy, from the All Members Select dropdown list, click Select. This option is useful when you want to include all members even if the hierarchy structure changes in the future.
   ○ To select members down to a named level, select a level from the Select All Members until Named Level list. A named level is, for instance, Country or City. You want level Country or City, whatever its position in the hierarchy.
   ○ To select all members until a specific level, select the level from the Select All Members until list.
5. Click OK to close the Member Selector dialog box.
   The members you selected appear below the hierarchy object in the Query Panel.

Related Information

To select hierarchy members [page 58]
   You select hierarchy members for your query via the Query Panel.
To search for members in the Member Selector dialog box [page 65]
   You can search a hierarchy for specific members in the Member Selector dialog box.

2.1.3.3.4.1 Hierarchical member selection in BEx queries

You use the Member Selector dialog box, available from a hierarchy object in the Query Panel, to select members of a hierarchy for your query.

The following hierarchy illustrates member selection behavior in BEx queries.

<table>
<thead>
<tr>
<th>World</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EMEA</td>
</tr>
<tr>
<td></td>
<td>Europe</td>
</tr>
<tr>
<td></td>
<td>Middle East</td>
</tr>
<tr>
<td></td>
<td>Africa</td>
</tr>
<tr>
<td></td>
<td>North America</td>
</tr>
</tbody>
</table>
Table 9: Hierarchy selection rules

<table>
<thead>
<tr>
<th>Rule</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you select a member of a hierarchy at a given level, all of the parent members in the hierarchy are selected.</td>
<td>The root is always selected. It is not possible to select one specific level.</td>
</tr>
</tbody>
</table>
| If you deselect a member when its parent member is already selected, all child members of the parent are also deselected. | If Pacific and all its child members are already selected and you deselect Australia, Philippines and New Zealand are also deselected. The following member selections appear:  
  ● Europe  
  ● Pacific |
| If you select a member with some of its child members already selected, all child members are selected. | If Europe is selected and you select EMEA, the Middle East and Africa are also selected. The following member selections appear:  
  ● EMEA  
  ● Children of EMEA |
| If you select a member when descendant members are already selected, all children of the member, and all siblings of the selected descendant members are also selected. | If you select Asia PAC when Australia was already selected, Asia, Pacific (children of Asia PAC) and Philippines and New Zealand (siblings of Australia) are also selected. The following member selections appear:  
  ● Asia PAC  
  ● Children of Asia PAC  
  ● Pacific  
  ● Children of Pacific |

### Related Information

- **Restrictions when using BEx queries** [page 82]
- **Hierarchical member selection in BEx queries** [page 59]

You use the Member Selector dialog box, available from a hierarchy object in the Query Panel, to select members of a hierarchy for your query.
2.1.3.3.5 To select hierarchy members in OLAP universes by relationship

You can select hierarchy members in OLAP relational universes via the Query Panel.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.
4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.
5. In the Members tab, right-click a member.
   The menu displays the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Children</td>
<td>Adds all child members of the member to the list of selected members. The members appear as Children of [selected member] in the list.</td>
</tr>
<tr>
<td></td>
<td>Note You cannot include children and descendants of the same member. If you select Descendants, then select Children, the descendants are removed from the list and replaced by children.</td>
</tr>
<tr>
<td>Descendants</td>
<td>Adds all descendant members of the member to the list of selected members. The members appear as Descendants of [selected member] in the list.</td>
</tr>
<tr>
<td></td>
<td>Note You cannot include children and descendants of the same member. If you select Children, then select Descendants, the children are removed from the list and replaced by descendants.</td>
</tr>
<tr>
<td>Parent</td>
<td>The member immediately above the selected member is its parent. The member appears as Parent of [selected member] in the list.</td>
</tr>
<tr>
<td></td>
<td>Note You cannot include the parent and ancestors of the same member. If you select Ancestors, then select Parent, the ancestors are removed from the list and replaced by the parent.</td>
</tr>
<tr>
<td></td>
<td>The Parent function is not available in BEx queries.</td>
</tr>
</tbody>
</table>

SAP BusinessObjects Web Intelligence User’s Guide
Working with queries
© 2014 SAP SE or an SAP affiliate company. All rights reserved.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ancestors</td>
<td>All members above the selected member in the hierarchy are its ancestors. This option adds the ancestor members of the member to the list of selected members. The members appear as <strong>Ancestors of [selected member]</strong> in the list. You cannot include the ancestors and parent of the same member in the list. If you select <strong>Parent</strong>, then select <strong>Ancestors</strong>, the parent is removed from the list and replaced by the ancestors. The <strong>Ancestors</strong> function is not available in BEx queries.</td>
</tr>
<tr>
<td>Siblings</td>
<td>All members at the same level as the selected member and that share the same parent are its siblings. The members appear as <strong>Siblings of [selected member]</strong> in the list. This option adds the selected member and its sibling members to the list of selected members. The <strong>Siblings</strong> function is not available in BEx queries.</td>
</tr>
</tbody>
</table>

6. Click **OK** to close the **Member Selector** dialog box. The selected members appear below the hierarchy object in the **Result Objects** pane. When you run the query, only those members are included in the query result.

### Related Information

*To select hierarchy members* [page 58]

You select hierarchy members for your query via the **Query Panel**.

*To select BEx query hierarchy members by relationship* [page 91]

You can select by relationship the members in a hierarchy for your BEx query.

### 2.1.3.3.6 About level-based member selection

You can select all members of a hierarchy to a specified depth. All members of the selected hierarchy until the specified depth are displayed in the report.

You can select members of a hierarchical object by level in the **Levels** tab in the **Member Selector** dialog box, accessed from the **Query Panel**.

When a hierarchy variable is defined on a characteristic, only one default hierarchy is displayed in the **Query Panel** universe outline.
2.1.3.3.7  To select hierarchy members from a level

You can select all the members at a level in a hierarchy organized into levels in Web Intelligence Applet interface or Web Intelligence Rich Client accessed via the BI launch pad.

- **Note**
  Not all hierarchies are organized into levels.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**.
   The **Query Panel** appears.
3. Add a hierarchy object to the **Result Objects** pane in the **Query Panel**.
4. Click the arrow next to the hierarchy object to launch the **Member Selector** dialog box.
5. In the **Levels** tab, select the levels you want to include.
   The members appear as **All members of the [selected level]** level in the **Summary** list.
6. Click **OK** to close the **Member Selector** dialog box.
   The selected members appear below the hierarchy object in the **Result Objects** pane. When you run the query, only those members are included in the query result.

### Related Information

**To select hierarchy members** [page 58]

You select hierarchy members for your query via the **Query Panel**.

2.1.3.3.8  To select calculated members

You can edit calculated members in the **Query Panel**.

The database on which your universe is based supports calculated members.

- **Note**
  BEx queries can only be edited in Web Intelligence Applet interface or Web Intelligence Rich Client accessed via the BI launch pad.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**.
   The **Query Panel** appears.
3. Add a hierarchy object to the **Result Objects** pane in the **Query Panel**.
4. Click the arrow next to the hierarchy object to launch the **Member Selector** dialog box.
5. In the **Levels** tab, select a calculated member.
6. Click OK to close the Member Selector dialog box. The selected members appear below the hierarchy object in the Result Objects pane. When you run the query, only those members are included in the query result.

Related Information

To select hierarchy members [page 58]
You select hierarchy members for your query via the Query Panel.

Calculated members [page 49]
Calculated members are members returned by an MDX expression. MDX is the language used to access hierarchical data in OLAP databases.

2.1.3.3.9 To select named sets

You can select named sets in the Query Panel.

i Note
BEx queries can only be edited in Web Intelligence Applet interface or Web Intelligence Rich Client accessed via the BI launch pad.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit. The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.
4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.
5. In the Levels tab, select a named set from within the Named Sets folder.
6. Click OK to close the Member Selector dialog box. The selected members appear below the hierarchy object in the Result Objects pane. When you run the query, only those members are included in the query result.

You can also include a named set by selecting it from the list of available query objects. Named sets appear beneath the analysis dimension containing the hierarchy with which they are associated. When you select a named set, its parent hierarchy is included as a result object and the named set appears as a member selection beneath the hierarchy object.
2.1.3.3.10  To exclude hierarchy members

You exclude members from hierarchies in the Query Panel.

Note
You cannot exclude members in BEx queries.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.
4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.
5. Select the members or member sets that you want to exclude.
6. Click Exclude next to the selected members.
7. Click OK to close the Member Selector dialog box.
   The excluded members appear below the hierarchy object in the Result Objects pane. When you run the query, these members are excluded from the hierarchy.

2.1.3.3.11  To search for members in the Member Selector dialog box

You can search a hierarchy for specific members in the Member Selector dialog box.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.
4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.
5. In the Members tab, click the Search button to launch the Search dialog box.

Note
○ The search is always performed on the entire hierarchy stored in the database, not on the members already retrieved in the Member Selector dialog box.
○ If Enable Levels is selected in the Levels tab, the Search button is disabled.
6. Type text in the Search text box.
   You can use wildcards in the search.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Replaces any string of characters</td>
</tr>
<tr>
<td>?</td>
<td>Replaces any individual character</td>
</tr>
</tbody>
</table>
7. Select one of the following:
○ Click **Search in Text** to search the display text of the members.
○ Click **Search in Key** to search their database keys.

8. Click **OK** to close the **Member Selector** dialog box.

### 2.1.3.3.12 To build prompts for selecting members using the Member Selector dialog box

You can defer member selection until the query is run. If you do so, the user is prompted to select members when they run the query.

#### Note
- BEx queries can only be edited in Web Intelligence Applet interface or Web Intelligence Rich Client accessed via the BI launch pad.
- Selection of member prompts is restricted to explicit selection of members. The user cannot select members using functions such as Ancestors or Parent.
- The rules about selecting members using functions apply here. Refer to the link at the bottom of this topic.

To build member-selection prompts:

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**.
   The **Query Panel** appears.
3. Add a hierarchy object to the **Result Objects** pane in the **Query Panel**.
4. Click the arrow next to the hierarchy object to launch the **Member Selector** dialog box.
5. In the **Prompts** tab, click **Enable Parameter**.

#### Note
When you select this option, the selections in the other tabs are deactivated.

6. Enter text in the **Prompt Text** box.
7. If you want the prompt to select the previously-chosen values by default when it is displayed, click **Keep last values selected**.
8. If you want the prompt to select default values when it is displayed, click **Set default values**, then **Edit** and select the default values.
9. Click **OK** to close the **List of Values** dialog box.
10. Click **OK** to close the **Member Selector** dialog box.

   The prompt text appears beneath the hierarchy in the **Query Panel**.

---

**Related Information**

*To select BEx query hierarchy members by relationship* [page 91]

You can select by relationship the members in a hierarchy for your BEx query.
### 2.1.3.4 Resolving ambiguous queries

An ambiguous query is a query that contains one or more objects that can potentially return two different types of information.

In a universe, certain dimensions may have values that are used for two different purposes in the database. For example, the [Country] dimension in the query below can return two types of information:

- Customers and the country in which they spent their vacation.
- Customers and the country from which they have made their reservation.

The role that Country plays in this query is ambiguous. A country can be either the country where a vacation was sold, or a country where a vacation is reserved. One is existing information (sales), and the other is future information (reservations).

To avoid ambiguities in a query, the universe designer identifies the different ways that objects can be used in the universe, and implements restrictions on how these objects can be combined. These restrictions are called contexts.

#### 2.1.3.4.1 Contexts in a query

A context is a defined group of objects that share a common business purpose.

This business purpose is usually the type of information that these related objects represent. For example, a sales context is a grouping of all the objects that can be used to create sales queries. A reservations context is a grouping of all the objects that can be used in reservation queries. Contexts are defined in the universe by the universe designer.

You can combine any objects within the same context to create a query. You can also combine objects in different contexts. If you use an object that is common multiple contexts in a query and it is not possible to determine the best context that fits all the other objects in the query, you are prompted to choose the context to apply.

#### 2.1.3.4.2 To choose a context when you run a query

When you create a query or refresh a report, you may be asked to choose a context before the query can run. Contexts are set up in a universe to avoid ambiguous queries.

You need to choose a context each time you run the query if the Reset contexts on refresh query property is selected in the Query Properties panel. You will also need to choose contexts if you select the Clear contexts option in the query properties.

**Note**

- After selecting the Clear contexts option, the next prompt on contexts will still show the last selected context and if you want to select another context, you must first remove the existing selection.
- Before you schedule a document that contains multiple contexts, you must first select a context. To do this, follow the steps below.
1. If you are migrating an XI 3.1 Desktop Intelligence document to BI 4.1 Web Intelligence using the Report Conversion Tool, you also must have a context selected, otherwise the contexts are lost during the conversion.

2. In a Web Intelligence document containing multiple contexts, run the query or refresh the document. The **Select a Context** dialog box appears.

3. Select a context.

If prompts have been set for the document, then the prompt panel appears. Otherwise the document content reflects the context you have selected.

### 2.1.3.4.3 To reset contexts when a query is refreshed

You can allow contexts to be refreshed every time you refresh a query in the **Query Panel**

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**. The **Query Panel** appears.
3. Click the **Query Properties** icon on the **Query Panel** toolbar to display the **Query Properties** dialog box.
4. Select **Reset contexts on refresh**.
5. Click **OK** to close the **Query Properties** dialog box.

### 2.1.3.4.4 To clear contexts from a query

You can clear the contents of a query in the **Query Properties** dialog box.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**. The **Query Panel** appears.
3. Click the **Query Properties** icon on the **Query Panel** toolbar to display the **Query Properties** dialog box.
4. Click **Clear contexts**.
5. Click **OK** to close the **Query Properties** dialog box.

### 2.1.3.5 Setting the scope of analysis

Setting the scope of analysis for a query is extra data that you can retrieve from the database that is available to offer more details on the results returned.

This extra data does not appear in the initial result report, but it remains available in the data cube, and you can pull this data into the report to allow you to access more details at any time. This process of refining the data to lower levels of detail is called drilling down on an object.
The Scope of Analysis Panel option in the Query Panel is only available for relational .unx universes and not for OLAP universes or BEx queries.

In the universe, the scope of analysis corresponds to the hierarchical levels below the object selected for a query. For example, a scope of analysis of one level down for the object Year, would include the object Quarter, which appears immediately under Year.

You can set this level when you build a query. It allows objects lower down the hierarchy to be included in the query, without them appearing in the Result Objects pane. The hierarchies in a universe allow you to choose your scope of analysis, and correspondingly the level of drill available. You can also create a custom scope of analysis by selecting specific dimensions to be included in the scope.

Related Information

Retrieving more levels of data to the report [page 237]

When you are drilling a report, you may want to drill up or down to a dimension that lies outside the scope of analysis defined for the document.

To drill out of the scope of analysis [page 237]

You can create an additional query for a document that returns additional data to the document and adds to the table data for the dimension on which you drilled.

Prompt when drill requires additional data option [page 238]

When you drill the results displayed on a report, you may want to drill to higher- or lower-level information that isn’t included in the scope of analysis for the document. A new query is required to retrieve this data.

2.1.3.5.1 Levels of scope of analysis

You can set different levels for a scope of analysis in a document.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>Only the objects that appear in the Result Objects pane are included in the query.</td>
</tr>
</tbody>
</table>
| ● one level  
● two levels  
● three levels | For each object in the Result Objects pane, one, two, or three objects lower down the hierarchy tree are included in the query. The data from these objects is stored in the cube until you add them to the document. |
| custom  | All objects added manually to the Scope of analysis pane are included in the query. |

Caution

Including a scope of analysis in a document increases the document size significantly because the data necessary for the scope you specify is saved with the document. It is not visible in the reports unless you start the Drill Mode and drill down to the data to display the corresponding values.
In order to minimize the size of documents and optimize performance, include a scope of analysis only in documents where you are certain that users will need to drill.

2.1.3.5.2  To set the scope of analysis

You can set a scope of analysis for a query in the *Scope of Analysis Panel* at the bottom of the *Query Panel*.

1. Open a Web Intelligence document in *Design* or *Data* mode.
2. In the *Data Access* tab, in the *Data Provider* subtab, click *Edit*. The *Query Panel* appears.
3. Click the *Scope of Analysis Panel* button. The *Scope of Analysis Panel* appears at the bottom of the *Query Panel*. The default scope of analysis is *None*. Each dimension in the *Result Objects* pane appears in the *Scope of analysis* pane.
4. Click the down arrow in the *Scope level* dropdown list box and select a level for the scope of analysis. The level appears in the list box and the dimensions that are hierarchically below each dimension in the *Result Objects* pane appear in the *Scope of analysis* pane.
5. If you want to add selected dimensions to the scope of analysis or create a custom scope of analysis, select dimensions in the data outline and drag them across to the *Scope of analysis* pane.

2.1.3.5.3  To deactivate a Scope of Analysis in a query

You can deactivate a scope of analysis a Web Intelligence document in *Design* or *Data* mode.

1. Open a Web Intelligence document in *Design* or *Data* mode.
2. In the *Data Access* tab, in the *Data Providers* subtab, click *Edit*.
3. In the *Query Panel*, click the *Scope of Analysis Panel* icon to show the *Scope of Analysis* pane.
4. In the *Scope of analysis* pane, set the *Scope level to none*.
5. Click *Run Query*.

2.1.3.6  Viewing the script generated by a query

When you build a query, it generates SQL or MDX script behind the scenes to run against the database to return the query result.

SQL is the query language understood by all relational databases. MDX is the query language understood by OLAP databases.

You can view and edit the SQL generated by the query. You can view MDX queries but you cannot edit them.

---

*Note*

You cannot view the script of queries that call database stored procedures.
2.1.3.6.1 To view and edit the generated script

You can view and edit generated query script in the Query Script viewer dialog box.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Click the View Script button on the query toolbar to display the Query Script viewer dialog box.

   Note
   You cannot edit the query SQL if the query contains optional prompts. Remove the optional prompts from
   the query before attempting to edit the SQL.

   If script cannot be edited, values supplied in response to prompts appear directly in the query.

   For example, if "UK" was supplied in response to a prompt on [Country], a line similar to the following appears
   in the query:

   ```sql
   Resort_country.country In ('UK')
   ```

   If no value has yet been supplied for the prompt, the Web Intelligence syntax for prompts (described below)
   appears in the query.

4. To make the generated script editable, click Use custom query script.
   When you make the script editable, the Web Intelligence syntax for prompts appears in the query.

   For example, a line similar to the following appears in the query:

   ```sql
   Resort_Country.country = @prompt('Enter Country:','A','Resort\Country',
   Mono,Free,Persistent,,User:0)
   ```

5. Click Validate after editing the script to check that your edits are valid.

6. Click Copy to copy the script to the clipboard.

   Note
   This option is not available in the Web Intelligence HTML interface; however you can select the text, right-
   click it and select Copy.

7. Click Print to print the script.

   Note
   This option is not available in the Web Intelligence HTML interface or Web Intelligence Applet interface. You
   can copy the text and paste it into a text document that you can print.

Related Information

Filtering data with query prompts [page 150]
A query prompt is a dynamic filter in a document that displays a question every time a user opens or refreshes the data in a document.

To remove a prompt [page 159]
You can delete query prompts in the Query Panel.

### 2.1.3.7 Restricting the amount of data returned by queries

#### 2.1.3.7.1 To restrict the amount of data returned by a query

You can restrict the amount of data returned by queries by setting the maximum number of rows a query can return, using a sampled result set, choosing whether to retrieve empty rows, and choosing whether to retrieve duplicate rows.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit. The Query Panel appears.
3. Click the Query Properties icon on the Query Panel toolbar.
4. In the Query Properties dialog box, select any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to...</th>
<th>Available in</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Max rows retrieved</strong></td>
<td>To select a maximum numbers of rows for retrieval. If you use this option, you also need to set maximum number of rows to be retrieved.</td>
<td>All instances.</td>
</tr>
<tr>
<td><strong>Retrieve duplicate rows</strong></td>
<td>To include duplicate rows. In a database, the same data may be repeated over many rows. You can choose to have these repeated rows returned in a query, or to have only unique rows returned. This option is not available in BEx queries, or if it is not supported by the underlying database.</td>
<td>Relational and OLAP .unx files. Not available in BEx queries.</td>
</tr>
<tr>
<td><strong>Sample result set</strong></td>
<td>To return a sample result set. To use fixed sampling, click Fixed. Sampling is not available in BEx queries. The Fixed option is visible, but not activated if this option is not supported by your data source.</td>
<td>Relational .unx files. Not available in OLAP .unx or BEx queries.</td>
</tr>
<tr>
<td><strong>Retrieving empty rows</strong></td>
<td>To include empty rows in the result.</td>
<td>OLAP .unx. Not available in BEx queries.</td>
</tr>
</tbody>
</table>

5. Click OK to return to the Query Panel.
Related Information

Sample result set query property [page 74]

The **Sample result set** property in the **Query Panel** determines the maximum number of rows that a query returns.

Max rows retrieved query property [page 73]

The **Max rows retrieved** query property determines the maximum number of rows of data that are displayed when a query is run.

Building queries based on BEx queries [page 79]

**BEx queries** (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).

2.1.3.7.2 Max rows retrieved query property

The **Max rows retrieved** query property determines the maximum number of rows of data that are displayed when a query is run.

If you only need a certain amount of data, you can set this value to limit the number of rows of data in your document.

**Max rows retrieved** is applied at the database level if the database supports it. If not, rows are discarded after retrieval from the database.

**Max rows retrieved** does not distinguish between levels in hierarchical data. If **Max rows retrieved** is set to 3, the data in the first table below is truncated as in the second table.

<table>
<thead>
<tr>
<th>Customers</th>
<th>Unit Sales</th>
<th>Store Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>276,773</td>
<td>234,555</td>
</tr>
<tr>
<td>CA</td>
<td>45,506</td>
<td>67,999</td>
</tr>
<tr>
<td>OR</td>
<td>32,104</td>
<td>56,700</td>
</tr>
<tr>
<td>Albany</td>
<td>10,324</td>
<td>12,325</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customers</th>
<th>Unit Sales</th>
<th>Store Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>276,773</td>
<td>234,555</td>
</tr>
<tr>
<td>CA</td>
<td>45,506</td>
<td>67,999</td>
</tr>
<tr>
<td>OR</td>
<td>32,104</td>
<td>56,700</td>
</tr>
</tbody>
</table>

The **Sample result set** query property also applies a restriction on the number of rows in the query, but at the database level. If you set **Max rows retrieved** to 2000 and **Sample result set** to 1000, the query retrieves a maximum of 1000 rows only.

This setting can be overridden by the limits set by the BI administrator in your security profile. For example, if you set the **Max rows retrieved** setting to 400 rows, but your security profile limits you to 200 rows, only 200 rows of data will be retrieved when you run the query.
Related Information

**Sample result set query property** [page 74]

The Sample result set property in the Query Panel determines the maximum number of rows that a query returns.

**To restrict the amount of data returned by a query** [page 72]

You can restrict the amount of data returned by queries by setting the maximum number of rows a query can return, using a sampled result set, choosing whether to retrieve empty rows, and choosing whether to retrieve duplicate rows.

### 2.1.3.7.3 Sample result set query property

The Sample result set property in the Query Panel determines the maximum number of rows that a query returns.

This restriction is applied at the database level, in the generated script that is used to return the data.

#### Note

The Sample result set option is only available for relational .unx universes, and not for OLAP .unx universes or BEx queries.

The Fixed option uses fixed sampling. At each data refresh, the query returns the same rows. If you do not set the Fixed option, the sampling is random. At each data refresh, the query returns a different set of sampled rows.

Sample result set is more efficient than the Max rows retrieved property, which discards rows beyond the maximum limit only after retrieving all the rows in the query.

Not all databases support sampling. If it is not supported, the option is deactivated. Similarly, the Fixed option may not be supported by certain databases, in which case the Fixed option is deactivated. Sampling is not available in BEx queries or OLAP .unx universes.

**Related Information**

**Max rows retrieved query property** [page 73]

The Max rows retrieved query property determines the maximum number of rows of data that are displayed when a query is run.

**Building queries based on BEx queries** [page 79]

BEx queries (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).

**To restrict the amount of data returned by a query** [page 72]

You can restrict the amount of data returned by queries by setting the maximum number of rows a query can return, using a sampled result set, choosing whether to retrieve empty rows, and choosing whether to retrieve duplicate rows.
### 2.1.3.8 To set the maximum amount of time a query can run

You can set the maximum running time for a query in the *Query Properties* dialog box.

**Note**
This feature is not available for BEx queries.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**. The **Query Panel** appears.
3. Click the **Query properties** button on the **Query Panel** toolbar to display the **Query Properties** dialog box.
4. Select **Max retrieval time (s)** and enter the amount of time in seconds.
5. Click **OK** to close the dialog box and return to the **Query Panel**.

### 2.1.3.9 To allow other users to edit queries

By default, queries can be edited only by the user who created them. You can give the ability to edit queries to users who have edit query rights assigned by the BI administrator.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**. The **Query Panel** appears.
3. Click the **Query Properties** icon on the **Query panel** toolbar to display the **Query Properties** dialog box.
4. Click **Allows other users to edit queries**.
5. Click **OK** to return to the **Query Panel**.

### 2.1.4 Building queries on data files

You can build queries on data files, such as, depending on your version of Web Intelligence, locally installed text files and Excel spreadsheets and Excel files on the CMS.

**Note**
You cannot build a query based on a text file in either the Web Intelligence HTML or Web Intelligence Applet interface.
Related Information

To build a query on a text file [page 76]
You can build a query using a text file as a data source in the Web Intelligence Rich Client.

To build a query on an Excel file [page 77]
In the Web Intelligence Rich Client and Web Intelligence Applet interface, you can build a query using an Excel file as a data source.

To edit a query based on a text file [page 78]
You can edit a query based on a text file in the Query Panel in the Web Intelligence Rich Client.

To edit a query based on an Excel file [page 79]
You can edit a query based on an Excel file in the Query Panel in the Web Intelligence Rich Client or Web Intelligence Applet interface.

2.1.4.1 To build a query on a text file

You can build a query using a text file as a data source in the Web Intelligence Rich Client.

1. Open Web Intelligence Rich Client.

   ![Note](image)
   
   You cannot build a query based on a text file in either the Web Intelligence HTML or Web Intelligence Applet interface.

2. To build a query using a text file, do one of the following:
   ○ Click **New** in the **File** menu.
   ○ In the **Create a new Web Intelligence Document** dialog box, select **Text** as the data source.
   ○ In the **Data Access** tab, in the **Data Providers** subtab, select **From Text** from the **New Data Provider** dropdown list.

3. Click **Browse** and select the text file.

4. Set the options to import data from the file.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Separator</strong></td>
<td>The character that separates the data relating to each result object.</td>
</tr>
<tr>
<td>○ <strong>Tabulation</strong></td>
<td>data is tab-separated</td>
</tr>
<tr>
<td>○ <strong>Space</strong></td>
<td>data is separated by spaces</td>
</tr>
<tr>
<td>○ <strong>Character</strong></td>
<td>data is separated by the character you specify</td>
</tr>
<tr>
<td><strong>Text Delimeter</strong></td>
<td>The character that encloses the data relating to each result object.</td>
</tr>
<tr>
<td>○ <strong>Double quote</strong></td>
<td>data is enclosed in double quotes</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>○ Single quote</td>
<td>data is enclosed in single quotes</td>
</tr>
<tr>
<td>○ None</td>
<td>data is not enclosed</td>
</tr>
<tr>
<td>First row contains column names</td>
<td>The first row in each column supplies the name of the column.</td>
</tr>
<tr>
<td>Locale</td>
<td>The locale of the data in the text file. For example, if the locale is French (France), commas in numbers are interpreted as indicating decimals because decimals contain commas in French.</td>
</tr>
<tr>
<td>Charset</td>
<td>The character set used by the text file.</td>
</tr>
<tr>
<td>Date Format</td>
<td>The date format to use in the report.</td>
</tr>
</tbody>
</table>

5. Click Next. The Query Panel opens and displays the data in the text file as report objects.

6. Click Run query to create a report based on the data from the text file. When you have more than one query and you want to run just one query, click Run Queries and select the query that you want to run.

### 2.1.4.2 To build a query on an Excel file

In the Web Intelligence Rich Client and Web Intelligence Applet interface, you can build a query using an Excel file as a data source.

In the Web Intelligence Rich Client or Web Intelligence Applet interface, you can use Excel files saved locally and in the CMS.

For information on saving Excel files to the CMS, consult the Saving objects directly to the CMS topic in the BI Launch Pad help.

1. Open the Web Intelligence Applet interface or Web Intelligence Rich Client.

   **Note**

   You cannot build a query based on an Excel file the Web Intelligence HTML interface.

2. To build a query using an Excel file, do one of the following:
   ○ Click New in the File menu.
   ○ In the Create a new Web Intelligence Document dialog box, select Excel as the data source.
   ○ In the Data Access tab, in the Data Providers subtab, select From Excel from the New Data Provider dropdown list.

3. Open the Excel file you want to use.
   ○ In the Web Intelligence Rich Client, browse in the local Excel files.
   ○ In the Web Intelligence Applet interface, browse in the CMS for the Excel file you want to use.

4. Set the options to import data from the file.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sheet Name</strong></td>
<td>The name of the worksheet containing the data.</td>
</tr>
<tr>
<td><img src="image" alt="Field Selection ➤ All Fields" /></td>
<td>All data in the worksheet is treated as query data.</td>
</tr>
<tr>
<td><img src="image" alt="Restriction" /></td>
<td>Web Intelligence only supports a contiguous cell selection.</td>
</tr>
<tr>
<td><img src="image" alt="Field Selection ➤ Range Definition ➤ Range Name ➤ First row contains column names" /></td>
<td>The data in the specified range is treated as query data.</td>
</tr>
<tr>
<td><img src="image" alt="Restriction" /></td>
<td>Web Intelligence only supports a contiguous Range Name selection.</td>
</tr>
<tr>
<td><img src="image" alt="First row contains column names" /></td>
<td>The first row in the range supplies the names of the result objects.</td>
</tr>
</tbody>
</table>

5. Click **Next**. The Query Panel opens and displays the data in the Excel file as report objects. In the Query Properties side pane, you can choose to make the query refreshable and/or editable depending on your user requirements.

6. Click **Run query** to create a report based on the data from the Excel file. When you have more than one query and you want to run just one query, click **Run Queries** and select the query that you want to run.

### 2.1.4.3 To edit a query based on a text file

You can edit a query based on a text file in the Query Panel in the Web Intelligence Rich Client.

1. Open Web Intelligence Rich Client in **Design** or **Data** mode.

   **Note**
   You cannot build a query based on a text file in either the Web Intelligence HTML or Web Intelligence Applet interface.

2. In the **Data Access** tab, in the **Data Providers** subtab, click **Edit**.

3. Edit the query in the **Query Panel**.

   **Caution**
   If you select a different file containing source data for the **Source Path**, the structure of the new file must match the structure of the existing file.

4. Edit the options for importing data from the file by clicking **Edit Settings** in the **Query Definition** pane. In the Query Properties side pane, you can choose to make the query refreshable and/or editable depending on your user requirements.
5. Click Run query to apply your changes to the query.

2.1.4.4 To edit a query based on an Excel file

You can edit a query based on an Excel file in the Query Panel in the Web Intelligence Rich Client or Web Intelligence Applet interface.

1. Open Web Intelligence in Design or Data mode.

   - **Note**
   
   You cannot build a query based on an Excel file in the Web Intelligence HTML interface.

2. In the Data Access tab, in the Data Providers subtab, click Edit.

3. Edit the query in the Query Panel.

   - **Caution**
   
   If you select a different file containing source data for the Source Path, the structure of the new file must match the structure of the existing file.

4. Edit the options for importing data from the file by clicking Edit Settings in the Query Definition section.

5. In the Query Properties side pane, you can choose to make the query refreshable, depending on your user requirements.

6. Click Run query to apply your changes to the query.

You can also go to the Data mode, and in the Data Provider tab in the side panel, right-click the query and select from the options in the contextual menu, which include Refresh, Edit, Purge, Delete, Rename, Copy, and Change Source.

2.1.5 Building queries based on BEx queries

BEx queries (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).

BEx queries retrieve the metadata from the data source. You use Web Intelligence to connect to a BEx query by using a BI Consumer services (BICS) connection, and retrieve data via the BEx query for reporting purposes.

You create, edit and refresh documents and reports based on BEx queries using the Web Intelligence Applet interface or Web Intelligence Rich Client launched from the BI launch pad. In the Web Intelligence HTML interface, you can view and refresh documents, but not edit them.

Web Intelligence automatically maps data from the BEx query to hierarchies, attributes, dimensions and measures as in universe-based hierarchical queries. Direct access into a SAP BEx query (through a BICS connection) does not allow you to rename, modify, or add metadata. You do not create a universe for BEx queries.

The resulting microcube is represented in the Available Objects pane as a tree of objects, but uses a subset of the features available in universe-based hierarchical queries. For example, the Siblings, Parent and Ancestor
member functions are not available for BEx queries in the Member Selector dialog box. These restrictions are noted in the documentation relating to the features.

**Note**

- You can only access BEx queries that have the flag *Allow External Access to the Query* is enabled.
- The object mapping is not all equivalent, refer to the equivalents and restrictions pages to ensure that the queries can be used correctly.
- Web Intelligence can create a document on a BEx query only when the BEx query connection authentication is pre-defined. Prompted authentication mode is not supported on the BEx query at document creation.

**Related Information**

*To create a query based on a BEx query that has no variables* [page 98]

You can create a query using BEx data that contains no variables.

## 2.1.5.1 Which interfaces should you use to work with BEx queries?

To build queries, view reports, edit, or refresh reports, you use the interfaces described below.

### Building queries

To create a document or build a query based on a BEx query, you should use one of the following:

- The Web Intelligence Applet interface, accessible from the BI launch pad
- Web Intelligence Rich Client installed from the SAP Business Objects suite

### Working with reports

To view reports, edit, or refresh reports, you can use any of the Web Intelligence interfaces:

- The Web Intelligence HTML interface (accessible from the BI launch pad)
- The Web Intelligence Applet interface (accessible from the BI launch pad)
- The Web Intelligence Rich Client downloaded and installed from the BI launch pad
- Web Intelligence Rich Client installed as a component of the SAP Business Objects suite
2.1.5.2  Supported BEx query metadata

Web Intelligence supports some metadata found in BEx queries.

The following SAP BW metadata features are supported:

- Characteristics (including Time and Unit)
- Hierarchies
- Basic Key Figures
- Navigational Attributes
- Display Attributes
- Calculated Key Figures/Formulas
- Restricted Key Figures
- Custom Structures
- Variables

The metadata types are mapped to universe objects that can be used to build your queries and run reports.

Table 10: How BEx query metadata is mapped

<table>
<thead>
<tr>
<th>BEx query metadata</th>
<th>Web Intelligence 4.x object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristic</td>
<td>Dimension</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Hierarchy</td>
</tr>
<tr>
<td>Hierarchy level</td>
<td>N/A (levels are displayed in the Member Selector dialog box)</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attribute</td>
</tr>
<tr>
<td>Characteristic properties (Key, Caption, Short description, Medium description, Long description)</td>
<td>Attribute</td>
</tr>
<tr>
<td>Key figure without unit/currency</td>
<td>Measure (numeric)</td>
</tr>
<tr>
<td></td>
<td>Property formatted value (string)</td>
</tr>
<tr>
<td>Key figure with unit/currency</td>
<td>Measure (numeric)</td>
</tr>
<tr>
<td></td>
<td>Property unit/currency (string)</td>
</tr>
<tr>
<td></td>
<td>Property formatted value (string)</td>
</tr>
</tbody>
</table>

How SAP Business Warehouse Characteristics map to Web Intelligence dimension objects

For data sources based on BEx queries, SAP Business Warehouse (BW) characteristics are mapped to dimension objects in Web Intelligence. Depending on the SAP BW Characteristic data type, these dimensions have a specific type assigned (STRING or DATE).

Although you have defined a BW characteristic in the SAP BW as a numerical data type (NUMC), BW treats the characteristic as a text character string (STRING). Consequently, when it is used in a Web Intelligence document, it is treated as a text character string (STRING). It is not considered a numeric data type.
How SAP BW Key Figures map to Web Intelligence measure objects

For data sources based on BEx queries, SAP BW (BW) Key Figures are mapped to measure objects in Web Intelligence. Depending on the BW Key Figure data type, these measures have a specific type assigned STRING, DATE or NUMERIC.

However, in the BEx query design, if the Key Figure and Characteristic objects are arranged in columns and rows so that the result set columns contain different object types in each row, and the measure object in the Web Intelligence report to shows up as type "STRING". For Web Intelligence, in order to be agnostic, the rule applies that one column equals one data type. The data type "STRING" is thus applied when it recognizes heterogeneous data types in the column. This is the case when the Key Figure Structure is on the Columns Axis only. You can also put both structures on the same axis in your BEx Query.

Example

When a BEx query has a structure that contains UNIT (Currency, for example), TIME (Date, for example), a formula ("City is X percent of State" for example) and a string-based Characteristic (City for example), each, when added, is a separate row for the column. A Key Figure (for example Order Amount) is added in the Columns section. When you execute the BEx query, a table appears that contains these different objects/types in the rows of the column.

Note

- UNIT and STRING are DataTypes you cannot get in a DataCell (DataCell = each intersection of two BEx structures). You can have NUMERIC (there is INTEGER and DOUBLE), PERCENT, DATE, and TIME. When creating a Web Intelligence report against this query, the measure object is shown as "STRING" due to the different object/types included in the result set for the column.
- If you want to manipulate the results by adding aggregations, for example, you have the choice to change the mapped Web Intelligence measure in the report by converting it via a formula into different data types.

2.1.5.3 Restrictions when using BEx queries

Note

The BI administrator must ensure that the BEx query complies with reporting restrictions described in the table below.

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local calculations</td>
<td>The key figures on which the local calculation are defined are removed from the BEx query. Avoid the use of these, and use instead the equivalent calculation function in the report.</td>
</tr>
<tr>
<td>BEx query feature</td>
<td>Web Intelligence restriction</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculations/Local calcul</td>
<td>Measures which use “Calculate Single Value as” will be omitted because they would produce inconsistent results within the client tools. The calculation depends</td>
</tr>
<tr>
<td></td>
<td>heavily on the layout of the data requested (for example, the order in which characteristics are requested, if the result line is switched on or off, and #) and could therefore be misinterpreted. To avoid those misinterpretations, these calculations are automatically switched off.</td>
</tr>
<tr>
<td></td>
<td>You should not use the following calculation functions:</td>
</tr>
<tr>
<td></td>
<td>● %GT</td>
</tr>
<tr>
<td></td>
<td>● %CT</td>
</tr>
<tr>
<td></td>
<td>● SUMCT</td>
</tr>
<tr>
<td></td>
<td>● SUMRT</td>
</tr>
<tr>
<td></td>
<td>● Leaf</td>
</tr>
<tr>
<td></td>
<td>They might not work correctly within the client tools (same reason as above). It is not feasible to filter them out, as the knowledge about the calculations are not exposed through the interface, therefore the query designer should make sure that those calculations are not used. If you switch on the MDX-Flag in the BEx Query Designer, the usage of those calculations is checked.</td>
</tr>
<tr>
<td>Formula with calculation</td>
<td>We recommend that you avoid using Formula with calculation because it may not be supported in the report layout, for example in the case of a Percentage Share of Results report.</td>
</tr>
</tbody>
</table>

Table 12: Data characteristics

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal number</td>
<td>The BEx query decimal number definition is not consumed in Web Intelligence. Use the formatted value instead if you need to keep the exact decimal setting in your report. You can also apply the decimal setting in the table and chart of your report.</td>
</tr>
<tr>
<td>Variables on default values</td>
<td>Do not define variables on default values in BEx queries. The variables will be prompted without an effect on the BEx query. Instead, define the default value in the filter.</td>
</tr>
<tr>
<td>OR operator</td>
<td>Not supported. The OR operator is not supported from some OLAP data sources such as BEx queries, and OLAP .unx universes on the top of Microsoft Analysis Services (MSAS) and Oracle Essbase.</td>
</tr>
<tr>
<td>BEx query feature</td>
<td>Web Intelligence restriction</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Merge on key for OLAP business object</td>
<td>The data synchronization of the same object from the same source (cube or BEx query) is based on the internal key of the value of these objects.</td>
</tr>
<tr>
<td>BEx query measure aggregation</td>
<td>Measures which aggregate with the SUM function, aggregate the sum in Web Intelligence. Other types of measure aggregation are delegated.</td>
</tr>
<tr>
<td>Complex selection</td>
<td>When a variable is defined to support the complex selection, there is no equivalent. This is limited to range selection.</td>
</tr>
<tr>
<td>Zero suppression</td>
<td>Rows of zero values are not removed from the result table.</td>
</tr>
<tr>
<td>Query default layout</td>
<td>Default positions of characteristics in Rows / Columns are not reproduced.</td>
</tr>
<tr>
<td>Result rows</td>
<td>We recommend that you rely on Web Intelligence summaries instead.</td>
</tr>
<tr>
<td>Drill-replace capability</td>
<td>There is no drill-replace capability on an object from a BEx query (there is no navigation path).</td>
</tr>
<tr>
<td>Attributes in result sets and filters</td>
<td>Cannot be used in the result set and in filters at the same time.</td>
</tr>
</tbody>
</table>

Table 13: Filters

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filters as default values</td>
<td>Not supported, these are removed from the BEx query. The filter will be ignored, or, if a variable is used, the variable prompt will display, but the user response is ignored. Move any restriction based on a variable into the filter zone in order for it to be taken into account for reporting.</td>
</tr>
<tr>
<td>Measures</td>
<td>Cannot be used in filters.</td>
</tr>
</tbody>
</table>

Table 14: Hierarchies

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked nodes</td>
<td>Linked nodes are not displayed.</td>
</tr>
<tr>
<td>Lower level nodes</td>
<td>Lower level nodes are always shown after the main node.</td>
</tr>
<tr>
<td>Row/Column display as hierarchy</td>
<td>It is not possible to show an overall hierarchy out of an axis hierarchy. The characteristics, hierarchies, and key figures that make up the hierarchy are retained.</td>
</tr>
</tbody>
</table>
Expand to level

By default, hierarchies are not expanded to a given level. Level00 is always the default level. To reproduce this behavior, expand the table and chart in the report, then save the document. Your IT administrator can re-define this default value using the CMC interface, but note that if the value is set too high, Web Intelligence retrieves the entire hierarchy data which will have an important impact on the performance and stability of the system. The report creator should always indicate explicitly the number of the hierarchy levels they want to retrieve while designing their report queries.

Ranking and hierarchies

Ranking on a table where there is a hierarchy does not take into account the hierarchical structure of the data. When you define a ranking in a table that contains a hierarchy, the ranking becomes flat.

Position of lower level nodes

These are always below the upper levels.

Hierarchical measure structures

Hierarchical measure structures are displayed as a flat list of measures, but you can use hierarchical non-measure structures.

Hierarchical display of an entire axis

This is not supported. You can achieve similar results directly within Web Intelligence.

Hierarchies in result sets and filters

Cannot be used in the result set and in filters at the same time.

Table 15: Prompts

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables ready for input</td>
<td>If you define variables ready for input in BEx Query Designer, it is not always possible to manually enter a string in the prompt panel in Web Intelligence. In this situation, you can only select from a list of values.</td>
</tr>
</tbody>
</table>

Table 16: Query structure

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of objects allowed in a query</td>
<td>Do not use more than 50 objects in a BEx query, otherwise an error occurs.</td>
</tr>
<tr>
<td>Variables dependent on compound characteristics and the parent object</td>
<td>When there are dependencies between variables in compound characteristics and their parent, the dependencies are not guaranteed.</td>
</tr>
<tr>
<td>Query stripping</td>
<td>Available for .unv, OLAP, and BEx query sources. For other types of sources it is not available.</td>
</tr>
<tr>
<td>Query exceptions</td>
<td>These are not taken into account in Web Intelligence. Apply conditional formatting in Web Intelligence instead.</td>
</tr>
<tr>
<td>BEx query feature</td>
<td>Web Intelligence restriction</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Conditions</td>
<td>Do not use conditions. When the query is run, the conditions, if present in the query, are not applied.</td>
</tr>
<tr>
<td>Default Layout</td>
<td>The Web Intelligence access in general does not take the default layout of the BEx query into account. Use the Query Panel to obtain the following effects:</td>
</tr>
</tbody>
</table>

- Arrangement of characteristics in rows and columns
- Default presentation (for example, Text / Key-Presentation)
- Structure members with the state hidden (can be shown) or visible

**Related Information**

*Query stripping in documents [page 173]*

*Query stripping is a reporting feature that can be used to optimize performance.*

**2.1.5.4  Accessing BEx queries**

You must meet certain conditions before you can access BEx queries.

1. You can only access BEx queries that have the *Allow External Access to the Query* option enabled in the BEx Query Designer.
2. You must have the appropriate security rights to access and use the BEx queries for reporting.

The BI administrator defines the connection in the CMC, or you can use the information design tool to publish the connection to the CMC. The simplest method is to use the CMC.

**2.1.5.4.1  To enable access to BEx queries**

BEx queries can only be accessed by other tools including Web Intelligence if the BEx query property *Allow External Access to the Query* is enabled in the BEx Query Designer.

1. In the BEx Query Designer, select the query that you want to access with Web Intelligence.
2. In the *Properties* pane, select *Advanced*, and ensure that *Allow External Access to the Query* is selected.
3. Save the query.
4. Repeat the above steps for all BEx queries that you want to make available to Web Intelligence.
2.1.5.4.2 To define a BICS connection with the CMC

You can connect to BEx queries via BICS connections that have been created and saved in the Central Management Console. You can define a connection to a single BEx query or to an InfoProvider containing several BEx queries.

You need the appropriate administrator rights to define a BICS connection in the CMC.

1. Log in to the CMC.
2. Choose OLAP connections.
3. Define a new connection.
   - In the New Connection window, in the Provider dialog box, select SAP Business Information Warehouse.
4. Enter the connection information and your system details.
5. Save the connection.

To connect to a BEx query, you also define a BICS connection in the information design tool.

2.1.5.4.3 To define a BICS connection to a BEx query in the information design tool

To connect to a BEx query, you can define a BICS connection in the information design tool. You can define a connection to a single BEx query or to an InfoProvider containing several BEx queries.

1. In the information design tool, use the New OLAP Connection wizard to define an OLAP connection and choose the SAP BW SAP BICS Client middleware driver.
2. Publish the connection to a repository where it can be accessed by Web Intelligence.

You can now use Web Intelligence to select the connection and connect to the BEx query.

2.1.5.5 Building a Web Intelligence query on a BEx query

When you have connected to a BEx query, Web Intelligence maps the BEx query metadata to the Web Intelligence query objects.

You use the Web Intelligence Query Panel to select the appropriate objects to build a hierarchical query. You can add filters and prompts in the same way as you create queries on universes, but there are restrictions in certain situations, refer to the section Restrictions when using BEx queries.

Related Information

Restrictions when using BEx queries [page 82]
Hierarchical member selection in BEx queries [page 59]

You use the Member Selector dialog box, available from a hierarchy object in the Query Panel, to select members of a hierarchy for your query.
2.1.5.5.1 Hierarchical queries

A hierarchical query contains at least one hierarchy object.

You can build hierarchical queries on universes that support hierarchical data, or on BEx queries which access SAP Info Queries directly. Hierarchical data can come from relational or OLAP databases, depending on how the data is structured in the universe.

Related Information

Hierarchical member selection in BEx queries [page 59]

You use the Member Selector dialog box, available from a hierarchy object in the Query Panel, to select members of a hierarchy for your query.

Measures [page 49]

Measures retrieve data, usually numeric, that is the result of calculations on data in the database.

Hierarchies [page 47]

A hierarchy is a set of data members arranged in levels or parent-child relationships.

Hierarchical member selection and query filters [page 56]

When you filter members in a query filter, you also impact measure aggregation.

Selecting members of a hierarchy [page 56]
When you have hierarchical members in a query, you use the Member Selector dialog box to select members of the hierarchy to appear in the report generated from the query result set.

### 2.1.5.5.2 Scaling factors in BEx queries

When a BEx query contains measures that are mapped from scaled key figures, the factor of scaling on the measure is displayed in the resulting report.

When the scaling factor is changed for the key figure, this change is reflected in the report when the report is refreshed. The scaling factor is displayed for the measure name in the report, and for the measure attribute in the Query Panel.

### 2.1.5.5.3 Hierarchy node variables in BEx queries

When a prompt is present on a characteristic of a hierarchy node in a BEx query, this is referred to as a hierarchy node variable.

If there is a hierarchy node variable, the member selection function is disabled for the hierarchy. The prompt related to the hierarchy node variable appears at run time.

### 2.1.5.5.4 Hierarchical member selection in BEx queries

You use the Member Selector dialog box, available from a hierarchy object in the Query Panel, to select members of a hierarchy for your query.

The following hierarchy illustrates member selection behavior in BEx queries.

<table>
<thead>
<tr>
<th>World</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EMEA</td>
</tr>
<tr>
<td></td>
<td>Europe</td>
</tr>
<tr>
<td></td>
<td>Middle East</td>
</tr>
<tr>
<td></td>
<td>Africa</td>
</tr>
<tr>
<td>North America</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Asia</td>
</tr>
<tr>
<td></td>
<td>Pacific</td>
</tr>
<tr>
<td>Asia PAC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Australia</td>
</tr>
<tr>
<td></td>
<td>Philippines</td>
</tr>
</tbody>
</table>
Table 17: Hierarchy selection rules

<table>
<thead>
<tr>
<th>Rule</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you select a member of a hierarchy at a given level, all of the parent members in the hierarchy are selected.</td>
<td>The root is always selected. It is not possible to select one specific level.</td>
</tr>
</tbody>
</table>
| If you deselect a member when its parent member is already selected, all child members of the parent are also deselected. | If Pacific and all its child members are already selected and you deselect Australia, Philippines and New Zealand are also deselected. The following member selections appear:  
  - Europe  
  - Pacific |
| If you select a member with some of its child members already selected, all child members are selected. | If Europe is selected and you select EMEA, the Middle East and Africa are also selected. The following member selections appear:  
  - EMEA  
  - Children of EMEA |
| If you select a member when descendant members are already selected, all children of the member, and all siblings of the selected descendant members are also selected. | If you select Asia PAC when Australia was already selected, Asia, Pacific (children of Asia PAC) and Philippines and New Zealand (siblings of Australia) are also selected. The following member selections appear:  
  - Asia PAC  
  - Children of Asia PAC  
  - Pacific  
  - Children of Pacific |

Related Information

*Restrictions when using BEx queries* [page 82]

*Hierarchical member selection in BEx queries* [page 59]

You use the **Member Selector** dialog box, available from a hierarchy object in the *Query Panel*, to select members of a hierarchy for your query.
2.1.5.4.1 To select BEx query hierarchy members by relationship

You can select by relationship the members in a hierarchy for your BEx query.

**Note**

BEx queries can only be edited in Web Intelligence Applet interface or Web Intelligence Rich Client accessed via the BI launch pad.

1. Open in Design or Data mode a Web Intelligence document that uses a BEx query.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.
4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.
5. In the Members tab, right-click a member to which you want to apply a function.
   The menu displays the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Children</td>
<td>Adds all child members of the member to the list of selected members.</td>
</tr>
<tr>
<td></td>
<td>The members immediately below the selected member are its children.</td>
</tr>
<tr>
<td></td>
<td>The members appear as Children of [selected member] in the list.</td>
</tr>
</tbody>
</table>

**Note**

You cannot include children and descendants of the same member. If you had already selected Descendants before selecting Children, the descendants are removed from the list and replaced by children.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Descendants</td>
<td>Adds all descendant members of the member to the list of selected members. All members below the selected member in the hierarchy are its descendants.</td>
</tr>
<tr>
<td></td>
<td>The members appear as Descendants of [selected member] in the list.  \n</td>
</tr>
<tr>
<td>Parent</td>
<td>The Parent function is not available in BEx queries.</td>
</tr>
<tr>
<td>Ancestors</td>
<td>The Ancestors function is not available in BEx queries.</td>
</tr>
<tr>
<td>Siblings</td>
<td>The Siblings function is not available in BEx queries.</td>
</tr>
<tr>
<td>Descendants until Named Level</td>
<td>Use the list of level names to choose the level.</td>
</tr>
<tr>
<td>Descendants until</td>
<td>Choose the number of levels that you want to include in the selection.</td>
</tr>
</tbody>
</table>

6. Click **OK** to close the **Member Selector** dialog box. The selected members appear below the hierarchy object in the **Result Objects** pane. When you run the query, only those members are included in the query result.

You cannot exclude hierarchy members in BEx queries.

### Related Information

- **To select hierarchy members** [page 58]  
  You select hierarchy members for your query via the **Query Panel**.

- **About level-based member selection** [page 62]  
  You can select all members of a hierarchy to a specified depth. All members of the selected hierarchy until the specified depth are displayed in the report.

- **To build prompts for selecting members using the Member Selector dialog box** [page 66]  
  You can defer member selection until the query is run. If you do so, the user is prompted to select members when they run the query.

- **Hierarchical member selection and query filters** [page 56]
When you filter members in a query filter, you also impact measure aggregation.

2.1.5.4.2 To search for members in the Member Selector dialog box

You can search a hierarchy for specific members in the Member Selector dialog box.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.
4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.
5. In the Members tab, click the Search button to launch the Search dialog box.

   Note
   ○ The search is always performed on the entire hierarchy stored in the database, not on the members already retrieved in the Member Selector dialog box.
   ○ If Enable Levels is selected in the Levels tab, the Search button is disabled.

6. Type text in the Search text box.
   You can use wildcards in the search.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Replaces any string of characters</td>
</tr>
<tr>
<td>?</td>
<td>Replaces any individual character</td>
</tr>
</tbody>
</table>

7. Select one of the following:
   ○ Click Search in Text to search the display text of the members.
   ○ Click Search in Key to search their database keys.

8. Click OK to close the Member Selector dialog box.

2.1.5.4.3 To build prompts for selecting members using the Member Selector dialog box

You can defer member selection until the query is run. If you do so, the user is prompted to select members when they run the query.

   Note
   ● BEx queries can only be edited in Web Intelligence Applet interface or Web Intelligence Rich Client accessed via the BI launch pad.
   ● Selection of member prompts is restricted to explicit selection of members. The user cannot select members using functions such as Ancestors or Parent.
To build member-selection prompts:

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.
4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.
5. In the Prompts tab, click Enable Parameter.

   ![Note]
   When you select this option, the selections in the other tabs are deactivated.

6. Enter text in the Prompt Text box.
7. If you want the prompt to select the previously-chosen values by default when it is displayed, click Keep last values selected.
8. If you want the prompt to select default values when it is displayed, click Set default values, then Edit and select the default values.
9. Click OK to close the List of Values dialog box.
10. Click OK to close the Member Selector dialog box.
    The prompt text appears beneath the hierarchy in the Query Panel.

Related Information

To select BEx query hierarchy members by relationship [page 91]
You can select by relationship the members in a hierarchy for your BEx query.

2.1.5.5.4.4 To select members based on relative depth from a selected node

You can define to which depth of a hierarchy for which information is retrieved. Use the member selector to define the relative depth.

   ![Note]
   This feature is only available when the BEx query has a hierarchy node variable on the characteristic that you are using for the query.

1. Open in Design or Data mode a Web Intelligence document that uses a BEx query.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. Add a hierarchy object to the Result Objects pane in the Query Panel.

4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.

5. In the Relative Depth tab, select:
   - All hierarchy node descendants for the query to handle all the descendants of the selected hierarchy node.
   - Hierarchy members based on the relative depth in order to return data from a relative depth in the hierarchy. Select the number of levels below the selected node for which data is returned. You can set a different depth level for each hierarchy node variable.

6. Click OK to close the Member Selector dialog box.

When you run the query, you are prompted to select a node, and the query returns the data from the selected node down to the specified depth.

2.1.5.5.4.5 To select members based on levels from a selected node

You can define the number of levels of a hierarchy from which to retrieve more detailed data.

1. Open in Design or Data mode a Web Intelligence document that uses a BEx query.

2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.

3. Add a hierarchy object to the Result Objects pane in the Query Panel.

4. Click the arrow next to the hierarchy object to launch the Member Selector dialog box.

5. In the Levels tab, select Enable levels and select the levels down to which you want to return data.

   \[\text{Note}\]
   Levels must start from the selected root, and you cannot skip levels.

6. Click OK to close the Member Selector dialog box.

When you run the query, data is retrieved down to the selected level. If you select a different hierarchy at refresh time, the level selection still applies on the new hierarchy and returns nodes and values of the new hierarchy, down to the selected level.

2.1.5.5.5 About the Set Variables dialog box

You use the Set Variables dialog box to enter or modify values for the variables in the BEx query.

When you first create a document based on a BEx query that contains variables, when the BEx query contains at least one mandatory variable that does not have a default value, the Set Variables dialog box automatically appears and displays all the variables and their default values, if any (including optional variables). When you save the variable values, the Query Panel appears and you can select the objects for your document.
Note
Currently, the Set Prompt option for each variable is not displayed automatically when you first select the BEx query for your document. When the transient universe has been created and the Query Panel displays the objects, you can open the Set Variables dialog box and access the Set Prompt dialog box.

Caution
If the BI administrator allows manual entry of values for a prompt, so that a start and end value selection is changed to a values list, and your document was created when manual entry was not allowed, you need to do the following for your document:

- Purge the document.  
- Change the default values for query prompts to be compatible with multivalue selection.

Related Information

Selecting prompt values in the Prompts dialog box [page 278]  
When you open or refresh a document with prompts, the Prompts dialog box appears.

2.1.5.5.6 Prompts on BEx variables

2.1.5.5.6.1 Managing mandatory variables that do not have a default value

When different users refresh a copy of a document based on a BEx query that has a mandatory variable that does not have a default value, you use the Variable Manager at query design time to define how the variable is managed for the users. When the report is published to multiple users, you can ensure that the user is presented with a prompt default value that makes sense.

To use the BEx default values, in the Variable Manager, select the option Use BEx query defined default values at runtime. How the BEx default values are used depends on the settings in the variable manager and how the user responds to the Purge Last Selected Prompt Values prompt when the query is purged.

Workflow when the query designer chooses to use the BEx query default values at runtime

1. When the query contains a BEx mandatory variable, the designer chooses to use the BEx variable default value and selects Use BEx query defined default values at runtime.  
2. When a user runs the report, the query displays the prompt for the BEx variable. The default value proposed is 'A'. The user chooses a different value ('C', for example).
3. The report contains the results for the user’s selected value ‘C’.
4. The user purges the report. The purge process displays a warning message asking the if the user wants to purge the last selected prompt value (‘C’).

If the user:
- Selects Purge Last Selected Prompt Values, the query will retrieve ‘A’ as the default prompt value, since Use BEx query defined default values at runtime was selected at query design time.
- Does not select Purge Last Selected Prompt Values, the query will retrieve ‘C’ as the default prompt value, since this value was the last selected prompt value.

Workflow when the query designer chooses not to use the BEx query default values at runtime

1. When the query contains a BEx mandatory variable, the designer chooses not to use the BEx variable default value (‘A’, for example), but chooses a different value (‘B’, for example). The designer has not selected Use BEx query defined default values at runtime.
2. When a user runs the report, the query displays the prompt for the BEx variable. The default value proposed is ‘B’, the value selected by the query designer. However, the user chooses a different value (‘C’, for example).
3. The report contains the results for the user’s selected value ‘C’.
4. The user purges the report. The purge process displays a warning message asking the if the user wants to purge the last selected prompt value (‘C’).

If the user:
- Selects Purge Last Selected Prompt Values, the query will retrieve ‘A’ as the default prompt value, since Use BEx query defined default values at runtime was selected at query design time.
- Does not select Purge Last Selected Prompt Values, the query will retrieve ‘B’ as the default prompt value, since this value was selected in the Variable Manager at query design time.

2.1.5.5.6.2 Manual entry of values in prompts on BEx variables

If there is a characteristics value variable that is of type Selection Option, normally Web Intelligence interprets this type as a BETWEEN operator, so that the user enters a start and end value.

The BI administrator can change this behavior to be an INLIST operator, which allows multivalue selection of variables on a Selection Option prompt. When this happens the start and end value selection is changed to a multivalues list.

⚠️ Caution
If a query was created when the Selection Option selection was interpreted as BETWEEN, then any values selected for this prompt do not work. You need to do the following for any document created before the change in selection behavior:
- Purge the document.
Change the default values for query prompts to be compatible with multi-value selection.

## 2.1.5.5.7 To create a query based on a BEx query that has no variables

You can create a query using BEx data that contains no variables.

To access the BEx query, it must have the **Allow External Access to the Query** option enabled in the BEx Query Designer.

1. In a Web Intelligence document in **Design** or **Data** mode, click the **New** icon in the **File** toolbar.
2. In the **Select a data source list**, select **Bex**, then **OK**.
3. Select the appropriate BICS connection in the dialog box.
4. Select the BEx query in the side pane and click **OK**. When a BICS connection is based on an InfoCube, there may be several BEx queries available.
   When there are variables in the BEx query, depending on the variable type, the Set Variable dialog box appears and you define the variable properties (see the link below for more information about BEx variables and the Set Variables dialog box. The **Query Panel** appears, displaying the objects in the query as hierarchies, dimensions and attributes. If you cannot see the BEx query that you want to use, use the BEx Query Designer to ensure that the **Allow External Access to the Query** option is selected in the query.
5. Build the query and query filters using the available objects.

**i Note**
When you create a Web Intelligence query based on a BEx query that contains one mandatory variable (or more) that does not have a default value, when you select a list of values or try to use the **Member Selector** dialog box, an error message appears. Use the **Set Variables** dialog box to set values for the mandatory variable.

**i Note**
You cannot filter on result objects in BEx queries.

6. To run the query, click **Run Query**. When you have more than one query and you want to run just one query, click **Run Queries** and select the query that you want to run.
2.1.5.5.8 To create a document based on a BEx query that uses variables

You can create a document based on a BEx query that contains variables.

1. In a Web Intelligence document in Design or Data mode, click the New icon in the File toolbar.
2. In the Select a data source list, select Bex, then OK.
3. Select the appropriate BICS connection in the dialog box.
4. Select the BEx query in the side pane and click OK. When a BICS connection is based on an InfoCube, there may be several BEx queries available. When there are variables in the BEx query, depending on the variable type, the Set Variable dialog box appears and you define the variable properties. See the table below for more information about defining BEx variables and using the Set Variables dialog box.
5. Build the query and query filters using the available objects.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you create a Web Intelligence query based on a BEx query that contains one mandatory variable (or more) that does not have a default value, when you select a list of values or try to use the Member Selector dialog box, an error message appears. Use the Set Variables dialog box to set values for the mandatory variable.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot filter on result objects in BEx queries.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the BEx query you connected includes SAP server-side variables, you can change the value of the variable in the Query Panel. Click the Set Variables icon in the Query Panel toolbar, and select a new variable.</td>
</tr>
</tbody>
</table>

When you have selected a BEx query that contains variables, you use the Set Variables dialog box to define or modify the value(s) of the variable(s). The steps you have to perform depend on the variable type (mandatory or optional), and on whether there is a default value or not.
Table 18: Setting variables for BEx queries

<table>
<thead>
<tr>
<th>When the BEx Query has...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory variable(s) where at least one variable has no default value.</td>
<td>Use the Set Variables dialog box to fill in any mandatory variables. The OK button is enabled when all mandatory variables have a value. After this, the Query Panel is appears and the outline shows the content of the BEx query as generated in the transient universe. At this point, you can open the Set Variables dialog box again and change the Set Prompts properties.</td>
</tr>
</tbody>
</table>

i  Note

If at this point you cancel the Set Variables dialog box settings:

a. If you are using the Applet interface, the main Web Intelligence interface appears with no document open. If another document was already open at step you will already have been prompted to save or discard the changes when you started to create the BEx query.

b. If you are using the Rich Client interface, this returns the interface to the home page.

| Mandatory variable(s) with default values (optional variables have no effect on the behavior). | The Set Variables automatically appears when the transient universe is created, the Query Panel displays the metadata. |
| Only optional variable(s), at least one of the variables has no default. | The transient universe is created and the Query Panel displays the metadata without opening the Set Variables dialog box. |
| Optional variables that all have default values. There are no mandatory variables. | The transient universe is created and the Query Panel displays the metadata without opening the Set Variables dialog box. |

You can now run the query for your document. You can modify variables later by accessing the Set Variables dialog box through the Query Panel.

2.1.5.5.9  To add a second BEx query data provider to a document

Your current document is already based on a BEx query and you want to add a second BEx query as an additional data provider.

1. In a Web Intelligence document in Design or Data mode, click the Add a new data provider icon in the File toolbar.
2. In the Select a data source list, select Bex, then OK.
3. Select the appropriate BICS connection in the dialog box.
4. Select the BEx query in the side pane and click OK. When a BICS connection is based on an InfoCube, there may be several BEx queries available.
When there are variables in the additional BEx query, depending on the variable type, the **Set Variables** dialog box appears and you define the variable properties. See the table below for more information about defining BEx variables and using the **Set Variables** dialog box.

5. Build the query and query filters using the available objects.

### Note

When you create a Web Intelligence query based on a BEx query that contains one mandatory variable (or more) that does not have a default value, when you select a list of values or try to use the **Member Selector** dialog box, an error message appears. Use the **Set Variables** dialog box to set values for the mandatory variable.

### Note

You cannot filter on result objects in BEx queries.

### Note

If the BEx query you connected includes SAP server-side variables, you can change the value of the variable in the **Query Panel**. Click the **Set Variables** icon in the **Query Panel** toolbar, and select a new variable.

Table 19: Setting variables for an additional BEx query

<table>
<thead>
<tr>
<th>When the BEx Query has...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| Mandatory variable(s) where at least one variable has no default value. | When you select the new BEx query, the **Set Variables** dialog box displays all the variables of the newly added BEx query and their default values, if any. Only variables of the newly added data provider are displayed. If variables are shared by the original BEx query and the new BEx query, then the values of those variables are not prefilled by the values entered for initial query. Although the merge option of BEx variables is active, no merge is applied at this stage. Provide the mandatory variables and click **OK**. The **Query Panel** appears and the outline shows the content of the new BEx query, generated by the underlying transient universe. Create and execute the query. The prompts dialog box displays and shows the variables of the two data Providers depending on the option “Merge BEx variables” of the document:  
  - Merge is active: the dialog box merges the prompts that are shared by the two BEx queries. The values to be displayed are the values entered previously for the first data provider.  
  - Merge is not active: the dialog box displays each prompt separately, with separate values entered for each data provider. |
<table>
<thead>
<tr>
<th>When the BEx Query has...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory variable(s) with default values (optional variables have no effect on the behavior).</td>
<td>The transient universe is created and the Query Panel displays the metadata without opening the Set Variables dialog box.</td>
</tr>
<tr>
<td>Only optional variable(s), at least one of the variables has no default.</td>
<td>The transient universe is created and the Query Panel displays the metadata without opening the Set Variables dialog box.</td>
</tr>
<tr>
<td>Optional variables that all have default values. There are no mandatory variables.</td>
<td>The transient universe is created and the Query Panel displays the metadata without opening the Set Variables dialog box.</td>
</tr>
</tbody>
</table>

### 2.1.5.5.10 To edit a document based on a BEx query

You edit data providers in a BEx query in the Set Variables dialog box.

The document has multiple data providers; some of them (not all) are based on BEx Queries.

When editing data providers, the Set Variables dialog box appears when a mandatory variable exists and has no values. This situation can only happen if a mandatory variable was added to one of the underlying BEx Queries after the document was created and saved.

1. In a Web Intelligence document, in the Data Access tab, click Edit.
   The Set Variables dialog box is displayed with variables of the BEx Query related to the first Data Provider based on BEx in the document, having mandatory variables with no values. All variables of the BEx Query are displayed, not only the mandatory variables that are missing values.

2. Fill in the values for the missing mandatory variables and click OK.
   The Set Variables dialog box appears with variables of the BEx Query related to the second Data Provider based on BEx in the document, having mandatory variables with no values. All variables of the BEx Query are displayed, not only the mandatory variables that are missing values.

3. Fill in the values for the missing mandatory variables for the second BEx query and click OK.

4. Repeat the previous step until there are no more BEx data providers with mandatory variables and no default values.
   The Query Panel appears and displays the available objects.

5. The prompts dialog box displays and shows the variables of all data Providers depending on the option "Merge BEx variables" of the document:
   a) When Merge BEx variables is enabled: the dialog box merges the prompts that are shared by the BEx Queries. The values to be displayed are the values entered previously for the first data provider.
   b) Merge BEx variables is disabled: the dialog box displays each prompt separately, with separate values entered for each data provider.

When you have entered the prompt values, you can run the query for the document.

### 2.1.5.5.11 To cancel an edit

You can cancel an edit action in a BEx query.

You have a Web Intelligence document that has one or more Data Providers open for edit.
1. In the **Data Access** tab, click **Edit**.
   The **Set Variables** dialog box is displayed with variables of the BEx Query related to the first Data Provider based on BEx in the document, having mandatory variables with no values. All variables of the BEx Query are displayed, not only the mandatory variables that are missing values.

2. Cancel the **Set Variables** dialog box.
   The entire action of edit is cancelled, not only the **Set Variables** dialog box. The **Set Variables** dialog box is not displayed for the other data providers.

### 2.1.5.5.12 About previewing data when a BEx query has variables

Variables with missing values have no impact on this function.

The prompts dialog box (runtime prompts) displays and invites user to answer variables in all cases. In addition, at this stage the variables should already have been answered in the **Set Variables** dialog box either at document creation time, or when the query is edited. You can preview the query in the same way as any other document.

### 2.1.5.5.13 Changing the data source for BEx queries

You can change the data source for a document based on a BEx query.

<table>
<thead>
<tr>
<th>Original data source</th>
<th>Change to</th>
</tr>
</thead>
<tbody>
<tr>
<td>A BEx query</td>
<td>A .unv universe on an OLAP source</td>
</tr>
<tr>
<td>A BEx query</td>
<td>Another BEx query</td>
</tr>
</tbody>
</table>

When you change the source, the **Query Panel** automatically starts. You must edit the query accordingly.

### 2.1.5.5.14 Changing the data source when BEx queries contain variables

When you change the document from any data source type to a BEx Data source where the BEx Query has mandatory variables with no values, Web Intelligence applies the most appropriate values to the variables.

1. In a Web Intelligence document open in **Design** mode, select **Change Source**.
2. Select one or more existing data sources from the document, and select a BEx query that has at least one mandatory variable without default values as a target data source.
   In the mapping step the target objects are generated, the missing value(s) are automatically filled using a 'best fit' mechanism.
3. Validate the mapping.
   The **Query Panel** appears.
4. In the **Query Panel**, open the **Set Variables** dialog box and validate or edit the variable the values, as required.
You can run the query and save the document.

### 2.1.5.6 Runtime Configuration

This section describes the configuration options that can be set at runtime to change the behavior of the BW Direct Access in the Semantic Layer and in the BI tools.

All these options are Java runtime options and need to be provided for the Java Virtual Machine (JVM), through the command line, property files, or even through environment variables.

An example of the command line is as follows:

For `-DoptionName=optionValue`, you would use:

These lists are valid for BI 4.1 versions SP01 and higher. Some of these options are also available in BI 4.0.

#### Infoprovder Browsing

<table>
<thead>
<tr>
<th>Option</th>
<th>Possible Values</th>
<th>Description</th>
<th>In 4.0, as of:</th>
<th>In 4.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long name: sap.sl.bics.detectMdxCompliance</td>
<td>rfcPerInfoQuery</td>
<td>Set the MDX compliance detection mechanism for BEx queries when browsing BW infoareas/infocubes. For more information, refer to the “SAP BW Browsing Runtime Configuration” below.</td>
<td>SP04</td>
<td>Yes</td>
</tr>
<tr>
<td>Short name: detectMdxCompliance</td>
<td>rfcProperty</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: rfcPerInfoQuery</td>
<td>infoArea</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>false</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Long name: sap.sl.bics.browsingImplementation</td>
<td>bics</td>
<td>Set the SL implementation to use for BW query browsing.</td>
<td>SP05</td>
<td>Yes</td>
</tr>
<tr>
<td>Default value: bics</td>
<td>olapClient</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### List of Values

<table>
<thead>
<tr>
<th>Option</th>
<th>Possible Values</th>
<th>Description</th>
<th>In 4.0</th>
<th>In 4.1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Long name:</strong> sap.sl.bics.bicslovlimit</td>
<td>n &gt; 0</td>
<td>Set the maximum number of members for a list of values.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Short name:</strong> bicslovlimit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Default value:</strong> 5000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| **Long name:** sap.sl.bics.intervalLimitForBigSets | n > 0 | Set the maximum number of intervals that can be retrieved for members that exceed the number of LOV (see property bicslovlimit). | No | Yes |
| **Short name:** intervalLimitForBigSets | | | | |
| **Default value:** 0 | | | | |

| **Long name:** sap.sl.bics.variableComplexSelectionMapping | multivaluel | Defines the method of selecting values for BEx characteristic variables of the type Selection Option. | No | Yes as of SP0 5 |
| **Short name:** variableComplexSelectionMapping | interval | | | |
| **Default value:** interval | | | | |

**Caution**

If the BI administrator allows manual entry of values for a prompt so that a start and end value selection is changed to a values list, and a document was created when manual entry was not allowed, a document owner needs to do the following for a document:

- Purge the document.
- Change the default values for query prompts to be compatible with multivalue selection.
## Member Selection and Result Set Scope

<table>
<thead>
<tr>
<th>Option</th>
<th>Possible Values</th>
<th>Description</th>
<th>In 4.0</th>
<th>In 4.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long name: sap.sl.bics.expandToLevel Short name: expandToLevel Default value: 0</td>
<td>n &gt; 0</td>
<td>Set the expandToLevel value for hierarchies when fetching data; n is 1-based, 0 means &quot;use the expand-to-level value of the BEx query&quot;.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.expandNotAssignedNodes Short name: expandNotAssignedNodes Default value: false</td>
<td>true false</td>
<td>Expand the not assigned node when no member selection has been set on a dimension or hierarchy.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.depthRelativeTo Short name: depthRelativeTo Default value: top</td>
<td>top root node</td>
<td>Defines the behavior of the relative depth used in member selectors: 'top' means 'depth relative to the selected top node, including out-of-bounds selected nodes that belong to another root' 'root' means 'depth relative to the selected root node only, and out-of-bounds nodes are excluded' 'node' means 'depth relative to each selected node'</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Diagnosis and Debug

<table>
<thead>
<tr>
<th>Option</th>
<th>Possible Values</th>
<th>Description</th>
<th>In 4.0</th>
<th>In 4.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long name: sap.sl.bics.profileRFC</td>
<td>true, false, txt, xml, csv</td>
<td>Enable/disable the BW RFC tracing, and choose a specific tracing format if enabled.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Short name: profile_rfc</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: false</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Long name: sap.sl.bics.viewResult</td>
<td>1, undefined</td>
<td>Print result sets.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Short name: View_Result</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: undefined</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Miscellaneous

<table>
<thead>
<tr>
<th>Option</th>
<th>Possible Values</th>
<th>Description</th>
<th>In 4.0</th>
<th>In 4.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long name: sap.sl.bics.reverseKeyFigureStructure</td>
<td>1, undefined</td>
<td>Reverse axis of Structure containing KeyFigures (ROWS &lt;-&gt; COLUMNS).</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Short name: Reverse_KF</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: undefined</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Long name: sap.sl.bics.retrieveBWLevels</td>
<td>true, false</td>
<td>Retrieve the BW levels for every hierarchy, or completely skip them.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Short name: retrieveBWLevels</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Possible Values</td>
<td>Description</td>
<td>In 4.0</td>
<td>In 4.1</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------</td>
<td>--------------------------------------------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Recycle Grouping Set View</td>
<td>true, false</td>
<td>Recycle and share a single query view for all grouping sets.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.recycleGroupingSet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short name: recycleGSView</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inline Grouping Set</td>
<td>true, false</td>
<td>Inline grouping set in the main query if possible.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.inlineGroupingSet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short name: inlineGroupingSet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: false</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Key in ResultSet</td>
<td>true, false</td>
<td>Always fetch the member display keys when executing a query.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.displayKeyInResultSet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short name: displayKeyInResultSet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: false</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Design Time Services</td>
<td>true, false</td>
<td>Use the design-time services of BICS/BW.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.useDesignTimeServices</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short name: useDesignTimeServices</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Design Time Query for Refresh</td>
<td>true, false</td>
<td>Use the design-time query for refresh workflows as well.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.useDesignTimeQueryForRefresh</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short name: useDesignTimeQueryForRefresh</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Concurrent Design Time Query</td>
<td>true, false</td>
<td>Instantiate the design-time query early in a concurrent thread.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.useConcurrentDesignTimeQuery</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short name: useConcurrentDesignTimeQuery</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Possible Values</td>
<td>Description</td>
<td>In 4.0</td>
<td>In 4.1</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Long name: sap.sl.bics.activateMemberResolutionFallbackWithKey</td>
<td>true false</td>
<td>If text is not found, input is considered a key; 4.0 SP8 and 4.1 SP2+.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Short name: activateMemberResolutionFallbackWithKey</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: false</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Long name: sap.sl.bics.hierarchyVariableAlwaysMandatory</td>
<td>true false</td>
<td>In BW system, Hierarchy Variables can be defined as optional. However, in the BEX Analyzer, this optional Hierarchy Variable is treated as mandatory and users must provide an answer. On the BI platform, optional hierarchy variables are shown as optional prompts and users can skip the prompt and execute the query. Incorrect LOV content and incorrect query execution can occur if users skip any prompts. If you set this option to True, users cannot skip the prompts.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Short name: hierarchyVariableAlwaysMandatory</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default value: false</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**SAP BW Browsing Runtime Configuration**

This section explains the runtime configuration to get the MDX compliance information (detectMdxCompliance).

Previously, access to a dedicated system InfoArea (SystemMdxQueriesTopLevel) was hard-coded and you could not configure it. As of BI 4.0 SP5, you can configure this method.
• **Reverting to the infoArea configuration for the InfoArea dedicated system**
  You can still use this configuration on a new BW system, and it is very efficient for small systems. However, it does not scale up. This method is for BW systems prior to BW version 7.30.
  To activate this method, set the \texttt{jvmArg} to:

  \begin{verbatim}
  sap.sl.bics.detectMdxCompliance=infoArea
  \end{verbatim}

  This is the default value for BI 4.0 up to version SP4.
  This is not the default value for BI 4.0 version SP5 and higher.
  This method works well with different languages.

• **Configuring the BO or BI system to access the BW system with an RFC call per InfoQuery**
  This method is for BW systems prior to version 7.30. It is still usable on new BW system, however it is not efficient for an InfoProvider with a lot of InfoQueries. For large systems, it is more efficient for retrieving information than the InfoArea system.
  To activate this method, set the \texttt{jvmArg} to:

  \begin{verbatim}
  sap.sl.bics.detectMdxCompliance=rfcPerInfoQuery
  \end{verbatim}

  This is the default value.

• **Configuring the BI system to access the BW system with an RFC call**
  This method is for BW systems from version 7.30 and 7.31. Refer to SAP note 1647346.
  This method is less efficient than the former method for small systems, however the performance is good and it scales up. Internally, an RFC call is done for a cluster of SAP BW nodes. It does not have any max number limitations. All information is received with several RFC calls for a limited number of nodes.
  To activate this method, set the \texttt{jvmArg} to:

  \begin{verbatim}
  sap.sl.bics.detectMdxCompliance=rfcProperty
  \end{verbatim}

  This is not the default value. Folders appear in English.

• **Deactivation of the MDX compliant flag retrieval**
  All InfoQuery queries will be assumed to be flagged as MDX compliant. Only deactivate the MDX compliant flag retrieval if all InfoQuery queries are verified to be MDX compliant.
  To deactivate the MDX compliant flag retrieval, set the \texttt{jvmArg} to:

  \begin{verbatim}
  sap.sl.bics.detectMdxCompliance=false
  \end{verbatim}

  This is not the default value.

### 2.1.6 Building queries on Advanced Analysis views

SAP BusinessObjects Analysis is an OLAP analysis tool that allows users to interactively define analyses to explore data in OLAP data sources.

Users can export data in their analysis as Analysis Views, for use in other applications including SAP BusinessObjects Web Intelligence.
You can build queries on Analysis Views to analyze their data in Web Intelligence documents. The data in the Analysis View appears in the **Query Panel** as report objects such as hierarchies, dimensions and attributes.

i Note
Analysis Views with custom objects are not supported. Only analysis views coming directly from SAP BW are supported.

### 2.1.6.1 To build a query on an Analysis View

You can build a query on an Analysis View in the Web Intelligence Applet interface or Web Intelligence Rich Client.

1. Open a Web Intelligence document in **Design** or **Data** mode, select **Data Access**  >  **New**  >  **From Analysis View** to display the **Select an Analysis View** dialog box.
2. To build a query using a text file, do one of the following:
   - Click **New** in the **File** menu, select **Analysis View** and click **OK**.
   - In the **Create a new Web Intelligence Document** dialog box, select **Analysis View** as the data source.
   - In the **Data Access** tab, in the **Data Providers** subtab, select **From Analysis View** from the **New Data Provider** dropdown list.
3. Select the folder containing the Analysis View from the **Folders** list.
4. Select the Analysis View in the Side Panel. The **Query Panel** appears, displaying the data in the Analysis View as a report object.
5. Click **Run Query**. When you have more than one query and you want to run just one query, click **Run Queries** and select the query that you want to run.

### 2.1.7 Building queries on web service data sources

In the Web Intelligence Rich Client, the Web Services plug-in enables you to create a document using "Document as a Web Service" (DaaS) as a data source.

i Note
You cannot use web service data sources in documents in the Web Intelligence Applet or HTML interfaces.

Although this plug-in is developed for DaaS consumption, it can also be used for generic Web Service with the following properties:

- SOAP 1.1
- WSDL 1.0
- Document and RPC literal
- Public WSDLs

For generic web services, Web Intelligence Rich Client does not support:

- Schemas with cyclic references
• Nested imports, only one level of imports is supported
• Attribute elements in an XML schema
• Schemas referring to specific platforms like Microsoft or Java types like: http://microsoft.com/wsdl/types/, maps, objects and so on.

Note
For information on how to develop, configure, and deploy Custom Data Provider Plug-in, see the Custom Data Provider Plug-in Developer Guide.

2.1.7.1 Prerequisite for using the Web Service plug-in

Before you use the Web Service plug-in to create a Web Intelligence document, the BI administrator must ensure you have a DaaS or a generic web service WSDL as input to the Web Service plug-in. DaaS exposes a set of Web Intelligence report part contents as a web service that can be called within and outside of Web Intelligence clients.

For more information on creating a DaaS WSDL, see the related topic below.

Related Information

Sharing content with other applications [page 405]
You can make Web Intelligence content available outside Web Intelligence documents by publishing report blocks (tables, charts or forms) as web services known as BI Services.

2.1.7.1.1 Proxy settings for the Web Service plug-in

When using internet proxy server to access any URLs or WSDLs through the Web Service plug-in, the BI administrator must update the proxy settings in the net.properties file located at: <BOBJ_INST_DIR>/SAP BusinessObjects Enterprise XI 4.1/win64_x86/jdk/jre/ with the following information:

• Provide the values for the following HTTP parameters:

  http.proxyHost= <http proxy hostname>
  http.proxyPort=<http proxy port number>
  http.nonProxyHosts=<http hosts for which proxy is not required>

Where:

  ○ proxyHost is the name of the proxy server. For example, proxy.mydomain.com
  ○ proxyPort is the port number to use. By default, the value is 80.
  ○ nonProxyHosts is list of hostnames separated by ‘|’ which can be accessed directly within the network, ignoring the proxy server. The default value is: localhost & 127.0.0.1
• Provide the following values for HTTPS parameters:

```
https.proxyHost=<http proxy hostname>
https.proxyPort=<http proxy port number>
```

Where:

- `proxyHost` is the name of the proxy server. For example, `proxy.mydomain.com`.
- `proxyPort` is the port number to use. By default the value is 443. The HTTPS protocol handlers use the `http.nonProxyHosts` list.

**Note**
The `.pac` files are not supported. The BI administrator has to explicitly configure the proxy server in the proxy settings.

---

### 2.1.7.2 To build a query based on a web service

You can build queries that use Document as a Web Service (DaaWS) or any generic web service as a data source.

1. Launch Web Intelligence Rich Client and connect to the CMS that is configured for web services.
2. To build a query using a web service as a data source, do one of the following:
   - Click **New** in the **File** menu, and select **Web Services**.
   - In the **Create a new Web Intelligence Document** dialog box, select **Web Services** as the data source.
   - In the **Data Access** tab, in the **Data Providers** subtab, select **From Web Service** from the **New Data Provider** dropdown list.
3. Enter the URL from the QaaWS service in the **Source Path** text box and click **Submit**.

**Note**
This URL must be to a CMS enabled for web services.

**Sample URL:** `http://dewdftv00458q.dhcp.corp:80/dsws/qaawsservices/biws?WSDL=1&cuid=AcFqxUlcxKVPtBMyI4M1ziY`

**Where:**
- **Server name:** `http://dewdftv00458q.dhcp.corp:80/`
- **Web service:** `dsws/qaawsservices/biws?WSDL=1&cuid=AcFqxUlcxKVPtBMyI4M1ziY`

The **Service Details** and **Message Details** sections appear in the same dialog box.

4. In the **Service Details** section, set the following if they are not configured by default:
   - a) From the **Service Name** dropdown list, select the QaaWS service.
   - b) From the **Port Name** dropdown list, select the port name.
   - c) From the **Operation Name** dropdown list, select the operation name.
5. To enable SSO authentication, select the **SSO Enabled** check box.
If SSO has not been enabled on the CMS, this option is not visible in the dialog box.

If you select the **SSO Enabled** check box, the login and password cannot be configured.

In SSO authentication, the session ID of Web Intelligence is used for authentication. When you log onto Web Intelligence Rich Client using the Windows NT or Standalone authentication mode, the SSO option is disabled. Hence, you must enter the login credentials to access the web service. When logging into Web Intelligence Rich Client using any other authentication modes, you can either provide login and password information or use the SSO authentication mode to access web services.

**Note**

The SSO authentication is supported only if the Web Intelligence Rich Client is connected to the CMS on which the web service is deployed. Otherwise, you must provide login credentials to access the web service. If the Web Intelligence Rich Client is connected to a different CMS, you cannot refresh the documents created by using SSO authentication.

6. If you are not using SSO authentication, provide authentication details:
   a) If the **SSO Enabled** option is available in the dialog box, ensure that it is not selected.
   b) In the **Message Details** section, from the **Input Message** list, select **login**, enter the CMS user name in the "Enter Value" text box.
   c) In the same list, select **password**, enter the password for the CMS user in the **Enter Value** text box, and click **Apply**.

7. To set a report filter for the GetReportBlock operation, do the following:
   a) In the **Message Details** section, from the **Output Message** list, click + to expand the dimension on which a filter has to be applied.
   b) Select an object, enter a value in the **Enter Value** text box, and click **Apply**.
   c) Select **operator**, and select a value from the **Select Value** dropdown list.

   **Note**

   Specify the value and operator only for the dimensions to which you want to apply the filter.

8. To set filters for a generic web service, do the following:
   a) In the **Message Details** section, from the **Input Message** list, select an input field, enter a value in the **Enter Value** field.
   b) In the **Output Message** list, select output fields.

   You must select at least one field in the **Output Message** panel. To select multiple fields in the **Output Message** panel, press the **Control** key, and select the fields.

9. Click **Next**.

   **Note**

   You can use the **Reset** button to remove the value for each field in the **Message Details** section of the **Select Web Service details** panel. The **Reset All** button can be used to remove the values for all the fields in the **Message Details** section.

The **Query Panel** appears. Save the query and configure it as necessary.
Related Information

**BI service structure** [page 410]
Applications use the SOAP protocol to call the functions and receive the function output which they can then parse.

**GetReportBlock_<blockname>** [page 411]

**Drill_<blockname>** [page 414]

### 2.1.7.3 To edit a query based on a web service

1. In Web Intelligence Rich Client, open the document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Providers** subtab, click **Edit**.
3. Edit the following query parameters in the **Query Panel**:
   - **Object Properties**: You can edit the object properties such as name, qualification, type, aggregate function, and aggregate dimension.
   - **Query Properties**: You can edit query properties such as **Name**, **Source URL**, **Refreshable**, and **Editable**.

   _Note_
   If you edit the source URL in the **Query Panel**, ensure that the new URL from the QaaWS service has the same structure as the WSDL that it replaces.

4. Click **Run query** to apply your changes.

A new report is displayed.

For information on creating Custom Data Provider plug-ins, see the **Custom Data Provider Plug-in Developer Guide**.

### 2.1.8 To create a query on a different data source in an existing document

If you have the rights to edit queries in the Web Intelligence Rich Client or Applet interface, then you can select additional data sources in an existing document.

1. Open a Web Intelligence document in **Design** mode.
2. In the **Data Access** tab, in the **Data Providers** subtab, select a data source from the **New Data Provider** dropdown list.
3. Build and run the query.
2.2 Managing queries

2.2.1 To switch to Data mode

In the Web Intelligence Applet interface or Web Intelligence Rich Client you can access the Data mode.

1. Open a Web Intelligence document in the Web Intelligence Applet interface or Web Intelligence Rich Client.

   Note
   
   Data mode is not available in the Web Intelligence HTML interface.

2. Click Data in the top toolbar.
   The data providers used in the query are listed, along with information about the data provider, such as the number of rows it contains and its last refresh date.

2.2.2 To open for edit the data provider of an existing query

If you are able to edit queries, then you can open the Query Panel to edit the data provider.

1. Open a Web Intelligence document in Design or Data mode.

2. Do one of the following:

   ○ In the toolbar above the Side Panel, click the Edit data provider button.
   ○ In the Data Access tab, in the Data Providers subtab, click Edit.

The Query Panel appears.

2.2.3 The Data mode in Web Intelligence

You can use the Data mode in the Web Intelligence Applet interface and Web Intelligence Rich Client to view, explore and manage all the queries in a document.

In Data view, only the toolboxes in the Data Access tab are available.

Note

Data mode is not available in the Web Intelligence HTML interface.
2.2.3.1 To view and filter the data in a data provider

You can filter data in a data provider based on the values you specify.

1. Open a Web Intelligence document in Web Intelligence Rich Client or the Web Intelligence Applet interface in Data mode.
2. Double-click a data provider to open it.

   **Note**
   If the data provider contains multiple contexts or grouping sets, they appear in a dropdown list at the top right of the list pane. Each context or grouping set appears as Result n. Select a context or grouping set from the list to display its data.

3. To filter the data, click the arrow on a column header and do one of the following:
   ○ Select a value from the dropdown list.
   ○ Select Custom and define a custom filter.

A custom filter contains a filter operators and values that you select from the list of values or type directly. The number of values you can specify depends on the operator.

The custom filters are as follows:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>is anything</td>
<td>The data is not filtered.</td>
</tr>
<tr>
<td>is</td>
<td>The data is equal to a single value, which is the same action as selecting a single value from the dropdown list.</td>
</tr>
<tr>
<td>does not equal</td>
<td>The data is not equal to a single value. All values apart from that value are displayed.</td>
</tr>
<tr>
<td>is in</td>
<td>The data is in a list of values. Only the selected values are displayed.</td>
</tr>
<tr>
<td>is not in</td>
<td>The data is not in a list of values. All values apart from the selected values are displayed.</td>
</tr>
<tr>
<td>is empty</td>
<td>Only rows with empty values are displayed.</td>
</tr>
<tr>
<td>is not empty</td>
<td>Only rows with non-empty values are displayed.</td>
</tr>
<tr>
<td>begins with</td>
<td>Only rows that begin with the text you type are displayed.</td>
</tr>
<tr>
<td>ends with</td>
<td>Only rows that end with the text you type are displayed.</td>
</tr>
<tr>
<td>contains</td>
<td>Only rows that contain the text you type are displayed.</td>
</tr>
<tr>
<td>does not contain</td>
<td>Only rows that do not contain the text you type are displayed.</td>
</tr>
</tbody>
</table>

The filter also restricts the display in the other column. For example, if you filter the column for the Customer dimension to show three values only, the Order Amount column displays only the values that correspond to the remaining Customer values.
2.2.4  To manage queries using the Data Manager

You can view, explore and manage all the queries in a document using the Data Manager.

The Data Manager lists all the queries and allows you to perform actions such as renaming a query or changing the source of the data on which a query is based.

1. Open a Web Intelligence document in Web Intelligence Rich Client or the Web Intelligence Applet interface in Data mode.
   The Data mode lists the objects in the selected query. Only the toolbox items relevant to managing queries are available.

2. Do one of the following:
   ○ To edit a query, right-click it and select Edit, or in the Data Providers tab, click Edit. The Query Panel for the query you selected appears.
   ○ To purge a query of data, do one of the following:
     ○ Right-click it and select Purge from the menu.
     ○ Click Purge in the Data Provider tab.
   ○ To rename a query, right-click it and select Rename, then type the new name.
   ○ To change the data source:
     ○ Right-click the query and select Change Source.
     ○ In the Tools tab, click Change Source.

   For detailed information on changing the data source of a query, see the link at the bottom of this topic.

Related Information

Changing the data source of a query [page 121]
You can change the data source of a query.

2.2.5  To set the keydates of queries

You can set keydates in a query that uses an SAP BW data source.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Providers subtab, select Keydates.
3. Select Use the default date for all queries to set each query to its default keydate.
4. Select Set date for all queries and choose the date to specify a keydate for all queries.
5. Select **Prompt users when refreshing data** to display a prompt for the keydate whenever a query containing a key date is refreshed.

To change keydate value variables, open the query for edit in the **Query Panel** and click the **Set Variables** icon.

### 2.2.6 To preview query results

You can activate a preview pane in the **Query Panel**.

You have defined the result objects and filter objects in the **Query Panel**.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Provider** subtab, click **Edit**.
   The **Query Panel** appears.
3. Click **Show/Hide Data Preview Pane** on the **Query Panel** toolbar to display the **Data Preview** pane.

### 2.2.7 To sort query results

You can sort the results returned by a query.

The sorts are added directly to the script generated by the query and the database returns the query results already sorted.

For example, sorts added to queries that generate SQL appear in the **ORDER BY** clause of the generated SQL.

**Note**

Sorting is not available in queries based on OLAP data sources.

1. In a Web Intelligence document in **Design or Data** mode, open the Data Provider for edit.
   The **Query Panel** appears.
2. Click **Sort** on the **Result Objects** toolbar to display the **Sort** dialog box.
3. Click **Insert sort object** and select an object in the **Select an Object** dialog box.
4. Select the sort direction from the **Sort type** list.
5. Repeat the previous steps to add additional sorts to the query.
6. Select an object and click **Delete selection** to remove a sort from the query, or click **Delete All** to remove all sorts from the query.
7. Click **OK** to close the **Sorts** dialog box.
   The sorts are added to the script generated by the query.

### Related Information

**To open for edit the data provider of an existing query** [page 116]

*If you are able to edit queries, then you can open the Query Panel to edit the data provider.*
2.2.8 To interrupt a query

You can interrupt a query before all the data is returned to the document. When you interrupt a query, only partial data is returned to the document. The values displayed in the document do not accurately reflect the definition in the query.

When you interrupt data retrieval, you have a choice of which data to display.

**Note**

In the Web Intelligence HTML interface, when you cancel a query that is running, the Web Intelligence HTML interface returns to the precedent state of the document, and does not propose the option to interrupt data retrieval.

1. In a Web Intelligence document, click the Refresh icon.
2. In the Retrieving Data dialog box, click Cancel.
3. Select one of the following options in the Interrupt Data Retrieval dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore the results from the previous data retrieval.</td>
<td>Restores the values to the document that were retrieved the last time the query was run. The values displayed will not be the most up-to-date information available on the database. You can run the query later to retrieve the up-to-date values from the database.</td>
</tr>
<tr>
<td>Purge all data from the document.</td>
<td>Displays the document empty of values. The structure and formatting of the document is retained. You can run the query later to return the up to date values from the database.</td>
</tr>
<tr>
<td>Return the partial results.</td>
<td>Displays the new values retrieved so far in the appropriate parts of the document. The rest of the document will display the values retrieved the last time the query was run.</td>
</tr>
</tbody>
</table>
4. Click OK.

2.2.9 To remove a query

You can remove a query in the Query Panel.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit. The Query Panel appears.
3. At the bottom of the Query Panel, select the tab for the query you want to remove.
4. Right-click and select Delete.
5. Click Run Query.

Related Information

*To open for edit the data provider of an existing query* [page 116]  
If you are able to edit queries, then you can open the Query Panel to edit the data provider.
2.2.10  To duplicate a query

You can duplicate a query in the Query Panel.

You must run the query first before you are allowed to duplicate it.

Tip

If you want to build a different query on a universe already included in the document, instead of starting from scratch, duplicate the existing query on that universe and then modify it.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit.
   The Query Panel appears.
3. At the bottom of the Query Panel, select the tab for the query you want to duplicate.
4. Right-click the tab and select Duplicate.
5. Click Run Query.

Related Information

To open for edit the data provider of an existing query [page 116]

If you are able to edit queries, then you can open the Query Panel to edit the data provider.

2.2.11  Changing the data source of a query

You can change the data source of a query.

This is useful, for example, when you want to develop a document on a universe in a test environment, and then change to a universe in a production environment.

You can change the source of the data, but you will have to map objects to different objects in the same query or in a different query.

It is not possible to change between all data sources. The following table lists the possible changes from a source to a target.

<table>
<thead>
<tr>
<th>Source</th>
<th>UNV universe</th>
<th>UNX universe on relational data source</th>
<th>UNX universe on OLAP data source</th>
<th>Personal data provider (CSV, Excel)</th>
<th>BEx query</th>
<th>Advanced Analysis view</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNV universe</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>UNX universe on relational data source</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### 2.2.11.1 To change the data source of a query

Where possible, source and target objects are mapped by default based on their name, object type, data type and location in the data source.

You cannot map query filter objects. You can change mappings manually, or create mappings manually for objects that could not be mapped by default.

1. Open a Web Intelligence document in the Web Intelligence Applet interface or Web Intelligence Rich Client in Data mode.

2. In the list of data providers, right-click the query whose source you want to change and select Change Source. When using an Excel data source in Web Intelligence Rich Client, the Tools > Change Source options in the Data Access tab are not available. Open the Query Panel, and in the Query Properties tab, use the Source Path menu to select a different source file.

---

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
<th>UNV universe on relational data source</th>
<th>UNX universe on OLAP data source</th>
<th>Personal data provider (CSV, Excel)</th>
<th>BEx query</th>
<th>Advanced Analysis view</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNX universe on OLAP data source</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal data provider (CSV, Excel)</td>
<td></td>
<td></td>
<td></td>
<td>Yes**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BEx query</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

* When changing between these two sources, extensive remapping of objects may be required.

** When using an Excel data source in Web Intelligence Rich Client, the Tools > Change Source options in the Data Access tab are not available. If you need to change the data source for a document based on an Excel data source, open the Query Panel and in the Query Properties tab, use the Source Path menu to select a different source file.

You can only change the data source in the Web Intelligence Applet interface or Web Intelligence Rich Client. In Web Intelligence Rich Client, you also have the option to change the data source of queries based on personal data files such as Excel files.

---

** Note

When a report contains two queries based on the same universe, you can change the data provider for one of the queries from a universe to a BEx query.

---

** Note

When the source for a query is a universe (.unv file), you can change the source to a BEx query. You must remap objects to their corresponding object type in the new data source.
3. Do one of the following:
   ○ To select a target data source that is already used in the document, select **Choose an existing data source from the document**.
   ○ To choose a different data source, select **Specify a new data source**, then specify the data source.
   The lists display only those data sources to which a change from the current data source is possible.
4. Click **Next**.
   The source and target objects appear in default mappings. If the data sources contain hierarchical data, all objects in the hierarchy appear beneath their parent hierarchy.
5. For each object pair that you want to map manually, click **...** to display the **Map Object** dialog box.
6. Choose an object in the new universe to replace the object in the current universe.
   Objects are mapped by default based on the object type, data type, name and path in the source and target data sources. You can accept the default mapping or choose your own mapping.
   
   **Caution**
   In the **Change Source Wizard**, a warning icon can appear next to an object in the current universe that warns that there is an ambiguous mapping that occurs if the object does not have the same name or path as the proposed object in the new universe.

   If no default mapping is possible, the object appears as **Remove result object** in the target data source. If you do not select an object from the new data source, the unmapped object is removed from the query when you change the data source.

   If the removed object is the filtered object or rank-based object in a database ranking, the application displays a warning message. If you decide to remove the objects, the objects are removed from the ranking or sub-query.

   If the removed object is the filtering object in a query on query filter, the application displays a warning message. If you remove the object, the query on query filter is removed.
7. Click **Finish** to change the data source.

**Related Information**

To open for edit the data provider of an existing query [page 116]

If you are able to edit queries, then you can open the Query Panel to edit the data provider.

**2.3 Working with multiple queries and data providers**

You can include one or multiple queries in a document. These queries can be based on any supported data source. For example, you can include product sales data and customer data in the same document. In this case, your corporate data for product line sales is available on one universe and customer data is available on another universe. You want to present product line sales results and information on customer age groups in the same
report. To do this, you create a single document that includes two queries; one query on each universe. You can then include and format results from both queries in the same report.

Defining multiple queries in a single document is necessary when the data you want to include in a document is available in multiple data sources, or when you want to create several differently-focused queries on the same data source. You can define multiple queries when you create a document or add more queries to an existing document. You can present the information from all of the queries on a single report or on multiple reports in the same document.

**Caution**

We recommend that you use no more than 15 data providers in a Web Intelligence document. The amount of data providers you use can affect the time it takes to refresh document data and even the performance of the Web Intelligence Report Server.

### 2.3.1 Multiple queries, combined queries and synchronized queries compared

Multiple queries can be related in a document in different ways.

- **Basic multiple queries** draw unrelated data from different sources.
- **Synchronized queries** relate the data from different queries around a dimension that contains data common to both queries. These dimensions are called merged dimensions. You merge dimensions after you have created and run your multiple queries.
- **Combined queries** generate SQL containing the `UNION`, `INTERSECT` and `MINUS` operators (if the database supports them) or simulate the effect of these operators. Combined queries allow you to answer complex business questions that are difficult to formulate using standard queries.

**Note**

This option is not accessible for OLAP databases or for `.unx` relational databases. It is available only for `.unv` relational universes.

### 2.3.2 To add a query to an existing document

You can add queries to an existing document.

1. Open a Web Intelligence document in **Design** or **Data** mode.
2. In the **Data Access** tab, in the **Data Providers** subtab, click **Edit**. The **Query Panel** appears.
3. Click the **Add a combined query** icon in the toolbar.
4. Select a data source, if necessary.
5. Select objects for the additional query.
6. Click Run Query.
7. In the New Query box, specify in how the added data should be displayed:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a table in a new report</td>
<td>Display the data in a new report in the document</td>
</tr>
<tr>
<td>Insert a table in the current report</td>
<td>Display the data in the currently selected report in a new table</td>
</tr>
<tr>
<td>Include the result objects in the document</td>
<td>Include the data in the document without displaying the data on a report.</td>
</tr>
<tr>
<td>without generating a table</td>
<td></td>
</tr>
</tbody>
</table>

**Note**
You can add the objects returned by the query to the report later.

8. Click OK.

**Related Information**

- **To open for edit the data provider of an existing query** [page 116]
  If you are able to edit queries, then you can open the Query Panel to edit the data provider.

- **To build a query on an Analysis View** [page 111]
  You can build a query on an Analysis View in the Web Intelligence Applet interface or Web Intelligence Rich Client.

- **To create a query based on a BEx query that has no variables** [page 98]
  You can create a query using BEx data that contains no variables.

- **To build a query on a universe** [page 54]
  You can build a query using a universe as a data source.

- **Building queries on data files** [page 75]
  You can build queries on data files, such as, depending on your version of Web Intelligence, locally installed text files and Excel spreadsheets and Excel files on the CMS.

- **To build a query based on a web service** [page 113]

**2.4 Using combined queries**

A combined query is a group of queries that work together to return a single result.

You can combine queries in three relationships:

- union
- intersect
- minus
A UNION query takes all the data from both queries, eliminates duplicate rows, and builds a combined data set.

An INTERSECT query returns the data that is common to both queries.

A MINUS query returns the data in the first query that does not appear in the second.

---

**Note**

You cannot combine BEx or OLAP queries.

---

### Example

**Union, intersect and minus queries**

In this example you have two queries that return lists of countries as shown in the following table:

<table>
<thead>
<tr>
<th>Query</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>US; UK; Germany; France</td>
</tr>
<tr>
<td>Query 2</td>
<td>US; Spain</td>
</tr>
</tbody>
</table>

The different types of combined query return the following values:

<table>
<thead>
<tr>
<th>Combination type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNION</td>
<td>US; UK; Germany; France; Spain</td>
</tr>
<tr>
<td>INTERSECT</td>
<td>US</td>
</tr>
<tr>
<td>MINUS</td>
<td>UK; Germany; France</td>
</tr>
</tbody>
</table>

---

### Related Information

*Building queries based on BEx queries* [page 79]

BEx queries (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).

---

### 2.4.1 An example of a combined queries

Combined queries allow you to answer questions that are otherwise difficult or impossible to frame in standard query.

**Example**

**Return a data set using a combined query**

The Island Resorts Marketing sample universe contains the dimension Year, which, with Customers, returns guests who have already stayed in a resort, and Reservation Year with Customers returns guests who have reserved to stay in the future. Because of the structure of the database and universe, these objects are incompatible, which means that you cannot include them in the same block in a report.
What if you want to return a single list of years that includes those years where more than n guests stayed in a resort and those years where more than n guests reserved to stay in a resort? You can do this using a combined query, as follows:

<table>
<thead>
<tr>
<th>Query</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>Years where more than n guests stayed in a resort</td>
</tr>
<tr>
<td>UNION</td>
<td></td>
</tr>
<tr>
<td>Query 2</td>
<td>Years where more than n guests reserved to stay in a resort</td>
</tr>
</tbody>
</table>

The union between these two queries returns the list of years that you want.

### 2.4.2 How combined queries are generated

Combined queries work at the database level by altering the query submitted to the database. They do so by generating query script containing UNION, INTERSECT and MINUS operators.

If your database does not support the type of combination in your query, the combination occurs after data retrieval. Multiple queries return data to the report and this data is then resolved into the same result generated by a database-level combined query.

### 2.4.3 To build a combined query

You can create a combined query that allows you to answer a question that is otherwise difficult or impossible to frame in a standard query.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Data Access tab, in the Data Provider subtab, click Edit. The Query Panel appears.
3. Create an initial query in the Query Panel.
4. Click the Add a Combined Query icon on the toolbar to display the Combined Queries panel beneath the list of query objects. The Combined Queries panel shows the current query. You can change the query name by clicking the query in the panel, selecting Edit Name from the menu, then typing a new name in the Name box in the dialog box that appears.
5. Click Add a query. The second query appears in the Combined Queries pane and has the following conditions:
   - It is combined with the original query in a UNION relationship.
   - It is named Combined Query #n.
6. To switch to the query, select it in the Combined Queries pane.
Note

To delete a query, select it in the Combined Queries pane and press the Delete key, or drag and drop the query to the universe outline.

7. To change the combination type, select the operator. The operator moves through the sequence UNION, MINUS, INTERSECT.

8. Build each query within the combined query as you build any normal query.

9. Click Run Query.

Related Information

To open for edit the data provider of an existing query [page 116]

If you are able to edit queries, then you can open the Query Panel to edit the data provider.

2.4.4 Combined query structure

The queries within a combined query must return the same number of objects of the same data type and the objects must be in the same order.

You cannot combine queries when the number of objects in the query results and the data types of those objects are not identical. For example, you cannot combine a query that returns Year with a query that returns Year and Revenue, or combine a query that returns Year with a query that returns Revenue.

You must also pay attention to the semantics of your combined queries. While it is possible to combine a query that returns Year with a query that returns Region, if both dimensions are of the same data type, the result - a mixed list of years and regions - is unlikely to be meaningful. Typically, if your first query contains a Year dimension, your second query also contains a dimension that returns a list of years.

2.4.4.1 Example: A query of guest occupancy and reservation rates per year

You want to build a query that returns a list of years consisting of years where more than n guests stayed in a resort and years where more than n guests placed reservations to stay in a resort.

Note

This task requires access to the Island Resorts Marketing sample universe in Web Intelligence.

Note

The object you are filtering on must also be in the Result Objects pane.
1. In Web Intelligence, create a document and select the Island Resorts Marketing universe in the list of universes.

2. In the Query Panel, drag the Year, Number of Guests, and Future Guests objects to the Result Objects pane.

3. Drag the Number of Guests object to the Query Filters pane and create a report filter that restricts Number of Guests to greater than $n$.

4. Click the Add a combined query icon. Below the list of objects in the Query Panel, the Combined Query pane appears, displaying the two queries joined by a union.

5. Click the second query and remove the Year and Number of Guests objects.

6. Drag the Reservation Year object to the Result Objects pane.

7. Drag the Future Guests object to the Query Filters pane and create a report filter that restricts the future guests to greater than $n$.

8. Click Run Query.

The query returns the combined list of years and reservation years.

**Related Information**

To build a query on a universe [page 54]

You can build a query using a universe as a data source.

## 2.4.5 Combined query precedence

The order of execution in a combined query is crucial in determining the final result.

In the simplest form of combined query you combine two or more queries in a relationship as follows:

<table>
<thead>
<tr>
<th>Query</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>US; UK; France; Germany</td>
</tr>
<tr>
<td>Query 2</td>
<td>US; France; Finland</td>
</tr>
<tr>
<td>INTERSECTION of 1 and 2</td>
<td>US; France</td>
</tr>
<tr>
<td>Query 3</td>
<td>US; Spain</td>
</tr>
</tbody>
</table>

In such a case, the first result to be calculated is the intersection between Combined Query $n$ and Combined Query $n + 1$. The next result is the intersection between the first result and the result of Combined Query $n + 2$. Query execution continues in this way through all the queries in the relationship. This gives the following result for the above example:
2.4.5.1 Nested combined queries

By default, each time you add a combined query, it is combined at the initial combination level with existing queries.

Each added query extends the list of combined queries. If you add Query 3 to Query 1 and Query 2, which are already combined in a UNION relationship, you get the following result:

<table>
<thead>
<tr>
<th>Query</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIO</td>
<td>Query 1</td>
</tr>
<tr>
<td></td>
<td>Query 2</td>
</tr>
<tr>
<td></td>
<td>Query 3</td>
</tr>
</tbody>
</table>

You can also nest combined queries in complex, multi-level relationships to control the order of execution, as in the following example, which combines the result of Query 1 MINUS Query 2 in an INTERSECT relationship with Query 3.

<table>
<thead>
<tr>
<th>Query</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>US; UK; Spain; Germany</td>
</tr>
<tr>
<td>Query 2</td>
<td>Germany</td>
</tr>
<tr>
<td>Query 1 MINUS Query 2</td>
<td>US; UK; Spain</td>
</tr>
<tr>
<td>Query 3</td>
<td>US; Spain; Finland</td>
</tr>
<tr>
<td>(Query 1 MINUS Query 2) INTERSECT Query 3</td>
<td>US; Spain</td>
</tr>
</tbody>
</table>

In an LTR locale, query groups are processed from right to left and from top to bottom within each group. In an RTL locale, query groups are processed from left to right and from top to bottom within each group. The way query groups are processed depends on the Preferred Viewing Locale you have selected in the BI launch pad preferences. Some locales, like the English locale, use the left-to-right (LTR) interface positioning, whereas others, like the Arabic locale, use the right-to-left (RTL) interface positioning.
2.4.5.2 To set the order of precedence of combined queries

You set an order of precedence in combined queries by placing queries into nested groups.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit. The Query Panel appears.
2. Build the queries you want to organize in the Combined Queries panel.
3. To nest a pair of queries, click the Add new combined query node button. This action creates a combined query node.
4. Drag and drop a query on to the query with which you want to associate the nested pair. The new combined query node is by default a UNION relationship.
5. Continue adding queries to the nested group by dragging and dropping them on to the space between any two queries already in the group.
6. To create further nested groups within an existing higher-precedence group, repeat the previous two steps.
7. Click the combination operators of all the groups in the query to change them as required.
8. Run the query.

Related Information

To open for edit the data provider of an existing query [page 116]
If you are able to edit queries, then you can open the Query Panel to edit the data provider.

To build a combined query [page 127]
You can create a combined query that allows you to answer a question that is otherwise difficult or impossible to frame in a standard query.
2.5 Filtering data in the queries

2.5.1 Filtering data using query filters

Query filters are defined on the query; they limit the data retrieved from the data source and returned to the document.

Query filters allow you to:

- retrieve only the data you need to answer a specific business question
- hide the data you don’t want specific users to see when they access the document
- minimize the quantity of data returned to the document to optimize performance

For example, you can filter the Year dimension to view only sales revenue for Year 2003; or filter the Annual Income dimension to view only customers whose annual income is equal to or greater than $1.5M.

**Example**

**In Q4 2002, which stores in my sales region gained margins above $130K?**

As Regional Marketing Manager for Texas, you are only interested in analyzing margins for Texas, but the sales universe includes data US-wide. In addition, you only want to view information for stores where margins reached over your 4Q 2002 quarterly target figure of $130K. To create a document with only the information you need, you apply a filter on the State, Year, and Quarter dimensions and a filter on the Margin measure.

To avoid displaying the filtered values Texas, 2002, and Q4 in the table columns Year, Quarter, and State, you exclude the Year, Quarter, and State objects from the Result Objects pane. When you generate the report, the report values correspond to Texas stores with 4Q 2002 margins greater than or equal to $130K:

<table>
<thead>
<tr>
<th>Store name</th>
<th>Sales Revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-Fashion Houston</td>
<td>307,914</td>
<td>133,802</td>
</tr>
<tr>
<td>e-Fashion Houston Leighton</td>
<td>316,232</td>
<td>136,055</td>
</tr>
</tbody>
</table>

Related Information

*Using simple report filters* [page 274]

Simple report filters filter information in an open Web Intelligence report, not in the document or in specific objects in the report.
2.5.1.1 Structure of query filters

Query filters contain a filtered object, operator, and operand.

For example, in the filter `[Country] In list (US;France),` the `[Country]` dimension is the filtered object. `In list` is the operator, and the list of values `(US;France)` is the operand. The filter removes all values of `[Country]` other than `US` and `France` from the query result.

Table 21: Query filter components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filtered object</td>
<td>The Filtered object is the object whose values are filtered. Dimensions, attributes, measures, hierarchies and levels can be used as filtered objects. With the exception of BEx queries, the Filtered object is not required to appear as a result object in the query. For example, a query that contains the <code>[Customer]</code> and <code>[Revenue]</code> objects can filter on the <code>[Region]</code> object. If the filter is <code>[Region] Equal to &quot;South West&quot;</code>, the query returns only those customers in the South West region.</td>
</tr>
<tr>
<td>Operator</td>
<td>The Operator is used to compare the filtered object with the operand. For example, the <code>Equal to</code> operator retains only those values of the filtered object that correspond exactly to the value of the operand.</td>
</tr>
<tr>
<td>Operand</td>
<td>The Operand supplies the value or values used to filter the object. The next table describes the operand types.</td>
</tr>
</tbody>
</table>

Table 22: Operand types

<table>
<thead>
<tr>
<th>Operand type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>The Constant operand is used to type values directly. For example, you can use a constant to type &quot;France&quot; into the filter <code>[Country] Equal to France.</code>. The operand cannot be a constant if the Filtered object is a hierarchy, unless the hierarchy is used in conjunction with the <code>Matches pattern</code> or <code>Different from pattern</code> operator.</td>
</tr>
<tr>
<td>List of Values</td>
<td>The List of Values operand is used to select values from the list associated with the filtered object. For example, if the filtered object is <code>[City]</code>, you can use List of Values to select one or more of the cities associated with the object.</td>
</tr>
<tr>
<td>Prompt</td>
<td>A Prompt is a dynamic filter that is answered when the query is refreshed.</td>
</tr>
</tbody>
</table>
### Operand type

<table>
<thead>
<tr>
<th>Operand type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universe object</td>
<td>You can select an object from the universe to filter the filtered object</td>
</tr>
<tr>
<td></td>
<td>against its values.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>You cannot select a universe object as an operand on some OLAP data</td>
</tr>
<tr>
<td></td>
<td>sources or the filtered object is a hierarchy.</td>
</tr>
<tr>
<td>Result from another query</td>
<td>You can compare the filtered object against the values returned by another</td>
</tr>
<tr>
<td></td>
<td>query.</td>
</tr>
</tbody>
</table>

**Note**

You cannot select a universe object as an operand on some OLAP data sources or the filtered object is a hierarchy.

---

**Related Information**

*Building queries based on BEx queries* [page 79]

BEx queries (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).

---

### 2.5.1.1.1 Query filter and prompt operators

#### 2.5.1.1.1.1 List of operators

**Equal to operator**

Use the **Equal to** operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal to US".

**Note**

This operator cannot be used for OLAP universe parent-child hierarchies or for BEx queries.

**Not Equal to operator**

Use the **Not Equal to** operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter "County Not Equal to US".
2.5.1.1.1.1.3 Greater than operator

Use the Greater than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter "[Customer Age] Greater than 60".

*i Note*
This operator cannot be used for OLAP universe parent-child hierarchies or for BEx queries.

2.5.1.1.1.1.4 Greater than or Equal to operator

Use the Greater than or equal to operator to retrieve data greater than or equal to a value.

For example, to retrieve data for revenue starting from $1.5M, create the filter "[Revenue] Greater than or equal to 1500000".

*i Note*
This operator cannot be used for OLAP universe parent-child hierarchies or for BEx hierarchies.

2.5.1.1.1.1.5 Less than operator

Use the Less than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter "[Exam Grade] Less than 40".

*i Note*
This operator cannot be used for OLAP universe, hierarchies in filters, or for hierarchies in BEx queries.

2.5.1.1.1.1.6 Less than or Equal to operator

Use the Less than or equal to operator to retrieve data less than or equal to a value.

For example, to retrieve data for customers whose age is 30 or less, create the filter "[Age] Less than or equal to 30".

*i Note*
This operator cannot be used for OLAP universe, hierarchies in filters or for hierarchies in BEx queries.
2.5.1.1.1.7 Between operator

Use the **Between** operator to retrieve data between two boundary values including the two boundary values.

The first value declared must be lower than the second value.

For example, to retrieve data for weeks starting at week 25 and finishing at 36 (including week 25 and week 36), create the filter "[Week] Between 25 and 36".

---

**Note**

This operator cannot be used for OLAP universe or BEx hierarchies in filters.

2.5.1.1.1.8 Not between operator

Use the **Not between** operator to retrieve data outside the range of two values.

For example, to retrieve data for all the weeks of the year, except for and not including weeks 25 through 36, create the filter "[Week] Not between 25 and 36".

---

**Note**

This operator cannot be used for OLAP universe or for BEx hierarchies in filters.

2.5.1.1.1.9 In list operator

Use the **In list** operator to retrieve data corresponding to values in a list of values.

For example, to retrieve data only for the US, UK and Japan, create the filter [Country] In list, when you can type values in the *Type a value* field, you enter **US;UK;Japan**.

When used in a query filter with a hierarchical list of values, either from a dimension associated with a hierarchical list of values or a hierarchy object, *In list* allows the selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the *In list* operator allows the selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

When used in a report filter, *In list* produces a flat list of values.

2.5.1.1.1.10 Not In List operator

Use the **Not in list** operator to retrieve data that does not correspond to multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan, create the filter "[Country] Not in list". In the *Type a value* field, you enter **US;UK;Japan**.
When used with a hierarchical list of values, either from a dimension associated with a hierarchical list of values, a hierarchy object or a level object, **Not in list** allows the selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the **Not in list** operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

**Note**
This operator can only be used in certain types of hierarchies, for example, it can be used in level-based hierarchies.

### 2.5.1.1.1.11 Matches Pattern operator

Use the **Matches pattern** operator to retrieve data that includes a specific string or part of a string.

For example, to retrieve customers whose date of birth is 1972, create the filter `[DOB] Matches pattern "72"`.

**Note**
This operator cannot be used for BEx hierarchies.

### 2.5.1.1.1.12 Different From Pattern operator

Use the **Different from pattern** operator to return data that doesn't include a specific string.

For example, to retrieve customers whose date of birth is not 1972, create the filter `[DOB] Different from pattern '72`.

**Note**
This operator cannot be used for BEx or OLAP .unx universe parent-based hierarchies.

### 2.5.1.1.1.13 Both operator

Use the **Both** operator to retrieve data that corresponds to two values.

For example, to retrieve customers who have both fixed and mobile telephone numbers, create the filter `[Account Type] Both 'Fixed' And 'Mobile'`.

**Note**
This operator is not supported for filters based on hierarchy objects, or in universes based on OLAP data sources.
2.5.1.1.1.1.1.14 Except operator

Use the `Except` operator to retrieve data that corresponds to one value and excludes another.

For example, to retrieve customers who have only a fixed telephone number and no mobile telephone number, create the filter `[Account Type] 'Fixed' Except 'Mobile'.

The `Except` operator is more restrictive than `Different from` or `Not in list`. For example, a report that returns customers and that includes the filter `[Lines] Different From 'Accessories'` excludes all sales records where the item sold is part of the 'Accessories' line. If the same customer has purchased Accessories and non-Accessories items, the customer still appears in the report, but their spending total includes only non-Accessories sales.

If the filter is `[Lines] Except 'Accessories'`, only customers who have bought no accessories are included in the report.

**Note**

This operator is not supported in universes based on OLAP data sources.

Related Information

`Not in List operator` [page 136]

Use the `Not in list` operator to retrieve data that does not correspond to multiple values.

2.5.1.1.1.2 Restrictions on filter operators

The following table lists the restrictions on prompt and filter operators based on the filtered object and query type.

<table>
<thead>
<tr>
<th>Object</th>
<th>Available filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level-based hierarchy</td>
<td>Equal to</td>
</tr>
<tr>
<td></td>
<td>Not equal to</td>
</tr>
<tr>
<td></td>
<td>In list</td>
</tr>
<tr>
<td></td>
<td>Not in list</td>
</tr>
<tr>
<td></td>
<td>Matches pattern</td>
</tr>
<tr>
<td></td>
<td>Different from pattern</td>
</tr>
<tr>
<td>Parent-child hierarchy</td>
<td>Equal to</td>
</tr>
<tr>
<td></td>
<td>In list</td>
</tr>
<tr>
<td></td>
<td>Matches pattern</td>
</tr>
</tbody>
</table>
2.5.1.2 Types of query filter

There are several types of query filters available in Web Intelligence.

<table>
<thead>
<tr>
<th>Query filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predefined filters</td>
<td>Filters created by the BI administrator.</td>
</tr>
<tr>
<td>Custom filters</td>
<td>User-defined queries</td>
</tr>
<tr>
<td>Quick filters</td>
<td>A simplified form of custom filter.</td>
</tr>
<tr>
<td>Prompts</td>
<td>You can define these dynamic filters to display a question or a list of values so that you or other users can select different filter values at each run query.</td>
</tr>
</tbody>
</table>

You can mix different types of filters on a single query.

2.5.1.2.1 Predefined query filters

Predefined filters make the specific data you most typically need for reports permanently available.

They are created by a BI administrator and saved with the universe. Predefined filters often contain complex expressions that require a detailed knowledge of the database structure. Including predefined filters on the universe means you don’t need to create the same custom filters every time you create a new document based on the same universe.

You cannot view the component parts of predefined filters or edit predefined filters.

2.5.1.2.1.1 To select a predefined query filter

When you select a predefined query filter and run the query, the data corresponding to the query filter you selected appears in the report.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit. The Query Panel appears.
2. Double-click a predefined filter or drag it to the Query Filters pane.
Related Information

To open for edit the data provider of an existing query [page 116]
If you are able to edit queries, then you can open the Query Panel to edit the data provider.

2.5.1.2.2 Quick filters

Quick filters allow you to quickly define the values you want to retrieve for a specific result object without launching the Filter Editor.

By default, Quick filters use the Equal to operator if you select a single value or the InList operator if you select multiple values.

For example:

- If you select the [Payment Status] dimension and the value "unpaid?", you are creating the following filter: [Payment Status] Equal to "unpaid?"
- If you select the [Country] dimension and the values US, Japan, Germany, you are creating the following filter: [Country] InList "US;Japan;Germany?"

i Note
Quick filters are not available in BEx queries.

Related Information

Building queries based on BEx queries [page 79]
BEx queries (Business Exchange queries) are queries created using the SAP BEx Query Designer, based on SAP Info Cubes in a SAP Business Warehouse (SAP BW).

2.5.1.2.2.1 To create or remove a quick filter

You can create and remove quick filters in the Query Panel.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit.
   The Query Panel appears.
2. Select the object you want to filter.
3. Click the Add Quick Filter icon in the top corner of the Result Objects pane.
   The Add Quick Filter dialog box appears. The values for the selected object are listed.
4. Select the values you want to retrieve from the database and click the arrow next to the Selected Value(s) list.
   For example, to filter the query for values in Q1, select the [Quarter] dimension, then select Q1 from the list of values.
5. Click OK
   The new filter appears on the Query Filters pane.
6. To remove the filter, select it in the Query Filters pane and press the Delete key.
7. Click Run Query.
8. Save the document.

Related Information

To open for edit the data provider of an existing query [page 116]
If you are able to edit queries, then you can open the Query Panel to edit the data provider.

2.5.1.2.3 Custom query filters

You create custom query filters to limit document data to information corresponding to a specific business question or the business information needs of a specific group of users.

For example, you can create custom filters to retrieve sales results data for specific dates, products, or services, or to view customer information only for customers who are high wage earners or who live in a particular region.

2.5.1.2.3.1 To add and remove custom query filters

You can edit and remove custom query filters in the Query Filters pane.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit.
   The Query Panel appears.
2. Select the object you want to filter and drag it to the Query Filters pane.
   The query filter appears in an outline in the Query Filters pane.
3. Click the arrow next to the default operator (In list) and select a query operator from the list of operators.
4. Click the arrow next to the query filter and select the type of filter you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>You compare the object against a constant value to filter the query result.</td>
</tr>
</tbody>
</table>
| Value(s) from List    | You compare the object against values from a list of values to filter the query result.  
                        |   ○ If the filtered object is a dimension, attribute or measure, you can select any of the values of the object.  
                        |   ○ If the filtered object is a hierarchy, you can select any members of the hierarchy.  
                        |   ○ If the filtered object is a level, you can select any member from the level. |
| Prompt                | You create a filter which requires the user to supply filter values on data refresh. |
| Object from this query| You compare the object against the values returned by an object from in the same query. |
You compare the object against the values returned by an object from another query (the filtering query) to filter the query result.

5. Type/select the constant, list of values or object you want to include in the filter.

6. To remove the filter, do one of the following:
   - Select the filter and press Delete on your keyboard.
   - Click Remove in the top corner of the Query Filters pane.
   - To remove all filters, click Remove All in the top corner of the Query Filters pane.

Related Information

To open for edit the data provider of an existing query [page 116]
If you are able to edit queries, then you can open the Query Panel to edit the data provider.

2.5.1.2.3.2 To select values from a list of values

When selecting from a list of values in a query, items in the list can appear either as a single or multi-column list or a hierarchy, depending on the object. In a multi-column list, additional columns provide related values to the main value. In a hierarchical list, values appear in a hierarchical relationship.

When you refresh a report with prompts, lists of values for the prompts appear in a flat list without multiple columns.

1. In a list of values, select items that you want to appear.
   - If the list of values does not appear when a dialog box opens, refresh the list, or search the list to retrieve values. Some list of values require an initial search to display values because the list is too large to be loaded in full.
   - If the list of values is divided into ranges, use the control above the list to navigate through the ranges. Some large lists of values are divided into ranges to reduce the amount of data retrieved from the database. When you select a range, the list displays the values in that range.
   - If the list of values depends on other lists of values, specify the dependent values in the prompt dialog box that appears. A list of values can be dependent on other lists of values, for example when it is part of a hierarchical list of values. For example, if the list of values contains cities, and the City object is part of the hierarchy Country > Region > City, you need to specify values for country and region first to filter the list of cities.
When you first display the list of values, you see the Prompts dialog box in which you specify the dependent values. Once you have specified the dependent values, you can select the values from the filtered list.

- To display the value keys in OLAP or BEx queries, click Show/hide key values.
  
  Key values are not indicated in the list of Selected Values, only in the list of available values. Some lists of values contain key values, which are unique values that can be used to identify values with the same display value. If the list of values contains multiple columns, only the key of the filtering column is displayed.

- To search for values in the list, type the search text in the box below the list and select one of the following options from the Search icon dropdown list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match case</td>
<td>The search is case-sensitive. This option is not available when the Search in keys or Search on database options are selected.</td>
</tr>
<tr>
<td>Search in keys</td>
<td>The search uses unique value keys rather than display values. This option is available only in lists of values that support key values.</td>
</tr>
<tr>
<td>Search on database</td>
<td>The search includes all values stored in the database rather than being restricted to the values loaded into the list. It improves search accuracy but reduces search speed. This option is available only in lists of values that support database searches. Database searching improves search accuracy at the cost of performance. It is useful when not all values in the list of values were retrieved. This can happen when the total number of values in the list exceeds the Max rows retrieved query property. Database searching is particularly useful when the list of values is hierarchical because values are loaded from the database only in response to their parent value being expanded in the hierarchy. For example, in a geographical hierarchy, the child values of the California value (cities in California) are not loaded from the database until the value is expanded. If the option is selected, the search includes these items even when the California value has not been expanded. The search includes all ranges if the list of values is divided into ranges. In search patterns, the '<em>' wildcard represents any string of characters and the '?' wildcard represents any single character. For example, the value &quot;March&quot; can be returned by the search patterns &quot;M</em>&quot; or &quot;Mar?h&quot;.</td>
</tr>
</tbody>
</table>
To include the "*" and "?" characters literally rather than as wildcards, precede them with "\" in the search pattern.

- Type values from the list directly if the list supports direct data entry or select values from the list.

2. Click **OK** or **Run Query**, as applicable.

### Related Information

**Max rows retrieved query property** [page 73]

The **Max rows retrieved** query property determines the maximum number of rows of data that are displayed when a query is run.

**Selecting prompt values in the Prompts dialog box** [page 278]

When you open or refresh a document with prompts, the **Prompts** dialog box appears.

### 2.5.1.2.3.3 Filtering a query on values returned from another query

You can filter a query on values returned from another query.

For example, if you want to return results for all the countries in Query 1 that have a corresponding country in Query 2, you can filter the `[Query 1].[Country]` object on the values of the `[Query 2].[Country]` object.

The filtered query must be in a universe based on a relational (RDBMS) data source. The query that supplies the filtering values (filtering query) can be based on a relational, OLAP or local data source.

When you are building a query on a query, the filtering query does not appear in the list of queries that can be used as filtering queries until it has been run or saved.

The query filter can filter against all or any of the values returned by the filtering query. The supported combinations of operator and filter mode appear in the table below. If you do not choose an operator from the table, the **Result from another query** menu item is not available.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Filter mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal to</td>
<td>Any</td>
<td>Keep values in the filtered query that are equal to any value returned by the filtering query.</td>
</tr>
<tr>
<td>Not equal to</td>
<td>All</td>
<td>Keep values in the filtered query that are different from all the values returned by the filtering query.</td>
</tr>
<tr>
<td>Greater than</td>
<td>Any</td>
<td>Keep values in the filtered query that are greater than/greater than or equal to any of the values in the filtering query.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>Any</td>
<td>Keep values in the filtered query that are greater than/greater than or equal to any of the values in the filtering query.</td>
</tr>
</tbody>
</table>
### 2.5.1.2.4 Combining query filters

You can retrieve data that answers several criteria by combining filters in the same query. Typical business questions require you to retrieve information that matches more than one criteria. For example, if you are analyzing customer services data, you will most likely want to focus on customers for a specific time period and also for a specific region, and probably also for a specific level of customer service contract.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Filter mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater than</td>
<td>All</td>
<td>Keep values in the filtered query that are greater than all of the values in the filtering query.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>All</td>
<td>In other words, keep values in the filtered query that are greater than or equal to the maximum value returned by the filtering query.</td>
</tr>
<tr>
<td>Less than</td>
<td>Any</td>
<td>Keep values in the filtered query that are less than or equal to any of the values in the filtering query.</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>All</td>
<td>In other words, keep values in the filtered query that are less than or equal to the minimum value returned by the filtering query.</td>
</tr>
<tr>
<td>In list</td>
<td>Any</td>
<td>Keep values in the filtered query that are equal to any value in the list of values returned by the filtering query.</td>
</tr>
<tr>
<td>Not In list</td>
<td>Any</td>
<td>Keep values in the filtered query that are not equal to any of the values in the list of values returned by the filtering query.</td>
</tr>
</tbody>
</table>
Example

Analyze sales revenue this year at stores where the floor size is over 4,000 square feet and sales revenue figures are equal to or less than $1.5M

In this example, you are an operations manager for a retail chain. You want to analyze information about the large retail stores in your chain that are making less than the sales revenue figure your company has set as the target.

To do this:

1. Add a predefined filter on the [Year] dimension to specify that you only want to retrieve values for this year.
2. Create a second filter on the [Sales Floor Size] dimension to specify that you only want to retrieve data for stores where the floor size is greater than 4,000 square feet.
3. Create a third filter on the [Sales Revenue] measure to specify that you only want to retrieve data for stores where the sales revenue figures are equal to or less than $1.5M.
4. Combine these three filters with the And operator:

<table>
<thead>
<tr>
<th>And</th>
<th>Last Year</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sales Floor Size Group Greater than or equal to: 4000</td>
</tr>
<tr>
<td></td>
<td>Sales Revenue Less than 1,500,000</td>
</tr>
</tbody>
</table>

When you run the query, only data for stores that satisfy all three criteria will be returned to the report.

Related Information

To combine query filters [page 146]

You can combine query filters in the Query Filters pane.

Nested query filters [page 147]

Nested query filters allow you to create more complex filter conditions than is possible when you combine filters at the same level.

2.5.1.2.4.1 To combine query filters

You can combine query filters in the Query Filters pane.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit. The Query Panel appears.
2. Create the filters and add them to the Query Filters pane. Filters are combined by default with the And operator.
3. Click the operator or the arrow next to the operator checkbox and select the other operator to toggle between And and Or.
Note
The Or operator is not supported from some OLAP data sources such as BEx queries, and OLAP .unx universes on the top of Microsoft Analysis Services (MSAS) and Oracle Essbase.

Related Information

Combining query filters [page 145]
You can retrieve data that answers several criteria by combining filters in the same query.

To open for edit the data provider of an existing query [page 116]
If you are able to edit queries, then you can open the Query Panel to edit the data provider.

2.5.1.2.4.2 Nested query filters

Nested query filters allow you to create more complex filter conditions than is possible when you combine filters at the same level.

When you nest filters, you set the order in which they are evaluated. For example, you can return the data given by two query filters joined in an Or relationship (where either one filter condition or the other is true) and then further restrict this data by applying another filter to it. In this case, the two filters in an Or relationship are nested, then compared with the other filter in an And relationship.

Example

List all sales made in Japan either in Q4 or where the revenue was greater than 1000000

To answer this question, you create the following nested query filter:

<table>
<thead>
<tr>
<th>And</th>
<th>Country Equal To Japan</th>
<th>Or</th>
<th>Quarter Equal To Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Revenue Greater Than 1000000</td>
<td></td>
</tr>
</tbody>
</table>

This combination of query filters first returns sales data where the sale was made in Q4 or the revenue was greater than 1000000, then restricts this data further by returning only those sales made in Japan.

Related Information

To nest query filters [page 148]
You can create nested query filters in the Query Panel.

Combining query filters [page 145]
You can retrieve data that answers several criteria by combining filters in the same query.
2.5.1.2.4.2.1  To nest query filters

You can created nested query filters in the Query Panel.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit. The Query Panel appears.
2. Drag and drop a report object onto an existing query filter. A query filter outline on the report object appears in a nested AND relationship with the existing query filter.
3. Define the new query filter.

Related Information

To open for edit the data provider of an existing query [page 116]
If you are able to edit queries, then you can open the Query Panel to edit the data provider.

Nested query filters [page 147]
Nested query filters allow you to create more complex filter conditions than is possible when you combine filters at the same level.

Combining query filters [page 145]
You can retrieve data that answers several criteria by combining filters in the same query.

2.5.1.3  Filtering hierarchical queries

2.5.1.3.1  How levels filter hierarchical queries

A level used as a query filter removes the specified members from the level and all their child members from the hierarchy.

The filter also impacts measure aggregation.

Example

Filtering on a level
You have the following data on which the level filter [Country] Not equal to Germany is applied.

You apply the filter by dragging the [Country] level to the Query Filters pane in the Query Panel, selecting the Not equal to operator and selecting “Germany” from the list of values of the level.

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
</tbody>
</table>
After filtering, the data appears as follows:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>$2,894,312.34</td>
</tr>
<tr>
<td>Brandenburg</td>
<td>$119,871.08</td>
</tr>
<tr>
<td>Hessen</td>
<td>$794,876.08</td>
</tr>
</tbody>
</table>

When the filter is applied, Germany and all descendant members are filtered from the hierarchy. The value of [Internet Sales Amount] for All Customers is also reduced because the value for Germany is no longer part of the aggregation.

### 2.5.1.3.2 How measures filter hierarchical queries

A filter on a measure applies to all levels in a hierarchy and does not impact measure aggregation in the filtered result.

#### Example

**Filtering on a measure**

You have the following data, to which you apply the filter [Internet Sales Amount] Greater than 500,000.

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
<tr>
<td>Germany</td>
<td>$2,894,312.34</td>
</tr>
<tr>
<td>Brandenburg</td>
<td>$119,871.08</td>
</tr>
<tr>
<td>Hessen</td>
<td>$794,876.08</td>
</tr>
</tbody>
</table>

The filtered data appears as follows:
The table shows the Internet Sales Amount for customers from France and Germany, with a breakdown for Seine (Paris) and Hessen.

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
<tr>
<td>Germany</td>
<td>$2,894,312.34</td>
</tr>
<tr>
<td>Hessen</td>
<td>$794,876.08</td>
</tr>
</tbody>
</table>

The filter is applied to all members, irrespective of their level in the hierarchy, and the aggregated measures are not impacted by the removal of the filtered members. For example, the All Customers amount remains at $29,358,677.22.

### 2.5.2 Filtering data with query prompts

A query prompt is a dynamic filter in a document that displays a question every time a user opens or refreshes the data in a document.

Users answer prompts by either typing or selecting the values they want to view when they refresh the data. The query then retrieves from the database only the values specified in the Prompts dialog box.

Prompts allow multiple users viewing a single document to specify a different sub-set of the database information and display it in the same report tables and charts. Prompts also reduce the time it takes for the data to be retrieved from the database.

A prompt contains the following elements:

- a filtered object
- an operator
- a message

For example, to prompt users to select a specific year, you define a prompt on the [Year] dimension:

```
Year Equal To ("Which year?")
```

In this prompt, the filtered object is [Year], the operator is Equal To, and the prompt message is "Which year?".

You can define prompts on dimensions, measures, attributes, hierarchies and levels. For example, you can filter the [Year] dimension to return values for a specific year, filter the [Sales Revenue] measure to return values for a range of revenue figures, or filter the [Geography] hierarchy to return members from the hierarchy.

**Note**

- In Web Intelligence Rich Client or Web Intelligence Applet interface, for OLAP .unx universes, when filtering on measures, you can only type a constant.
- In Web Intelligence Rich Client or Web Intelligence Applet interface, you cannot add measures or detail objects in the filter panel for BEx queries.

You can create multiple prompts, related by the AND or OR operators, in the same query. You can also nest prompts. When the user runs a query, the prompts are displayed.
Note
On BEx queries and OLAP .unx universes, you can only use the AND operator.

Prompts appear in the script generated by the query as either the value supplied in response to the prompt or as special prompt syntax. For example, a prompt on [Country] can appear in generated SQL as:

```sql
Resort_Country.country = @prompt('Enter Country:','A', 'Resort\Country', Mono, Free, Persistent,,User:0)
```

or as

```sql
Resort_country.country In ('UK')
```

Prompts can be optional. You are not obliged to supply values for optional prompts. If you do not supply a value, the prompt is ignored.

Related Information

Selecting prompt values in the Prompts dialog box
When you open or refresh a document with prompts, the Prompts dialog box appears.

2.5.2.1 Merged prompts

When a document contains multiple data providers, any prompts that include objects with the same data type, operators of the same operator type, and that use the same prompt text are merged.

When all the data providers are refreshed, a single prompt message appears for such prompts.

The List of Values displayed by the merged prompt is the list associated with the object in the prompt that has the most display property constraints.

2.5.2.2 HANA query prompts in Web Intelligence

In Web Intelligence, HANA universes behave like any other relational UNX universe: variables and input parameters in SAP HANA information models are associated with the corresponding tables in the data foundation.

If there are variables and input parameters, then when you run a query in the Query Panel, prompts will appear that require you to enter values for the variables and parameters, and also when the document is refreshed. The values available in the prompts come directly from a HANA source.

For more information on HANA universes and query prompts at the universe level, see the Information Design Tool User Guide.
2.5.2.3 Hierarchical prompts

Depending on the filter operator in the prompt, you can select items from different levels of the list of values, or at the lowest level only.

The following objects display their lists of values hierarchically in a prompt:

- Hierarchies
- Levels
- Dimensions associated with a hierarchical list of values

A hierarchical list of values appears in tree form. You can navigate up and down the tree to the items you want.

2.5.2.4 Query filter and prompt operators

2.5.2.4.1 List of operators

2.5.2.4.1.1 Equal to operator

Use the Equal to operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal to US".

2.5.2.4.1.2 Not Equal to operator

Use the Not Equal to operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter "County Not Equal to US".

Note

This operator cannot be used for OLAP .unx universe parent-child hierarchies or for BEx queries.
2.5.2.4.1.3 Greater than operator

Use the Greater than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter "[Customer Age] \textgreater \text{ than } 60".

\textbf{Note}

This operator cannot be used for OLAP .unx universe parent-child hierarchies or for BEx queries.

2.5.2.4.1.4 Greater than or Equal to operator

Use the Greater than or equal to operator to retrieve data greater than or equal to a value.

For example, to retrieve data for revenue starting from $1.5M, create the filter "[Revenue] \textgreater \text{ than or equal to } 1500000".

\textbf{Note}

This operator cannot be used for OLAP .unx universe parent-child hierarchies or for BEx hierarchies.

2.5.2.4.1.5 Less than operator

Use the Less than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter "[Exam Grade] \textless \text{ than } 40".

\textbf{Note}

This operator cannot be used for OLAP .unx universes, hierarchies in filters, or for hierarchies in BEx queries.

2.5.2.4.1.6 Less than or Equal to operator

Use the Less than or equal to operator to retrieve data less than or equal to a value.

For example, to retrieve data for customers whose age is 30 or less, create the filter "[Age] \textless \text{ than or equal to } 30".

\textbf{Note}

This operator cannot be used for OLAP .unx universes, hierarchies in filters or for hierarchies in BEx queries.
2.5.2.4.1.7  Between operator

Use the Between operator to retrieve data between two boundary values including the two boundary values.

The first value declared must be lower than the second value.

For example, to retrieve data for weeks starting at week 25 and finishing at 36 (including week 25 and week 36), create the filter "[Week] Between 25 and 36".

Note
This operator cannot be used for OLAP .unx universe or BEx hierarchies in filters.

2.5.2.4.1.8  Not between operator

Use the Not between operator to retrieve data outside the range of two values.

For example, to retrieve data for all the weeks of the year, except for and not including weeks 25 through 36, create the filter "[Week] Not between 25 and 36".

Note
This operator cannot be used for OLAP .unx universe or for BEx hierarchies in filters.

2.5.2.4.1.9  In list operator

Use the In list operator to retrieve data corresponding to values in a list of values.

For example, to retrieve data only for the US, UK and Japan, create the filter [Country] In list, when you can type values in the Type a value field, you enter US;UK;Japan.

When used in a query filter with a hierarchical list of values, either from a dimension associated with a hierarchical list of values or a hierarchy object, In list allows the selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the In list operator allows the selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

When used in a report filter, In list produces a flat list of values.

2.5.2.4.1.10  Not In List operator

Use the Not in list operator to retrieve data that does not correspond to multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan, create the filter "[Country] Not in list". In the Type a value field, you enter US;UK;Japan.
When used with a hierarchical list of values, either from a dimension associated with a hierarchical list of values, a hierarchy object or a level object, Not in list allows the selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the Not in list operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

**Note**
This operator can only be used in certain types of hierarchies, for example, it can be used in level-based hierarchies.

### 2.5.2.4.1.11 Matches Pattern operator

Use the Matches pattern operator to retrieve data that includes a specific string or part of a string.

For example, to retrieve customers whose date of birth is 1972, create the filter [DOB] Matches pattern "72".

**Note**
This operator cannot be used for BEx hierarchies.

### 2.5.2.4.1.12 Different From Pattern operator

Use the Different from pattern operator to return data that doesn't include a specific string.

For example, to retrieve customers whose date of birth is not 1972, create the filter [DOB] Different from pattern '72'.

**Note**
This operator cannot be used for BEx or OLAP universe parent-based hierarchies.

### 2.5.2.4.1.13 Both operator

Use the Both operator to retrieve data that corresponds to two values.

For example, to retrieve customers who have both fixed and mobile telephone numbers, create the filter [Account Type] Both 'Fixed' And 'Mobile'.

**Note**
This operator is not supported for filters based on hierarchy objects, or in universes based on OLAP data sources.
2.5.2.4.14 Except operator

Use the Except operator to retrieve data that corresponds to one value and excludes another.

For example, to retrieve customers who have only a fixed telephone number and no mobile telephone number, create the filter [Account Type] 'Fixed' Except 'Mobile'.

The Except operator is more restrictive than Different from or Not in list. For example, a report that returns customers and that includes the filter [Lines] Different From 'Accessories' excludes all sales records where the item sold is part of the 'Accessories' line. If the same customer has purchased Accessories and non-Accessories items, the customer still appears in the report, but their spending total includes only non-Accessories sales.

If the filter is [Lines] Except 'Accessories', only customers who have bought no accessories are included in the report.

Note

This operator is not supported in universes based on OLAP data sources.

Related Information

Not In List operator [page 136]

Use the Not in list operator to retrieve data that does not correspond to multiple values.

2.5.2.4.2 Restrictions on filter operators

The following table lists the restrictions on prompt and filter operators based on the filtered object and query type.

<table>
<thead>
<tr>
<th>Object</th>
<th>Available filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level-based hierarchy</td>
<td>Equal to</td>
</tr>
<tr>
<td></td>
<td>Not equal to</td>
</tr>
<tr>
<td></td>
<td>In list</td>
</tr>
<tr>
<td></td>
<td>Not in list</td>
</tr>
<tr>
<td></td>
<td>Matches pattern</td>
</tr>
<tr>
<td></td>
<td>Different from pattern</td>
</tr>
<tr>
<td>Parent-child hierarchy</td>
<td>Equal to</td>
</tr>
<tr>
<td></td>
<td>In list</td>
</tr>
<tr>
<td></td>
<td>Matches pattern</td>
</tr>
</tbody>
</table>
2.5.2.5 To build a prompt

You build a query prompt in the Query Panel.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit. The Query Panel appears.

2. Drag the object you want to filter with a prompt and drop it into the Query Filters pane. The query filter appears in outline in the Query Filters pane. The outline shows the filtered object, the operator and the type of filter applied to the object. By default the filter is a constant.

3. Select a filter operator from the list.

4. Click the arrow next to the outline query filter and select Prompt from the menu to filter the object using a prompt.

The Prompts dialog box appears.

5. Select Prompt with list of values to allow the user to select from a list of values when answering the prompt.

If you deselect the Prompt with list of Values option, type the prompt text (for example "Enter a City") in the Prompt text box.

6. In the Parameter Properties dialog box, do any of the following:
   ○ Select Select only from list to restrict the user choice to values available in the list.
Note

- The option is selected by default if the filtered object has an associated list of values in the universe, and cannot be deselected if the filtered object is a hierarchy.
- Do not select this option if the filtered object is a date and you want users to see a popup calendar to select the date.

Select **Keep last values selected** to ensure that, by default, the prompt selects the values the user selected the last time they answered the prompt. The option is selected by default if the filtered object has an associated list of values in the universe, and cannot be deselected if the filtered object is a hierarchy.

Select **Set default values** if you want the prompt to select values by default when it appears, and type a value in the **Type a value** box, or click ... and select default values in the **List of Values** dialog box.

- Select **Optional prompt** to make the prompt optional. If the user does not supply a value for an optional prompt, the prompt is ignored. Click the icon next to the text box and use the dialog box that appears to set the prompt properties.

The prompt appears at each document refresh.

### Related Information

*To open for edit the data provider of an existing query* [page 116]
  
  If you are able to edit queries, then you can open the Query Panel to edit the data provider.

*Defining how prompts display* [page 159]
  
  You can modify how prompts appear in the **Prompts** dialog box.

*Merged prompts* [page 151]

  When a document contains multiple data providers, any prompts that include objects with the same data type, operators of the same operator type, and that use the same prompt text are merged.

*Selecting prompt values in the Prompts dialog box* [page 278]

  When you open or refresh a document with prompts, the **Prompts** dialog box appears.

### 2.5.2.6 To select an existing prompt

You can select from pre-existing prompts to add to a query. Only pre-existing prompts that are compatible with the object you are filtering are displayed.

1. In a Web Intelligence document in **Design** or **Data** mode, open the Data Provider for edit.
   The **Query Panel** appears.
2. Drag the object on which you want to apply a prompt and drop it onto the **Query Filters** pane.
   The query filter appears in outline in the **Query Filters** pane.
3. Click the arrow next to the query filter and select Prompt from the menu.

4. Click Select from universe, select an existing prompt and click OK.

   The list displays only those universe prompts that are compatible with the object you are filtering. For example, the filtered object and the universe prompt must have the same data type.

**Related Information**

*To open for edit the data provider of an existing query* [page 116]

If you are able to edit queries, then you can open the Query Panel to edit the data provider.

### 2.5.2.7 To remove a prompt

You can delete query prompts in the Query Panel.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit.
   The Query Panel appears.

2. Select the prompt in the Query Filters pane and click the Delete icon.

**Related Information**

*To open for edit the data provider of an existing query* [page 116]

If you are able to edit queries, then you can open the Query Panel to edit the data provider.

### 2.5.2.8 Defining how prompts display

You can modify how prompts appear in the Prompts dialog box.

In the Prompts dialog box, users select values by either entering a value in the Type a value text box, if available, and adding it to the selected value list, or by selecting values from a list of values defined by the query prompt.

<table>
<thead>
<tr>
<th>If you want the prompt to display...</th>
<th>(useful when you...)</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the list of values associated with the filtered dimension, measure, or detail.</td>
<td>want to view all the values for the object and then select from those values</td>
<td>leave the option selected by default: Prompt with List of Values</td>
</tr>
</tbody>
</table>
If you want the prompt to display... | (useful when you...) | then...
---|---|---
the values specified the last time the prompt was answered (users can select a different values). | default to the same values when you refresh the document, but want the ability to select a different value when necessary, such as the name of the current month | select the option: *Keep last values selected*
the values you specify as the default (users can select a different values). | almost always reselect the same values when you refresh the document, but want the ability to select a different value when necessary, such as the number for the current year | select the option: *Set default value(s)*
a list of values from which users select a values. | prevent users from typing a value that might not exist on the database or that you do not want them to view | select the option: *Select only from List*

To make the prompt optional, select *Optional prompt*. You are not obliged to specify a value for the prompt, in which case it is ignored.

Note

If the prompt is for a date, the users will see the popup calendar and a list of values. If you want users to see the popup calendar in order to select the dates, deselect *Prompt with List of Values*.

### Related Information

*Selecting prompt values in the Prompts dialog box* [page 278]

When you open or refresh a document with prompts, the Prompts dialog box appears.

### 2.5.2.9 Combining prompts

Combining multiple prompts on a single query enables you to filter the data returned to the document so that each person viewing the reports sees only the information relevant to their business need.

For example, you can combine the following three prompts on a Customer Accounts document:

- Which customer?
- Which account?
- Which calendar period: from? to?

This enables each accounts manager viewing the document to view report values for a specific customer account during a specific period.

You combine prompts in the same way that you combine query filters.
2.5.2.9.1  Combining prompts with query filters

Combining prompts and filters on a single query enables you to decide the values for some of the selected objects on the query using filters and allow users to decide the values of other selected objects using prompts.

For example, if you combine the following filters and prompts on a Human Resources document:

- [Year] Equal to This Year
- [Job title] Not equal to Senior Executive
- Which employee?

Users viewing the document can choose which employee they view information for, but they can only view data for the current year and they can’t view data for senior executives.

2.5.2.10  To change the order of prompts

You change the order of query prompts in the Query Panel.

1. In a Web Intelligence document in Design or Data mode, open the Data Provider for edit. The Query Panel appears.
2. Click the Query properties icon on the Query Panel toolbar.
3. Select the prompt you want to move up or down in the prompt order in the Prompt Order dialog box, then press the up or down arrow next to the box.

Related Information

To open for edit the data provider of an existing query [page 116]
If you are able to edit queries, then you can open the Query Panel to edit the data provider.

2.5.3  Filtering data using subqueries

A subquery is a flexible query filter that allows you to restrict values in more sophisticated ways than is possible with an ordinary query filter.

Subqueries are more powerful than ordinary query filters for the following reasons:

- They allow you to compare the values of the object whose values are used to restrict the query with values from other objects.
- They allow you to restrict the values returned by the subquery with a WHERE clause.
- They allow you to pose complex questions that are difficult or impossible to formulate with simple query filters. For example: what is the list of customers and their associated revenue where the customer purchased a service that had previously been reserved (by any customer) in Q1 of 2003?

Subqueries work by modifying the SQL that is generated to retrieve the query data. The SQL contains a subquery that restricts the data returned by an outer query. SQL is the query language supported by all relational databases.
(RDBMS), although each database has its own syntax. For more information on SQL subqueries, see any book on SQL.

**Note**
Subqueries are not supported in all databases. If they are not supported, the option to build subqueries does not appear in the **Query Panel**.

**Note**
You can build subqueries using dimensions, attributes and measures. You cannot build subqueries using hierarchical objects.

**Related Information**

To build a subquery [page 162]
You can build subqueries in the **Query Panel**.

Subquery parameters [page 164]
A subquery or set of subqueries contains several parameters.

### 2.5.3.1 To build a subquery

You can build subqueries in the **Query Panel**.

1. In a Web Intelligence document in **Design** or **Data** mode, open the Data Provider for edit. The **Query Panel** appears.

2. Add the objects that you want to appear in the query to the **Result Objects** pane.

3. Select the object in the **Result Objects** pane that you want to filter with a subquery and click the **Add a subquery** icon at the top of the **Query Filters** pane. The subquery outline appears in the **Query Filters** pane. By default the object you selected appears as the **Filter** object and **Filter By** object.

4. To add a WHERE condition to the subquery, drag a report object to the area of the subquery below the **Drop an object here** image.

   You can use an existing subquery or standard query filter as a WHERE condition in a subquery. To do so, drag and drop the existing filter or subquery to the area of the subquery below the **Drop an object here** boxes. To copy rather than move the existing filter to the WHERE condition, hold down the **Control** key while dragging and dropping. In this case the existing filter remains in its initial place and becomes part of the WHERE condition of the subquery.

5. Select the operator and values used to filter the object in the WHERE condition.

6. Click **Subquery** to add an additional subquery to the query filter.

   In addition to linking subqueries in AND or OR relationships, you can nest them (create subqueries within subqueries) by dragging an existing subquery to the area beneath the **Drop an object here** boxes. In this case the inner subquery becomes part of the WHERE condition of the outer subquery. To copy rather than move
the subquery to the WHERE condition, hold down the Control key while dragging and dropping. In this case the second subquery remains at the same level as the first, and becomes part of the WHERE clause of the first.

By default the two subqueries are linked in an AND relationship. Click the AND operator to toggle between AND and OR.

7. To nest a subquery (create a subquery within a subquery), drag an existing subquery to the area beneath the Drop an object here image.

To copy rather than move the subquery to the WHERE condition, hold down the Control key while dragging and dropping. In this case the second subquery remains at the same level as the first, and becomes part of the WHERE clause of the first.

The inner subquery becomes part of the WHERE condition of the outer subquery.

**Related Information**

To open for edit the data provider of an existing query [page 116]

> If you are able to edit queries, then you can open the Query Panel to edit the data provider.

Filtering data using subqueries [page 161]

> A subquery is a flexible query filter that allows you to restrict values in more sophisticated ways than is possible with an ordinary query filter.

Example: Customers bought a service reserved in Q1 of 2003, and how much revenue they generated [page 163]

> This example uses the Island Resorts Marketing sample universe in Web Intelligence to build a subquery.

Subquery parameters [page 164]

> A subquery or set of subqueries contains several parameters.

Nested combined queries [page 130]

> By default, each time you add a combined query, it is combined at the initial combination level with existing queries.

### 2.5.3.2 Example: Customers bought a service reserved in Q1 of 2003, and how much revenue they generated

This example uses the Island Resorts Marketing sample universe in Web Intelligence to build a subquery.

1. In a Web Intelligence document in **Design or Data** mode, open the Data Provider for edit. The Query Panel appears.
2. Drag the **Customer** and **Revenue** objects to the **Result Objects** pane in the Query Panel.
3. Select the **Service** object.
4. Click **Subquery**.
   > The subquery outline appears in the Query Filters pane.
5. Drag the Reservation Year object to the area of the subquery outline beneath the Service object, which adds a WHERE condition on the Reservation Year object.

6. Set the Reservation Year condition operator to Equal to.

7. Type FY2003 in the Type a constant box.

8. Drag the Reservation Quarter object to the area of the subquery outline beneath the Service object, which adds the Reservation Quarter object to the WHERE condition.

9. Set the Reservation Quarter condition operator to Equal to.

10. Type Q1 in the Type a constant box.

11. Click Run Query.

### 2.5.3.3 Subquery parameters

A subquery or set of subqueries contains several parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter objects</td>
<td>The object whose values are used to filter the result objects. You can include more than one filter object. If you do, the values of the objects you select are concatenated.</td>
</tr>
<tr>
<td>Filter by objects</td>
<td>The object that determines which Filter object values the subquery returns. You can include more than one Filter by object. If you do, the values of the objects you select are concatenated.</td>
</tr>
<tr>
<td>Operator</td>
<td>The operator that specifies the relationship between the Filter object and the Filter by object. Because of database restrictions you cannot use certain combinations of operators and Filter by objects together. For example, if you use the Equal to operator with a Filter by object that returns multiple values, the database rejects the SQL because this type of subquery requires the Filter by object to return one value only. In cases where the generated SQL is rejected by the database, you see an error message showing the error description returned by the database.</td>
</tr>
<tr>
<td>WHERE condition (optional)</td>
<td>An additional condition that constrains the list of values of the Filter by object. You can use ordinary report objects, predefined conditions or existing query filters, including subqueries, in the WHERE condition.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relationship operator</td>
<td>If there is more than one subquery, this operator determines the relationship between the subqueries. AND - the conditions in all of the subqueries must be satisfied. OR - the conditions in any one of the subqueries must be satisfied.</td>
</tr>
</tbody>
</table>
3 Working with reports

3.1 Creating reports

3.1.1 To create a blank document

You can create a document without selecting a data source.

1. In any open version of Web Intelligence, click the New button on the toolbar.
2. Select No data source, then OK.

You can build a query in the document later to retrieve data to the document.

Note

If you have just launched Web Intelligence Rich Client, click Blank Document in the New Document dialog box.

Related Information

To create a query on a different data source in an existing document [page 115]

If you have the rights to edit queries in the Web Intelligence Rich Client or Applet interface, then you can select additional data sources in an existing document.

3.1.2 Web Intelligence features that are supported in reports for mobile devices

You can use several Web Intelligence query and report features in reports for mobile devices.

In the following table are the major features of Web Intelligence and if they are supported on mobile devices. This is not a complete list; the features listed below have been tested for viability on mobile devices. For more information on designing Web Intelligence reports for mobile devices, see the Mobile BI Report Designer’s Guide.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose and how it helps</th>
<th>Supported on Mobile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchies</td>
<td>You can use hierarchies to navigate through data that uses parent-child relationships.</td>
<td>Yes</td>
</tr>
<tr>
<td>Free-standing blank cells</td>
<td>You can use free-standing cells display text or formulas. For example, you can use these cells for report titles and images. You can put in them basic formulas, for example a conditional status indicator.</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Purpose and how it helps</td>
<td>Supported on Mobile</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Pre-defined cells</td>
<td>You can use free-standing cells with defined formulas that show information like drill filters, the last refresh date, and the document name.</td>
<td>Yes</td>
</tr>
<tr>
<td>Tables</td>
<td>You can use tables to show data in a list format that is easy to scroll through.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Restriction</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>There is a limit to the maximum number of rows and columns that can be displayed on the screens of mobile devices. For more information, see the Mobile BI Report Designer’s Guide.</td>
<td></td>
</tr>
<tr>
<td>Groups in tables</td>
<td>You can group dimension values. This feature can save space in a table. For example, if you have branches of stores in several states, you may prefer to group the stores into groups by region.</td>
<td>No</td>
</tr>
<tr>
<td>Table breaks</td>
<td>To save space by removing repetitive data in a table, you can use table breaks.</td>
<td>Yes</td>
</tr>
<tr>
<td>Sections</td>
<td>You can use sections to split information into smaller parts. For example, in a table with City, Quarter, and Sales Revenue, the city and quarter content can be repetitive. You can create section based on Quarter, which gives you quarterly tables on Sales Revenue by City.</td>
<td>Yes</td>
</tr>
<tr>
<td>Sorts</td>
<td>In tables, you can use sorts to organize the order in which values are displayed in a table. For example, you sort the revenue values in Descending order.</td>
<td>Yes</td>
</tr>
<tr>
<td>Ranking</td>
<td>You can use ranking in a table to show only top or bottom items based on certain criteria. This helps readers to focus on the top or bottom items in a data set.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Restriction</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supported only the following Mobile server versions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- BI 4.1 SP03 Patch 01 and higher</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- BI 4.0 SP09 Patch 01 and higher</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Purpose and how it helps</td>
<td>Supported on Mobile</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Charts</td>
<td>You can use charts to show data in a visual way that adds impact to the results.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>⚠️ Restriction</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>There is a limit to the maximum number of rows and columns that can be displayed on the screens of mobile devices. For more information, see the <em>Mobile BI Report Designer’s Guide</em>.</td>
<td></td>
</tr>
<tr>
<td>Prompts</td>
<td>You can use prompts in reports to allow users refine the data that is shown on the mobile device. You can also control the type or amount of data the user can access and that appears on the mobile device.</td>
<td>Yes</td>
</tr>
<tr>
<td>Query filters</td>
<td>You can use query filters to limit the amount of data retrieved from the data source, reducing the data retrieval time.</td>
<td>Yes</td>
</tr>
<tr>
<td>Report filters</td>
<td>You can use report filters to limit the retrieved data displayed in a report.</td>
<td>Yes</td>
</tr>
<tr>
<td>Input controls</td>
<td>You can use input controls as report element-specific filter controls.</td>
<td>Yes</td>
</tr>
<tr>
<td>Folding and unfolding</td>
<td>You can fold and unfold report data to see only the amount of data you want at a given time.</td>
<td>No</td>
</tr>
<tr>
<td>data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drilling</td>
<td>You can use drilling to move through the data levels. For example, you can drill down from region to city to store.</td>
<td>Yes</td>
</tr>
<tr>
<td>Conditional formatting</td>
<td>You can use rules in reports to have table cell or section format change based on rules. You can highlight in a visual fashion important results by, for example, text, cell border and background display color and size changes, and even via images or web pages.</td>
<td>Yes</td>
</tr>
<tr>
<td>Data tracking</td>
<td>You can display data changes in a report in a document, for when the changes in data is the focus of a report.</td>
<td>No</td>
</tr>
<tr>
<td>Linking to other docu­</td>
<td>You can link to other documents in the report, as in the case where you want to offer users access to related documents.</td>
<td>Yes</td>
</tr>
<tr>
<td>ments</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3.2 Viewing document properties

You can view in the Document Summary pane in the Side Panel or set in the Document Summary dialog box.

The following table lists the document properties that you can view in the Document Summary pane in the Side Panel or set in the Document Summary dialog box that is found at Properties > Document.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name of the document in the BI launch pad. This is displayed above the general properties and cannot be edited.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of document. This option is only available in the Web Intelligence HTML interface.</td>
</tr>
<tr>
<td>Author</td>
<td>The creator of the document.</td>
</tr>
<tr>
<td>Creation date</td>
<td>The date the document was created.</td>
</tr>
<tr>
<td>Locale</td>
<td>Tells you the formatting locale of the document.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional information that describes the document.</td>
</tr>
<tr>
<td>Keywords</td>
<td>Optional keywords that can be used to search for the document in the BI launch pad.</td>
</tr>
<tr>
<td>Last refresh date</td>
<td>In the Side Panel, this field informs you of when the results were last refreshed with the latest data from the database.</td>
</tr>
<tr>
<td>Last modified</td>
<td>In the Side Panel, this field informs you when the document was last modified.</td>
</tr>
<tr>
<td>Last modified by</td>
<td>In the Side Panel, this field informs you who the last person was to modify the document.</td>
</tr>
<tr>
<td>Duration of the previous refresh</td>
<td>In the Side Panel, this field informs you how long it took to retrieve the data from the database the last time the results were refreshed.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Refresh on open</td>
<td>Automatically refreshes the results in reports with the latest data from the database each time the document is opened.</td>
</tr>
<tr>
<td></td>
<td>When <strong>Refresh on open</strong> is selected, data tracking does not display the difference between the data prior to the refresh and the data after the refresh. Data after the refresh is treated as new data because the refresh purges the document.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The <strong>Refresh on open</strong> option is dependent on the following CMS settings:</td>
</tr>
<tr>
<td></td>
<td>• In <a href="#">CMC &gt; Application &gt; Web Intelligence &gt; Properties</a>, the property <strong>Automatic Refresh</strong> security setting is enabled by the BI administrator.</td>
</tr>
<tr>
<td></td>
<td>• In <a href="#">CMC &gt; Application &gt; Web Intelligence &gt; User Security</a>, the security right <strong>Document - disable automatic refresh on open</strong> is disabled for this user by the BI administrator.</td>
</tr>
<tr>
<td>Permanent regional formatting</td>
<td>Formats the document according to the format locale with which it was saved.</td>
</tr>
<tr>
<td>Use query drill</td>
<td>Allows drilling in query drill mode.</td>
</tr>
<tr>
<td>Enable query stripping</td>
<td>Generates queries that only use objects that contribute to the reports in which they are used. Each time a query is refreshed, non-contributing objects are ignored. Only relevant data is retrieved from the data provider. This feature enhances performance.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Query stripping is enabled by default for BEx queries.</td>
</tr>
<tr>
<td>Hide warning icons in chart</td>
<td>Hides General Warning icons in order to enhance readability.</td>
</tr>
<tr>
<td>Change Default Style</td>
<td>This button is only available in the Web Intelligence Applet interface and Web Intelligence Rich Client. In the <strong>Document Summary</strong> edit dialog box, you can change the default style for the document. You can import a new style or export the current style.</td>
</tr>
<tr>
<td>Data tracking reference mode</td>
<td>In the Side Panel, this field indicates whether data tracking is turned on or off.</td>
</tr>
<tr>
<td>Data tracking</td>
<td>Track the following kinds of data changes:</td>
</tr>
<tr>
<td></td>
<td>• Inserted data</td>
</tr>
<tr>
<td></td>
<td>• Deleted data</td>
</tr>
<tr>
<td></td>
<td>• Changed data</td>
</tr>
<tr>
<td></td>
<td>• Increased values</td>
</tr>
<tr>
<td></td>
<td>• Decreased values</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auto-merge dimensions</td>
<td>Automatically merges dimensions with the same name and from the same universe. You see the merged dimension in the list of available objects with the dimensions merged within it below.</td>
</tr>
<tr>
<td></td>
<td>Merged dimensions are the mechanism for synchronizing data from different data providers.</td>
</tr>
<tr>
<td>Extend merged dimension values</td>
<td>The option, when selected, extends values of merged dimensions. Merged dimensions are the mechanism for synchronizing data from different data providers. This controls the results when a table contains synchronized data.</td>
</tr>
<tr>
<td></td>
<td>If a table contains a dimension used in a merge, this dimension returns the value of its query plus the values of the other dimensions merged from other data providers for which there is an object in the table.</td>
</tr>
<tr>
<td></td>
<td>When this option is not selected and a table contains a dimension used in a merge, this dimension returns the value of its query.</td>
</tr>
<tr>
<td>Auto-refresh</td>
<td>This option, available in Document Summary panel, when activated causes the document to be automatically refreshed.</td>
</tr>
<tr>
<td></td>
<td>The Auto-refresh option applies to the use of delegated measures. Block elements that are affected by this include adding/deleting a column, inserting a break, including a footer, filter bar, input control and so on.</td>
</tr>
<tr>
<td></td>
<td>When this option is selected, and an object is added to or removed from the query, or when a different value is selected from a list in the Report Filter bar (all values, simple values), for example, the document is refreshed automatically. The #TOREFRESH message will not appear in the report because the refresh is automatic.</td>
</tr>
<tr>
<td></td>
<td>This option only applies to aggregated delegated measures. For example when you add a total to a table in a report.</td>
</tr>
<tr>
<td></td>
<td>Using this option can slow down the performance. If the drop in performance is a problem, consider deselecting this option. In this case #TOREFRESH will display when the report is modified.</td>
</tr>
<tr>
<td></td>
<td>This option can only be modified if the BI administrator has enabled it in the Web Intelligence application properties in the CMC.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default Style | You can change the default style that is used for the document. You can do the following:  
  - Import a different .css style sheet to replace the existing style sheet.  
  - Export the current style sheet to save or use elsewhere.  
  - Reset the document to use the original style sheet installed with the product. This option is only available when the current document style sheet is different from the original style sheet.  
  
  **Note**  
  This option is only available in the Web Intelligence Applet interface and Web intelligence Rich Client. |
| Merge prompts (BEx variables) | Select this option if you want to merge prompts that are created in Web Intelligence from BEx variables in the original BEx query. Only BEx variables that have the same technical name are merged. When this option is unselected, any previously merged BEx variables are unmerged and treated as separate prompts. |
| Prompts | In the Side Panel, this box indicates the prompts entered for the current view of the document. |
| KeyDates | In the Side Panel, this box indicates any keydates associated with the document |

### Related Information

**Merging data from dimensions and hierarches** [page 220]  
You can synchronize the data returned by dimensions, hierarchies or attributes by creating merged objects which incorporate them.

**Drilling with query drill** [page 253]  
When you activate query drill, you drill by modifying the underlying query (adding and removing dimensions and query filters) in addition to applying drill filters.

**Data tracking and Refresh on Open** [page 205]  
When a document is set to refresh its data on opening (when the Refresh on open document property is selected), data tracking does not display the difference between the data prior to the refresh and the data after the refresh.

**Warning icons in charts** [page 374]  
Warning icons in charts can alert you when there are chart and data object errors.
### 3.2.1 To configure document properties

You can configure the document properties in the *Document Summary* dialog box.

1. In a Web Intelligence document in *Design* or *Data* mode, do one of the following:
   - Click *Document* on the *Properties* tab.
   - In the Side Panel, select the *Document Summary* pane, then click *Edit*.
2. In the *Document Summary* dialog box, edit the document properties.
3. Click *OK* to close the *Document Summary* dialog box.

**Related Information**

*Viewing document properties* [page 169]

You can view in the *Document Summary* pane in the Side Panel or set in the *Document Summary* dialog box.

### 3.2.2 To select default folders for local documents and universes

In Web Intelligence Rich Client and the Web Intelligence Applet interface, you can select a folder where local documents and universes are stored by default on your local machine.

1. In a Web Intelligence document in *Design* mode, click *Application* in the *Properties* tab.
2. In the *Web Intelligence Options* dialog box, select the *General* tab.
4. Next to *Universes*, click *Browse*, and select a folder for universes.
5. Click *OK* to close the *Web Intelligence Options* dialog box.

### 3.2.3 Query stripping in documents

Query stripping is a reporting feature that can be used to optimize performance.

Query stripping is used only by Web Intelligence.

For relational universes, query stripping is only enabled if the following parameters are set:

- The *Allow query stripping* option is selected in the business layer properties in the information design tool (unselected by default).
- The *Enable query stripping* option is selected for the data provider in the *Query Properties* in Web Intelligence.
- The *Enable query stripping* option is selected in the *Document Properties* in Web Intelligence (selected by default if query stripping is enabled for the data provider).

For OLAP universes, query stripping is enabled by default.
When query stripping is enabled, the query is rewritten to reference only objects that are used in the report. Let’s take for example a query that contains three result objects: Country, City, and Revenue. A report based on this query may contain only City and Revenue. If query stripping is enabled, when the report is refreshed, in most cases the query will only retrieve the data for City and Revenue.

In relational universes, a report with query stripping enabled may return different data than when query stripping is disabled, depending on the schema of the data foundation. Let’s look again at the example of a query that contains Country, City, and Sales Revenue. In the data foundation, there is a self-restricting join on the Country table that restricts the country to the US. With query stripping disabled, the report on City and Revenue returns revenue for only cities in the US. With query stripping enabled, the report returns revenue for cities in all countries, because the Country table was stripped out of the query.

Enhanced Query Stripping

The USE_ENHANCED_QUERY_STRIPPPING parameter allows you to take advantage of enhancements to the query stripping method. Normal query stripping rewrites the query to contain only the objects referenced in the report and any joins concerned by those objects. Enhanced query stripping only optimizes the SELECT and GROUP BY clauses to avoid fetching unused data, but it doesn’t modify the other clauses or the joins. It is recommended to use enhanced query stripping in the following situations:

- The data foundation contains outer joins.
- The data foundation contains self-restricting joins (column filters).
- The data foundation contains shortcut joins.

If aggregate awareness is defined in the business layer (using the @Aggregate_aware function in the definition of business layer objects), enhanced query stripping is used in every case, even if the USE_ENHANCED_QUERY_STRIPPPING parameter is not set.

The USE_ENHANCED_QUERY_STRIPPPING parameter is not set by default. It can be set in the data foundation or business layer. For more information on query stripping, see the Information Design Tool user guide.

Related Information

**Viewing document properties** [page 169]
You can view in the Document Summary pane in the Side Panel or set in the Document Summary dialog box.

**Restrictions when using BEx queries** [page 82]

### 3.3 Hierarchical and non-hierarchical data

Depending on their data source, reports can contain non-hierarchical or hierarchical data.

Non-hierarchical and hierarchical data behaves differently and you work with it in different ways.
3.3.1 Working with non-hierarchical data

Non-hierarchical data has no parent-child relationships. A dimension is an example of a non-hierarchical object.

For example, the [Country] and [City] dimensions, displayed in a table, display their values as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
</tr>
<tr>
<td>US</td>
<td>Atlanta</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
</tr>
<tr>
<td>France</td>
<td>Rennes</td>
</tr>
</tbody>
</table>

Although the data has a hierarchical relationship (for example, "New York" and "Atlanta" are child values of "US"), the data appears in non-hierarchical columns and the parent-child relationship is not expressed in the data structure.

You can analyze non-hierarchical data in many ways in your reports, for example by sorting or filtering it.

3.3.2 Working with hierarchical data

Hierarchical data organizes data in parent-child relationships, and you can use these relationships to navigate and analyze the data and the results returned by related measures.

Measures associated with hierarchies are aggregated based on the position of the data in the hierarchy. For example, the [Revenue] measure calculates total revenue for [San Diego], and total revenue for [California], at a less detailed level of aggregation, when associated with a [Geography] hierarchy. Navigating the hierarchy allows you to explore different measure values at different levels of the hierarchy.

How hierarchical data appears and behaves depends on the report element that contains it.

Collapsing and expanding hierarchies

When the user is executing a collapse or expand on a hierarchy that is next to another hierarchy, the system is doing an asymmetric collapse or expand. The collapse or expand action is done only for the selected member for a given member on the hierarchy. The user can explicitly ask for a symmetric collapse or expand, in that case the action is done for any instances of the selected member.

The system is doing symmetric collapse or expand by default on a hierarchy that is next to a dimension (in that case default collapse or expand and symmetric collapse or expand is producing the same result).

Collapse or expand on a hierarchy which is changing on refresh (hierarchy node variable, prompted member selection, modification at the cube level), may be blocked after a refresh from the preview from the [Query Panel]. In that case, the user can drag and drop the hierarchy again in the column.
Related Information

Working with non-hierarchical data [page 175]

Non-hierarchical data has no parent-child relationships. A dimension is an example of a non-hierarchical object.

3.3.2.1 Restrictions concerning reporting with hierarchical data

Some restrictions can apply when you are using hierarchical data.

These restrictions are repeated in the appropriate sections in this guide.

Table 24: Restrictions when reporting with hierarchies

<table>
<thead>
<tr>
<th>The restriction concerns...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEx query measures</td>
<td>Measures which aggregate with the SUM function in Web Intelligence, and not in the BEx query. The other types of measure aggregation are delegated.</td>
</tr>
<tr>
<td>Break on measure or detail</td>
<td>A break is always associated with the sort on the object where it is applied. For this reason, any hierarchy in the table the where break applies, the hierarchy becomes flat. The user can remove the break on the underlying object to restore the hierarchy.</td>
</tr>
<tr>
<td>Delegated measure aggregation</td>
<td>This restriction applies whenever delegated measures are used, and is not specific to reporting on hierarchical data. Delegated measure aggregation returns <code>#TOREFRESH</code>, when the required aggregation is not available in the query. The user has to refresh the document to get the new level of aggregation. This occurs, for example, when using the filter bar, and the user selects a value before “all value” and vice versa when selecting “all value” before a selected value. Delegated measure aggregation returns the <code>#UNAVAILABLE</code> message if the delegated measure is in a formula on a dimension, or if it is in a multi-valued filter (for example, an input control) on a dimension that is not in the context of the aggregation of the measure. This occurs for example when defining a URL on top of a dimension in a table where there is a delegated measure. In that case, we recommend that you create a variable on top of the URL formula as a detail of the original dimension and include, but hide, the original dimension in the block. In the formula: If ( condition) then [dimension1] else [dimension2] , any delegated measure that is given against this formula will still return <code>#UNAVAILABLE</code>.</td>
</tr>
</tbody>
</table>

© 2014 SAP SE or an SAP affiliate company. All rights reserved.
<table>
<thead>
<tr>
<th>The restriction concerns...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drilling</td>
<td>There is no drill-replace capability on objects from a BEx query (there is no navigation path). There is no query drill on OLAP sources.</td>
</tr>
</tbody>
</table>
| Filtering on hierarchies | A report/table filter where there is a hierarchy may remove rows without respecting the hierarchy structure. For this reason, a filter can remove a parent node currently expanded and but keep leaves or nodes collapsed. To avoid returning an empty table, the system automatically expands the hierarchy in the block to shows the resulting members. 

A filter can remove an intermediary node of a hierarchy. In that case, the user cannot access the next level of member from the parent node with a simple expand action. To see the descendant of the parent node, the user can do an expand all. 

It is not possible to filter on a merge object based on a hierarchy. 

Filter bar (drill bar): when filtering through the filter bar on a hierarchy, selecting a node that is not shown in the table because it is collapsed, the table is shown empty. The user can do an expand all to see all the value. 

To filter from the filter bar is to filter on the caption, even for OLAP business objects that have a key. |
| Report filters            | When the user changes any report filter, the system proceeds with an “expand all” on any hierarchy in the report. |
| Flattening hierarchies    | When a hierarchy becomes flat, the system shows all the members of the hierarchy at the same level, like for a dimension, without using + or - to navigate and without contextual menu “collapse/expand”. |
| Merged objects            | A merged object based on a hierarchy cannot be directly used in the report. This is because where the original hierarchy has a conflicting hierarchy structure (a member A is descendant of another member B, whereas in the other hierarchy the member A is ancestor of member B), the system cannot build a merge hierarchy. The system prevents you from dragging the merged object. 

If the user builds a formula using the merged object, the system returns #SYNTAX. The user can use directly the original hierarchy instead in the report. 

A merge on a key for a OLAP business object is a data synchronization of the same object from the same source (cube or BEx query), and is based on the internal key of the value of these objects. It can also be based on the caption. 

It is not possible to filter on a merged object based on a hierarchy. |
The restriction concerns... | Description
--- | ---
OLAP | The order of an OLAP dimension member in a report LOV (filter bar, input control) is ascending in lexicographical order. Filtering on an OLAP object from the filter UI filter is based on the key of the given object. Filtering from an input control on an OLAP dimension is filtering on the caption. Filtering on a hierarchy is filtering on a key.

Query stripping | Query stripping is only available for .unv, OLAP, and BEx query sources.

Refreshing reports | When you refresh a report, the system proceeds with a “collapse all” for any hierarchy whose root value has changed.

Ranking on hierarchical data in a table | A ranking on a table where there is a hierarchy does not take into account the hierarchy structure of the data. For this reason, any hierarchy in a table where the user defines a ranking becomes flat.

Sorting | Sorting a hierarchy and, in the case of OLAP sources, a dimension is based on the order of the member in the underlying system. It is based on the source ordinal called natural order, but not lexicographical order like for other type of business object. The sort on a hierarchy respects the structure of the hierarchy; it is sorting sibling members at a given level.

Sorting on a measure does not preserve the order of member within a hierarchy in the same table. For this reason the system is showing the hierarchy flat in a table, where the user applied a sort on measure.

Variables | Variable (formula) on hierarchy: a formula based on a hierarchy is always resulting in flat value list (no hierarchical data).

### 3.3.2.2 Working with hierarchical data in tables

Hierarchies appear in tables as hierarchical columns. A hierarchical column displays the hierarchy in parent-child relationships. You can explore the hierarchy by expanding and collapsing its values.

#### Example

A hierarchical column in a table

The following table displays the [Product] hierarchy and the [Revenue] measure:

<table>
<thead>
<tr>
<th>Product</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>203,124</td>
</tr>
<tr>
<td>Baking Goods</td>
<td>100,101</td>
</tr>
</tbody>
</table>
The measure displays the total revenue for the corresponding value in the hierarchy. For example, the total revenue for Grocery products is 203,124.

You can find more information about Beverages by expanding the [Beverages] member:

<table>
<thead>
<tr>
<th>Product</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>203,124</td>
</tr>
<tr>
<td>Baking Goods</td>
<td>100,101</td>
</tr>
<tr>
<td>Beverages</td>
<td>54,345</td>
</tr>
<tr>
<td>Soft Drinks</td>
<td>10,100</td>
</tr>
<tr>
<td>Soda</td>
<td>20,200</td>
</tr>
<tr>
<td>Milk</td>
<td>24,045</td>
</tr>
<tr>
<td>Breads</td>
<td>48,678</td>
</tr>
</tbody>
</table>

When you expand the member, the Revenue column also displays the measure values associated with different kinds of beverage.

### 3.3.2.3 Hierarchical data in cross tables

Hierarchical data behaves similarly in cross table to how it behaves in tables.

If an axis of the crosstab is based on a hierarchy, you can click a data item to expand it.

**Example**

**Hierarchical data in a cross table**

The following crosstab has the [Time] hierarchy on the vertical axis and the [Product] hierarchy on the horizontal axis.

<table>
<thead>
<tr>
<th>Time</th>
<th>Grocery</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>203,110</td>
</tr>
<tr>
<td>2009</td>
<td>321,400</td>
</tr>
<tr>
<td>2010</td>
<td>350,444</td>
</tr>
</tbody>
</table>

If you click the [Grocery] item, it expands to display its child items and displays the corresponding measure values.
<table>
<thead>
<tr>
<th>Time</th>
<th>Grocery</th>
<th>Baking Goods</th>
<th>Beverages</th>
<th>Bread</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>54,570</td>
<td>67,000</td>
<td>81,540</td>
<td></td>
</tr>
<tr>
<td>2009</td>
<td>101,000</td>
<td>98,990</td>
<td>121,410</td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td>124,000</td>
<td>133,000</td>
<td>93,444</td>
<td></td>
</tr>
</tbody>
</table>

3.3.2.4 Exploring hierarchies in queries based on OLAP universes

3.3.2.4.1 To expand and collapse all the hierarchies in a table

In a table with hierarchical values, you can expand all the hierarchies to show all possible combinations of hierarchy members.

1. From the BI launch pad, open a document based on a .unx OLAP universe in Web Intelligence Rich Client or Web Intelligence Applet interface.

2. Switch to Reading or Design mode.

3. To expand all the hierarchies in a table, right-click anywhere in the table and select Hierarchical Navigation All Expand All Hierarchies.

4. To collapse all the hierarchies in a table, right-click anywhere in the table and select Hierarchical Navigation All Collapse All Hierarchies.

3.3.2.4.2 Exploring a hierarchy asymmetrically

Asymmetric exploration is the way you explore a hierarchy by default when you select members to expand or contract them.

When you explore a hierarchy asymmetrically, your expand and collapse actions are applied only to the current value of the other dimensions that appear next to the explored hierarchy.

Example

Asymmetric exploration


<table>
<thead>
<tr>
<th>Product</th>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>California</td>
<td>540,000</td>
</tr>
<tr>
<td>Beverages</td>
<td>California</td>
<td>453,300</td>
</tr>
</tbody>
</table>

If you expand the [California] member to display cities in California in the first row of the table, the expansion applies only to the current value (Grocery) of the [Product] dimension.
<table>
<thead>
<tr>
<th>Product</th>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>California</td>
<td>540,000</td>
</tr>
<tr>
<td></td>
<td>Los Angeles</td>
<td>320,000</td>
</tr>
<tr>
<td></td>
<td>San Diego</td>
<td>100,000</td>
</tr>
<tr>
<td></td>
<td>San Francisco</td>
<td>120,000</td>
</tr>
<tr>
<td>Beverages</td>
<td>California</td>
<td>453,300</td>
</tr>
</tbody>
</table>

Related Information

To explore a hierarchy asymmetrically [page 181]
You can expand a hierarchy for only the current values of a dimension or hierarchy.

To expand and collapse all the hierarchies in a table [page 180]
In a table with hierarchical values, you can expand all the hierarchies to show all possible combinations of hierarchy members.

3.3.2.4.2.1 To explore a hierarchy asymmetrically

You can expand a hierarchy for only the current values of a dimension or hierarchy.

1. Open a Web Intelligence document based on a hierarchical data source in any mode.
2. To expand the child members of a member, click the member, or right-click and select Expand Children from the menu.
   The hierarchy expands only for the current value of the dimensions or hierarchies next to the expanded hierarchy in the table.
3. To expand all descendant members of a member, click the member, or right-click and select Expand Descendants.
   The hierarchy collapses only for the current value of the dimensions or hierarchies next to the expanded hierarchy in the table.
4. To collapse the child members of a member, click the expanded member, or right-click and select Collapse Children.
   The hierarchy collapses only for the current value of the dimensions or hierarchies next to the collapsed hierarchy in the table.
3.3.2.4.3 Exploring a hierarchy symmetrically

When you explore a hierarchy symmetrically, your expand and collapse actions are applied in relation to all values of the other hierarchies or dimensions that appear next to the explored hierarchy in the table.

**Example**

**Symmetric exploration**


<table>
<thead>
<tr>
<th>Product</th>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>California</td>
<td>540,000</td>
</tr>
<tr>
<td>Beverages</td>
<td>California</td>
<td>453,300</td>
</tr>
</tbody>
</table>

If you expand the [California] member on the first row to display cities in California, the expansion applies to both values of the [Product] dimension.

<table>
<thead>
<tr>
<th>Product</th>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>California</td>
<td>540,000</td>
</tr>
<tr>
<td></td>
<td>Los Angeles</td>
<td>320,000</td>
</tr>
<tr>
<td></td>
<td>San Diego</td>
<td>100,000</td>
</tr>
<tr>
<td></td>
<td>San Francisco</td>
<td>120,000</td>
</tr>
<tr>
<td>Beverages</td>
<td>California</td>
<td>453,300</td>
</tr>
<tr>
<td></td>
<td>Los Angeles</td>
<td>120,000</td>
</tr>
<tr>
<td></td>
<td>San Diego</td>
<td>200,000</td>
</tr>
<tr>
<td></td>
<td>San Francisco</td>
<td>133,300</td>
</tr>
</tbody>
</table>

**Related Information**

To expand and collapse all the hierarchies in a table [page 180]

In a table with hierarchical values, you can expand all the hierarchies to show all possible combinations of hierarchy members.

To explore a hierarchy symmetrically [page 183]

You can expand a hierarchy for all values of a dimension or hierarchy.
3.3.2.4.3.1 To explore a hierarchy symmetrically

You can expand a hierarchy for all values of a dimension or hierarchy.

1. Open a Web Intelligence document based on a hierarchical data source in any mode.

2. To expand the child items of a member, right-click the member and select **Hierarchical Navigation** ➤ **Symmetric** ➤ **Expand Children**.
   The hierarchy expands for all values of the dimensions or hierarchies next to the expanded hierarchy in the table.

3. To expand all descendant items of a member, right-click the member and select **Hierarchical Navigation** ➤ **Symmetric** ➤ **Expand Descendants**.
   The hierarchy expands for all values of the dimensions or hierarchies next to the expanded hierarchy in the table.

4. To collapse the child members of a member, right-click the member and select **Hierarchical Navigation** ➤ **Symmetric** ➤ **Collapse Children**.
   The hierarchy collapses for all values of the dimensions or hierarchies next to the collapsed hierarchy in the table.

3.3.2.4.4 Changing the drill focus of a hierarchy

You can change the drill focus when exploring hierarchies.

When you change the drill focus you filter out the parent member and all members at and above its level when expanding it.

Changing the drill focus is useful when creating charts on hierarchical data. Because measure values associated with parent members are more aggregated than their child members, it is difficult to display them on the same chart axis using the same scale. By removing the parent member, it is possible to display the values for the child members using the same scale.

### Example

**Drilling down on a hierarchy**

You have the following data in a table:

<table>
<thead>
<tr>
<th>Time</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>29,358,677.22</td>
</tr>
<tr>
<td>2009</td>
<td>30,242,323</td>
</tr>
<tr>
<td>2010</td>
<td>45,320,243</td>
</tr>
</tbody>
</table>

When you drill down on the [2010] member, you see the following display:

<table>
<thead>
<tr>
<th>Time</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>12,500,650</td>
</tr>
<tr>
<td>Q2</td>
<td>14,353,231</td>
</tr>
</tbody>
</table>
The year members, with values that are much larger than the measure values of the quarter members, do not appear in the display.

### 3.3.2.4.4.1 To change the drill focus of a hierarchy

You can drill up and down in a table hierarchy.

1. Open the Web Intelligence document in Design mode.
2. To drill down on a table hierarchy, do one of the following:
   - In the Web Intelligence HTML interface, right-click the member you want to expand and select **Start Drill** ➔ **Drill down to**.
   - In the Web Intelligence Applet interface or Web Intelligence Rich Client, right-click the member you want to expand and select **Start Drill** ➔ **Drill**.
3. To drill up on a table hierarchy, right-click any child member of a member you previously drilled down on and select **Drill Focus** ➔ **Drill Up**.

### 3.3.2.5 Aggregating hierarchical data

Hierarchical measure data is aggregated differently depending on whether the method of aggregation is default or explicit.

The aggregation logic is based on the following rules:

- **Data sets used for aggregation:**
  1. When there is a hierarchy in a measure context the measure values for the root members of the hierarchy are aggregated - this is by default (the Aggregate() mechanism is not explicitly declared).
  2. For explicit types (SUM, MAX, MIN), the hierarchical nature of the data is ignored. All the visible data is aggregated, including data that has already been aggregated (parent members already aggregated).
- **Sensitivity to the collapse/expand status:**
  1. Explicit aggregation only aggregates visible data, except when the set expression is used for a specific hierarchy, then an aggregation is performed on the objects defined in the set expression.
  2. Default aggregation including the aggregate() function is not sensitive to the state of the collapse/expand.
3.3.2.5.1 Default aggregation

With default aggregation (including `Aggregate()` function), we do a non-redundant aggregation (no double-counting). Default aggregation uses the default aggregation function for the data in the hierarchy.

If you include a measure in a cell without specifying an aggregation function, or if you use the `Aggregate` function, the measure is calculated using the default aggregation function.

Default aggregation uses the rolled-up values returned by the database - in other words, it is compatible with the aggregated values returned by the database. Default values are calculated by applying the default aggregation function to all the root values in the hierarchy. This means that default aggregation does not count values more than once except in situations where the same value appears beneath different root items in a hierarchy. (In the example below, the root items are `Drink` and `Food` and no items appear beneath both root items.)

**Example**

**Default aggregation**

You place `[Unit Sales]` in a free-standing cell in a report that contains the hierarchy below. The default aggregation function is `Sum`; as a result, the value in the free-standing cell is 43,791 (24,597 + 19,194). The application returns a value by applying the default aggregation function to the root values of the hierarchy.

<table>
<thead>
<tr>
<th>Product</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drink</td>
<td>24,597</td>
</tr>
<tr>
<td>Alcoholic Beverages</td>
<td>6,838</td>
</tr>
<tr>
<td>Beverages</td>
<td>13,573</td>
</tr>
<tr>
<td>Food</td>
<td>19,194</td>
</tr>
<tr>
<td>Baked Goods</td>
<td>7,870</td>
</tr>
</tbody>
</table>

3.3.2.5.2 Explicit aggregation

In explicit aggregation, the application references the visual state of the hierarchy. As a result, values can be counted more than once, and the result of calculations can change depending on whether an item is expanded or collapsed.

Explicit aggregation includes a specific aggregation function (for example `SUM`) directly in a formula. If the same value is included more than once in an explicit aggregation, it can be counted more than once depending on the visual state of the hierarchy. For example, if an item is expanded, and an explicit aggregation references both the item and one of its child items, Depending on the rollup calculation, the value of the child may be counted twice: once for itself once with the value of its parent. This is because Web Intelligence is adding the child and parent value.
Restriction concerning set-based explicit aggregation

When a measure is aggregated along hierarchies that are not part of the set expression declared in the aggregation function, the aggregation is not implicit.

For example, when hierarchies are present in a table and aggregation using set is in the table footer and the hierarchies in the table are not specified in the set expression, if there is a filter somewhere in the report which removes the initial roots of the hierarchy in the table, the system will not aggregate values for these roots, but along the original unfiltered roots (the original query result).

Related Information

Examples of default and explicit aggregation [page 186]

If you include a measure in a cell without specifying an aggregation function, or if you use the Aggregate function, the measure is calculated using the default aggregation function.

3.3.2.5.3 Examples of default and explicit aggregation

If you include a measure in a cell without specifying an aggregation function, or if you use the Aggregate function, the measure is calculated using the default aggregation function.

### Example

Default and explicit aggregation

You have a hierarchy with the following data and the hierarchy appears fully expanded in a report:

<table>
<thead>
<tr>
<th>Product</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drink</td>
<td>24,597</td>
</tr>
<tr>
<td>Alcoholic Beverages</td>
<td>6,838</td>
</tr>
<tr>
<td>Beverages</td>
<td>13,573</td>
</tr>
<tr>
<td>Food</td>
<td>19,194</td>
</tr>
<tr>
<td>Baked Goods</td>
<td>7,870</td>
</tr>
</tbody>
</table>

- Placed in the table footer, `[Unit Sales]` returns 43,791. This default aggregation returns the total aggregated value of the measure (24,597 + 19,194).
- Placed in a table footer, `Sum([Unit Sales])` returns 72,072. This explicit aggregation counts every visible value in the hierarchy (24,597 + 6,838 + 13,573 + 19,194 + 7,870).
- The explicit aggregation `Sum([Unit Sales];[Product]&[Drink].children)` returns 20,411 (6,838 + 13,573) because `[Drink]` is expanded.
- The explicit aggregation `Sum([Unit Sales];{{[Product]&[Drink];[Product]&[Beverages]}})` returns 38,170 (24,597 + 13,573). The value for `[Beverages]` appears twice in the calculation because `[Drinks]` is expanded.
The default aggregation \( \text{Aggregate}([\text{Unit Sales}];([\text{Product}] & [\text{Drink}]; [\text{Product}] & [\text{Beverages}])) \) returns 24,597. The value for [Beverages] does not appear twice in the calculation.

If you collapse the [Drink] node in the report, the calculations are as follows:

- [Unit Sales] returns 43,791. The default aggregation is not affected by the change in display.
- \( \text{Sum}([\text{Unit Sales}]) \) returns 51,661 \((24,597 + 19,194 + 7,870)\). The explicit aggregation uses all the visible values to return the value.
- \( \text{Sum}([\text{Unit Sales}]; [\text{Product}] & [\text{Drink}].\text{children}) \) returns a non-NULL value even though the child members of [Drink] are not visible.
- \( \text{Sum}([\text{Unit Sales}]; ([\text{Product}] & [\text{Drink}] & [\text{Product}] & [\text{Beverages}]) \) returns 38,170 because [Beverages] is not visible. The explicit aggregation uses visible values only.
- \( \text{Aggregate}([\text{Unit Sales}]; ([\text{Product}] & [\text{Drink}]; [\text{Product}] & [\text{Beverages}]) \) returns 24,597. The default aggregation is not affected by the change in display.

### 3.3.2.6 Setting default hierarchy levels in a report table

Using the **Hierarchical Navigation** option, you can set the default hierarchy member levels that are visible in a hierarchy table so that they will remain visible to the preferred level or fixed at the root level, even after refresh and data purge actions.

**Note**

If you create a filter, the hierarchy expands to the specified level number.

This option is available from the right-click contextual menu for a report table. If the filter is searching for hierarchy members that are on levels lower that those specified for the **Hierarchical Navigation**, then the table will appear empty.

Normally, the hierarchy in a table is automatically collapsed to the root hierarchy member in the following cases:

- You have just opened the document.
- You have changed the root members of the hierarchy.
- You have purged or refreshed a document.

If you do not use this option, then when a document is refreshed and the root members of the hierarchy are changed, or when the document has been purged and refreshed, the hierarchy in the table is automatically collapsed to the root hierarchy member.

### 3.3.2.6.1 To set the default hierarchy level in a report table

You can set the default number of hierarchy levels on a hierarchy member that are visible in a report table.

1. From the BI launch pad, open a document in Web Intelligence.
2. In *Design* mode, select the report that contains the table you want to configure.
3. Right-click in the table the hierarchy whose level you want to set, and select **Hierarchical Navigation > Default Level Expansion**.
4. In the Default Level Expansion contextual list, do one of the following:
   - Set the default level expansion from None to 4.
   - Select More to select or enter in the Default level expansion dialog box any level between 1 and 99.

3.4 Finding text in a report page

You can search for text in a report in a Web Intelligence document in Reading or Design mode.

1. Open a Web Intelligence document.
2. Do one of the following:
   - If you are in Reading mode, click the Find icon on the toolbar.
   - If you are in Design mode, click the Find icon on the toolbar in the File tab toolbar.

   The Find bar appears at the bottom of the report panel.
3. Type text in the Find box and press Enter or click the Find text on the current page icon.

   To perform a case-sensitive search, click the arrow next to the box and select Match case.

4. If the text occurs more than once, click the Next or Previous icon to highlight other occurrences of the text.

   If you are using the Web Intelligence Applet interface or Web Intelligence Rich Client, click Highlight all to highlight all occurrences of the text on the page.

To close the Find box, click the X located at the far end of the Find bar.

3.5 Viewing modes

In the Reading and Design document modes, you can view reports in different modes depending on how you want to work with data and how you want the data to appear.

The viewing modes are controlled by buttons at the bottom of the Web Intelligence screen, on the status bar.

3.5.1 Page view mode

In the Reading and Design document modes, the Page view mode displays the page layout of reports, including page margins, headers, and footers.

Use Page view mode when you want to fine-tune the formatting of tables and charts and the layout of report pages.
3.5.1.1 Setting the report size in Page mode

You can set a report size to a specific percentage or to a specific number of pages in *Page* mode.

For example, if you set a report to be one page tall, all elements on the report are re-organized to fit on one horizontal page.

Setting the report size overrides all other settings that control the page layout of a report. For example, if you have a report with three sections and the report is set to start each section on a new page, the report still contains one page if the report is set to be one page tall.

The report size setting takes effect in *Page* mode only.

3.5.1.1.1 To set the report size

You can set the width and height of the report, or even set the size as a percentage.

1.  In a Web Intelligence document in *Design* mode, select the *Page Setup* tab.
2.  In the *Scale to Page* subtab, select the report width in the *Width* box and the height in the *Height* box, or set the report size as a percentage in the *Scale* box.

   If you define a percentage, the width and height are calculated automatically.

3.5.2 Quick Display view mode

In the *Reading* and *Design* document modes, the *Quick Display* view mode is the default display mode.

It is a pagination mode that is based on the data, rather than the physical size of report pages. The *Quick Display* view mode displays just the tables, reports, and free standing cells in reports and displays a maximum number of records vertically and horizontally, depending on the *Quick Display* settings. The *Quick Display* view mode also specifies the minimum page width and height and the amount of padding around the edges of the report.

Because the *Quick Display* view mode restricts the number of horizontal and vertical rows, a report might not contain all possible data.

Use the *Quick Display* view mode when you want to focus on analyzing results, add calculations or formulas, or add breaks or sorts to tables to organize results.

The *Quick Display* view mode properties are configurable either by the BI administrator, or directly in the application.

<table>
<thead>
<tr>
<th>Property</th>
<th>Configuration</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum vertical records</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Maximum horizontal records</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Minimum page width</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Minimum page height</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Configuration</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Right padding</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Bottom padding</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Vertical records per page</td>
<td>Application</td>
<td>• Impacts horizontal tables and crosstabs only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Horizontal tables are never cut vertically</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The number of rows in a horizontal table is ignored in vertical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>records calculation</td>
</tr>
<tr>
<td>Horizontal records per</td>
<td>Application</td>
<td>• Impacts vertical tables, forms and crosstabs only</td>
</tr>
<tr>
<td>page</td>
<td></td>
<td>• The number of rows in a vertical table is ignored in horizontal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>records calculation</td>
</tr>
</tbody>
</table>

Other notes:
- Table headers and footers do not count as rows.
- Free standing cells and charts do not count as rows.
- Section cells do not count as rows when the section is not empty.
- Sections cells count as vertical rows when the section is empty.
- The Avoid Page Break in Block option has no effect in Quick Display view mode.

### 3.5.2.1 To change Quick Display mode settings

You can change the number of horizontal and vertical records per page in Quick Display mode.

1. In a Web Intelligence document in Design mode, right-click the report and select Format Report to display the Format Report dialog box.
2. Select the General tab.
3. Select the number of horizontal and vertical records per page in the Page content (Quick Display mode only) section.
4. Click OK to return to the document.

### 3.5.3 To switch between viewing modes

You can switch between Quick Display and Page view modes.

1. Open a Web Intelligence document, in the Reading or Design document mode.
2. In the status bar at the bottom of the document, select one of the following icons:
   - To display a report in Quick Display view mode, click the Quick Display icon.
   - To display a report in Page view mode, click the Page icon.
3.6  Folding and unfolding report data

You can hide and display report data by folding and unfolding the display of different report elements.

You can fold and unfold sections, breaks and tables. Data is concealed and displayed in different ways depending on the report element.

<table>
<thead>
<tr>
<th>Report element</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section</td>
<td>When a section is folded, section details are hidden and free cells only are displayed. In Reading mode, you can fold and unfold sections.</td>
</tr>
<tr>
<td>Table or break</td>
<td>When a table or break is folded, the rows are concealed, and only headers and footers are displayed. Tables must have headers and footers to be folded and unfolded. Vertical tables, horizontal tables and cross tables can be folded and unfolded. In Reading mode, you can fold and unfold sections.</td>
</tr>
</tbody>
</table>

3.6.1  To fold and unfold report data

You can fold and unfold data in Reading and Design mode by activating the outline.

1. Open a Web Intelligence document.
2. Select a cell in the table.
3. Do one of the following:
   ○ In the Reading mode, click Outline.
   ○ In the Design mode, in the Analysis tab, select the Interact subtab and click Outline.

   The fold and unfold bars appear to the side of and above the report panel, depending on the report structure.
4. Use the +/- or arrow icons on the bars, which correspond to and are aligned with individual report elements, to fold and unfold them.
5. Use the icons at the side or upper part of the bar to fold and unfold all instances of a type of report element.

3.7  To redisplay all hidden content in a report

You can hide tables, cells and sections in reports.

1. Open a Web Intelligence document in Design mode.
2. Right-click the report containing hidden content and click Show All Hidden Content.
### 3.8 Formatting the report layout

You can format your report and report elements in order to present the report with a company style.

You can format the report layout manually, or you can create a company stylesheet using a CSS file. You can add color background, corporate images, and so on. To change the report format, you must view the report in Design mode in order to access the report formatting options. You can format the following report elements:

<table>
<thead>
<tr>
<th>To set the...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name the report</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>General</em>  then name the report.</td>
</tr>
<tr>
<td>Number of records per page</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>General</em> then set the number of records per page.</td>
</tr>
<tr>
<td>Report border style</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>Border</em> then set the border style, thickness, and color.</td>
</tr>
<tr>
<td>Report background</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>Appearance</em> and set the background (color, pattern, image).</td>
</tr>
<tr>
<td>Page size</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>Layout</em> then select a page size.</td>
</tr>
<tr>
<td>Page orientation</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>Layout</em> then select landscape or portrait orientation.</td>
</tr>
<tr>
<td>Page scaling</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>Layout</em> then select the page scaling.</td>
</tr>
<tr>
<td>Page margins</td>
<td>Right-click in the report, select <a href="#">Format Report</a> <em>Layout</em> then set the different margin sizes, as required.</td>
</tr>
</tbody>
</table>
| Show/hide header               | Right-click in the report, select [Format Report](#) *Layout* then select or unselect Show header.  
|                                | or Right-click in the report header, select [Format Header](#) then select or unselect Show header. |
| Header size                    | Right-click in the report, select [Format Report](#) *Layout* then enter a size for the header.  
|                                | or Right-click in the report header, select [Format Header](#) then enter a size for the header. |
| Header border style            | Right-click in the report header, select [Format Header](#) then select a style for the header border. |
To set the...  

| Header background | Right-click in the report header, select Format Header, select a background color, a pattern or enter an address for an image. |
| Show/hide footer | Right-click in the report, select Format Report > Layout, select or unselect Show footer or Right-click in the report footer, select Format Footer and select or unselect Show footer. |
| Footer size | Right-click in the report, select Format Report > Layout, enter a size for the footer. or Right-click in the report footer, select Format Footer, enter a size for the footer. |
| Footer border style | Right-click in the report footer, select Format Footer, select a style for the footer border. |
| Footer background | Right-click in the report footer, select Format Footer, select a background color, pattern or enter an address for an image. |

**Related Information**

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]  
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.  

Formatting your reports using Cascading Style Sheets [page 256]  
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.  

Creating a corporate palette for charts [page 381]  
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.  

Formatting tables and table cells [page 299]  
In Web Intelligence, you can define several visual aspects of tables and cells in reports.
3.8.1 To format the appearance of reports and their headers, footers, sections, tables, and table cells

You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

1. In a Web Intelligence document in Design mode, right-click the report, a header, footer, report section, table, or a selection of one or more cells in a table and select the applicable Format option from the contextual menu.
   
   For example, if you right-click on a selection of a group of cells, select Format Cells from the contextual menu.

2. In the format dialog box that appears, select the Appearance tab.
   
   The Background section in this tab shows the settings you can apply to your selected items.

3. To select a color for the background of the selected items:
   a) Click the radio button next to the color palette icon.
   b) Click the arrow next to the color palette icon to display the palette.
   c) Select a color from the palette.
   d) Click OK to return to the document.

   
   ![Note](image)

   When the background color of cells are defined (even as white), they take precedence over the table background color. If you apply a background color to an entire table but one or more cells remain white, open the Format Cells dialog box for these cells and check their color background setting.

4. To format the pattern for the selected items, do one of the following:
   ○ To select a skin, select the Skin radio button, and select a skin from the dropdown list.

   ![Note](image)

   If you are formatting the table appearance, you need to set the horizontal or vertical padding value to greater than 0 in the Spacing and Padding section of the Appearance tab, otherwise the skin will not appear.

   ○ To select an image at a URL location, select the Image from address radio button, and do one of the following:

   ○ Paste in the text box the URL address for an image. Click the Validate icon.

   ○ To create a dynamic image using a complex formula, click the Formula Editor icon next to the text box.

   Example: Table cell syntax
   “<URL>”<column header object>”+”.<image format>”

   ![Note](image)

   To access an image on the corporate server, type the image name. The application inserts boimg:// when you click Apply.
Caution
The dynamic image appears only if the column header object used to define the image is in the table. However, the object can be hidden. If the object is not in the table, then there is no context available to calculate the images address.

- To select use an image from a file on your computer or a server, select the Image from file radio button, click Add or Browse, navigate to the image and click Open.
- If you are using an image, you can select a display location from the Display dropdown list.
  - If you select Normal display, then you can set the position of the image from the Position dropdown lists.
  - If you select Stretch, the image adjusts to fit the entire space, irrespective of the image height and width settings.
  - If you select Tile, the image is repeated in the space.
  - If you select a Horizontal Tile or Vertical Tile location, then you also have additional Position options.

Note
To remove an image or pattern, select None for the pattern.

5. Click OK to return to the document.

Restriction
Because there is no background image feature in Excel, when you save or export a report to the Excel format any background images are not exported to the output file.

Related Information

To build a formula in the Formula Editor [page 289]
You can use the Formula Editor to define the formula for a table cell.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting tables and table cells [page 299]
In Web Intelligence, you can define several visual aspects of tables and cells in reports.

3.9 Printing reports

You can print one or multiple reports from a Web Intelligence document.

You print documents directly from Web Intelligence Applet interface and Web Intelligence Rich Client. However, when you print from the Web Intelligence HTML interface, you export the document to a PDF file that you can then print.
3.9.1 To print reports in Web Intelligence

A variety of methods are available for printing reports in Web Intelligence.

1. Open a Web Intelligence document.
2. Do one of the following:
   ○ If you are in Reading mode, click the Print icon.
   ○ If you are in Design or Data mode, click the Print icon in the File tab toolbar.
   ○ If you are using the Web Intelligence HTML interface, the File Download dialog box appears. Open the PDF file and print the report.
   ○ If you are using the Web Intelligence Applet interface or Web Intelligence Rich Client interface, the Print dialog box appears. Choose your printing options and print the report.

3.10 Tracking changes in data

To make informed and effective business intelligence decisions, you need to understand how the data on which you base those decisions changes over time.

You can track and display data changes to help you focus your analysis on key areas and avoid wasting time exploring irrelevant data.

When you track data changes, you select a particular data refresh as a reference point. This data is known as the reference data. When you activate data tracking, you see your data in relation to the reference data.

Here are some examples of data tracking:

● If an outlet no longer appears in a list of the top outlets by sales, it would be interpreted as deleted from the list. You can use this information to investigate why the outlet is no longer a top performer.
● If sales have decreased in a region, data tracking displays the decrease. You can then drill down into the data for the region to understand why revenue is falling.

In both these cases, data tracking makes the current data more meaningful by placing it in context with older data. Without this context it is much more difficult to identify trends.

Note

Tracking data changes operates at document level and not report level. If a document contains several reports, the tracking will apply to all of the reports. The information in the Status Bar at the bottom of the report indicates the document level status. An asterisk on a report tab indicates that change tracking is activated on the report.
3.10.1 Types of data change

You configure the display of data changes through the interface or formula language.

You can track the following types of data change:

- **Types of data change** [page 197]
  You configure the display of data changes through the interface or formula language.

- **Automatic update tracking mode** [page 198]
  In the *Auto-update* data tracking mode, you always compare the current data with the data before the last refresh.

- **Absolute reference data tracking mode** [page 198]
  In the *Fixed data* tracking mode, you manually select the reference data in the Data Tracking dialog box.

- **To activate data tracking** [page 198]
  You can activate data tracking in the Data Tracking dialog box.

- **To display changed data** [page 199]
  You can choose whether to display changed data when data tracking is activated.

- **Configuring the appearance of changed data** [page 199]
  You can configure the appearance (font style, size and color) of changed data in your document.

- **To configure the appearance of changed data** [page 200]
  You can configure the appearance of changed data in the Data Tracking dialog box.

- **How changed data is displayed in blocks** [page 200]
  This example uses a document with a block showing [Country], [Year] and [Revenue].

- **How changed data is displayed in blocks with breaks** [page 204]
  When a block contains a break and the *Merge* block property is set, the display of the centered value follows rules similar to those for section headers.

- **How changed data is displayed in sections** [page 202]
  In this example you have a document with a block showing [Country], [Year] and [Revenue].

- **How changed data is displayed in reports with merged dimensions** [page 201]
  A dimension appears as changed only if all the dimensions that participate in the merge are changed.

- **How changed data is displayed in charts** [page 204]
  When the data in a chart has changed, a changed data icon appears above the chart.
• Inserted data
• Deleted data
• Changed data
• Increased values
• Decreased values

The formula language provides advanced users with additional power and flexibility in displaying and formatting changed data.

3.10.2 Automatic update tracking mode

In the Auto-update data tracking mode, you always compare the current data with the data before the last refresh. This is achieved by automatically setting the current data as the reference data just before each refresh. The reference data is always one refresh behind the current data.

Automatic data tracking is appropriate for scheduled documents when you want to compare the current data with the data before the last refresh.

⚠️ Restriction
This applies only to documents scheduled to the Web Intelligence output format.

3.10.3 Absolute reference data tracking mode

In the Fixed data tracking mode, you manually select the reference data in the Data Tracking dialog box. You continue to use this data as a reference point until you update the reference point.

3.10.4 To activate data tracking

You can activate data tracking in the Data Tracking dialog box.

ℹ️ Note
If your user rights do not permit document tracking, then the options mentioned below are grayed out.

1. Open a Web Intelligence document.
2. Do one of the following:
   ○ In any mode, click Track changes on the status bar at the bottom of the window.
   ○ In the Reading mode, click Track in the toolbar.
   ○ In the Design mode, in the Analysis tab, select the Data Tracking subtab and click Track.
3. In the Data Tracking dialog box, select the Data tab.
4. To compare the data with the last refresh, select **Compare with last data refresh**. When you select this option, the current data becomes the reference data after each data refresh. The report always shows the difference between the most recent data and the data before the last refresh.

   If this option is selected, the status bar displays **Track changes: Auto-update**.

5. To compare the data with a specific data refresh, select **Compare with data refresh from** and select the date of the data refresh from the list.

   When you select this option, the data refresh you choose becomes the reference data. The report always shows the difference between the most recent data and the data refresh you chose.

   If this option is selected, the status bar displays **Track changes: Fixed data**.

6. Select the reports that you want to display data tracking from the **Reports with data tracking shown** list.

7. Select **Refresh data now** to refresh the data when the dialog box closes.

8. Click **OK** to close the **Data Tracking** dialog box.

---

### 3.10.5 Displaying changed data

#### 3.10.5.1 To display changed data

You can choose whether to display changed data when data tracking is activated.

1. Open a Web Intelligence document in **Reading** or **Design** mode.
2. Activate data tracking.
3. Do one of the following:
   - If you are in **Reading** mode, select **Track > Show Changes**.
   - If you are in **Design** mode, in the **Analysis** tab, in the **Data Tracking** subtab, click **Show Changes**.
4. Select the option again to turn off the display of changed data.

---

### Related Information

- **Configuring the appearance of changed data** [page 199]
  - You can configure the appearance (font style, size and color) of changed data in your document.

- **To activate data tracking** [page 198]
  - You can activate data tracking in the **Data Tracking** dialog box.

---

### 3.10.5.2 Configuring the appearance of changed data

You can configure the appearance (font style, size and color) of changed data in your document.

You can separately configure the appearance of the following changes:
• Inserted, deleted dimensions and changed detail values
• Increased or decreased measure values

Measure values can also adopt the formatting of inserted or deleted dimension values. For example, if a dimension value disappears from a list of values in a block, and the block also shows a measure value for the dimension, both the dimension and measure values appear as deleted data.

The BI administrator defines the default appearance of changed data in the Central Management Server (CMS). When you configure the appearance of changed data locally, you override the CMS defaults.

### 3.10.5.2.1 To configure the appearance of changed data

You can configure the appearance of changed data in the Data Tracking dialog box.

1. Open a Web Intelligence document in Reading or Design mode.
2. Click Track Changes on the status bar at the bottom of the window to display the Data Tracking dialog box.
3. In the Options tab, select each type of changed data you wish to display and click Format to specify how you want the changes to appear.
4. Click OK to close the Data Tracking dialog box.

### Related Information

**Highlighting data using conditional formatting** [page 208]

Conditional formatting enables you to highlight results or change formatting based on data.

### 3.10.5.3 How changed data is displayed in blocks

This example uses a document with a block showing [Country], [Year] and [Revenue].

#### Example

**Changed data in a simple block**

The original data is as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2003</td>
<td>1000</td>
</tr>
<tr>
<td>France</td>
<td>2004</td>
<td>2000</td>
</tr>
<tr>
<td>Japan</td>
<td>2002</td>
<td>1000</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>1200</td>
</tr>
</tbody>
</table>

After a refresh, the data is as follows:
<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2004</td>
<td>3000</td>
</tr>
<tr>
<td>Japan</td>
<td>2003</td>
<td>900</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>800</td>
</tr>
<tr>
<td>UK</td>
<td>2004</td>
<td>900</td>
</tr>
</tbody>
</table>

When data tracking is activated and data changes displayed, the block appears as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2003</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>France</td>
<td>2004</td>
<td>3000</td>
<td>[increased data formatting on Revenue cell]</td>
</tr>
<tr>
<td>Japan</td>
<td>2002</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>Japan</td>
<td>2003</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>800</td>
<td>[decreased data formatting on Revenue cell]</td>
</tr>
<tr>
<td>UK</td>
<td>2004</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
</tbody>
</table>

- The rows showing revenue for France in 2003 and Japan in 2002 represent data that no longer exist after the refresh.
- The revenue for France in 2004 has increased.
- The revenue for Poland in 2002 has decreased.
- The rows showing revenue for Japan in 2003 and the UK in 2004 appeared after the refresh.

### 3.10.5.4 How changed data is displayed in reports with merged dimensions

A dimension appears as changed only if all the dimensions that participate in the merge are changed.

#### Example

**Changed data and merged dimensions**

In this example, Country is a merged dimension containing the Country dimensions from two data providers. Before data refresh, the data is as follows:

<table>
<thead>
<tr>
<th>Country (DP1)</th>
<th>Revenue (DP1)</th>
<th>Country (DP2)</th>
<th>Sales (DP2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>10000</td>
<td>US</td>
<td>5000</td>
</tr>
</tbody>
</table>
After a data refresh, the data becomes:

<table>
<thead>
<tr>
<th>Country (DP1)</th>
<th>Revenue (DP1)</th>
<th>Country (DP2)</th>
<th>Sales (DP2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>4000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK</td>
<td>5000</td>
<td>UK</td>
<td>3000</td>
</tr>
<tr>
<td>Germany</td>
<td>1000</td>
<td>Germany</td>
<td>1000</td>
</tr>
</tbody>
</table>

When displayed in a block with the merged Country dimension and data changes displayed, the data appears as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Revenue</th>
<th>Sales</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>10000</td>
<td>4000</td>
<td>[decreased data formatting on Sales cell]</td>
</tr>
<tr>
<td>France</td>
<td>4000</td>
<td>3000</td>
<td>[inserted data formatting on Revenue cell]</td>
</tr>
<tr>
<td>UK</td>
<td>6000</td>
<td>4000</td>
<td>[increased data formatting on Revenue and Sales cells]</td>
</tr>
<tr>
<td>Poland</td>
<td>2000</td>
<td></td>
<td>[inserted data formatting on Country and Revenue cells]</td>
</tr>
</tbody>
</table>

In the France row, France does not appear as inserted because a France row was not inserted in both data providers. Revenue appears as inserted because it is a new measure value after the data refresh.

In the Poland row, Poland appears as inserted because it is a new dimension value after the data refresh.

### 3.10.5.5 How changed data is displayed in sections

In this example you have a document with a block showing [Country], [Year] and [Revenue].

**Example**

**Changed data in a report with sections**

The original data is as follows:
After a refresh, the data is as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2003</td>
<td>1000</td>
</tr>
<tr>
<td>France</td>
<td>2004</td>
<td>2000</td>
</tr>
<tr>
<td>Japan</td>
<td>2002</td>
<td>1000</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>1200</td>
</tr>
<tr>
<td>US</td>
<td>2003</td>
<td></td>
</tr>
<tr>
<td>US</td>
<td>2004</td>
<td></td>
</tr>
</tbody>
</table>

If you create a section on [Country] and display data changes, the report appears as follows:

France [no formatting]

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>2004</td>
<td>3000</td>
<td>[increased data formatting on Revenue cell]</td>
</tr>
</tbody>
</table>

Japan [no formatting]

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>2003</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
</tbody>
</table>

Poland [no formatting]

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>800</td>
<td>[decreased data formatting on Revenue cell]</td>
</tr>
<tr>
<td>2004</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
</tbody>
</table>

The data appears in the section header in either of two ways, depending on the changes in the data in the section:
If all the rows in the block in the section have changed in the same way, the section header is displayed with the same formatting as the rows.

If the rows have changed in different ways, or only some rows have changed, the section header retains its default format.

### 3.10.5.6 How changed data is displayed in blocks with breaks

When a block contains a break and the Merge block property is set, the display of the centered value follows rules similar to those for section headers.

- If all the rows in the break have changed in the same way, the centered value is displayed with the same formatting as the rows.
- If the rows have changed in different ways, or only some rows have changed, the centered value retains the default formatting.

### 3.10.5.7 How changed data is displayed in charts

When the data in a chart has changed, a changed data icon appears above the chart.

When you click the icon, the chart changes to a table to allow you to see the details of the changes.

### 3.10.6 Data tracking restrictions

If you change or purge a data provider, the report no longer displays changed data.

If the data provider is changed, the current version of the document is no longer compatible with the reference version. If the data is cleared, the old data no longer exists for comparison.

As a result, the following actions are incompatible with data tracking:

- Drill out of scope
- Query drill
- Deleting a query
- Any modification (including modifications to security rights) that changes the SQL generated by a data provider
- Purging the document

When you perform any of these actions, the data history of the document is cleared because the actions are incompatible with the display of changed data. For example, if you modify a query, the data in the document changes because of the modification. Any comparison between this data and old data generated from a different query is misleading.

---

**Note**

When you use query drill or drill out of scope, the data history is cleared because these actions change the data provider. This should not affect you because, when you start to drill, you have already identified the data that
requires further analysis. Data tracking has served its purpose and you can now continue with your data analysis.

Related Information

To drill out of the scope of analysis [page 237]
You can create an additional query for a document that returns additional data to the document and adds to the table data for the dimension on which you drilled.

Drilling with query drill [page 253]
When you activate query drill, you drill by modifying the underlying query (adding and removing dimensions and query filters) in addition to applying drill filters.

To manage queries using the Data Manager [page 118]
You can view, explore and manage all the queries in a document using the Data Manager.

3.10.6.1 Data tracking and Refresh on Open

When a document is set to refresh its data on opening (when the Refresh on open document property is selected), data tracking does not display the difference between the data prior to the refresh and the data after the refresh.

The data after the refresh is considered to be new data because the refresh purges the document.

Note

The Refresh on open option is dependent on the following CMS settings:

- In CMC ➤ Application ➤ Web Intelligence ➤ Properties, the property Automatic Refresh security setting is enabled by the BI administrator.
- In CMC ➤ Application ➤ Web Intelligence ➤ user security, the security right Document - disable automatic refresh on open is disabled for this user by the BI administrator.

In these cases, even if the document is not set as being Refresh on open, it will still be refreshed on opening.

Related Information

To save a document in the corporate repository in the Web Intelligence HTML interface [page 441]
You can save a document to the corporate repository using the Web Intelligence HTML interface.

To save a document in the corporate repository in the Web Intelligence Applet interface [page 441]
You can save a document to the corporate repository using the Web Intelligence Applet interface.
3.10.7 Using formulas to track changed data

When you use the interface to configure the display of changed data, the changes are tracked using special behind-the-scenes alerters.

These special alerters do not appear in the list of standard alerters.

Cell formulas allows you to build your own custom alerters for formatting data changes. You can also use formulas with special calculations based on data changes. For example, you can include a calculation to show the difference between the previous value and the current value of a measure.

3.10.7.1 The RefValue function

The formula language provides access to changed data through the RefValue function.

This function gives the value of the reference data for a measure. If there is no reference data, the function returns null.

For example, if the [Revenue] measure currently has the value 1000, and its reference value is 900, the formula RefValue([Revenue]) returns 900.

3.10.7.1.1 Building formulas using the RefValue function

You can use the RefValue function to build formulas that give information about the current data in relation to the reference data.

**Example**

Finding the difference between the reference value and the current value

The following formula returns the difference between the reference value and the current value of the [Revenue] measure:

\[ \text{If(Not(IsNull([Revenue])) Or Not (IsNull(RefValue([Revenue])))); [Revenue] - RefValue([Revenue])} \]

The following table shows data before a data refresh:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnson</td>
<td>2000</td>
</tr>
<tr>
<td>Smith</td>
<td>3000</td>
</tr>
<tr>
<td>Wilson</td>
<td>3500</td>
</tr>
</tbody>
</table>

After refresh, the data changes as follows:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnson</td>
<td>3000</td>
</tr>
</tbody>
</table>
Placed in a third column, the formula returns the following figures:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
<th>Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnson</td>
<td>3000</td>
<td>1000</td>
</tr>
<tr>
<td>Smith</td>
<td>2500</td>
<td>-500</td>
</tr>
<tr>
<td>Wilson</td>
<td>3500</td>
<td></td>
</tr>
</tbody>
</table>

### 3.10.7.2 The RefValueDate function

The `RefValueDate` function returns the date of the reference data used for data tracking.

### 3.10.7.3 The RefValueUserResponse function

The `RefValueUserResponse` function is used for tracking prompts and returns the value of the user response of the reference data (prompts) used for data tracking.

### 3.10.8 Changed data and the calculation context

When data tracking is activated, data only appears as changed when the calculation context remains the same.

For example, if a measure value changes because you have changed the calculation context of a block, the new value is not flagged as changed.

#### Example

**Changing the calculation context**

In this example you have a block showing [City], [Customer] and [Revenue] as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>San Francisco</td>
<td>Smith</td>
<td>1000</td>
</tr>
<tr>
<td>San Francisco</td>
<td>Jones</td>
<td>2000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>Wilson</td>
<td>3000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>Harris</td>
<td>4000</td>
</tr>
</tbody>
</table>

If you remove [Customer] from the block, revenue is aggregated by city:
The revenues do not appear as increased because the amount of revenue has not changed. Only the calculation context has changed. Revenues are now aggregated by city only, giving higher figures.

If, after a data refresh, Jones’ revenue falls to 1000 and Wilson’s revenue rises to 4000, the data appears as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>San Francisco</td>
<td>2000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>8000</td>
</tr>
</tbody>
</table>

The data appears as changed because, independently of the change of calculation context, the total revenue for San Francisco has decreased and the total revenue for Los Angeles has increased.

### 3.11 Highlighting data using conditional formatting

Conditional formatting enables you to highlight results or change formatting based on data.

You can, for example, conditionally format results to highlight particularly high or low results with specific colors or with text comments, such as **High Performer** or **Low Performer**.

You can apply conditional formatting to the following elements:

- Columns in a vertical table
- Rows in a horizontal table
- Cells in forms and crosstables
- Section headers
- Free-standing cells

You can apply up to 30 conditional formatting rules in a document. You can apply these rules to a maximum of 20 table columns or rows, free-standing cells, or section cells on the reports. You can apply up to 10 different rules on a single table column or row, free-standing cell, or section cell.

You can define conditional formatting rules to activate the following formatting changes:

- text color, size and style
- cell border colors and style
- cell background display – specific colors, images, or hyperlinks to web pages

You can also define rules that display a text or formula, an image, or a hyperlink. In this case, the results that meet the condition defined in the rule will be replaced by the text or formula.

Conditional formatting is dynamic. When you refresh reports with the latest data from the database, the rules highlight the new results accordingly.
If you apply conditional formatting to a table row or column with a break, the rule is only activated when the value that meets the conditional rule appears on the first row of that break.

### 3.11.1 Conditions in conditional formatting

Conditional formatting rules contain multiple conditions, allowing you to apply multiple formats depending on the data.

A conditional formatting rule operates as follows:

```
If <Main Condition> is true, Apply <Main Format>
ElseIf <Second Condition> is true,  Apply <Second Format>
ElseIf <Third Condition> is true,  Apply <Third Format>
ElseIf...
Else Apply <Default Format>
```

In the above example, if `<Main Condition>` is `Sales Revenue > 100,000` and `<Main Format>` formats the text in blue, the conditional formatting displays the measure in blue whenever the Sales Revenue measure is greater than 100,000.

If `<Second Condition>` is `Sales Revenue < 10,000` and `<Second Format>` formats the text in red, the conditional formatting also displays the measure in red whenever its value is less than 10,000.

Each condition can contain multiple tests, and all tests must return True for the conditional formatting to be applied. For example, a condition can test the values of the `[Country]` and `[Resort]` objects. Both objects must return the value specified in the test for the formatting to be applied.

### 3.11.2 To build a conditional formatting rule

You can create and edit conditional formatting in the Web Intelligence Applet interface or Web Intelligence Rich Client.

1. Open a Web Intelligence document in **Design** mode.
2. In the **Analysis** tab, select the **Conditional** subtab.

![Note](image)

You cannot build conditional formatting rules in the Web Intelligence HTML interface.

3. Click **New Rule** to display the **Formatting Rule Editor** panel.
4. Enter a rule name and rule description.
5. Click **...** next to the **Filtered object or cell** box and select objects.
   - You cannot define a rule on a cell containing a date or numeric type data (for example, a date or a calculation) because the application considers any value you type into the **Value** text box as a character string.
6. Select an operator.
7. Enter the value that triggers the formatting rule in the **Operands** box.
   - To enter a value directly, type it in the box.
To select a value from the list of values, click ... next to the Operands box and select a value.

To change the object or variable as the value, click ... next to the Operands box, click Select an Object or Variable on the menu, then select a different object or variable.

To clear the Operands box, click ... next to the box, then select Empty.

8. To add an additional test within the condition, click + by the existing conditions, then choose the filtered cell or object, operator and value as described above.

9. To remove a condition, click x next to the Condition box.

10. To trigger the condition using a formula, click the arrow next to Condition and select Fx.

11. Click Fx next to the formula box to display the Formula Editor in which you can build formulas.

   ○ If you want your formula to return a text string, do not include quote marks before or after the text. For example, if you want the alerter to display OVERDUE, then type: OVERDUE.

   ○ The formula must return True or False. True triggers the condition; False does not. For example, if the formula is RowIndex()=3, the conditional formatting appears on the fourth row of the table.

12. To add an additional condition to the rule, click Add at the top corner of the box to display an additional condition box, then define the conditions or build a formula as described above.

   You can add multiple conditions.

13. To set the format that appears when the rule is triggered, click Format in the If the above is true, then display panel.

   The Formatting Rules Display dialog box to set the format appears.

14. Click OK to save the IF/THEN formats, then OK to set the rule format in the report.

3.11.3 To set the format displayed by a conditional formatting rule

You can create and edit conditional formatting in the Web Intelligence Applet interface or Web Intelligence Rich Client.

Note
This option is not available in Web Intelligence HTML interface.

1. Open a Web Intelligence document in Design mode.

2. In the Analysis tab, select the Conditional subtab.

3. Click Formatting Rules.

4. Select a rule from the list and click Edit.

5. In the Formatting Rule Editor dialog box, click Format to display the Formatting Rule Display dialog box.

6. To display text or a formula, select the Display tab and build the formula in the box.

   ○ To define the displayed text or formula as HTML, an image URL or a hyperlink, click Read content as, then select HTML, Image URL or Hyperlink from the list.

Note
When you select Read content as: HTML, the Autofit Width and Autofit Height properties do not work, because the size of the HTML data in a cell cannot be decoded by the browser properly. The HTML
To change the number format, select the format from the Format Number list or click Custom and select the format from the Format Number dialog box.

7. To change the font style, click the Text tab, and define the font using the controls in the tab.

8. To change the background style, select the Background tab then define the background using the controls in the tab.

9. To change the border style, select the Border tab and define the border using the controls in the tab.

10. Click OK, then OK again to return to the document.

Related Information

To build a conditional formatting rule [page 209]

You can create and edit conditional formatting in the Web Intelligence Applet interface or Web Intelligence Rich Client.

3.11.4 To apply conditional formatting

You can apply previously-defined conditional formatting rules to report elements.

You can format the following report elements:

- Columns in a vertical table
- Rows in a horizontal table
- Cells in forms and crosstables
- Section headers
- Free-standing cells

1. In a Web Intelligence document in Design mode, select a report element on which you want to conditionally format.

2. In the Analysis tab, select the Conditional subtab.

3. Click the arrow next to Formatting Rules and select the rule you want to apply from the list.

4. Save the document.

3.11.5 To manage conditional formats

You can manage conditional formatting in the Web Intelligence Applet interface or Web Intelligence Rich Client.

1. Open a Web Intelligence document in Design mode.

2. In the Analysis tab, select the Conditional subtab.

3. From the Formatting Rules dropdown list, select Manage Rules to display the Conditional Formats dialog box.
3.11.6 Using formulas to create advanced conditional formatting rules

You can build advanced conditional formatting rules using the formula language rather than using the Filtered object or cell, Operator and Value choices offered by in the Formatting Rules Editor.

**Example**

Highlighting three ranges of quarterly sales revenue results calculated as percentages of the average sales revenue

In this example, you build three rules to color-code sales revenues, depending on their relationship to the average sales revenue. The table includes results for three years, and this is the average to which you want to compare each sales revenue result calculated per quarter per product line.

Using the formula option in the Formatting Rules Editor, you build the following rule, which contains three conditions The conditions are as follows:

Condition:

\[
[Sales\ revenue] < \text{Average}([\text{Sales\ revenue}] \text{ In Block}) \times 0.8
\]

Else Condition:

\[
= [Sales\ revenue] < \text{Average}([Sales\ revenue] \text{ In Block}) \times 1.2
\]

Else Condition:

\[
= [Sales\ revenue] > \text{Average}([Sales\ revenue] \text{ In Block}) \times 1.2
\]

The formula you specify for each condition works as follows:

- The first condition applies when sales revenues are are < 0.8, or 80%, of the average.
- The second condition applies when sales revenues are < 1.2, or less than 120%, of the average.
- The third applies when sales revenue are > 1.2, or greater than 120%, of the average.

You then use the Formatting Rules Display dialog box to specify the conditional formatting you want displayed in report cells that meet one of the conditions. You choose the following formatting:

- Report cells containing sales revenue that is less than 80% of the average revenue (the first condition) display the revenue in red.
• Report cells containing sales revenue that is less than 20% above the average revenue (the second condition) display the revenue in blue.

  Note

  This condition covers values also covered by the first condition. For example, if the average is 100, 79 is less than 80% below the average and less than 20% above the average. In this case, the first condition takes precedence.

• Report cells containing sales revenue that is greater than 20% above the average revenue (the third condition) display the revenue in green.

This formatting enables you to see at a glance which product lines are generating above average, below average, or close to average sales revenue.

## 3.12 Ranking report data

Ranking allows you to isolate the top and bottom records in a set based on a variety of criteria.

For example, if you have a block showing countries and associated revenues, ranking allows you to rank the data in the block to show the top 3 countries only, based on the revenue they generate.

Ranking allows you to answer business questions such as:

• Which 3 regions generate the most revenue?
• Which are the bottom 10% of stores in terms of revenue generation?
• What is the group of the best-performing stores that generates a combined revenue of up to $10,000,000?

You can rank data in many ways to answer these kinds of business questions. You can:

• rank the top and/or bottom n records by dimension (for example Country) based on the sum of a related measure (for example Revenue)
• rank the top and/or bottom n% of the total number of records by dimension based on the value of a related measure as a percentage of the total value of the measure
• rank the top and/or bottom n records by dimension based on the cumulative sum of a related measure
• rank the top and/or bottom n records by dimension based on the value of a related measure as a cumulative percentage of the total value of the measure

### 3.12.1 Rankings and sorts

When you rank data, the data must be sorted to display the ranking.

For example, if you rank the top 3 stores by revenue, the stores are sorted in descending order by revenue generated.

Sorts applied to display rankings take precedence over sorts that you previously applied to data. For example, if you previously sorted the list of stores in alphabetical order, the ranking sort overrides the alphabetical sort.
3.12.2 Tied rankings

Tied rankings are assigned equal ranking values and subsequent ranking values are pushed back to compensate.

This means that a bottom n ranking can return more than n records.

Example

Top and bottom tied rankings

The following table shows a tied top 3 ranking and a tied bottom 3 ranking.

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
<th>Top 3 Ranking</th>
<th>Bottom 3 Ranking</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>D</td>
<td>30</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

Each ranking includes records up to and including rank 3. This results in the following result for a top 3 ranking:

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>30</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
</tr>
</tbody>
</table>

It results in the following result for a bottom 3 ranking:

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
</tr>
<tr>
<td>D</td>
<td>30</td>
</tr>
</tbody>
</table>

3.12.3 Ranking and data order

You cannot rank on an object whose values depend on the data order.

This is because the ranking changes the data order, which in turn changes the object data, which then requires a recalculation of the ranking. The result is a circular dependency between the ranking and the object that cannot be resolved.

If you create a rank on a measure whose values depend on the data order, for example a measure that that uses the Previous function or any of the running aggregate functions such as RunningSum, the #RANK error message appears in all cells in the block.
3.12.4 Ranking parameters

The following parameters can be configured in the Ranking dialog box.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>When the calculation mode is Count, the ranking returns the top/bottom n records based on the measure specified as the Based on parameter. For example, the top 3 countries by revenue generated, the bottom 3 year/quarter combinations by revenue generated.</td>
</tr>
<tr>
<td></td>
<td>When the calculation mode is Percentage, the ranking returns the top/bottom n% of the total number of records based on the measure specified as the Based on parameter. For example, if there are 100 records and you rank the top 10%, the ranking returns the top 10 records.</td>
</tr>
<tr>
<td></td>
<td>When the calculation mode is Cumulative Sum, the ranking returns the top/bottom records, for which the cumulative sum of the measure specified as the Based on parameter does not exceed n.</td>
</tr>
<tr>
<td></td>
<td>When the calculation mode is Cumulative Percentage, the ranking returns the top/bottom records, for which the cumulative sum of the measure specified as the Based on parameter does not exceed n% of the total of the measure.</td>
</tr>
<tr>
<td>Based on</td>
<td>The measure on which the ranking is based.</td>
</tr>
<tr>
<td>Ranked By</td>
<td>The ranking dimension. If you specify a ranking dimension, the aggregated values of the Based on parameter, calculated for the dimension, determine the ranking. If you do not specify this dimension, the values of the Based on parameter calculated for all dimensions in the block determine the ranking. In other words, the ranking returns the top/bottom X rows in the block based on the measure.</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>The type of calculation used to create the ranking. See the description of the Top/Bottom parameters in this table for more information.</td>
</tr>
</tbody>
</table>

Related Information

To create a ranking [page 217] You configure ranking filters in the Ranking dialog box.

3.12.4.1 Example of a ranking

If you rank the top 2 of each Quarter based on Revenue, the ranking filters out all the rows for Q1 and Q3 because Q4 and Q2 have the highest aggregate revenues.

A table contains the following data:
Year | Quarter | Revenue
---|---|---
2006 | Q1 | 100
2006 | Q2 | 200
2006 | Q3 | 300
2006 | Q4 | 500
2007 | Q1 | 400
2007 | Q2 | 700
2007 | Q3 | 300
2007 | Q4 | 600
2008 | Q1 | 200
2008 | Q2 | 200
2008 | Q3 | 400
2008 | Q4 | 500

Total for Q1: 700
Total for Q2: 1100
Total for Q3: 1000
Total Q4: 1600

### 3.12.5 Ranking workflows

A ranking uses sorts and filters that are applied transparently according to the ranking you specify.

There are two ways of ranking data. You can:

- create a ranking by using the interface
- use the Rank function to return a ranking value

For example, if you rank the top 3 countries in a block by revenue, you implicitly sort the countries in descending order by revenue, then filter the block to remove all countries other than the 3 with the highest revenue.

**Note**

When you create a ranking using the interface, the Rank function is used behind the scenes to assign ranking values.
3.12.5.1 To create a ranking

You configure ranking filters in the Ranking dialog box.

1. Open a Web Intelligence document in Design mode.
2. Select the block that you want to rank.
3. In the Analysis tab, in the Filters subtab, click Ranking.
4. In the Ranking dialog box, any one of the following:
   - To rank the highest records in the block, click Top and select the number of records you want to rank.
   - To rank the lowest records in the block, click Bottom and select the number of records you want to rank.
   - Select the measure on which the ranking is based in the Based on list.
   - To rank by a particular dimension rather than by all dimensions in the block, click Ranked by and select the dimension on which the ranking is based.
   - Select a rank calculation mode in the Calculation mode list.
5. Click OK to close the Ranking dialog box.

Related Information

Ranking parameters [page 215]

The following parameters can be configured in the Ranking dialog box.

3.12.6 Ranking examples

In the following examples, you have a dimension, Region, and a measure, Revenue.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>% of Total Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1000000</td>
<td>7%</td>
</tr>
<tr>
<td>South West</td>
<td>2000000</td>
<td>13%</td>
</tr>
<tr>
<td>North East</td>
<td>3000000</td>
<td>20%</td>
</tr>
<tr>
<td>North West</td>
<td>4000000</td>
<td>24%</td>
</tr>
<tr>
<td>Central</td>
<td>5000000</td>
<td>33%</td>
</tr>
</tbody>
</table>

Example

Rank the top 3 regions by revenue generated

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>3</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ranked by</td>
<td>Region (or unspecified because region is the only dimension in the block and therefore the default ranking dimension)</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Count</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>5000000</td>
</tr>
<tr>
<td>North West</td>
<td>4000000</td>
</tr>
<tr>
<td>North East</td>
<td>3000000</td>
</tr>
</tbody>
</table>

The implicit steps in calculating this ranking are:
- Sort the records in descending order.
- Display the top 3 records.

**Example**

**Rank the bottom 40% of regions by revenue**

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom</td>
<td>40%</td>
</tr>
<tr>
<td>Ranked by</td>
<td>Region</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Percentage</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1000000</td>
</tr>
<tr>
<td>South West</td>
<td>2000000</td>
</tr>
</tbody>
</table>

The implicit steps in calculating this ranking are:
- Sort the record in ascending order.
- Work through the records until 40% of the total number of records are displayed.

**Example**

**Rank the top regions whose cumulative revenue is less than or equal to 10,000,000**

To perform this ranking you set the following parameters:
This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>5000000</td>
</tr>
<tr>
<td>North West</td>
<td>4000000</td>
</tr>
</tbody>
</table>

The implicit steps in calculating this ranking are:

- Sort the records in descending order.
- Work through the records until the record that causes the cumulative total of the measure to pass 10,000,000.
- Include those records that do not cause the cumulative total to pass 10,000,000.

Example

Rank the bottom regions whose cumulative revenue is less than or equal to 30% of the total revenue

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom</td>
<td>30%</td>
</tr>
<tr>
<td>Ranked by</td>
<td>Region</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Cumulative percentage</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1000000</td>
</tr>
<tr>
<td>South West</td>
<td>2000000</td>
</tr>
</tbody>
</table>

The implicit steps in calculating this ranking are:

- Sort the records in ascending order.
- Work through the records until the record that causes the cumulative total of the measure, expressed as a percentage of the overall total of the measure, exceeds 30%.
- Display those records that do not cause the cumulative percentage to pass 30%.
3.13 Merging data from dimensions and hierarchies

You can synchronize the data returned by dimensions, hierarchies or attributes by creating merged objects which incorporate them.

You merge data from different data providers. For example, if you have one data provider that contains detailed customer information and another data provider that contains sales data, you can synchronize the two data providers around the customer.

When you merge data from the same data source (for example the same universe or BEx query), the merge is based on the internal ID of each data member. When you merge data from different data sources, the merge is based on the caption of each data member. For example, if you synchronize two [Geography] hierarchies, the data member [Los Angeles] is merged with [Los Angeles] through its internal ID when the hierarchies are based on the same data source. The members are merged on the caption "Los Angeles" when the hierarchies are in different data sources.

In cases where merging is based on the caption, and different members with the same caption have different parent members, it is not possible to merge the members and the #MULTIVALUE error occurs.

When a merged object contains a hierarchy, you cannot include it directly in a report, but you can still see synchronized hierarchical data by using the original hierarchies. If you include a merged object without hierarchies in a report, the object returns the #COMPUTATION error if hierarchies are subsequently added to it.

When merged objects are from different data providers

When two merged objects are from different data providers, note the following restriction concerning the dimension value for a merged object and object participating in a merge:

When [DIM1] coming from data provider 1, and [DIM2] coming from data provider 2), are merged, the value for the [MERGE] is the union of the values of [DIM1] and [DIM2].

- When you use [DIM1] (or [DIM2]) in a table, the table shows only the value from [DIM1] (or [DIM2]) This behavior is as expected.
- When you filter (using an input control, drill bar, or filter panel) on one of these dimensions, this shows the list of values of the [MERGE] because it will result in a filter on the [MERGE].
- When [DIM1] (or [DIM2]) is used in context modifier (In, foreach, forall) the calculation will be done based on the [MERGE]. For example, count([measure] foreach ([DIM1])) counts all the measure items given against [MERGE].

Related Information

Merging hierarchies [page 222]  
You can take advantage of data synchronization by using the original hierarchies that make up a merged hierarchy.
3.13.1 Merging data providers based on keys

When you merge two data sources based on detail objects for a query based on BICS, the BEx query keys are mapped to details. In this way it is possible to merge data providers based on keys. Once merged, the attribute is used in the report in the same way as a dimension.

3.13.2 Choosing which data to merge

You merge data when your report draws data from different but related sources. For example, you have a report showing revenue and sales targets. The report contains sections based on the year, and each section shows revenue and sales targets. If revenue and sales target data comes from two different data providers, it is not synchronized. You synchronize the data by merging the two data providers on the common dimension, Year.

The only technical restriction imposed on merged dimensions is that they must be of the same data type. You can, for example, merge two dimensions containing character data. But it does not make sense to merge unrelated dimensions even when their data types are the same. For example, it does not make sense to merge a dimension containing customer names with a dimension containing sales regions.

Merged dimensions often have the same name in both data sources, but this is not obligatory. It can make sense to merge dimensions with different names if they contain related data.

Merged dimensions often have the same name in both data sources, but this is not obligatory. It can make sense to merge dimensions with different names if they contain related data.

To merge dimensions correctly you need to be aware of the semantics of the data (what the data refers to) in the different data sources. The dimension data types and names are an approximate guide only to dimensions’ suitability for merging.

3.13.3 Merged dimension example

In this topic, you can see an example of merged dimensions with two data providers.

**Example**

Merging City dimensions

Data Provider 1:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
</tr>
</tbody>
</table>

Data Provider 2:
If you do not merge the City dimensions, you get the following result if you place the Country, City and Revenue objects in a table:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
<td>325000</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
<td>325000</td>
</tr>
</tbody>
</table>

Because there is no link between the two data providers through a merged dimension, city revenues are not related to countries. The table shows the total revenue in data provider 2 against each Country/City pair.

If you merge the City dimensions, you get the following result:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
<td>100000</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
<td>75000</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
<td>90000</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
<td>60000</td>
</tr>
</tbody>
</table>

### 3.13.4 Merging hierarchies

You can take advantage of data synchronization by using the original hierarchies that make up a merged hierarchy.

The data in the report takes the structure of the hierarchy you select.

**Example**

**Merged hierarchies**

You have two data sources, each using a hierarchy that you have merged into a merged object. Data provider 1 contains the following data:

<table>
<thead>
<tr>
<th>Product</th>
<th>Store Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>5401</td>
</tr>
<tr>
<td>Product</td>
<td>Store Invoice</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Gym</td>
<td>4073</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1236</td>
</tr>
<tr>
<td>Tops</td>
<td>1208</td>
</tr>
<tr>
<td>Weights</td>
<td>1629</td>
</tr>
<tr>
<td>Swimming</td>
<td>1328</td>
</tr>
<tr>
<td>Camping</td>
<td>16961</td>
</tr>
<tr>
<td>Tents</td>
<td>3534</td>
</tr>
<tr>
<td>Sleeping Bags</td>
<td>3423</td>
</tr>
<tr>
<td>Kitchen Equipment</td>
<td>5352</td>
</tr>
<tr>
<td>Electrical</td>
<td>4652</td>
</tr>
</tbody>
</table>

Data provider 2 contains the following data:

<table>
<thead>
<tr>
<th>Product</th>
<th>Units Ordered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>13348</td>
</tr>
<tr>
<td>Gym</td>
<td>8814</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1231</td>
</tr>
<tr>
<td>Tops</td>
<td>3241</td>
</tr>
<tr>
<td>Weights</td>
<td>4342</td>
</tr>
<tr>
<td>Swimming</td>
<td>4534</td>
</tr>
<tr>
<td>Camping</td>
<td>34234</td>
</tr>
</tbody>
</table>

If you use the first hierarchy in a report, the merged data is structured as follows:

<table>
<thead>
<tr>
<th>Product</th>
<th>Store Invoice</th>
<th>Units Ordered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>5401</td>
<td>13348</td>
</tr>
<tr>
<td>Gym</td>
<td>4073</td>
<td>8814</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1236</td>
<td>1231</td>
</tr>
<tr>
<td>Tops</td>
<td>1208</td>
<td>3241</td>
</tr>
<tr>
<td>Weights</td>
<td>1629</td>
<td>4342</td>
</tr>
<tr>
<td>Swimming</td>
<td>1328</td>
<td>4534</td>
</tr>
<tr>
<td>Camping</td>
<td>16961</td>
<td>34234</td>
</tr>
<tr>
<td>Tents</td>
<td>3534</td>
<td></td>
</tr>
<tr>
<td>Sleeping Bags</td>
<td>3423</td>
<td></td>
</tr>
<tr>
<td>Kitchen Equipment</td>
<td>5352</td>
<td></td>
</tr>
<tr>
<td>Electrical</td>
<td>4652</td>
<td></td>
</tr>
</tbody>
</table>
The child members of [Camping] appear in the hierarchy because they appear in the hierarchy you selected. The [Units Ordered] measure does not display values for these members because they do not exist in the second data source.

If you select the second hierarchy, the merged data is structured as follows:

<table>
<thead>
<tr>
<th>Product</th>
<th>Store Invoice</th>
<th>Units Ordered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>5401</td>
<td>13348</td>
</tr>
<tr>
<td>Gym</td>
<td>4073</td>
<td>8814</td>
</tr>
<tr>
<td>Tops</td>
<td>1236</td>
<td>1231</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1208</td>
<td>3241</td>
</tr>
<tr>
<td>Weights</td>
<td>1629</td>
<td>4342</td>
</tr>
<tr>
<td>Swimming</td>
<td>1328</td>
<td>4534</td>
</tr>
<tr>
<td>Camping</td>
<td>16961</td>
<td>34234</td>
</tr>
</tbody>
</table>

The child members of [Camping] do not appear because they do not appear in the original hierarchy you selected.

### 3.13.5 Merging different types of objects

You can include dimensions, attributes and hierarchies in merged objects.

The structure of the data that appears in the report depends on which object you chose.

#### Example

**Merging a dimension and a hierarchy**

You have two data sources, one containing a dimension and the other a hierarchy. Data provider 1 contains the [Country] dimension as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Stock Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Los Angeles</td>
<td>4545</td>
</tr>
<tr>
<td>San Francisco</td>
<td>6465</td>
</tr>
<tr>
<td>San Diego</td>
<td>4564</td>
</tr>
</tbody>
</table>

Data provider 2 contains the [Geography] hierarchy as follows:

<table>
<thead>
<tr>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>54342</td>
</tr>
<tr>
<td>California</td>
<td>6996</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>3423</td>
</tr>
<tr>
<td>San Francisco</td>
<td>2342</td>
</tr>
</tbody>
</table>
You merge the dimension and hierarchy in a merged object. If you include the [Country] dimension in a report, the data appears as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Stock Items</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Los Angeles</td>
<td>4545</td>
<td>3423</td>
</tr>
<tr>
<td>San Francisco</td>
<td>6465</td>
<td>2342</td>
</tr>
<tr>
<td>San Diego</td>
<td>4564</td>
<td>1231</td>
</tr>
</tbody>
</table>

If you place the [Geography] hierarchy in a report, the result is as follows:

<table>
<thead>
<tr>
<th>Product</th>
<th>Stock Items</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>54342</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6996</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Los Angeles</td>
<td>3423</td>
</tr>
<tr>
<td></td>
<td>San Francisco</td>
<td>2342</td>
</tr>
<tr>
<td></td>
<td>San Diego</td>
<td>1231</td>
</tr>
</tbody>
</table>

### 3.13.6 Forcing merged calculations with the ForceMerge function

By default, calculations do not account for merged dimensions if the merged dimensions do not explicitly appear in the calculation context.

**Example**

**Calculating revenue with ForceMerge**

This example has two data providers as follows:

**Data Provider 1:**

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
</tr>
</tbody>
</table>

**Data Provider 2:**
<table>
<thead>
<tr>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>New York</td>
<td>100000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>75000</td>
</tr>
<tr>
<td>Paris</td>
<td>90000</td>
</tr>
<tr>
<td>Toulouse</td>
<td>60000</td>
</tr>
</tbody>
</table>

If you merge the City dimensions, then create a table with Country and Revenue, you get the following result:

<table>
<thead>
<tr>
<th>Country</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>325000</td>
</tr>
<tr>
<td>US</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>325000</td>
</tr>
</tbody>
</table>

Because City, the merged dimension, does not appear in the table, it does not influence the calculation of the revenue. The total revenue in the second data provider appears against each country.

To display the correct result, replace Revenue in the second column with the formula `ForceMerge([Revenue])`:

<table>
<thead>
<tr>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>175000</td>
</tr>
<tr>
<td>US</td>
<td>175000</td>
</tr>
<tr>
<td>France</td>
<td>150000</td>
</tr>
<tr>
<td>France</td>
<td>150000</td>
</tr>
</tbody>
</table>

The relationship between countries and cities now influences the calculation of the revenue.

**Note**

If Revenue is a smart measure in the above example, `ForceMerge([Revenue])` returns `#MULTIVALE`. This is because the grouping set (Country) does not exist for the Revenue measure.

`ForceMerge([smart_measure])` always returns `#MULTIVALE`, unless by chance no aggregation is required to calculate the measure.

### 3.13.7 To merge details, dimensions, or hierarchies

You can merge data objects in the *Available Objects* pane.

1. Open a Web Intelligence document in *Design* mode.
2. In the *Data Access* tab, in the *Data Objects* subtab, click *Merge*.
3. Hold down the `[Control]` key and select the dimensions or hierarchies you want to merge.
4. Click OK.

You can view the merged object in the Available Objects pane of the Side Panel. The original hierarchies or dimensions that make up the merged object appear beneath it. You edit or remove the merged dimension or hierarchy in the Available Objects pane.

Tip

You can also select objects in the Available Objects pane, right-click the selected objects and click Merge.

5. To add additional objects to a group of merged objects:
   a) Select the Available Objects button in the Side Panel.
   b) Select the merged object.
   c) Hold down the Control key on your keyboard and select one or several object you want to add to the group.
   d) Right-click the selection and select Add to Merge from the contextual menu.

Related Information

To unmerge objects [page 228]
You can unmerge data objects in the Available Objects pane.

To edit merged objects [page 228]
You can edit merged objects in the Edit Merged Dimension dialog box.

3.13.8 To merge dimensions automatically

You can merge dimensions automatically if the dimensions have the same name and data type, and are in the same universe. The auto-merge happens only at the document level.

1. Open a Web Intelligence document in Design mode.
2. In the Properties tab, click Document.
3. In the Document Summary dialog box, select Auto-merge dimensions.

Caution

If this option is activated, Web Intelligence searches for all dimensions sharing the same name and data type in a universe and merges them. In the case where you have the same object with different names, we recommend that you merge dimensions manually.
4. Click OK to close the Document Summary dialog box.

3.13.9 To edit merged objects

You can edit merged objects in the Edit Merged Dimension dialog box.

1. In a Web Intelligence document in Design mode, select the Available Objects button in the Side Panel.
2. Right-click a merged dimension, then select Edit Properties.
3. In the Edit Merged Dimension dialog box, type the merged dimension name in the Merged Dimension Name text box.
4. Type a description in the Description box.
5. Select a dimension that provides default properties for the merged dimension from the Source Dimension dropdown list.
6. Click OK to close the Edit Merged Dimension dialog box.

3.13.10 To unmerge objects

You can unmerge data objects in the Available Objects pane.

1. In a Web Intelligence document in Design mode, select the Available Objects button in the Side Panel.
2. Do one of the following:
   ○ To unmerge a group of objects, right-click a merged dimension and click Unmerge from the contextual menu.
   ○ To remove an object from a merged group, right-click it in the group and select Remove from Merge from the contextual menu.
3. Click Yes to confirm.

3.13.11 Synchronizing data providers with different aggregation levels

You can synchronize data providers with different aggregation levels. This can have implications for the calculation of measures.

Example

Synchronizing data providers with different aggregation levels

In this example you have two data providers as follows:
<table>
<thead>
<tr>
<th>Customer</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>2004</td>
<td>1500</td>
</tr>
<tr>
<td>Jones</td>
<td>2005</td>
<td>2000</td>
</tr>
<tr>
<td>Smith</td>
<td>2005</td>
<td>1200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer</th>
<th>Number of sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>12</td>
</tr>
<tr>
<td>Smith</td>
<td>10</td>
</tr>
</tbody>
</table>

If you merge the two data providers and the table properties *Avoid duplicate row aggregation* and *Show rows with empty dimension values* are unchecked, the result is as follows:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Year</th>
<th>Revenue</th>
<th>Number of sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>2004</td>
<td>1500</td>
<td>12</td>
</tr>
<tr>
<td>Jones</td>
<td>2005</td>
<td>1200</td>
<td>12</td>
</tr>
<tr>
<td>Smith</td>
<td>2005</td>
<td>1200</td>
<td>10</td>
</tr>
</tbody>
</table>

It is not possible to determine the number of sales per year for customer Jones because the data provider that stores the number of sales does not break them down by year. Instead you see the total number of sales on each row.

**Note**

Although the Number of Sales values are duplicated, if you add a standard calculation to the bottom of the column (for example a Sum or Average calculation), the result is correct.

One way of addressing this issue is to add the dimensions to the second data provider that allow calculation to the appropriate level of data. If this is not possible, you must be aware of any situations where it is not possible to aggregate the data to the necessary level of detail.

**Related Information**

*To show or hide tables, rows or columns* [page 314]

You can display or hide tables or table objects in a Web Intelligence document in Reading mode.

*To avoid duplicate row aggregation* [page 315]

When rows contain duplicate data, measure values are aggregated by default. You can choose not to aggregate measure values in this situation.
### 3.13.12 Attributes and merged dimensions

Attributes are associated with dimensions and provide additional information about the dimension. There must be a one-to-one relationship between dimensions and attributes. An attribute can have one value only for each value of its associated dimension. Attribute objects are not taken into account when synchronizing data. The following example illustrates why this is necessary.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Address</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
<td>10000</td>
</tr>
<tr>
<td>Paul</td>
<td>Liverpool</td>
<td>15000</td>
</tr>
<tr>
<td>Paul</td>
<td>London</td>
<td>27000</td>
</tr>
</tbody>
</table>

**Note**

Some previous versions of SAP BusinessObjects Web Intelligence (Web Intelligence, Desktop Intelligence and BusinessObjects), allowed a one-to-many relationship between dimensions and attributes. If you migrate a report created using any of these products and the attribute contains multiple values, you see the #MULTIVALUE error in the attribute cell.

---

#### Example

**Synchronizing data providers with attributes**

In this example you have two data providers, and Address is an attribute of Customer:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Address</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
<td>10000</td>
</tr>
<tr>
<td>Paul</td>
<td>Liverpool</td>
<td>15000</td>
</tr>
<tr>
<td>Paul</td>
<td>London</td>
<td>27000</td>
</tr>
</tbody>
</table>

If you create a merged Customer dimension to synchronize the data providers, and Address can have more than one value for each customer, the result is ambiguous because there is no common value for data synchronization.

In the example, Paul has addresses in Liverpool and London, which means that there is no unique ‘Paul’ row for synchronization of Paul’s telephone number. Paul has a different telephone number for each address, and we do not know which address to associate with the telephone number:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Address</th>
<th>Telephone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
<td>1234</td>
</tr>
<tr>
<td>Paul</td>
<td>#MULTIVALUE</td>
<td>5678</td>
</tr>
</tbody>
</table>

If the relationship between Customer and Address is one-to-one, Address can be ignored in the synchronization. This removes the ambiguity:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Address</th>
<th>Telephone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
<td>1234</td>
</tr>
</tbody>
</table>

---

© 2014 SAP SE or an SAP affiliate company. All rights reserved.
3.13.13 Incompatible objects and merged dimensions

As a general rule, you cannot place dimensions from different data providers in the same table. This is to avoid Cartesian products (the display of all possible combinations of values from unrelated objects) or other ambiguous results, depending on the universe structure.

You can always place measures from different data providers in a table. The measure calculation depends on what dimensions are available. For example, if you place a measure in a table that contains no dimensions from the same data provider as the measure, the calculation displays its total value in the table.

You can place a merged dimension in a table as long as the table contains other dimensions from a data provider that participates in the merge. You can also place attributes from different data providers in a table, as long as the details are associated with dimensions that participate in a merged dimension.

In certain situations, it can be valid to place a dimension from another data provider in a table, even when this is not allowed by the software. This occurs when the incompatible dimension has a one-to-one or one-to many relationship with a dimension already in the table. The important point is that there is only one value of the incompatible dimension associated with the dimension in the table (one-to-one). On the other hand, the same value of the incompatible dimension can be associated with multiple values of the dimension in the table (one-to-many).

In the table below, the relationship between Address and Name conforms to these rules: Address has a one-to-one or one-to-many association with Name. There is no one-to-many association in the other direction, between Name and Address (one name with more than one address):

<table>
<thead>
<tr>
<th>Dimension in table (Name)</th>
<th>Incompatible dimension (Address)</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
</tr>
<tr>
<td>Paul</td>
<td>London</td>
</tr>
<tr>
<td>George</td>
<td>Liverpool</td>
</tr>
</tbody>
</table>

In this case the universe design is incorrect - the incompatible dimension (Address) should be defined as a detail of the dimension in the table (Name). If you encounter this situation, contact the BI administrator and ask for a redesign of the universe.
Tip

If it is not practical to change the universe:

1. Create a variable at the report level.
2. Define this variable as a detail.
3. Associate it with the dimension in the table.
4. Supply the name of the incompatible dimension as the variable definition.

The variable simply returns the same values as the incompatible dimension. Because it is defined as a detail of the dimension in the table, you can place it in the same table as the dimension.

Related Information

To create a variable [page 290]

You can remove a variable in Web Intelligence.

3.13.14 Filtering and drilling on merged dimensions

Merging dimensions has implications for the application of filters.

Note

You cannot apply a filter on a merged object containing hierarchies.

Block filters and merged dimensions

When you apply a block filter to a dimension that is part of a merged dimension, the filter is applied to the block. It is not applied to other data providers synchronized through the merged dimension.

Section filters and merged dimensions

When a dimension that is part of a merged dimension is set as a section header, any filter applied to the section also applies to blocks from synchronized data providers within the section.
Report filters and merged dimensions

When you apply a report filter to a dimension that is part of a merged dimension, then the filter will impact all related blocks in the report that use the merged dimension (or any dimensions that participate in the merge).

Example

When you have two queries with a common dimension that you have merged, and you have two tables in a report, each table with data coming from a different query, when you filter on the merged dimension in one query, the filter will also impact the corresponding dimension in the second query and therefore in the second table.

Drilling on merged dimensions

When you merge dimensions, the new merged dimension belongs to the hierarchies of all dimensions involved in the merge.

3.13.15 Extending the values returned by merged dimensions

When you merge dimensions from different data providers, Web Intelligence creates a merged dimension. When you place the merged dimension in the report, only those dimension values that have corresponding values in the data providers synchronized through the merge are returned.

i Note

Web Intelligence and Desktop Intelligence handle merged dimensions differently, you need to be aware of this when migrating reports from Desktop Intelligence and Web Intelligence. Desktop Intelligence does not create a dimension based on the merged dimension for the report. The following section describes how the differences affect your reports.

Example

Web Intelligence and Desktop Intelligence behavior when dimensions are merged

You have a report with the following data providers:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>470</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japan</td>
<td>499</td>
</tr>
</tbody>
</table>

Web Intelligence returns the values of the Country of Origin dimension through the values returned by the Revenue measure.
If you include the Country of Origin dimension from Data Provider 1 and the Quantity measure from Data Provider 2 in the same block, in Web Intelligence, you get the following result:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td></td>
</tr>
</tbody>
</table>

The same block in Desktop Intelligence returns the following result:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td></td>
</tr>
<tr>
<td>Japan</td>
<td>499</td>
</tr>
</tbody>
</table>

To get the same results table as above with Web Intelligence, you must extend the dimension values.

### 3.13.15.1 To extend dimension values

You can activate the dimension extension option in the *Document Properties* pane.

1. Open a Web Intelligence document in Design mode.
2. In the Properties tab, select Document.
3. In the Document Properties pane, select the *Extend merged dimension values* option.
4. Click OK to close the Document Properties pane.

### 3.14 Drilling on report data

Drilling on reports lets you look deeper into your data to discover the details behind a good or bad summary result displayed in tables, charts, or sections.

**Table 25: Restrictions**

<table>
<thead>
<tr>
<th>Restriction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queries on BEx queries</td>
<td>You cannot use a Navigation path on BEx queries. Navigation path (previously called the drillpath) has been replaced by the collapse/expand workflow on the real hierarchy.</td>
</tr>
<tr>
<td>Queries on .unv and .unx universes</td>
<td>You can only drill on a .unv or .unx universe if the drill paths are already defined in the universe.</td>
</tr>
</tbody>
</table>

**Example**

**Why did sales of accessories, outerwear, and overcoats rise in Q3?**

You work for a US national fashion retail chain, and are in charge of sales of accessories, outerwear and overcoat clothing lines in western states. You see that revenue is much higher for Q3 than the other quarters.
To understand why, you drill down to look at the factors behind the result and you see that jewelry sales were much higher in July.

### 3.14.1 Setting the scope of analysis

The scope of analysis for a query is extra data that you can retrieve from the database that is available to offer more details on the results returned.

This extra data does not appear in the initial result report, but it remains available in the data cube, and you can pull this data into the report to allow you to access more details at any time. This process of refining the data to lower levels of detail is called drilling down on an object.

**Note**

The Scope of Analysis Panel option in the Query Panel is only available for relational .unx universes and not for OLAP universes or BEx queries.

In the universe, the scope of analysis corresponds to the hierarchical levels below the object selected for a query. For example, a scope of analysis of one level down for the object Year, would include the object Quarter, which appears immediately under Year.

You can set this level when you build a query. It allows objects lower down the hierarchy to be included in the query, without them appearing in the Result Objects pane. The hierarchies in a universe allow you to choose your scope of analysis, and correspondingly the level of drill available. You can also create a custom scope of analysis by selecting specific dimensions to be included in the scope.

### Related Information

- **Retrieving more levels of data to the report** [page 237]
  
  When you are drilling a report, you may want to drill up or down to a dimension that lies outside the scope of analysis defined for the document.

- **To drill out of the scope of analysis** [page 237]
  
  You can create an additional query for a document that returns additional data to the document and adds to the table data for the dimension on which you drilled.

- **Prompt when drill requires additional data option** [page 238]
  
  When you drill the results displayed on a report, you may want to drill to higher- or lower-level information that isn’t included in the scope of analysis for the document. A new query is required to retrieve this data.
3.14.1.1 Levels of scope of analysis

You can set different levels for a scope of analysis in a document.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>Only the objects that appear in the Result Objects pane are included in the query.</td>
</tr>
<tr>
<td>one level</td>
<td>For each object in the Result Objects pane, one, two, or three objects lower down the hierarchy tree are included in the query. The data from these objects is stored in the cube until you add them to the document.</td>
</tr>
<tr>
<td>two levels</td>
<td></td>
</tr>
<tr>
<td>three levels</td>
<td></td>
</tr>
<tr>
<td>custom</td>
<td>All objects added manually to the Scope of analysis pane are included in the query.</td>
</tr>
</tbody>
</table>

⚠️ Caution

Including a scope of analysis in a document increases the document size significantly because the data necessary for the scope you specify is saved with the document. It is not visible in the reports unless you start the Drill Mode and drill down to the data to display the corresponding values.

In order to minimize the size of documents and optimize performance, include a scope of analysis only in documents where you are certain that users will need to drill.

3.14.1.2 To set the scope of analysis

You can set a scope of analysis on a document query in the Query Panel, in the Scope of Analysis Panel.

1. Open a Web Intelligence document in Design mode.
2. In the Data Access tab, in the Data Providers subtab, click Edit.
3. In the Query Panel, click the Scope of Analysis Panel button to display the Scope of analysis pane.
   All the dimensions in the Result Objects pane appear in the Scope of Analysis pane. The default scope level is None, meaning that there are no additional levels selected for analysis.
4. Select an analysis level from the Scope level dropdown list at the top corner of the Scope of analysis pane. The objects hierarchically below the objects in the Result Objects pane appear in the Scope of Analysis pane down to the number of levels you selected.
5. To add selected dimensions to the scope of analysis or create a custom scope of analysis, select dimensions in the query manager and drag them across to the Scope of analysis pane.
6. Click Run Query.
3.14.1.3 Retrieving more levels of data to the report

When you are drilling a report, you may want to drill up or down to a dimension that lies outside the scope of analysis defined for the document.

Returning the additional data requires running a new query that includes the additional dimensions you specify. This is called extending the scope of analysis.

You can extend the scope of analysis during your drill sessions only if your security profile allows you to do so. Your security profile is controlled by the BI administrator.

If your drill options are not set to display the *Extend the Scope of Analysis* prompt message during drill, you will not be given the option to select filters if you drill beyond the data already available in the document. In this case, the new query runs automatically and returns data for all the values on the dimensions you are drilling.

3.14.1.3.1 To drill out of the scope of analysis

You can create an additional query for a document that returns additional data to the document and adds to the table data for the dimension on which you drilled.

1. Open a Web Intelligence document in Reading or Design mode.
2. In the Analysis tab, in the Interact subtab, select Start Drill from the Drill dropdown list.
3. Hold your mouse cursor over a dimension value that is at the end of the scope of analysis. A ToolTip informs you that a new query is necessary to return the additional data to the document.
4. Drill on the dimension.
   - If your drill options are set to prompt you when a drill action requires a new query, the *Extend the Scope of Analysis* dialog box appears.
   - The dialog box lists the dimensions in the hierarchy above and below the drilled value. The dimensions already included in the document are checked. The dialog box also displays the filters that you can select to filter the new query.
5. Select the check boxes next to the dimensions you want to drill.
6. Select the check boxes next to the filters you want to use to filter the query.
7. Click OK.

3.14.2 Drill paths and hierarchies

When you analyze data in drill mode, you move along a drill path.

These paths are based on the dimension hierarchies set by the designer of the universe. Universe designers organize objects in classes in a hierarchy with the summary objects at the top and the most detailed at the bottom. So if you want to make a high-level report, you know that your query should include objects at the top of the list. If you want to see more detailed information, you can then switch to Drill Mode and drill down on each dimension value displayed in the reports.
For example, if the data from [Quarter] did not sufficiently explain a result, you could drill down to [Month] or [Week], depending on how the universe designer set up the hierarchy. When you drill to a different level, measures, such as a [Revenue] or [Margin], are recalculated accordingly.

Drill paths usually follow the same hierarchy order as the classes on a universe. For example, a class called Time typically includes the [Year] dimension at the top of the class, followed by the [Quarter], [Month], and [Week] dimensions. The hierarchies for drill within the Time hierarchy typically follow the same order, because users want to drill annual results to analyze details for quarter, month, and so on. However, the universe designer can also define custom hierarchies.

**Note**
A dimension can belong to several hierarchies. When you drill a result on a dimension that belongs to more than one hierarchy, you must answer a prompt to select the drill path.

### 3.14.2.1 To view drill hierarchies

You can view drill hierarchies in a data provider.

1. Open a Web Intelligence document in Data or Design mode.
2. In the Data Access tab, in the Data Providers subtab, click Edit.
3. In the Query Panel, underneath Universe Outline, select Display by Navigation Paths from the Master Perspective dropdown list.

### 3.14.3 Prompt when drill requires additional data option

When you drill the results displayed on a report, you may want to drill to higher- or lower-level information that isn’t included in the scope of analysis for the document. A new query is required to retrieve this data.

Since queries on large selections of data may take a long time to be completed, you can choose to be prompted with a message every time a new query is necessary. The prompt message asks you whether you want to run the additional query or not. In addition, the prompt lets you apply filters to the extra dimensions you include in the new query. This means you can restrict the size of the query to only the data necessary for your analysis.

You need permission from the BI administrator to drill out of the scope of analysis.

### 3.14.4 Setting drill options

Before you begin a drill session, you can set your drill options to specify how reports will change each time you drill.

How you set the drill options depends on the interface you are using:

- BI launch pad, if you are using the Web Intelligence HTML or Web Intelligence Applet interface or Web Intelligence Rich Client.
• Your computer, if you are using Web Intelligence Rich Client from the BI platform deployment on your computer.

**Related Information**

**To set drill options in the BI launch pad** [page 239]
You can configure drill options for Web Intelligence in the BI launch pad preferences.

**To set drill options in Web Intelligence Rich Client** [page 239]
You can configure drill options in a document.

**Synchronize drill on report blocks option** [page 240]
When you select the **Synchronize drill on report blocks** option for Web Intelligence in the BI launch pad preferences, the display of all blocks changes to correspond with your drill actions.

**Hide Drill toolbar on startup option** [page 240]
When you drill on a value displayed on a report, the **Drill** toolbar appears and displays the value on which you drilled.

**Start drill session on existing report option** [page 241]
You can activate the ability to drilling in Web Intelligence documents via the BI launch pad preferences.

**Start drill session on a duplicate report option** [page 241]
You can activate the ability to drilling in duplicate reports in Web Intelligence documents via the BI launch pad preferences.

### 3.14.4.1  To set drill options in the BI launch pad

You can configure drill options for Web Intelligence in the BI launch pad preferences.

1. In the BI launch pad, click **Preferences**.
2. In the **Web Intelligence** section, select the drill options under **Drill options** and **Start drill session**.

### 3.14.4.2  To set drill options in Web Intelligence Rich Client

You can configure drill options in a document.

1. In the Web Intelligence Rich Client, click ➤ **Properties ➤ Application** ➤ **Application**.
2. Click **Tools**, and select **Options** from the menu in the top corner next to the Help menu to display the **Options** dialog box.
3. Select the **Drill** tab.
4. Select the drill options.
3.14.4.3 Synchronize drill on report blocks option

When you select the Synchronize drill on report blocks option for Web Intelligence in the BI launch pad preferences, the display of all blocks changes to correspond with your drill actions.

For example, if you drill down on a block from year to quarter, and your report also contains a chart showing data by year, the chart display also changes to display data by quarter.

If you do not select the option, only the structure of the drilled block changes. Drill filters are applied to the whole report.

Synchronizing drill across multiple tables and charts

A report can contain several tables or charts. The generic term used to refer to tables and charts in this guide is a block. There are two ways to drill on a report with multiple blocks:

- Drill simultaneously on each block in the report the contains the drilled dimension
- Drill on only the current block of data

You set how drill is performed on reports with the Synchronize drill on report blocks option.

If synchronize drilling across all blocks in a report, you drill on each block in the report containing that drilled dimension. The next dimension in the drill path replaces the previous dimension in all blocks in the report.

If you do not synchronize drilling across all blocks in a report, the next dimension in the drill path replaces the previous dimension only in the current block in the report.

3.14.4.4 Hide Drill toolbar on startup option

When you drill on a value displayed on a report, the Drill toolbar appears and displays the value on which you drilled.

The value displayed on the toolbar filters the results displayed on the drilled report.

For example, if you drill on year 2010, the results displayed on the drilled table are Q1, Q2, Q3, and Q4 for year 2010. This means that the quarterly values you drilled to are filtered by 2001.

The Drill toolbar allows you to select alternative values on the same level, in order to filter the results differently. For example, if you use the Drill toolbar illustrated above to select “2002,” the results displayed on the drilled table would be Q1, Q2, Q3, and Q4 for year 2002.

In the Web Intelligence section of the BI launch pad Preferences, you can select Hide Drill toolbar on startup to hide the Drill toolbar when you start the drill mode. The Drill toolbar is only useful if you want to select filters during your drill session.
3.14.4.5  Start drill session on existing report option

You can activate the ability to drilling in Web Intelligence documents via the BI launchpad Preferences.

In the Web Intelligence section of the BI launch pad Preferences, select Start drill session on existing report so that the current report becomes drillable when you start drill mode. When you end drill mode, the report displays the drilled values.

3.14.4.6  Start drill session on a duplicate report option

You can activate the ability to drilling in duplicate reports in Web Intelligence documents via the BI launchpad preferences.

In the Web Intelligence section of the BI launch pad Preferences, select Start drill session on duplicate report to drill on a duplicate of the current report when working in drill mode. This allows you to compare the results of the original report with the results you discover during your drill analysis.

3.14.5  To switch to drill mode

To start drilling on a report you either switch to Drill mode or, if the report is saved in Drill mode, drill directly.

1. In a Web Intelligence document in Design mode, select the report you want to drill.
2. In the Analysis tab, in the Interact subtab, select Start Drill from the Drill dropdown list.

By default, a drill icon appears on the tab of the drillable report. Depending on the drill options you selected in the BI launch pad Preferences page, either the selected report becomes drillable or a drillable duplicate of the selected report is created.

Related Information

Start drill session on a duplicate report option [page 241]

You can activate the ability to drilling in duplicate reports in Web Intelligence documents via the BI launchpad preferences.
3.14.6 To choose a drill path when more than one is available

A dimension can belong to multiple hierarchies. When you drill down on such a dimension value, it is not clear which drill path to follow. You must define the drill path.

**Note**
If the dimension value you choose to drill on is the result of a previous drill, the drill path is already known. Therefore you do not need to select a drill path.

1. Open a Web Intelligence document in **Design** mode.
2. In the **Analysis** tab, in the **Interact** subtab, select **Start Drill** from the **Drill** dropdown list.
3. Drill on the dimension.
   - The **Select Drill Path** dialog box appears. The dialog box lists the dimensions in the hierarchy above and below the drilled value. A check box appears next to each dimensions below the current dimension you are drilling, so that you can select which of these dimensions you want to retrieve from the database. The dialog box also displays the filters that you can select to filter the new query.
4. Select the path you want to drill.
5. Click **OK**.

3.14.7 To take a snapshot of report drill results

You can create a report in the existing document that contains the results of a drill action.

1. Open a Web Intelligence document in **Reading** or **Design** mode.
2. Activate the Drill mode:
   - If you are in **Reading** mode, select **Start Drill Mode** from the **Drill** dropdown list.
   - If you are in **Design** mode, go to the **Analysis** tab, and in the **Interact** subtab, select **Start Drill Mode** from the **Drill** dropdown list.
3. Do one of the following:
   - If you are in **Reading** mode, select **Snapshot** from the **Drill** dropdown list.
   - If you are in **Design** mode, go to the **Analysis** tab, and in the **Interact** subtab, select **Snapshot** from the **Drill** dropdown list.

3.14.8 Drilling on measures in tables and sections

When you drill on a measure value, you drill one level down for each related dimension in the block, and you see the measure calculated for the displayed dimensions.

**Example**

**Drill on annual sales revenue results to see the breakdown by city and quarter**

For example, you drill down on the year 2003 sales revenue value for California, which is displayed on a crosstab that shows sales revenue by year and by state.
3.14.9 Drilling on dimensions in tables and sections

When you drill on a dimension to see the more data behind the displayed result, it is calculated according to the values to which you drill.

Dimensions typically represent character data, such as customer or business names, and dates. Calculations are based around the dimensions in a report. For example, a report calculates a region’s total sales revenue for a given year where a Sales Revenue measure is calculated based on the State and Year dimensions.

If you drill on Year, you display sales revenue by state and quarter, because Quarter is the next dimension in the time hierarchy below Year.

i Note
Detail objects cannot be drilled on in reports.

3.14.9.1 Drilling down on report data

You can drill down to see the lower-level data that makes up the summary results displayed on reports. This helps explain why high or low results occurred.

Example

Using drill analysis to find out why sales decreased dramatically in 2003

In this example, you receive a report that shows sales revenue results for the accessories line at the eFashion retail store. The following crosstab shows that the Accessories line decreased in 2003.

<table>
<thead>
<tr>
<th></th>
<th>2001</th>
<th>2002</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$2,546,222</td>
<td>$5,468,913</td>
<td>$1,899,405</td>
</tr>
</tbody>
</table>

To analyze more precisely when the decrease occurred, you drill down on the cell value 2003, to view the detailed data for each quarter.

<table>
<thead>
<tr>
<th></th>
<th>2001</th>
<th>2002</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$2,546,222</td>
<td>$5,468,913</td>
<td>$1,899,405</td>
</tr>
</tbody>
</table>

When you drill down on the cell value 2003, a filter appears in the Drill toolbar to show that the quarterly values you have drilled to are filtered for the year 2003. The drilled chart clearly shows that the problem arose in Q4 of 2003.
To find out which of the categories within the Accessories line was responsible for the drop in revenue, you drill down again on the cell value Accessories.

The drilled crosstab shows which categories were responsible for low revenue in Q4.

**Note**

If you try to drill to a dimension that is already displayed in another column or row of the same table, the next available dimension in the drill path is displayed.

### 3.14.9.1.1  To drill down on a value in a table or section cell

You can drill down on a measure value in a table or section in a report.

1. Open a Web Intelligence document in **Design** mode.
2. In the **Analysis** tab, in the **Interact** subtab, select **Start Drill** from the **Drill** dropdown list.
3. On a table or section cell, place your pointer over the dimension value on which you want to drill.
   A ToolTip appears, showing the next dimension in the drill path. If the drilled report includes dimensions from multiple data providers, the ToolTip displays the name of the query and the dimension for the value.
4. Right-click the cell and select **Drill**, then the drill direction.
   The drilled table or section displays data one dimension level down. The Drill toolbar, at the top of the report, displays the values from which you drilled. These values filter the values displayed on the drilled table.
3.14.9.2  Drilling up on report data

You can drill up on a dimension value to see how the more detailed data aggregates to a higher-level result.

For example, you may have drilled down on Year to examine data for each quarter. If you want to see how this data aggregates to yearly results, you can drill up.

When you drill up on a dimension value, you move along the drill path from lower to higher-level data. For example, you may have drilled down on [Year] to [Quarter]. If you drill up on [Quarter], you return to [Year].

You can only drill up on a dimension value if you have previously drilled down to that dimension, or you have defined the appropriate drill path in the scope of analysis.

3.14.9.2.1  To drill up on a dimension or measure value

You can drill up on a dimension or measure value in a table in a document.

1. Open a Web Intelligence document in Design mode.
2. In the Analysis tab, in the Interact subtab, select Start Drill from the Drill dropdown list.
3. On a table or section cell, do one of the following:
   - Right-click the cell and select Drill > Drill up.
   - Click the Drill Up icon next to the dimension value you want to drill up.

If the table is a crosstab without headers that display the names of the dimensions on the table, then the Drill Up icon appears next to each value from which you can drill up.

3.14.9.3  Drilling by other dimensions in a report

When you drill down or up, you move through a hierarchy one dimension at a time.

However, you can get another view of the data by slicing it in a different way, and then look at the data in other hierarchies. To do this, you drill by the other dimensions that interest you.
Note

You can only use **Drill by** with a dimension that is included in the scope of analysis of the document.

Example

**Drilling by the Products hierarchy to slice sales revenue results by product**

You work as regional manager for California in a retail clothing store, and have been sent the following report that shows quarterly sales revenue by state:

<table>
<thead>
<tr>
<th>Quarter</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>California</td>
<td>$519,220</td>
</tr>
<tr>
<td></td>
<td>Colorado</td>
<td>$131,797</td>
</tr>
<tr>
<td></td>
<td>DC</td>
<td>$206,324</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>$137,530</td>
</tr>
<tr>
<td></td>
<td>Illinois</td>
<td>$256,464</td>
</tr>
<tr>
<td></td>
<td>Massachusetts</td>
<td>$92,596</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>$555,983</td>
</tr>
<tr>
<td></td>
<td>Texas</td>
<td>$758,796</td>
</tr>
<tr>
<td>Q1</td>
<td><strong>Sum:</strong></td>
<td><strong>$2,660,699</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Average:</strong></td>
<td><strong>$332,587</strong></td>
</tr>
</tbody>
</table>

You are only interested in analyzing the results in the state of California. In addition, you want to analyze the sales revenue broken down by each product line you sell. To drill on California data, you place your pointer on the table cell that says California.

If you drilled down now, however, you would drill to results for each city within California, because [City] is the dimension below [State]. Instead, you select **Drill by** from the drill menu and then you navigate through the dimensions on the Products hierarchy by selecting the sub-menus until you reach the [Lines] dimension.

The drilled report displays the detailed sales revenue results for each product line sold in California.
3.14.9.3.1 To drill by a dimension value

You can drill by a measure value in a report table.

1. Open a Web Intelligence document in Design mode.
2. In the Analysis tab, in the Interact subtab, select Start Drill from the Drill dropdown list.
3. Right-click a dimension value in a table or section cell.
   The contextual menu appears, displaying the available drill paths.
4. Click Drill by.

   i Note
   If this option does not appear in the contextual menu, then the cell does not have lower levels of data.

5. Select the class to which you want to drill and then the dimension to which you want to drill.
   The report now displays data for the dimension to which you drilled.

Related Information

To take a snapshot of report drill results [page 242]
You can create a report in the existing document that contains the results of a drill action.
3.14.10 Drilling on charts

Drilling down, up, or by on a chart, provides you with a graphical explanation for why summary results are particularly high or low.

You can drill on:

- dimensions – by drilling on chart axes or the chart legend
- measures – by drilling on the data bars or markers in the body of the chart

You cannot drill by dimensions on chart axes. However, you can drill by dimensions on chart legends.

Related Information

- **Drilling on axis legends** [page 251]
  You can drill on charts via the chart legend whenever the legend lists the dimensions displayed on the chart.

- **Drilling on dimensions via chart axes** [page 248]
  On 2D charts, you can drill on dimensions via the X Axis. On 3D charts, you can drill on dimensions via the X Axis and the Z Axis.

- **Drilling on measures in charts** [page 249]
  When you drill on measures, the drill occurs on each dimension displayed on the chart axes.

- **Restrictions when drilling measures on charts** [page 250]
  When you drill on charts that are not bar charts, the drill action might be performed only on certain dimensions instead of on all of the dimensions on the chart axes.

3.14.10.1 Drilling on dimensions via chart axes

On 2D charts, you can drill on dimensions via the X Axis. On 3D charts, you can drill on dimensions via the X Axis and the Z Axis.

Charts can contain one or multiple dimensions on a single axis. When an axis contains multiple dimensions, each possible combination of the dimension values appear on the axis (this is sometimes referred to as a cartesian product).

When you drill on an axis value with multiple dimensions, the drilled results are filtered by both dimensions.

3.14.10.1.1 To drill on a chart axis

You can drill down or up on a dimension value in a chart axis.

1. Open a Web Intelligence document in **Design** mode.
2. In the **Analysis** tab, in the **Interact** subtab, select **Start Drill** from the **Drill** dropdown list.
3. Do one of the following:
To drill down on the dimension value, click the value.
To drill up on the dimension value, right-click the value then select Drill Up.
To drill down on the dimension value, right-click the value then select Drill Down.
To drill by the dimension value, right-click the value then select Drill By.

Note
Drill By is not available if the axis has multiple dimensions.

3.14.10.2 Drilling on measures in charts

When you drill on measures, the drill occurs on each dimension displayed on the chart axes.

You can drill on the measures displayed on the following types of chart:

- bar charts – by drilling on the bars
- line and radar line charts – by drilling on the data markers
- pie chart – by drilling on the segments

The new measure calculations displayed on the bars or data markers on the drilled chart, correspond to the lower or higher-level dimensions to which you drilled. The chart axis labels display the names of the drilled dimensions.

Example

Analyze detailed information for the sales revenue measure on a chart

For example, this 3D bar chart displays values for the [State] dimension on the X Axis and displays values for the [Lines] dimension on the Z Axis. This means that the chart bars display values for sales revenue per state per line.

As the example below shows, when you drill down on the bar for “City Trousers” in “California”, you also drill down from [State] to [City] on the X Axis and from [Lines] to [Category] on the Y Axis.

The drilled chart displays sales revenue per city per category for the “City Trousers” clothing line.
3.14.10.2.1 To drill on a measure in a chart

You can drill down or up on a measure value in a chart.

1. Open a Web Intelligence document in Design mode.

2. In the Analysis tab, in the Interact subtab, select Start Drill from the Drill dropdown list.

3. Do one of the following:
   ○ To drill down on the measure value, click the bar or data marker.
   ○ To drill up on the measure value, right-click the bar or data marker, and then click Drill up.

On charts, each measure is represented by a bar (on bar charts) or by a data marker (on line charts and radar line charts).

3.14.10.2.2 Restrictions when drilling measures on charts

When you drill on charts that are not bar charts, the drill action might be performed only on certain dimensions instead of on all of the dimensions on the chart axes.

When you drill on measures in the following chart types, the drill action is performed only on the values in the axis legend:

- area charts – 2D, 3D, and stacked
- radar and scatter charts – all types

**Note**

You cannot drill on measures in 3D area charts.
3.14.10.3 Drilling on axis legends

You can drill on charts via the chart legend whenever the legend lists the dimensions displayed on the chart. However, when the chart legend lists the measures displayed on the chart, drilling on the legend is not possible.

Drilling on a legend is useful if you are working with a pie chart, because the axis labels, which display the names of the dimensions represented by each pie segment, are not often displayed.

i Note
You can only use Drill By on a chart legend if there is a single dimension on the axis.

3.14.10.3.1 To drill on an axis legend

You can drill down on a dimension value, or drill up or by a dimension value.

1. Open a Web Intelligence document in Design mode.
2. In the Analysis tab, in the Interact subtab, select Start Drill from the Drill dropdown list.
3. Do one of the following:
   - To drill down the dimension value, click the color associated with the value.
   - To drill up the dimension value, right-click the color associated with the value, then click Drill up.
   - To drill by the dimension value, right-click the color associated with the value, then click Drill by.

3.14.11 Using filters when you drill

When you drill on a dimension or measure value in a table or chart, the drilled results are filtered by the dimension or measure you drilled on.

The filter is applied to all of the results displayed on the drilled report.

Filters appear as list boxes in the Drill toolbar. Each list box contains the values associated with that filter. You select the data displayed in a table or chart by choosing the appropriate values from the list boxes.

i Note
You can also use the Drill toolbar outside drill mode to quickly add simple report filters to reports. In this context the toolbar is known as the Report Filter toolbar.

Example

Filtering drilled reports by different US states

For example, if you drill down on a table cell displaying “California” to view results for cities in California, you filter the values in the entire report for California and display results for California only in the report.

By changing the value of each filter, you can then see data for other values on the drilled dimension. For example, you can select Colorado in the filter on State.
Note

If the drilled report includes dimensions from multiple data providers, aToolTip appears when you rest your cursor on the value displayed on the filter. The ToolTip displays the name of the query and the dimension for the value.

Related Information

To create simple report filters  [page 274]

You can filter a report on the object value you select. For example, if you select "US" from the list of values of the Country object, the report is filtered to exclude all rows where Country does not have the value "US".

3.14.11.1  To add or remove a drill filter

You can add or remove a drill filter in a document.

1.  Open a Web Intelligence document in Design mode.
2.  In the Analysis tab, in the Interact subtab, select Start Drill from the Drill dropdown list.
3.  From the Available Objects list, drag the dimension containing the values around which you want to filter your report and drop it onto the Drill toolbar.
4.  A list box for the new filter appears on the Drill toolbar. You can select a value from the list of values to filter the results displayed on the drilled table, chart, or report.
5.  To remove a drill filter, drag the dimension away from the Drill toolbar.

3.14.12  Saving reports with drill filters

When you save a document with reports in Drill mode, filters generated during drill are saved with the document.

When you open a document saved in Drill mode, the Drill toolbar appears on the drilled reports and shows the filters generated during the last drill session.

Note

Documents saved in Drill mode take longer to open.
3.14.13 Refreshing data in a drilled report with prompts

When you refresh a document, a prompt can appear that requires you to specify the values you want to retrieve from the database and return to the reports in the document.

For example, a prompt can require you to specify a year for which you want to retrieve data. This drilled report shows values for Year 2003, the year selected for the prompt.

If the drilled report is filtered for Year 2003, and you then refresh the document and select year 2002 to answer the prompt, the report displays results for 2002 instead of 2003.

3.14.14 Drilling with query drill

When you activate query drill, you drill by modifying the underlying query (adding and removing dimensions and query filters) in addition to applying drill filters.

You use query drill when your report contains aggregate measures calculated at the database level. It is designed in particular to provide a drill mode adapted to databases such as Oracle 9i OLAP, which contain aggregate functions which are not supported in Web Intelligence, or which cannot be accurately calculated in the report during a drill session.

Query drill is also useful for reducing the amount of data stored locally during a drill session. Because query drill reduces the scope of analysis when you drill up, it purges unnecessary data.

Example

Drilling down from month to week

In this example, Month is the lowest dimension currently available in the query from a time hierarchy, and Week is the dimension immediately below it in the hierarchy.

If you drill down on Month = January, three things happen:

- Week is added to the scope of analysis.
- A query filter restricts Month to "January".
- A drill filter is added to restrict Month to "January".

If you drill up from Week to Month, the process is reversed:

- Week is removed from the scope of analysis.
- The query filter is removed.
- The drill filter is removed.

Note

Drill filters are not strictly necessary in query drill mode. They are applied for consistency with standard drill mode. For example, the DrillFilters function returns the correct value in query drill mode because a query drill applies drill filters to match the query filters.
3.14.14.1 Drilling down with query drill

When you drill down, query drill behaves similarly to standard drill at the point where the data moves outside the scope of analysis.

A drilled dimension is filtered in query drill mode by adding a query filter in addition to a drill filter. For example, if you drill on Year=2001, you add a query filter to restrict the Year dimension to 2001. For this reason, the only value that appears in the drill toolbar for the drilled dimension is the value on which you drilled (in this case 2001). This is different from standard drill mode, in which all values of the dimension are visible in the toolbar. As a result, you cannot change filter values in query drill mode (for example, drill on Year=2001 then switch to Year=2003) as you can in standard drill mode.

Because query drill automatically extends the scope of analysis, you can use it only if you have the right to drill outside the scope. Contact the BI administrator for more details.

3.14.14.2 Drilling up with query drill

When you drill up, query drill removes dimensions from the query.

For example, if you drill up from Month to Quarter, you remove Month from the query. This has two consequences:

- Query drill is incompatible with drill snapshots.
- You cannot drill up beyond any dimension that appears as one of the report objects. For example, if your report displays Year, Quarter and Revenue, you cannot drill up from Quarter to Year because this would remove quarter from the list of report objects.
In query drill mode, snapshots change when you drill up beyond a dimension that you included in a snapshot.

To take a snapshot of report drill results [page 242]
You can create a report in the existing document that contains the results of a drill action.

3.14.14.3 Query drill and drill snapshots

In query drill mode, snapshots change when you drill up beyond a dimension that you included in a snapshot.

Do not use drill snapshots when working in query drill mode, because query drill means that snapshots cannot be guaranteed to stay the same.

Because the drill up removes the dimension from the underlying query, it also removes the dimension from the snapshot.

Related Information

To take a snapshot of report drill results [page 242]
You can create a report in the existing document that contains the results of a drill action.

3.14.14.4 Query drill and other reports based on the same data provider

If your document contains other reports that contain dimensions on which you drill in query drill mode, these reports are affected because the query drill modifies the dimensions they contain.

You can avoid this (at the cost of retrieving duplicate data) by creating a new data provider and rebuilding the other report against it. Now when you drill in query drill mode, the other report remains unaffected.

Example

Drilling on a dimension that appears in another report

If you have two reports based on a query that contains Year, Quarter and Sales Revenue, and you use query drill to drill down to Year = 2001 on the first report, you also filter the data for Year in the second report to include 2001 only.
3.14.14.5 To activate query drill

If your report already has a scope of analysis defined, you see an error message telling you to clear the scope of analysis before activating query drill.

1. Open a Web Intelligence document in Design or Data mode.
2. In the Properties tab, click Document to display the Document Properties dialog box.
3. Select Use query drill.
4. Click OK to close the Document Properties dialog box.

Note

The Use query drill option is unavailable if there is a scope of analysis activated in the Query Panel.

Related Information

To set the scope of analysis [page 236]

You can set a scope of analysis on a document query in the Query Panel, in the Scope of Analysis Panel.

3.15 Formatting your reports using Cascading Style Sheets

Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

You can edit the CSS to apply a specific style to the presentation of documents. You can export the file, modify the styles according to your needs and then import the file back. You can also distribute the style sheet to other users as a standard style.

The Web Intelligence CSS conforms to the W3C CSS core syntax. However, the core syntax does not imply anything about property names, types and semantic. Web Intelligence CSS supports locale-specific style sheets.

Note

The CSS style sheet does not control the color of charts. There is a separate file for defining corporate palettes for charts.

Note

The Cascading Style Sheets are derived from the W3C CSS. In order to modify the CSS of your documents, you must be familiar with the CSS core syntax of the W3C. For more information, see http://www.w3.org.
Using a CSS allows you to:

- Define a company-wide style sheet in order to define standard settings (such as a company logo).
- Define different styles to present a specific type of information. For example, you can use one color for products sold, another color for expenses and another color for revenues.
- Create a style sheet in order to encode personal preferences.
- Personalize the presentation of the documents you create.

**Related Information**

*Formatting the report layout* [page 192]

You can format your report and report elements in order to present the report with a company style.

*Creating a corporate palette for charts* [page 381]

You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called `VisualizationConfig.xml`. You can only define one corporate palette, and the palette ID must not be changed.

*Formatting tables and table cells* [page 299]

In Web Intelligence, you can define several visual aspects of tables and cells in reports.

### 3.15.1 Using a Cascading Style Sheet in documents

When you create a report or a report element in a Web Intelligence document, the formatting is entirely based on the default style.

If specific formatting is done on these elements by the user from the Right-click context menu (*Format* option), the modified properties overwrite locally the values taken from the default style.

To remove this specific formatting, right-click the report and select *Format ➤ Clear Format*.

### 3.15.2 Modifying the document default style

The document default style is stored in a Cascading Style Sheet (CSS) file that is embedded into the document itself.

- To modify the default style, you can export the CSS file. To export a CSS file, in the *Properties* tab, click *Document ➤ Change Default Style ➤ Export Style*.
- You can use any text editor to edit a CSS file. Once you have edited the file, save and import it to apply the changes.

**Note**

You have to import the CSS file every time you edit it.
To import a CSS file, in the Properties tab, click Document Change Default Style Import Style. The CSS file you import is applied to the report.

- To apply a CSS to an element that has already been formatted through the user interface, you have to clear its format. To clear the format of an element, right-click the element and select Format Clear Format.
- To clear the format of all the elements in a page, right-click the report body and select Format Clear Format.

**Note**

You have to clear the format of the header and footer manually because they are not a part of the report body.

- You can undo changes at any time by clicking the Undo button.
- To restore the default CSS, in the Properties tab, click Document Reset standard Default Style.

### 3.15.3 Modifying and using the standard default style

The standard CSS file is named WebIDefaultStyleSheet.css.

This standard CSS file is located by default at:

c:\Program Files(x86)\SAP BusinessObjects Entreprise XI\images \WebIDefaultStyleSheet.css

When you create a 4.X document, or when you edit a Web Intelligence 3.1 document for the first time, the standard CSS is embedded into the Web Intelligence document to become the document style. This default style document diverges from the standard and can be locally modified.

To reset the document default style to the standard style, in the Properties tab, click Document Reset standard Default Style. The standard CSS will replace the previous CSS in the document.

To publish a standard default file, you must have access to the ../images/ folder of your servers and Web Intelligence Rich Client installations to put a new version of WebIDefaultStyleSheet.css.

### 3.15.4 Web Intelligence CSS syntax

The Web Intelligence CSS conforms to the W3C CSS core syntax. However, the core syntax does not imply anything about property names, types and semantic.

Web Intelligence CSS supports locale-specific style sheets.
Related Information

http://www.w3.org/TR/CSS21/syndata.html

3.15.4.1 Cascading Style Sheet elements

In order to modify the way your document is displayed, you have to modify the Web Intelligence CSS elements of the document.

To modify an element, you have to modify its properties.

This table shows the elements you can edit in the CSS file:

<table>
<thead>
<tr>
<th>Element</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPORT</td>
<td>Tag that contains the report</td>
</tr>
<tr>
<td>PAGE_BODY</td>
<td>Tag that contains the page</td>
</tr>
<tr>
<td>PAGE_HEADER</td>
<td>Tag that contains the area on top of the PAGE_BODY</td>
</tr>
<tr>
<td>PAGE_FOOTER</td>
<td>Tag that contains the area in the bottom of the PAGE_BODY</td>
</tr>
<tr>
<td>SECTION</td>
<td>Tag that contains an area inside the PAGE_BODY</td>
</tr>
<tr>
<td>TABLE</td>
<td>Tag that contains a table</td>
</tr>
<tr>
<td>VTABLE</td>
<td>Tag that modifies a table vertically</td>
</tr>
<tr>
<td>HTABLE</td>
<td>Tag that modifies the table horizontally</td>
</tr>
<tr>
<td>COLINFO</td>
<td>Tag that contains the columns of a table</td>
</tr>
<tr>
<td>ROWINFO</td>
<td>Tag that contains the rows of a table</td>
</tr>
<tr>
<td>CELL</td>
<td>Tag that contains the cells of a table</td>
</tr>
<tr>
<td>AXIS</td>
<td>Tag that defines the relationship between the columns and rows of a table</td>
</tr>
<tr>
<td>FORM</td>
<td>Tag that contains a form</td>
</tr>
<tr>
<td>XELEMENT</td>
<td>Tag that contains a graphic</td>
</tr>
<tr>
<td>BAG</td>
<td>Tag that contains elements and places them relatively using X and Y</td>
</tr>
<tr>
<td>WOB</td>
<td>Tag that contains elements and places them automatically</td>
</tr>
</tbody>
</table>

3.15.4.2 Cascading Style Sheet properties

For many properties, Web Intelligence CSS uses the same names as the W3C CSS.

Some property names change and some are ignored.
Example

Web Intelligence CSS uses the property `min-width` and the W3C CSS uses the property `width`. Both properties have the same use.

Related Information

For CSS 2.1

For CSS 3

3.15.4.2.1 Report page properties

For cascading style sheets, you can edit the following report page properties.

This table shows the properties that can be applied to the element `REPORT`:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>page-format-dimension-height</td>
<td>Height of page</td>
<td>42094</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-dimension-width</td>
<td>Width of page</td>
<td>29764</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-margin-bottom</td>
<td>Size of the bottom margin of the page</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-margin-left</td>
<td>Size of the left margin of the page</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-margin-right</td>
<td>Size of the right margin of the page</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-orientation</td>
<td>Orientation of page</td>
<td>portrait</td>
<td>landscape, portrait</td>
</tr>
<tr>
<td>page-records-horizontal</td>
<td>In Quick Display mode, specifies how many data records can be horizontally displayed before triggering a page break</td>
<td>150</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-records-vertical</td>
<td>In Quick Display mode, specifies how many data records can be vertically displayed before triggering a page break</td>
<td>50</td>
<td>Numeric value</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
<td>Default value</td>
<td>Value range</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>page-scaling-factor</td>
<td>Zoom percentage</td>
<td>100</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-scaling-tall</td>
<td>When this property is defined, the report will be scaled so that it fits in the given height</td>
<td>100</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-scaling-wide</td>
<td>When this property is defined, the report will be scaled so that it fits in the given width</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-target-mode</td>
<td>Pagination mode: quick display or not</td>
<td>undefined</td>
<td>undefined, quick, all</td>
</tr>
</tbody>
</table>

### 3.15.4.2.2 Report element properties

For cascading style sheets, you can edit the properties in report elements.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>autofit-height</td>
<td>Specifies whether the height of the element can be adjusted to fit its content</td>
<td>yes</td>
<td>yes/no</td>
</tr>
<tr>
<td>autofit-width</td>
<td>Specifies whether the width of the element can be adjusted to fit its content</td>
<td>yes</td>
<td>yes/no</td>
</tr>
<tr>
<td>bookmark</td>
<td>Specifies whether the element will be bookmarked</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>h-align</td>
<td>Horizontal positioning of the element</td>
<td>none</td>
<td>none, top, center, bottom</td>
</tr>
<tr>
<td>hide</td>
<td>Specifies whether the element is hidden</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>min-height</td>
<td>Minimal height of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>min-width</td>
<td>Minimal width of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>never-alternate</td>
<td>This property can be used to avoid the application of the alternate style on the element</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>padding-bottom</td>
<td>How much space to put between the bottom border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>padding-left</td>
<td>How much space to put between the left border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
<td>Default value</td>
<td>Value range</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>padding-right</td>
<td>How much space to put between the right border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>padding-top</td>
<td>How much space to put between the top border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>struct-min-height</td>
<td>Minimal height of the element when displayed in structure mode</td>
<td>900</td>
<td>Numeric value</td>
</tr>
<tr>
<td>struct-min-width</td>
<td>Minimal width of the element when displayed in structure mode</td>
<td>4050</td>
<td>Numeric value</td>
</tr>
<tr>
<td>v-align</td>
<td>Vertical positioning of the element</td>
<td>none</td>
<td>none, top, center, bottom</td>
</tr>
</tbody>
</table>

These properties can be applied to the following elements:

- BAG
- WOB
- CELL
- VTABLE
- HTABLE
- XTABLE
- TABLE
- XELEMENT
- SECTION

### 3.15.4.2.3 Formatting properties

For cascading style sheets, you can edit the Formatting elements.

This table shows the properties that you can edit to modify the Formatting elements:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>background-color</td>
<td>Color to be displayed in background</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>background-fill</td>
<td>Describes what will be displayed in background</td>
<td>none</td>
<td>color, bitmap, bitmapAndColor, skin, none</td>
</tr>
<tr>
<td>background-h-align</td>
<td>Horizontal position of the background image</td>
<td>center</td>
<td>left, center, right</td>
</tr>
<tr>
<td>background-image</td>
<td>Image to be displayed in background</td>
<td>None</td>
<td>Any image you want</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
<td>Default value</td>
<td>Value range</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------</td>
<td>---------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>background-inner-height</td>
<td>Inner height of background</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>background-inner-width</td>
<td>Inner width of background</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>background-type</td>
<td>Determines how the background image will be laid out or repeated</td>
<td>box</td>
<td>box, tile, vtile, htile, stretch</td>
</tr>
<tr>
<td>background-v-align</td>
<td>Vertical position of the background image</td>
<td>center</td>
<td>top, center, bottom</td>
</tr>
<tr>
<td>border-bottom-color</td>
<td>Color of an element’s bottom border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-bottom-style</td>
<td>Style of an element’s bottom border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-bottom-width</td>
<td>Width of an element’s bottom border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>border-left-color</td>
<td>Color of an element’s left border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-left-style</td>
<td>Style of an element’s left border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-left-width</td>
<td>Width of an element’s left border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>border-right-color</td>
<td>Color of an element’s right border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-right-style</td>
<td>Style of an element’s right border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-right-width</td>
<td>Width of an element’s right border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>border-top-color</td>
<td>Color of an element’s top border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-top-style</td>
<td>Style of an element’s top border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-top-width</td>
<td>Width of an element’s top border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>color</td>
<td>Foreground color</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>default-date-h-align</td>
<td>Default horizontal alignment when a date is being displayed</td>
<td>right</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
<td>Default value</td>
<td>Value range</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------</td>
<td>---------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>default-numeric-h-align</td>
<td>Default horizontal alignment when a numeric value is being displayed</td>
<td>right</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>default-text-h-align</td>
<td>Default horizontal alignment when a text is being displayed</td>
<td>left</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>font-family</td>
<td>Name of font family</td>
<td>default</td>
<td>Web Intelligence-supported fonts</td>
</tr>
<tr>
<td>font-orientation</td>
<td>Describes the orientation of the displayed text</td>
<td>normal</td>
<td>normal, hotel, 45D, 90D, 180D, 270D, 315D</td>
</tr>
<tr>
<td>font-size</td>
<td>Size of the displayed font</td>
<td>0</td>
<td>Numeric value in points (pt.)</td>
</tr>
<tr>
<td>font-style-italic</td>
<td>Activates the italic font style</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>font-weight-bold</td>
<td>Activates the bold font style</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>text-align</td>
<td>Horizontal alignment of the text</td>
<td>left</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>text-decoration-line-through</td>
<td>Activates the line-through text decoration</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>text-decoration-underline</td>
<td>Activates the underline text decoration</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>text-v-align</td>
<td>Vertical alignment of the text</td>
<td>bottom</td>
<td>top, center, bottom</td>
</tr>
<tr>
<td>text-wrap</td>
<td>Specifies whether the text may be wrapped</td>
<td>no</td>
<td>yes/no</td>
</tr>
</tbody>
</table>

These properties can be applied to the following elements:

- BAG
- WOB
- CELL
- VTABLE
- HTABLE
- XTABLE
- TABLE
- XELEMENT
- SECTION

### 3.15.4.2.4 Spacing properties

For cascading style sheets, you can edit the spacing element properties.

This table shows the properties that you can edit to modify the spacing elements:
<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>h-spacing</td>
<td>Horizontal spacing of children</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>v-spacing</td>
<td>Vertical spacing of children</td>
<td>0</td>
<td>Numeric value</td>
</tr>
</tbody>
</table>

These properties can be applied to the following elements:

- BAG
- WOB

### 3.15.4.2.5 Hyperlink properties

For cascading style sheets, you can edit the hyperlink elements.

This table shows the properties that you can edit to modify the hyperlink elements:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>active-color</td>
<td>Color of hyperlinks when they are being activated</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>ahover-color</td>
<td>Color of hyperlinks when the user designates it (by a pointing device)</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>link-color</td>
<td>Color of hyperlinks</td>
<td>#0000ff</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>visited-color</td>
<td>Color of visited hyperlinks</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
</tbody>
</table>

These properties can be applied to the following elements:

- BAG
- WOB
- CELL
- VTABLE
- HTABLE
- XTABLE
- TABLE
- XELEMENT
- SECTION

### 3.15.4.2.6 Break properties

For cascading style sheets, you can edit the break element properties.

This table shows the properties that can be applied to the BREAK element:
### 3.15.4.3 Cascading Style Sheet units

Numeric values can be very important in Cascading Style Sheet units.

#### Numeric values in fonts

When you assign a numeric value to the property `font-size`, you can only use the unit "points" (pt).

For example: `font-size : 14pt;`

#### Numeric values in dimension properties

When you assign a numeric value to any other dimension property, you can use centimeters (cm), inches (in) or "metric" (without any unit).

`width : 1.0in;` would be the same as `width : 2.54cm;` and the same as `width : 3600;`

### 3.15.5 Style and 3.x documents

When you open a Web Intelligence 4.x document with a Web Intelligence 3.x format, the style of the document does not change, regardless of the style defined in the standard CSS.

However, the style used while creating report elements or during `Turn into` operations will come from the CSS.

The Web Intelligence CSS replaces the old way of personalizing your documents.

To set the default style defined by the report elements in the document, select the report elements and go to `Format` > `Clear Format`. The formatting of the selected objects will be cleared and the default style will be applied.

The `DefaultConfig.xml` file used in the previous versions is obsolete.

Here are some correspondances between the entries of Web Intelligence CSS and the obsolete entries of the `DefaultConfig.xml` file used in previous versions.
3.16 Filtering report data

3.16.1 Filtering report data

You can filter reports to limit the displayed results.

For example, you can limit the displayed results to information for a specific customer or a sales period. The data you filter out remains in the document; it is simply not displayed in the report tables or charts. This means you can change or remove report filters in order to view the hidden values, without modifying the query behind the document.

You can apply different filters to different parts of a report. For example, you can limit the results in the entire report to a specific product line and then limit results in a table or chart further to focus on results for a specific region or customer profile.

To create a report filter, you need to specify the following elements:

- a filtered object
- an operator
- filter values
- the report element to be filtered (the whole report, sections, or blocks)

In the Side Panel, click the “Document Structure and Filters” tab, to see the structure of the document and the report elements that are filtered by operator and value.

Related Information

*Using report filters in report sections* [page 332]

You can apply report filters to sections using values in the section header or that appear within the section.
3.16.1.1 Query filters and report filters compared

You can apply filters at two levels within a document. Query filters are defined on the query; they limit the data retrieved from the data source and returned to the document. Report filters limit the values displayed on reports, tables, charts, sections within the document, but they don’t modify the data that is retrieved from the data source; they simply hide values at the report level.

**i Note**
The List of Values option [EMPTY_VALUE] appears in your filter when NULL values are present in your query. You can use [EMPTY_VALUE] only when filtering on queries, not when filtering on reports to remove or find NULL values. Certain calculations, such as an average, can be inaccurate if NULL columns are included.

3.16.1.2 Report filter operators

3.16.1.2.1 Equal to operator

Use the Equal to operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal to US".

**i Note**
This operator cannot be used for OLAP universe parent-child hierarchies or for BEx queries.

3.16.1.2.2 Not Equal to operator

Use the Not Equal to operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter "County Not Equal to US".

**i Note**
This operator cannot be used for OLAP universe parent-child hierarchies or for BEx queries.

3.16.1.2.3 Greater than operator

Use the Greater than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter "[Customer Age] Greater than 60".

**i Note**
This operator cannot be used for OLAP universe parent-child hierarchies or for BEx queries.
3.16.1.2.4 Greater than or Equal to operator

Use the Greater than or equal to operator to retrieve data greater than or equal to a value.

For example, to retrieve data for revenue starting from $1.5M, create the filter “[Revenue] greater than or equal to 1500000”.

Note
This operator cannot be used for OLAP universe parent-child hierarchies or for BEx hierarchies.

3.16.1.2.5 Less than operator

Use the Less than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter “[Exam Grade] less than 40”.

Note
This operator cannot be used for OLAP universe, hierarchies in filters, or for hierarchies in BEx queries.

3.16.1.2.6 Less than or Equal to operator

Use the Less than or equal to operator to retrieve data less than or equal to a value.

For example, to retrieve data for customers whose age is 30 or less, create the filter “[Age] less than or equal to 30”.

Note
This operator cannot be used for OLAP universe, hierarchies in filters or for hierarchies in BEx queries.

3.16.1.2.7 Between operator

Use the Between operator to retrieve data between two boundary values including the two boundary values.

The first value declared must be lower than the second value.

For example, to retrieve data for weeks starting at week 25 and finishing at 36 (including week 25 and week 36), create the filter “[Week] between 25 and 36”.

Note
This operator cannot be used for OLAP universe or BEx hierarchies in filters.
### 3.16.1.2.8 Not between operator

Use the Not between operator to retrieve data outside the range of two values.

For example, to retrieve data for all the weeks of the year, except for and not including weeks 25 through 36, create the filter “[Week] Not between 25 and 36”.

**Note**

This operator cannot be used for OLAP universe or for BEx hierarchies in filters.

### 3.16.1.2.9 In list operator

Use the In list operator to retrieve data corresponding to values in a list of values.

For example, to retrieve data only for the US, UK and Japan, create the filter [Country] In list, when you can type values in the Type a value field, you enter US;UK;Japan.

When used in a query filter with a hierarchical list of values, either from a dimension associated with a hierarchical list of values or a hierarchy object, In list allows the selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the In list operator allows the selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

When used in a report filter, In list produces a flat list of values.

### 3.16.1.2.10 Not In List operator

Use the Not in list operator to retrieve data that does not correspond to multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan, create the filter “[Country] Not in list”. In the Type a value field, you enter US;UK;Japan.

When used with a hierarchical list of values, either from a dimension associated with a hierarchical list of values, a hierarchy object or a level object, Not in list allows the selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the Not in list operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

**Note**

This operator can only be used in certain types of hierarchies, for example, it can be used in level-based hierarchies.
3.16.1.2.11  IsNull operator

Use the IsNull operator to retrieve data for which there are no values in the database.

For example, to retrieve customers without children (the children column in the database has no value), create the filter [Children] IsNull.

3.16.1.2.12  Is not Null operator

Use the Is not Null operator to return data for which there is a value in the database.

For example, to return customers with children, create the filter [Children] Is not Null.

3.16.1.3  Types of report filter

Report filters are filters that can be applied on different report elements: report, section, table, graph.

There are two types of report filter:

- Standard report filters.
  Standard report filters are the most flexible type of report filter. They can use any filter operator and can filter on single values or lists of values.

- Simple report filters.
  Simple report filters provide an easy way to create filters using the Equal to operator. They can filter on single values only, and are applied to a whole report (not an entire document or report element).

3.16.1.4  To create, edit, and delete standard report filters

You can work with report filters in the Report Filter dialog box.

1. In a Web Intelligence document in Design mode, select the report element you want to filter.
2. In the Analysis tab, select the Filters subtab.
3. From the Filter dropdown list, select Add filter.
4. Click Add filter in the Report Filter dialog box to display the objects you can filter.
5. In the Available objects panel, select the objects you want to filter and click OK.

   If you selected more than one object, the filtered objects appear in an AND relationship. Double-click the AND operator to change it to OR.

6. For each filter, select the filter operator from the list.
7. Type values directly in the box above the list of values of the object, or select values from the list and click > to add them to the list of filtered values.

   The values you can type or select depend on the operator. For example, if you select the Equal to operator, you can type or select one value only.
If the filtered object is a hierarchy, the values are displayed hierarchically. All members of the hierarchy are visible even if they are collapsed in the report. You must select hierarchy members from the hierarchy; you cannot type them manually. All member values that have been selected in the Query Panel are displayed in gray and can’t be selected if they are not in the final report because they are not linked to any measures. To help you select the right values, you can also click the key icon to see both the text and key ID value for the members.

If the filtered object is a level, the values are displayed in a list. It is not possible to type the values.

8. Click OK to apply the report filter to the element.

9. To edit a report filter, select the report element and select Edit Filter from the Filter dropdown list and edit the filter using the dialog box. Click OK to return to the document.

10. To delete a report filter, select the report element and select Remove Filter from the Filter dropdown list.

You use this to remove all filters for the selected report element. To remove only one filter, click Edit Filter and in the Report Filter dialog box, select the filter and click the Remove icon.

3.16.1.4.1 To select values from a list of values

When selecting from a list of values in a query, items in the list can appear either as a single or multi-column list or a hierarchy, depending on the object.

In a multi-column list, additional columns provide related values to the main value. In a hierarchical list, values appear in a hierarchical relationship.

When you refresh a report with prompts, lists of values for the prompts appear in a flat list without multiple columns.

1. In a list of values, select items that you want to appear.

   ○ If the list of values does not appear when a dialog box opens, refresh the list, or search the list to retrieve values. Some list of values require an initial search to display values because the list is too large to be loaded in full.

   ○ If the list of values is divided into ranges, use the control above the list to navigate through the ranges. Some large lists of values are divided into ranges to reduce the amount of data retrieved from the database. When you select a range, the list displays the values in that range.

   ○ If the list of values depends on other lists of values, specify the dependent values in the prompt dialog box that appears. A list of values can be dependent on other lists of values, for example when it is part of a hierarchical list of values. For example, if the list of values contains cities, and the City object is part of the hierarchy Country > Region > City, you need to specify values for country and region first to filter the list of cities.

When you first display the list of values, you see the Prompts dialog box in which you specify the dependent values. Once you have specified the dependent values, you can select the values from the filtered list.
To display the value keys in OLAP or BEx queries, click *Show/hide key values*. Key values are not indicated in the list of *Selected Values*, only in the list of available values. Some lists of values contain key values, which are unique values that can be used to identify values with the same display value. If the list of values contains multiple columns, only the key of the filtering column is displayed.

To search for values in the list, type the search text in the box below the list and select one of the following options from the *Search* icon dropdown list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match case</td>
<td>The search is case-sensitive.</td>
</tr>
<tr>
<td></td>
<td>This option is not available when the <em>Search in keys</em> or <em>Search on database</em> options are selected.</td>
</tr>
<tr>
<td>Search in keys</td>
<td>The search uses unique value keys rather than display values.</td>
</tr>
<tr>
<td></td>
<td>This option is available only in lists of values that support key values.</td>
</tr>
<tr>
<td>Search on database</td>
<td>The search includes all values stored in the database rather than being restricted to the values loaded into the list. It improves search accuracy but reduces search speed.</td>
</tr>
<tr>
<td></td>
<td>This option is available only in lists of values that support database searches.</td>
</tr>
<tr>
<td></td>
<td>Database searching improves search accuracy at the cost of performance.</td>
</tr>
<tr>
<td></td>
<td>It is useful when not all values in the list of values were retrieved.</td>
</tr>
<tr>
<td></td>
<td>This can happen when the total number of values in the list exceeds the <em>Max rows retrieved</em> query property.</td>
</tr>
<tr>
<td></td>
<td>Database searching is particularly useful when the list of values is hierarchical because values are loaded from the database only in response to their parent value being expanded in the hierarchy. For example, in a geographical hierarchy, the child values of the California value (cities in California) are not loaded from the database until the value is expanded. If the option is selected, the search includes these items even when the California value has not been expanded.</td>
</tr>
</tbody>
</table>

The search includes all ranges if the list of values is divided into ranges.

In search patterns, the "*" wildcard represents any string of characters and the "?" wildcard represents any single character. For example, the value "March" can be returned by the search patterns "M*" or "Mar?h". To include the "*" and "?" characters literally rather than as wildcards, precede them with "\" in the search pattern.

Type values from the list directly if the list supports direct data entry or select values from the list.

2. Click *OK* or *Run Query*, as applicable.

**Related Information**

*Max rows retrieved query property* [page 73]
The Max rows retrieved query property determines the maximum number of rows of data that are displayed when a query is run.

Selecting prompt values in the Prompts dialog box [page 278]
When you open or refresh a document with prompts, the Prompts dialog box appears.

3.16.1.5 Using simple report filters

Simple report filters filter information in an open Web Intelligence report, not in the document or in specific objects in the report.

The Report Filter toolbar provides a quick method for adding simple report filters to reports.

You can filter on the following objects in a report:

- Dimension or detail objects
- Hierarchies, characteristics or attributes for OLAP universes or BEx queries (but not at the hierarchy level or on measures)

Simple report filters can only use the Equal to operator and can only filter on a single value. They can use the All values operator.

Related Information

To create simple report filters [page 274]
You can filter a report on the object value you select. For example, if you select "US" from the list of values of the Country object, the report is filtered to exclude all rows where Country does not have the value "US".

3.16.1.5.1 To create simple report filters

You can filter a report on the object value you select. For example, if you select "US" from the list of values of the Country object, the report is filtered to exclude all rows where Country does not have the value "US”.

1. Open a Web Intelligence document.
2. Do one of the following:
   - In the Reading mode, click Filter Bar.
   - In Design mode, in the Analysis tab, select the Interact subtab and click Filter Bar.

The Report Filter toolbar appears.

Note

When opening the filter bar, filters are automatically inserted when their report scopes are:

- Single value (Equal to operator)
- With the All Values operator
Those filters are no longer displayed in the Filter box.

**Note**
When collapsing the *Report Filter* toolbar, all "simple filters" are put back as *Equal to* or *All values* report filters that filter on the entire report. To avoid creating *All values* filters, remove the object from the filter bar before you collapse it.

3. Click the *add simple report filter* icon on the toolbar and select the object on which you want to filter from the menu.
   You can add multiple objects to the toolbar to create multiple filters.

**Note**
Depending on the data sources and selected objects, the values or objects available in a filter may depend on the values set in another filter object.

4. Select the value on which you want to filter from the dropdown list of values.

**Note**
For non-hierarchical objects, the list contains all values contained in the report for this object after applying all other report scope filters. For example if you have an *In List* filter reducing this object values, you will have this list of values for the filter bar *Equal to* filter.

For hierarchical objects, the list contains the flat list of all member values at any level. This list is in tree view order, not alphabetical order.

**Tip**
In the Web Intelligence Applet interface, or in Web Intelligence Rich Client, you can drag objects from the tree view to the *Report Filter* toolbar.

To remove a filter:
- In the Web Intelligence HTML interface in *Reading* or *Design* mode, from the dropdown list for the operator in the *Report Filter* toolbar, select *(Remove).*
- In the Web Intelligence Applet interface or Web Intelligence Rich Client in *Design* mode, select the filter and drag and drop it into the report.

**Related Information**

*To create, edit, and delete standard report filters* [page 271]

You can work with report filters in the *Report Filter* dialog box.
### 3.16.1.6 To create nested filters in a report

A nested report filter contains more than one filter that use AND and OR clauses.

1. Open a Web Intelligence document in Design mode.
2. To add a filter to the existing filter list, in the Analysis tab, select the Filters subtab.
3. From the Filter dropdown list, click Add Filter.
4. In Report Filter panel, click Add filter, select one or more object for the filter, and click OK.
5. Select an operator and values for the filter.
6. Click the operator to change the type from AND to OR and vice versa.
7. When you have finished adding filters, click OK to return to the document.

### 3.16.1.7 Filtering data with prompts

You can filter report data by supplying values for prompts.

When you refresh a report with prompts, the Prompts dialog box displays a summary of all the defined prompts in the Prompt Summary pane. You select the prompt you want to answer, and supply values in the Enter values for prompt pane of the dialog box.

Depending on the prompt you select, you type values directly or select values from a list. A list of values can contain display only values, or the values and their corresponding database key values. Database key values are unique values used to identify the display within the database.

Lists of values can be organized hierarchically if the list was defined as a hierarchy by the universe designer, or the prompt is based on a hierarchy or level object.

Lists of values can be split into ranges to improve performance.

You can search or filter lists of values for easier access to the values you are interested in.

Prompts can be optional or mandatory. If you do not supply a value for an optional prompt, the prompt is ignored. You must supply values for all mandatory prompts before you can filter the data by running the prompts.

Prompts can depend on other prompts. For example, a prompt on a City object can be dependent on a prompt on a Region object. By supplying values to the Region prompt, you restrict the number of possible values of the City prompt.

You can supply values for dependent prompts only when you have supplied values for all the prompts on which they depend. If you wish to supply values to dependent prompts of an optional prompt, you must supply values for the optional prompt.

---

**Related Information**

*To select values from a list of values* [page 142]

*When selecting from a list of values in a query, items in the list can appear either as a single or multi-column list or a hierarchy, depending on the object.*
Selecting prompt values in the Prompts dialog box [page 278]

When you open or refresh a document with prompts, the Prompts dialog box appears.

3.16.1.7.1 To supply values for prompts

You can filter report data based on the prompt values you use.

1. Open a Web Intelligence document containing a query-level prompt in Design mode.
2. Click the Refresh button.
3. Select the prompt in the Prompts Summary pane.
4. If the prompt has a list of values and the values are not displayed, click the Refresh button to display them. In this case, the list displays the text To see the contents of the list, click Refresh.
   
   If the prompt is dependent on other prompts, the list of values displays links to the dependent prompts. You must supply values for the dependent prompts before you can supply a value for the current prompt. Groups of dependent prompts appear in separate groups in the Prompt Summary pane.

   The values can appear as single values, in multiple columns (where the additional columns supply further information about the main filtering column), or hierarchically, depending on the prompt.

   If the list of values is too large to display all at once, the list is split into ranges and a box above the list of values displays the current range. You can scroll through the ranges to see all the values in the list.

5. Select values and click > to add values to the selected values list, or type values directly if the prompt allows you to do so.
   
   You cannot type values directly if the list of values is hierarchical.
   
   If the prompt requires a date, you can select it from the calendar that appears in the box in which you select the value.

   i Note

   SAP Key Dates appear as date prompts, with other prompts in the same data provider appearing as dependent prompts.

6. Repeat the previous step if the prompt allows you to select multiple values.

   If a prompt allows you to make multiple selections from a hierarchical list of values, you can select values at different levels of the hierarchy. If the prompt allows single values only, you can select values only from the bottom level of the hierarchy.

   If a prompt allows you to type values directly and allows multiple values, you can specify multiple values separated by ";", for example California;Nevada;Iowa. After you have typed or pasted the separated list, click the tooltip that says Click here to interpret as multiple values. If you click >, the list is interpreted as a single value.

7. Run the query:
   
   a) In the Web Intelligence HTML interface, click Run Query to run the query.
   
   b) In the Web Intelligence Applet interface or Web Intelligence Rich Client, click OK to run the query.
Related Information

To select values from a list of values [page 142]
When selecting from a list of values in a query, items in the list can appear either as a single or multi-column list or a hierarchy, depending on the object.

To build a prompt [page 157]
You build a query prompt in the Query Panel.

3.16.1.7.2 Selecting prompt values in the Prompts dialog box

When you open or refresh a document with prompts, the Prompts dialog box appears.

The actions you can take in the Prompts dialog box depend on the type of data source the document is accessing or the settings selected by the data source or document query designer.

Table 26: Features of the Prompts dialog box

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Actions you can take</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts Summary</strong> list box</td>
<td>A list of the prompts and your previous selections.</td>
<td>To change the selections for a specific prompt, you can select it from the list, and supply different values.</td>
</tr>
<tr>
<td><strong>Type a value</strong> text box</td>
<td>A text box in which you can manually enter values, including wildcard text patterns (for example 9* for all accounts starting with 9), to add to the Selected Value(s) list box.</td>
<td>To manually add a value, or use wildcard text patterns, you enter the text string in this box and click the right angle bracket (&gt;) icon to add it to the Selected Value(s), Start Value, or End Value list box.</td>
</tr>
<tr>
<td><strong>List of values</strong> box</td>
<td>The list box that shows the available data values.</td>
<td>To add an item in this list box to a Selected Value(s), Start Value, or End Value list box:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Select the item in the List of values box (to select additional items, press Control and click other items).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Click the right angle bracket (&gt;) icon.</td>
</tr>
</tbody>
</table>

Note
- If the document or data source settings do not allow manual entry of values, this box does not appear in the Prompts dialog box.
- Not all data sources recognize wildcard text patterns for prompts values.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Actions you can take</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh values button</td>
<td>When you click this icon, the List of values box shows the values that can be selected for the prompt. Some lists of values require an initial search to display values because the list is too large to be loaded in full. See [To select values from a list of values](page 142) for more information on lists of values.</td>
<td>To refresh the list of values box, click the <strong>Refresh values</strong> button.</td>
</tr>
<tr>
<td>Search text box</td>
<td>A text box in which you can enter a search pattern. Next to this text box is a <strong>Search</strong> button that offers three search options: Match case, Search in keys, and Search on database. See [To select values from a list of values](page 142) for more information on lists of values.</td>
<td>To search the list of values, enter text in the search text box and press <strong>Enter</strong> or click the <strong>Search</strong> button.</td>
</tr>
<tr>
<td>Selected Value(s) list box</td>
<td>In a prompt that allows multivalue variable selection, the list box that shows the values that you have entered for a prompt.</td>
<td></td>
</tr>
<tr>
<td>Start Value text box</td>
<td>In a prompt that requires an interval selection, this shows the start value you have entered.</td>
<td></td>
</tr>
<tr>
<td>End Value text box</td>
<td>In a prompt that requires an interval selection, this shows the end value you have entered.</td>
<td></td>
</tr>
<tr>
<td>Right angle bracket (&gt;)</td>
<td>A button that allows you to add items to the <strong>Selected Value(s)</strong>, <strong>Start Value</strong>, or <strong>End Value</strong> list box.</td>
<td>When you have manually entered a value in the <strong>Type a value</strong> text box or selected one or more values in the list of values box, click &gt; to add the values to the <strong>Selected Value(s)</strong>, <strong>Start Value</strong>, or <strong>End Value</strong> list box.</td>
</tr>
<tr>
<td>Left angle bracket (&lt;)</td>
<td>A button that allows you to remove items to the <strong>Selected Value(s)</strong>, <strong>Start Value</strong>, or <strong>End Value</strong> list box.</td>
<td>To remove an item from a <strong>Selected Value(s)</strong> list box, select the item and click &lt;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To remove an item from a <strong>Start Value</strong> or <strong>End Value</strong> list box, click &lt; next to the applicable list box.</td>
</tr>
</tbody>
</table>

**Caution**

If the data being queried is very large, list of values can be divided into limited ranges. In this case, your search string may not be found. If manual entry of values in the **Selected Value(s)**, **Start Value**, or **End Value** list box is allowed, you should add your values manually.
3.16.2 Filtering data using input controls

Input controls provide a convenient, easily-accessible method for filtering and analyzing report data.

You define input controls using standard windows controls such as text boxes and radio buttons. You associate these controls with report elements such as tables or section headers, and use the controls to filter the data in the report elements. When you select values in the input control, you filter the values in the associated report elements by the values you selected.

You can also define tables and charts as input controls. When you select a value in the table or chart, you filter the values in the associated report elements by the values you selected.

You can use input controls to analyze different scenarios by changing the value of variables. You define a variable with a constant value, then assign an input control, for example a slider, to the variable. You can then change the value of the variable using the slider control; if the variable is part of a formula, you can use the slider control to examine different formula results based on the variable value.

Input controls are report-specific. They are grouped on the Input Controls tab on the Side Panel.

3.16.2.1 Using input controls with hierarchical data

You can use input controls on hierarchical data.

When you select a node of a hierarchy, you can select a single value and use the Equal to operator, or you can select multiple values from a hierarchical tree list.

When you select a hierarchical tree list, right-click and select the member, its children, or its descendants in the hierarchy. The elements of the hierarchies that you select display in the report pane. Refer to the PDF version of the documentation for more information.

3.16.2.2 Available input controls

You can choose from several input controls to help users filter data in your reports.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry field</td>
<td>For any type of object, you can use the entry field input control on a report object where you want to be able to directly type a value name into a text box. This is useful for objects with simple names, for example if you are using a Year universe object. In an input control based on year, you simply type the year and click OK. To clear the input control, you delete the text box contents and click OK.</td>
</tr>
<tr>
<td>Combo box</td>
<td>For a dimension object, you can use the combo box to select a value from a list of possible values. The combo box is compact and only expands when you select it, otherwise only the current selection is displayed.</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Radio buttons</td>
<td>For a dimension object, you can use ever visible radio buttons to select one value from a list of possible value.</td>
</tr>
<tr>
<td>List box</td>
<td>For a dimension object, you can use a list box that displays all available values.</td>
</tr>
<tr>
<td></td>
<td>For single value selections:</td>
</tr>
<tr>
<td></td>
<td>You can select one value from a list of possible values. The selected value is highlighted.</td>
</tr>
<tr>
<td></td>
<td>For multiple value selections:</td>
</tr>
<tr>
<td></td>
<td>You can select several values from a list of possible values, using the [Control] and click method, and then click <strong>OK</strong> to update the display of those report elements affected by the input control.</td>
</tr>
<tr>
<td>Calendar</td>
<td>For a (dimension) date object, you can pick a value that appears in with a manual entry text box and a calendar icon. If you click the calendar icon, you can then select a date from a popup calendar.</td>
</tr>
<tr>
<td>Spinner</td>
<td>For a measure object, you can have an arrow-activated, spinning list of values.</td>
</tr>
<tr>
<td>Simple slider</td>
<td>For a measure object, you can have a slider bar to navigate to a specific value. You must set interval bounds and a default value.</td>
</tr>
<tr>
<td>Tree list</td>
<td>For a dimension object, you can have a list of hierarchy values.</td>
</tr>
<tr>
<td></td>
<td>For single value selections:</td>
</tr>
<tr>
<td></td>
<td>You can select a node or node subset. By default, the control shows the currently selected value, and can be toggled to tree selection.</td>
</tr>
<tr>
<td></td>
<td>For multiple value selections:</td>
</tr>
<tr>
<td></td>
<td>You can select more than one value from a list of possible values in a hierarchy, using the [Control] and click method. By default, control displays the list of currently selected values, and can be toggled to tree selection.</td>
</tr>
<tr>
<td>Check box</td>
<td>For a dimension object, you can have a list of alternatives from which you can select more than one value.</td>
</tr>
</tbody>
</table>

**Note**

The availability of the **OK** button is controlled in the input control create or edit mode.

| Double slider| For a measure object, you can have a slider list based on a measure object from which you can select two values from an interval. You must set interval bounds and default values. |
3.16.2.3 To add an input control

You can add an input control to a Web Intelligence document. You must have sufficient document modification rights to add input controls.

1. In a Web Intelligence document in Design mode, do one of the following:
   ○ In the Analysis tab, select the Filters subtab, and then from the Input Controls dropdown list, select Define Control.
   ○ In the Web Intelligence HTML interface, from the Input Controls dropdown list, select Define Control. If you selected an entire table or chart before clicking Define Control, you can select Include objects from selected block only to restrict the list of objects to the objects in the table or chart you selected.
   ○ In the Web Intelligence Rich Client, from the Controls dropdown list, select Define Control.
   You can also select the type of input control directly from the list of controls under Analysis > Filters Controls instead of selecting Define Control. Those controls not compatible with the data from the report element you selected are disabled. The control is automatically associated with the report object that supplies data to the selected report element and uses its default properties, and you move directly to selecting the report elements you want the input control to filter.

   ➤ Tip

   Another way to open the Select Report Object panel is to click New in the Input Controls tab in the Side Panel.

2. In the Select Report Object panel, select the report object to supply values for the input control, then click Next.

3. Select the input control type.
   The list of control types is determined by the data type of the report object.

4. To define the input control, select an input control, then set the properties.
   If you are in Web Intelligence Rich Client, click the empty field next to the input control property.

   The available properties are determined by the control type.

<table>
<thead>
<tr>
<th>Rich Client Property</th>
<th>HTML Interface Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name</td>
<td>The name of the input control</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>The description of the input control</td>
</tr>
<tr>
<td></td>
<td>List of values</td>
<td>The list of values available in the input control. You can use all values of the report object on which the input control is based (the default) or define your own custom list of values.</td>
</tr>
</tbody>
</table>
### Rich Client Property

<table>
<thead>
<tr>
<th>HTML Interface Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use restricted List of Values</strong></td>
<td>If you define a custom list of values for the report object, this setting filters the data in the report element you assign to the input control based on this list of values. Even when no values are selected in the input control, any values not in the restricted list are excluded from the report element filtered by the input control. For example, if an input control based on the Country dimension is restricted to the values &quot;US&quot; and &quot;France&quot;, a table filtered by the input control shows data for US and France only, even when no value is selected in the input control. If you deselect <strong>Use restricted List of Values</strong>, all values of Country appear in the table when no value is selected in the input control.</td>
</tr>
<tr>
<td><strong>Allow selection of all values</strong></td>
<td>This property allows you to show or hide the All Values option in an input control. For example, you may want to hide the All values option when the aggregation of the values makes no sense.</td>
</tr>
<tr>
<td><strong>Operator</strong></td>
<td>The operator that the input control uses to filter the associated report elements.</td>
</tr>
<tr>
<td><strong>Default values</strong></td>
<td>The default values that the input control uses to filter the associated report element.</td>
</tr>
<tr>
<td><strong>Number of lines</strong></td>
<td>The number of lines that the input control displays in the Input Control pane. For example a list of five radio buttons with Number of lines set to 3 displays only three radio buttons by default. You access the other two radio buttons by using the scrollbar.</td>
</tr>
<tr>
<td><strong>Minimum value</strong></td>
<td>The minimum numerical value you can select in the input control.</td>
</tr>
<tr>
<td><strong>Maximum value</strong></td>
<td>The maximum numerical value you can select in the input control.</td>
</tr>
<tr>
<td><strong>Increment</strong></td>
<td>The amount by which the input control increases/descrceased a numerical value when you are choosing a value.</td>
</tr>
</tbody>
</table>

5. Click **Next**.
6. In the **Assign Report Elements** panel, select the report elements you want the input control to filter.

   ![Note](image)

   Each time you save a document, any input controls that have no associated report elements are removed.

7. Click **Finish**.

   The input control appears on the **Input Controls** pane.
3.16.2.4 To reuse an input control in another reports in a Web Intelligence document

You can reuse the input controls from an existing report in a new report.

1. Open a Web Intelligence document in Design mode.
2. Go to the report with the input controls you want to reuse.
3. Right-click the report tab and click Duplicate Report.

The report and its input controls are duplicated.

3.16.2.5 To edit an input control

You can edit an input control in the Edit Input Control dialog box.

1. In a Web Intelligence document in Design mode, select the Input Controls tab in the Side Panel.
2. Select the input control, then click the Edit icon on the input control toolbar to display the Edit Input Control dialog box.
3. To edit the input control properties:
   a) In the Web Intelligence HTML interface, edit the input control properties in the Properties tab.
   b) In the Web Intelligence Applet interface or Web Intelligence Rich Client, edit the input control properties in the Control tab.
4. Edit the report elements associated with the input control on the Dependencies tab.
5. Click OK to return to the document.

3.16.2.6 To highlight input control dependencies

You can highlight input control dependencies in a document.

1. In a Web Intelligence document in Design mode, click the Input Controls tab in the Side Panel.
2. Do the following:
   a) In the Web Intelligence HTML interface, select the input control in the list, then click the Highlight dependencies icon on the input control toolbar.
   b) In the Web Intelligence Applet interface or Web Intelligence Rich Client, click the Show dependencies icon on the input control toolbar.

The report elements associated with the input control are highlighted.
3.16.2.7 To organize input controls

You can change the order of input controls in the Input Controls pane.

1. In a Web Intelligence document in Design mode, select the Input Controls tab in the Side Panel.
2. Drag and drop input controls to move them up or down on the Input Controls pane.
3. Select an input control, then click the Remove icon on the input control toolbar to remove it from the Input Controls pane.
4. Click Yes to confirm the action.

3.16.2.8 To view the input controls map

You can find all of the input controls used in a document via the Input Controls tab.

1. In a Web Intelligence document in Design mode, select the Input Controls tab in the Side Panel.
2. Click Map at the top of the Input Controls tab.

3.16.2.9 Using tables and charts as input controls

You can define tables and charts as input controls.

Table and chart-based input controls appear in the Input Controls panel in the same way as regular input controls, but you select values in the table or chart itself to filter the dependent report elements. When you select cells, columns or rows in tables, or clickable data areas in charts, the values in the associated report elements are filtered according to the values you selected.

When you select a table or chart-based control in the Input Controls panel, the table or chart used as an input control is highlighted.

When a report is in drill mode, table and chart-based input controls are disabled. They are re-enabled when drill mode is deactivated.

3.16.2.9.1 To define a table or chart as an input control

You can use a table or a chart as an input control in a Web Intelligence document.

1. In a Web Intelligence document in Design mode, right-click the table or chart and select Linking Add Element Link.
2. Do one of the following:
   - To define all the objects in the table or chart as the filtering objects, select All objects.
   - To define a single object in the table or chart as the filtering object, select Single object and then select an object.
3. Click Next.
4. Type a name and a description for the input control, then click Next.
5. Select the report elements to be filtered by the input control.

You cannot select the table or chart that you are defining as an input control from the list of report elements.

6. Click Finish. The table or chart input control appears in the Input Controls pane. When you click Show Dependencies, the table or chart defined as the input control is highlighted.

7. To modify the way a table or chart filters other report elements, right-click the table or chart and select Linking Edit Element Link.

8. To remove a link between a table or chart and other report elements, disable the element link, then right-click the table or chart and select Linking Remove.

Related Information

To edit an input control [page 284]
You can edit an input control in the Edit Input Control dialog box.

3.16.2.10 To filter data using input controls

You can filter data in a document using input control.

1. In a Web Intelligence document in Design mode, select the Input Controls tab in the Side Panel.

The input control displays the following message if the report elements filtered by the input control are no longer in the report: There are no dependent report elements in the report.

2. Select values in the input control. The associated report elements are filtered based on the values you select. For example, if you select the "US" value of the [Country] dimension, the filter operator is Equal To, and there is a table associated with the input control, the table is filtered on the condition [Country] = "US".

3. To filter using a table or chart defined as an input control, select dimension values in the table (rows, columns or cells) or chart (clickable data areas).
Note

- Tables or charts defined as input controls can only filter using dimension values.
- In the Web Intelligence Applet interface, a warning message appears when you delete objects used by an input control.
- The input control shows the following message if the table or chart is no longer in the report: The table or chart is not in the report.
- The input control shows the following message if the filtering dimensions are no longer in the table or chart: Filtering dimensions not available. The input control becomes usable again if you add the dimensions to the table or chart.
- The input control shows the following message if the report is in drill mode: Control not usable while the report is in drill mode. Drill mode must be turned off to make the input control usable.
- Table and chart-based input controls are indicated by an icon in the top corner of the table or chart. Right-clicking the icon displays the following menu options:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Edits the input control</td>
</tr>
</tbody>
</table>
| Highlight
dependencies (Web Intelligence HTML interface) | Highlights the report elements filtered by the input control |
| Show
dependencies (Web Intelligence Applet interface) |                                      |
| Reset            | Removes the filters applied by the input control |
| Disable/Enable   | Disables or enables the input control            |

4. To remove all filters applied by input controls, click Reset at the top of the Input Controls pane.

3.17 Enhancing reports with calculations, formulas and variables

You can add calculations, formulas and variables (named formulas) to reports.

For detailed information on the available calculations, see the Using Functions, Formulas and Calculations in Web Intelligence guide or the Web Intelligence online help.
3.17.1 Working with standard calculations

3.17.1.1 To insert a standard calculation in a table or cross table

You can insert standard calculations in tables or cross tables to make quick calculations on table data.

For more information on the standard calculations, see the Using Functions, Formulas and Calculations in Web Intelligence guide or in the online help.

You can insert multiple calculations in a table or cross table. When you apply two calculations to a table or crosstab, a footer is added for each calculation result. You insert multiple calculations in a table or cross table in the same way that you insert one calculation, but you repeat the procedure for as many calculations as you want to insert.

1. In a Web Intelligence document in Design mode, click the table cell that contains the data you want to calculate.
2. In the Analysis tab, in the Functions subtab, select a calculation.

You can repeat this step to add multiple calculations to the same column.

Tip

Double-click a cell to launch the Formula Editor toolbar, in which you can edit the formula.

A footer containing the result of the calculation is added below the column.

3.17.1.2 To remove a standard calculation

You can remove a standard calculation in Web Intelligence.

1. Open a Web Intelligence document in Design mode.
2. Right-click that contains the calculation that you want to remove and select Delete.

3.17.2 Working with formulas

3.17.2.1 To enter a formula by typing

You can manually enter formulas in the Formula Editor in Web Intelligence.

1. In a Web Intelligence document in Design mode, select the Properties tab.
2. From the View dropdown list, select Formula Bar to display the Formula Bar.
3. Select or insert a cell or text box in the report.
4. Type a formula in the Formula box.
5. To build a formula using the Formula Editor, click the Formula Editor icon on the Formula Bar.

6. Build the formula.

7. To confirm and apply the formula, do one of the following:
   ○ In the Web Intelligence Rich Client, click Validate.
   ○ In the Web Intelligence HTML or Web Intelligence Applet interface, click OK.

3.17.2.2 To build a formula in the Formula Editor

You can use the Formula Editor to define the formula for a table cell.

1. In a Web Intelligence document in Design mode, select the table cell where you want to insert the formula.
2. In the the Properties tab, select Formula Bar from the View dropdown list to display the Formula Bar.
3. To build a formula using the Formula Editor, click the Formula Editor icon on the Formula Bar.
4. Double-click to select an object for the formula from the Available Objects pane.
5. Double-click to select a function for the formula from the Available Functions pane.
6. Double-click to select an operator for you formula from the Available Operators pane.

   If your formula requires you to select one or more values from a list of values, perform the following steps:
   a) Select an object in the Available Operators list.
   b) Double-click Prompts to open the prompt editor and define a prompt.
   c) Double-click the Values item to open the List of Values dialog box.
   d) Do one of the following:

       - To select one value, select the value and then click OK.
       - To select contiguous values, select the first value. While pressing the Shift key, click the last value and then click OK.
       - To select several (non-contiguous) values, select the first value. While pressing the Control key, click the other values you want to select and then click OK.

7. To confirm and apply the formula, click OK.
3.17.3 Working with variables

3.17.3.1 To create a variable

You can remove a variable in Web Intelligence.

1. Open a Web Intelligence document in Design mode.
2. To display the Formula Bar, in the Properties tab, select Formula bar from the View dropdown list.
3. Click the Create Variable icon in the Formula Bar to display the Create New Variable or Create Variable panel.
4. Type the variable name in the Name box.
5. In the Formula box, build a formula for the variable, if one is not already displayed.

   i Note
   If a cell is selected before you open the Formula Editor, the formula you create is assigned to the cell.

6. Select a variable type.
7. Click OK to save the variable and return to the document.

3.17.3.2 To edit a variable

1. In a Web Intelligence document in Design mode, select the Available Objects tab on the Side Panel.
2. Right-click the variable you want to edit and select Edit.
   The Variable Editor or Edit Variable panel appears.
3. Edit the variable.
4. Click OK to return to the document.

3.17.3.3 To delete a variable

You can delete a variable in Web Intelligence.

1. In a Web Intelligence document in Design mode, select the Available Objects tab on the Side Panel.
2. Right-click in the list the variable that you want to delete and select Remove.

3.17.3.4 To rename a variable

You can rename a variable in the Web Intelligence Applet interface and Web Intelligence Rich Client.

1. In a Web Intelligence document in Design mode, select the Available Objects tab on the Side Panel.
2. Right-click the variable that you want to rename and select Rename.
You cannot rename variables in the Web Intelligence HTML interface.

3. Rename the variable and save it.

### 3.18 To rename a report

You can rename a report in a Web Intelligence document in *Design* mode.

1. In a Web Intelligence document in *Design* mode, right-click the *Report* tab of the report you want to rename.
2. Select *Rename Report* on the menu and type the new report name.
3. Click outside the report name tab and save the document.

### 3.19 To duplicate a report

You can duplicate a report in a Web Intelligence document in *Design* mode.

1. In a Web Intelligence document in *Design* mode, right-click the report tab of the report you want to duplicate.
2. Click *Duplicate Report*.
3. Rename the duplicated report, if required.
4. Save the document.

**Related Information**

*To reuse an input control in another reports in a Web Intelligence document* [page 284]

You can reuse the input controls from an existing report in a new report.

### 3.20 To delete a report

You can delete a report from a Web Intelligence document in *Design* mode.

1. In a Web Intelligence document in *Design* mode, right-click the report tab of the report you want to delete and select *Remove Report*.
2. Click *Yes* to confirm the deletion.
3. Save the document.
3.21 To change the order of reports

You can change the order of reports in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, right-click the report tab of the report whose order you want to change in the document.

2. Click Move Report on the menu, then select one of the menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>The report becomes the first report in the document.</td>
</tr>
<tr>
<td>Previous</td>
<td>The report is moved to the previous position in the document.</td>
</tr>
<tr>
<td>Next</td>
<td>The report is moved to the next position in the document.</td>
</tr>
<tr>
<td>Last</td>
<td>The report is moved to the last position in the document.</td>
</tr>
</tbody>
</table>

3.22 To add a report

You can add a report to a Web Intelligence document in the Design mode.

In a Web Intelligence document in Design mode, right-click the report tab of any existing report and click Add Report.

A blank report is added to the document with the default name Report n.
4 Working with tables in reports

4.1 Displaying data in tables

When you create a document and run the query the first time to display the results, the document contains a report that includes the query results in a vertical table.

You can do the following:

- Modify how the table is organized
- Remove or add data
- Insert other rows or columns
- Hide columns (see note below)
- Change the table type
- Turn the table into a chart
- Insert other tables

### Note

When you create a new name for a column, it is a custom header and it isn't attached to the dimension. Therefore, when you hide the column and show it again, it will revert to the old name. If you want to show a new name and have it persist, you will need to create a variable.

#### 4.1.1 Table types

##### 4.1.1.1 Vertical tables

Vertical tables display header cells at the top of the table and the corresponding data in columns.

By default, the header cells display the names of the dimensions, details, and measures included in the table. The body cells display the corresponding values.

<table>
<thead>
<tr>
<th>Lines</th>
<th>Sales revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$9,914,545</td>
<td>$3,809,135</td>
</tr>
<tr>
<td>City Skirts</td>
<td>$347,775</td>
<td>$132,302</td>
</tr>
<tr>
<td>City Trousers</td>
<td>$284,734</td>
<td>$104,346</td>
</tr>
<tr>
<td>Dresses</td>
<td>$2,916,620</td>
<td>$1,173,361</td>
</tr>
<tr>
<td>Jackets</td>
<td>$677,307</td>
<td>$286,130</td>
</tr>
<tr>
<td>Leather</td>
<td>$187,413</td>
<td>$70,599</td>
</tr>
<tr>
<td>Outerwear</td>
<td>$1,183,083</td>
<td>$474,302</td>
</tr>
<tr>
<td>Overcoats</td>
<td>$436,258</td>
<td>$185,522</td>
</tr>
<tr>
<td>Shirt Waist</td>
<td>$4,018,220</td>
<td>$1,615,210</td>
</tr>
<tr>
<td>Sweaters</td>
<td>$2,639,035</td>
<td>$1,000,673</td>
</tr>
<tr>
<td>Trousers</td>
<td>$903,320</td>
<td>$327,515</td>
</tr>
</tbody>
</table>
4.1.1.2 Horizontal tables

Horizontal tables display header cells on the side of the table and the corresponding data in rows.

By default, the header cells display the names of the dimensions, details, and measures included in the table. The body cells display the corresponding values.

<table>
<thead>
<tr>
<th>Fiscal Period</th>
<th>FY01</th>
<th>FY02</th>
<th>FY03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales revenue</td>
<td>$8,095,814</td>
<td>$13,232,246</td>
<td>$15,059,143</td>
</tr>
<tr>
<td>Margin</td>
<td>$3,731,971</td>
<td>$5,187,886</td>
<td>$5,667,084</td>
</tr>
</tbody>
</table>

4.1.1.3 Cross tables

Cross tables display values for dimensions across the top axis and on the side axis.

The body displays the values of a measure that correspond to the cross-section of the dimensions.

Values in cross tables

In the following example, the cross table displays values for [Quarter] across the top axis and displays values for [State] on the side axis. The body displays values that [Sales Revenue] for each quarter in each state.

<table>
<thead>
<tr>
<th>State</th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>$1,899,680</td>
<td>$1,760,148</td>
<td>$1,930,517</td>
<td>$1,889,225</td>
</tr>
<tr>
<td>Colorado</td>
<td>$525,662</td>
<td>$500,076</td>
<td>$510,777</td>
<td>$523,740</td>
</tr>
<tr>
<td>DC</td>
<td>$766,622</td>
<td>$706,447</td>
<td>$692,250</td>
<td>$796,423</td>
</tr>
<tr>
<td>Florida</td>
<td>$515,668</td>
<td>$489,998</td>
<td>$387,610</td>
<td>$485,663</td>
</tr>
<tr>
<td>Illinois</td>
<td>$846,408</td>
<td>$550,095</td>
<td>$610,766</td>
<td>$714,890</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>$312,896</td>
<td>$291,431</td>
<td>$249,529</td>
<td>$429,850</td>
</tr>
<tr>
<td>New York</td>
<td>$1,987,115</td>
<td>$2,028,091</td>
<td>$1,672,581</td>
<td>$1,894,435</td>
</tr>
<tr>
<td>Texas</td>
<td>$2,875,563</td>
<td>$2,499,277</td>
<td>$2,146,303</td>
<td>$2,596,516</td>
</tr>
</tbody>
</table>
Multiple dimensions in cross tables

You can include multiple dimensions in cross tables. In the following example, the cross table displays two dimensions. The values for the [Sales Revenue] measure are values each state by quarter for each line.

<table>
<thead>
<tr>
<th></th>
<th>Q1 City Skirts</th>
<th>Q1 City Trousers</th>
<th>Q2 City Skirts</th>
<th>Q2 City Trousers</th>
<th>Q3 City Skirts</th>
<th>Q3 City Trousers</th>
<th>Q4 City Skirts</th>
<th>Q4 City Trousers</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>$7,735</td>
<td>$8,495</td>
<td>$9,075</td>
<td>$12,845</td>
<td>$12,477</td>
<td>$11,933</td>
<td>$13,685</td>
<td>$16,517</td>
</tr>
<tr>
<td>Colorado</td>
<td>$7,238</td>
<td>$8,279</td>
<td>$2,379</td>
<td>$6,877</td>
<td>$9,791</td>
<td>$9,923</td>
<td>$8,915</td>
<td>$7,483</td>
</tr>
<tr>
<td>DC</td>
<td>$2,416</td>
<td>$4,091</td>
<td>$3,624</td>
<td>$1,137</td>
<td>$9,748</td>
<td>$9,335</td>
<td>$2,331</td>
<td>$9,440</td>
</tr>
<tr>
<td>Florida</td>
<td>$1,765</td>
<td>$1,737</td>
<td>$2,735</td>
<td>$2,907</td>
<td>$4,937</td>
<td>$2,517</td>
<td>$7,577</td>
<td>$9,563</td>
</tr>
<tr>
<td>Illinois</td>
<td>$500</td>
<td>$2,139</td>
<td>$2,902</td>
<td>$459</td>
<td>$6,562</td>
<td>$6,385</td>
<td>$7,486</td>
<td>$12,987</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>$1,104</td>
<td>$532</td>
<td>$2,973</td>
<td>$6,752</td>
<td>$1,088</td>
<td>$2,134</td>
<td>$7,585</td>
<td></td>
</tr>
<tr>
<td>New York</td>
<td>$10,020</td>
<td>$14,203</td>
<td>$17,241</td>
<td>$17,695</td>
<td>$10,995</td>
<td>$36,564</td>
<td>$41,324</td>
<td></td>
</tr>
<tr>
<td>Texas</td>
<td>$10,812</td>
<td>$12,084</td>
<td>$22,272</td>
<td>$1,885</td>
<td>$97,115</td>
<td>$20,239</td>
<td>$26,939</td>
<td>$49,639</td>
</tr>
</tbody>
</table>

When you create cross tables that include dimensions in the body, the body cell values are calculated according to a multi-dimensional data model. In the following example, the values displayed in the body are calculated according to all of the coordinates on the table axes, whether or not there is a row for the specific coordinate in the data.

4.1.1.4  Forms

You can use in your report to display detailed information per customer, product, or partner.

For example, you can use a form to display customer information such as the account, name, address, and so on. Forms are also useful for formatting address labels for envelopes.
4.1.2 Creating and editing tables

4.1.2.1 To create a table by dragging objects onto a report

You are working with a report and want to insert a table into the report. You use the available objects from the query.

1. In a Web Intelligence document in Design mode, click the Available Objects icon to display the Available Objects list in the Side Panel.

2. Select an object or objects and drag and drop them with the mouse cursor to an empty part of the report. When you release the mouse button the objects appear as columns in a vertical table.

3. To add another object or objects to the table, drag them onto an existing table.
   For example:
   ○ To add a column next to an existing column, drag and drop the object next to the column.
   ○ To replace an existing column, drag and drop the object to the middle of the column.

4.1.2.2 To create a table

Working in Structure mode allows you to define and preview a new table without data from the server.

1. In a Web Intelligence document, from the Design mode dropdown list in the top corner of the toolbar, click Structure only to switch to Structure mode.

2. In the Report Elements tab, select the Tables subtab.

3. Select one of the following:
   ○ Define Vertical Table
   ○ Define Horizontal Table
   ○ Define Cross Table
   ○ Define Form

4. Click the report at the position where you want the table to appear.

5. Right-click the table border and select Assign Data from the contextual menu. The Assign Data dialog box appears.

6. Click the arrow in the Pick text box and from the dropdown list select the object to associate with the table column, row or body cell.

   Note
   You can associate a formula rather than a report object with the component by clicking the arrow next to the component, selecting Edit Formula and defining the formula in the Formula Editor.

7. To add another table element, click + next to the Pick text box.

8. To delete a table component, do one of the following:
   ○ Click the X icon.
   ○ Click the arrow next to an element text box and select Delete from the contextual menu.
9. When you have finished defining the table, select \textit{Design} \textit{With Data} to populate it with data, or click \textit{OK}.

4.1.2.3 \textbf{To change the format of a table}

You can turn a table into a different format or into a chart using the \textit{Turn Table Into} option.

1. In a Web Intelligence document in \textit{Design} mode, right-click the table you want to reformat, then select \textit{Turn Table Into} to display the \textit{Turn Into} options.

   You can also select the table or chart style from the \textit{Tools} section of the \textit{Report Elements} tab.

2. Choose a table or chart type.

   \textbf{Note}

   When you turn a table with a unicode font into a chart, the font is not retained unless unicode is defined as your default font for charts. Contact the BI administrator for further information on setting unicode as your default font.

4.1.2.4 \textbf{To add table rows or columns}

You can add table rows and columns in Web Intelligence document in \textit{Design} mode.

1. In a Web Intelligence document in \textit{Design} mode, select a cell in the column or row next to which you want to insert another column or row.

2. Do one of the following procedures:

   \begin{itemize}
   \item Select the \textit{Report Element} tab, and in the \textit{Table Layout} subtab, from the \textit{Insert} list, select one of the following:
     \begin{itemize}
     \item \textit{Insert Rows Above}
     \item \textit{Insert Rows Below}
     \item \textit{Insert Columns on Left}
     \item \textit{Insert Columns on Right}
     \end{itemize}
   \item Right-click the cell and select \textit{Insert}, then one of the following:
     \begin{itemize}
     \item \textit{Row Above}
     \item \textit{Row Below}
     \item \textit{Column on Left}
     \item \textit{Column on Right}
     \end{itemize}
   \end{itemize}

3. Drag an object from the \textit{Available Objects} pane in the Side Panel to the empty column or row you inserted.
To remove table rows or columns

You can remove table rows or columns in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, right-click the table column or row you want to remove and select Delete from the menu. By default, if you select Delete from the menu, it deletes the column in a vertical table or a row in a horizontal table.

2. Select Row or Column.

3. Click OK.

To move a row or column

You can move a row or column in a table in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, drag the selected column or row and drop it before or after another column or row on the table.

When you drag a row or column, the column or row header displays next to your pointer.

To swap a row or column

You can swap rows and columns in tables in a Web Intelligence document in Design mode.

1. Open a Web Intelligence document in Design mode.

2. Drag the selected column or row onto the column or row that you want to swap.

To clear cell contents from a table

You can clear different types of cells in a table.

You can clear the following types of cell in a table:

- Header cells – you can clear each header cell separately
- Footer cells – you can clear each footer cell separately
- Related body cells – when you clear one body cell, you automatically clear all of the body cells in the same column or row of the table

1. In a Web Intelligence document in Design mode, select the cell you want to clear. The cell borders are highlighted.

2. Right-click the selected cell and click Clear Contents.
4.1.2.9 To remove a table

You can remove a table in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, click the top edge of the table you want to remove. A gray border appears around the table.
2. Press the Delete key on your keyboard.

4.1.2.10 To copy a table

You can copy and paste tables within a report or into external applications such as Microsoft Word and Excel.

1. In a Web Intelligence document in Design mode, select and right-click the table you want to copy.
2. Select Copy.
3. To paste the table to another part of the report, right-click where you want the table to appear and select Paste.

⚠️ Caution

You cannot copy tables from one version of Web Intelligence to another.

4. To paste the table into another application, paste the contents in the other application.

4.1.3 Formatting tables and table cells

In Web Intelligence, you can define several visual aspects of tables and cells in reports.

- Select a background color for the table
- Insert an image or skin in a table or one or more of its cells
- Format table cells or borders
- Format text in table cells
- Set cell height and width
- Copy and paste formatting
- Set the position of the table in the report page
- Layer tables and cells
- Merge table cells

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]

You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

To define alternate row and column colors for a table [page 302]
You can define row colors in a table in a Web Intelligence document in Design mode.

To format table or cell borders [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.

To format text in table cells [page 304]
You can format text in tables in a Web Intelligence document in Design mode.

To set cell height and width [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To copy formatting using the Format Painter tool [page 308]
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

To set the position of a table or chart on the report page [page 309]
You can set the position of a table or chart in a report.

To layer tables and cells [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

To merge table cells [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

4.1.3.1 To select a background color for the table or cells

You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

1. In a Web Intelligence document in Design mode, right-click the table or cell and select Format Table or Format Cell from the contextual menu.
2. In the Appearance tab, click the radio button next to the color palette icon.
3. Click the arrow next to the color palette icon to display the palette.
4. Select a color from the palette.
5. Click OK to return to the document.

Note
If you try to apply a background color to all of a table, and the cells remain white, make sure that the cells are not set with a white background.

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To define alternate row and column colors for a table [page 302]
You can define row colors in a table in a Web Intelligence document in Design mode.

To format table or cell borders [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.

To format text in table cells [page 304]
You can format text in tables in a Web Intelligence document in Design mode.

To set cell height and width [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To copy formatting using the Format Painter tool [page 308]
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

To set the position of a table or chart on the report page [page 309]
You can set the position of a table or chart in a report.

To layer tables and cells [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

To merge table cells [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

4.1.3.2 To define alternate row and column colors for a table

You can define row colors in a table in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, right-click the table and select Format Table from the contextual menu.
2. In the Appearance tab, in the Alternate Color section, set the frequency with which you want the alternate color to appear for the alternate row color in the combo box next to Frequency.
3. Click the arrow next to Color and select the color using the color palette.
4. Click OK to return to the document.

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]  
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]  
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

To format text in table cells [page 304]  
You can format text in tables in a Web Intelligence document in Design mode.

To set cell height and width [page 306]  
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To copy formatting using the Format Painter tool [page 308]  
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

To set the position of a table or chart on the report page [page 309]  
You can set the position of a table or chart in a report.

To layer tables and cells [page 310]  
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

To merge table cells [page 312]  
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]  
You can format your report and report elements in order to present the report with a company style.
Formatting your reports using Cascading Style Sheets [page 256]

Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]

You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

4.1.3.3 To format table or cell borders

You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, right-click the table or cell and select Format Table or Format Cell from the contextual menu.

2. In the Border tab, use the controls in the tab to configure the border styles and colors.

   Each time you change a style setting, you need to click the square or one of the line buttons so that it is applied to the Preview section, or it will not be applied to the cell or table.

   When borders are defined between two adjacent cells, priority is given to the larger, plain line. In case of equivalent priorities between the two cells, the right border of the left cell or the bottom border of the top cell will be shown.

3. Click OK to return to the document.

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]

You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]

You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

To define alternate row and column colors for a table [page 302]

You can define row colors in a table in a Web Intelligence document in Design mode.

To format text in table cells [page 304]

You can format text in tables in a Web Intelligence document in Design mode.

To set cell height and width [page 306]

You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To copy formatting using the Format Painter tool [page 308]

You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

To set the position of a table or chart on the report page [page 309]
You can set the position of a table or chart in a report.

To layer tables and cells [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

To merge table cells [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

4.1.3.4 To format text in table cells

You can format text in tables in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, select the cells whose text you want to format.

   ➤  Tip

   If you select one cell in a column, all cells in the column are selected. To select multiple columns or cells, select the first column or cell, hold down the Control key, then continue selecting columns or cells.

2. Right-click on the cell selection and click Format Cell.
3. In the Font tab, select the font, style, size and effects, as required.
4. Click OK to return to the document.

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

To define alternate row and column colors for a table [page 302]
You can define row colors in a table in a Web Intelligence document in Design mode.

To format table or cell borders [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.
To set cell height and width [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format
Cell dialog box.

To copy formatting using the Format Painter tool [page 308]
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports,
tables or cells.

To set the position of a table or chart on the report page [page 309]
You can set the position of a table or chart in a report.

To layer tables and cells [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object
further forward in the layering order appears over an object further backward in the layering order.

To merge table cells [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the
presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors
are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate
palette, and the palette ID must not be changed.

4.1.3.5 To activate text wrapping in a table cell

You can activate the text wrapping in a cell in a table.

1. Open a Web Intelligence document in Design mode.
2. Select a cell in the table and do one of the following:
   ○ In the Format or Formatting tab and in the Alignment subtab, click the Wrap Text icon.
   ○ Right-click the cell and do one of the following:
     ○ Select Text, then Wrap Text.
     ○ Select Format Cell. In the Format Cell dialog box, select Alignment in the Side Pane and activate Wrap
       Text. Click OK to close the dialog box.

To deactivate text wrapping in a cell, select it and do one of the following techniques offered above and unselect
Wrap Text.
4.1.3.6  To set cell height and width

You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

If you want to hide cell contents on reports, you can set the cell width to 0.1 cm so that the cell width can be modified to display the cell contents later.

1. Open a Web Intelligence document in Design mode.

2. To set a fixed cell height and width, do one of the following:
   ○ Drag the cell borders until the cell is the height and width you want.
   ○ Select the cells you want to change, then right-click the cells and select Format Cell. In the General tab, set the cell height and width.

3. To set the cell to automatically fit to its text contents, do one of the following:
   ○ Select Autofit width to content or Autofit height to content or both, and set the minimum width and height. Autofit retains the current cell size as the minimum size and enlarges the cell size if the string that the cell contains is larger than the minimum size specified. Some functions are incompatible with autofitted cells. If you place any of these functions in an autofitted cell, the function returns the #RECURSIVE error message.
   ○ To set an autofit cell width, double-click either sides of the cell.
   ○ To set an autofit cell height, double-click the bottom border of the cell.

### Note
Documents that contain tables with the cell size set to autofit take longer to display than documents where tables contain cells with a fixed cell width and height.

### Note
Autofit height to content and Autofit width to content properties do not work as well when the Read content as option is set to HTML.

**Related Information**

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

To define alternate row and column colors for a table [page 302]
You can define row colors in a table in a Web Intelligence document in Design mode.

To format table or cell borders [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.

To format text in table cells [page 304]
You can format text in tables in a Web Intelligence document in Design mode.

**To copy formatting using the Format Painter tool** [page 308]
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

**To set the position of a table or chart on the report page** [page 309]
You can set the position of a table or chart in a report.

**To layer tables and cells** [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

**To merge table cells** [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

**Formatting the report layout** [page 192]
You can format your report and report elements in order to present the report with a company style.

**Formatting your reports using Cascading Style Sheets** [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

**Creating a corporate palette for charts** [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

### 4.1.3.6.1 Effects of autofit and text wrapping in table cells

This topic lists the effects of the autofit and wrap text features when used separately and in combination.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wrap text</strong></td>
<td>Text is wrapped at the end of the cell.</td>
</tr>
<tr>
<td><strong>Autofit width to content</strong></td>
<td>Cell width is adjusted to display all the text.</td>
</tr>
<tr>
<td><strong>Autofit height to content</strong></td>
<td>Cell height is adjusted to display all the text.</td>
</tr>
<tr>
<td><strong>Autofit width to content + Autofit height to content</strong></td>
<td>Cell width and height is adjusted to display all the text.</td>
</tr>
<tr>
<td><strong>Wrap text + Autofit width to content</strong></td>
<td>Cell width is adjusted to accomodate the longest word. Because the cell height is not adjusted to the number of lines of text, text might be truncated vertically.</td>
</tr>
<tr>
<td><strong>Wrap text + Autofit height to content</strong></td>
<td>Cell height is adjusted to accommodate the number of lines of text created by the wrap text. Because the cell width is not adjusted to the longest word, text might be truncated horizontally.</td>
</tr>
<tr>
<td><strong>Wrap text + Autofit height to content + Autofit width to content</strong></td>
<td>Cell height and width is adjusted to the text and there is no horizontal or vertical truncation.</td>
</tr>
</tbody>
</table>
Related Information

**To activate text wrapping in a table cell** [page 305]
You can activate the text wrapping in a cell in a table.

**To set cell height and width** [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

### 4.1.3.7 To copy formatting using the Format Painter tool

You use the **Format Painter** tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

The formatting options applied depend on the objects you choose as the source and target. In general, only properties that affect the visual formatting, for example font style, background color, are applied. Properties that affect the display of data, for example table properties such as **Avoid duplicate row aggregation**, are not applied.

1. In a Web Intelligence document in **Design** mode, select the report, table or cell whose formatting you want to apply.
2. In the **Tools** subtab under the **Formatting** tab, click the **Format Painter** icon to apply the formatting once, or double-click to apply the formatting multiple times.
3. Click the report, table or cell to which you want to apply the formatting.

   If you single-clicked the **Format Painter** icon, it is deactivated.

   If you double-clicked the Format Painter, it remains activated. To deactivate it, click the **Format Painter** icon again or press **Esc** to cancel the formatting operation.

**Related Information**

**To format the appearance of reports and their headers, footers, sections, tables, and table cells** [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

**To select a background color for the table or cells** [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

**To define alternate row and column colors for a table** [page 302]
You can define row colors in a table in a Web Intelligence document in **Design** mode.

**To format table or cell borders** [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in **Design** mode.

**To format text in table cells** [page 304]
You can format text in tables in a Web Intelligence document in **Design** mode.

**To set cell height and width** [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To set the position of a table or chart on the report page [page 309]
You can set the position of a table or chart in a report.

To layer tables and cells [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

To merge table cells [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

4.1.3.8 To set the position of a table or chart on the report page

You can set the position of a table or chart in a report.

1. In a Web Intelligence document in Design mode, right-click the border of the table or chart, and select Format Table or Format Chart.

2. In the Global Layout section of the table or chart format panel, use the controls in the Relative Position section to set the position of the table or chart in relation to other report elements.

   ➤ Tip
   You can also reach the Layout tab in the table or chart format panel by one of the following ways:
   ○ In the Report Elements tab, in the Position subtab, click Align, then an alignment option.
   ○ Right-click the table or chart and select Align, then an alignment option.

3. Click OK.

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

**To define alternate row and column colors for a table** [page 302]
You can define row colors in a table in a Web Intelligence document in **Design** mode.

**To format table or cell borders** [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in **Design** mode.

**To format text in table cells** [page 304]
You can format text in tables in a Web Intelligence document in **Design** mode.

**To set cell height and width** [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the **Format Cell** dialog box.

**To copy formatting using the Format Painter tool** [page 308]
You use the **Format Painter** tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

**To layer tables and cells** [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

**To merge table cells** [page 312]
You can merge table cells in a Web Intelligence document in **Design** mode.

**Formatting the report layout** [page 192]
You can format your report and report elements in order to present the report with a company style.

**Formatting your reports using Cascading Style Sheets** [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

**Creating a corporate palette for charts** [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called **VisualizationConfig.xml**. You can only define one corporate palette, and the palette ID must not be changed.

### 4.1.3.9 To layer tables and cells

Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

1. In a Web Intelligence document in **Design** mode, select the table or cell whose layer you want to set.
2. Right-click the selection, click **Order** and select the layering option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bring to Front</td>
<td>Make the table or cell the first object in the layering order.</td>
</tr>
<tr>
<td>Send to Back</td>
<td>Make the table or cell the last object in the layering order.</td>
</tr>
<tr>
<td>Bring Forward</td>
<td>Bring the table or cell one layer forward in the layering order.</td>
</tr>
<tr>
<td>Send Backward</td>
<td>Send the table or cell one layer backward in the layering order.</td>
</tr>
</tbody>
</table>
Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

To define alternate row and column colors for a table [page 302]
You can define row colors in a table in a Web Intelligence document in Design mode.

To format table or cell borders [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.

To format text in table cells [page 304]
You can format text in tables in a Web Intelligence document in Design mode.

To set cell height and width [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To copy formatting using the Format Painter tool [page 308]
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

To set the position of a table or chart on the report page [page 309]
You can set the position of a table or chart in a report.

To merge table cells [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

4.1.3.10  To exclude zero values in charts and tables

In charts and tables, you can exclude zero values from the displayed data.

If a chart or table has zero values, you can choose to remove them from the visible output. You can also have hidden items that have zero values.

If you deactivate either of the zero value options:
• In a chart, there are no items.
In a table, if the values in a column or row for an item equal zero, the column or row does not appear.

1. In a Web Intelligence document in Design mode, right-click the chart or table frame and select Format Chart or Format Table.

2. Do one of the following:
   - For a chart, in the Global chart area, select the General tab.
   - For a table, select the General tab.

3. Select the following Display options as required:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show rows for which all measure values = 0</td>
<td>In vertical and cross tables, to suppress rows where all measure values are equal to zero.</td>
</tr>
<tr>
<td>Show rows for which the sum of measure values = 0</td>
<td>In vertical and cross tables, to suppress rows where the sum of the measure values is equal to zero.</td>
</tr>
<tr>
<td>Show columns for which all measure values = 0</td>
<td>In horizontal and cross tables, to suppress columns where all measure values are equal to zero.</td>
</tr>
<tr>
<td>Show columns for the sum of measure values = 0</td>
<td>In horizontal and cross tables, to suppress columns where the sum of the measure values is equal to zero.</td>
</tr>
<tr>
<td>Show measure values where values = 0</td>
<td>In charts, to suppress a chart item if its measure values are equal to zero.</td>
</tr>
<tr>
<td>Show measure values for which the sum of values = 0</td>
<td>In charts, to suppress a chart item where the sum of its measure values is equal to zero.</td>
</tr>
</tbody>
</table>

i Note
In charts and tables, empty values are considered the same as zero values, and therefore are also affected by these Display options.

4. Click OK to close the dialog box.

### 4.1.3.11 To merge table cells

You can merge table cells in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, to select the cells you want to merge, hold down the **Control** key and click the cells.

2. Keep the **Control** key pressed, right-click the selected cells, and select Merge.

**Caution**
When you merge cells, the resulting merged cell contains the data only from the first cell you selected only. Data from all the other cells is lost.
Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.

To define alternate row and column colors for a table [page 302]
You can define row colors in a table in a Web Intelligence document in Design mode.

To format table or cell borders [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.

To format text in table cells [page 304]
You can format text in tables in a Web Intelligence document in Design mode.

To set cell height and width [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To copy formatting using the Format Painter tool [page 308]
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

To set the position of a table or chart on the report page [page 309]
You can set the position of a table or chart in a report.

To layer tables and cells [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.
4.1.4 Controlling the display of tables

4.1.4.1 To show or hide tables, rows or columns

You can display or hide tables or table objects in a Web Intelligence document in Reading mode.

Sometimes tables or specific rows and columns display no values. For example, if a sales of a specific product are discontinued, table rows or columns that normally show results for that product appear empty. By default, these empty rows, columns, or tables are displayed.

You can also display and hide tables based on the result of a formula.

1. Open a Web Intelligence document in Design mode.
2. Hover the mouse over the table border until the cursor becomes a plus sign, click the right mouse button and select Format Table from the contextual menu.
3. In the General tab, select any of the following options:
   ○ To hide the table, select Hide always.
   ○ To hide the table when it is empty, select Hide when empty.
   ○ To hide the table when the formula is true, select Hide when following formula is true and type a formula in the box.
   ○ To display rows with empty measure values, select Show rows with all empty measure values.
   ○ To display rows with empty dimension values, select Show rows with empty dimension values.

   ![Restriction]
   This option only applies to merged dimensions.

4. Click OK to return to the document.

When a table or element is hidden, its name is italicized in grey in the Document Structure and Filters pane in the Side Panel.

4.1.4.2 To redisplay hidden tables, cells or sections

You can redisplay hidden objects in a Web Intelligence document in Design mode.

1. In a Web Intelligence document in Design mode, select one of the following:
   ○ The hidden table, free-standing cell or section in the Document Structure and Filters tab in the Side Panel.
   ○ The hidden report object in the table in which it is displayed.
2. Right-click the object and select Hide ➔ Show ➔.

   ![Tip]
   To show all hidden elements in a report, right-click in the report and select Show All Hidden Content.
4.1.4.3 To hide dimensions in tables

You can hide table dimensions in a Web Intelligence report in Design mode.

1. In a Web Intelligence document in Design mode, select the table column containing the dimension you want to hide.
2. In the Report Elements tab, select the Behaviors subtab.
3. Click \( \text{Hide} \) Hide Dimension \( \text{Hide Dimension} \) to hide.

4.1.4.4 To redisplay hidden dimensions

You can redisplay dimensions that have been hidden in a Web Intelligence report in Design mode.

1. In a Web Intelligence document in Design mode, select a table containing the hidden dimensions.
2. In the Report Elements tab, select the Behaviors subtab.
3. Click \( \text{Hide} \) Show Hidden Dimensions \( \text{Show Hidden Dimensions} \) to redisplay the dimensions.

**Tip**

If the hidden dimensions were the only objects in the table, right-click the table in the Document Structure and Filters pane of the Side Panel and select \( \text{Hide} \) Show Hidden Dimensions \( \text{Show Hidden Dimensions} \).

4.1.4.5 To avoid duplicate row aggregation

When rows contain duplicate data, measure values are aggregated by default. You can choose not to aggregate measure values in this situation.

1. Open a Web Intelligence document in Design mode.
2. Hover the mouse over the table border until the cursor becomes a plus sign, click the right mouse button and select Format Table from the contextual menu.
3. In the General tab, select Avoid duplicate row aggregation.

**Caution**

This option does not work in tables containing hierarchical data.

4. Click OK to return to the document.
4.1.4.6  To show or hide table headers and footers

You can show and hide table headers in a Web Intelligence document in Design mode.
1.  Open a Web Intelligence document in Design mode.
2.  Hover the mouse over the table border until the cursor becomes a plus sign, click the right mouse button and select Format Table from the contextual menu.
3.  In the Format Table dialog box, select the General tab.
4.  For the table header, do one of the following:
   ○ To display the headers:
     ○ If you are using Web Intelligence HTML Interface, select Table headers or, in the case of a cross table, Top header or Left header or both.
     ○ If you are using Web Intelligence Applet interface or Web Intelligence Rich Client, select Show table headers or, in the case of a cross table, Show top header or Show left header or both.
   ○ To hide the headers, unselect the header options.
5.  For the table footer, do one of the following:
   ○ To display the footers:
     ○ If you are using Web Intelligence HTML Interface, select Table footers or, in the case of a cross table, Bottom footer or Right footer.
     ○ If you are using Web Intelligence Applet interface or Web Intelligence Rich Client, select Show table footers or, in the case of a cross table, Show bottom footer or Show right footer.
   ○ To hide the footers, unselect the footer options.
6.  Click OK to return to the document.

4.1.4.7  To start tables on a new report page

You can set a table to start on a new Web Intelligence report page in Design mode.
1.  Open a Web Intelligence document in Design mode.
2.  Hover the mouse over the table border until the cursor becomes a plus sign, click the right mouse button and select Format Table from the contextual menu.
3.  In the Layout tab, select Start on a new page in the Vertical or Horizontal panes.
   The Horizontal and Vertical panes refer to the table axes.
4.  Click OK to return to the document.

4.1.4.8  To display object names in headers on cross tables

You can display object names in headers in cross tables in a Web Intelligence document in Design mode.
1.  Open a Web Intelligence document in Design mode.
2.  Hover the mouse over the table border until the cursor becomes a plus sign, click the right mouse button and select Format Table from the contextual menu.
3. In the General tab, click Show object names to display the object names in additional headers on the cross table.
4. Click OK to return to the document.

4.1.4.9  To avoid page breaks in tables

You can stop page breaks from occurring in tables in a Web Intelligence report in Design mode.
1. Open a Web Intelligence document in Design mode.
2. Hover the mouse over the table border until the cursor becomes a plus sign, click the right mouse button and select Format Table from the contextual menu.
3. In the Layout tab, select Avoid page breaks in table in the Vertical or Horizontal panes.
   The Horizontal and Vertical panes refer to the table axes.
4. Click OK to return to the document.

4.1.4.10  To repeat table headers or footers on report pages

You can set table headers and footers to be repeated in Web Intelligence report pages in Design mode.
1. Open a Web Intelligence document in Design mode.
2. Hover the mouse over the table border until the cursor becomes a plus sign, click the right mouse button and select Format Table from the contextual menu.
3. In the Layout tab, select Repeat header on every page or Repeat footer on every page in the Vertical or Horizontal panes.
   The Horizontal and Vertical panes refer to the table axes.
4. Click OK in the document.

4.1.5  Transforming a dimension in a table using dimension value groups

In a table column in a Web Intelligence report, you can collect the values of a dimension into an aggregated group to which you can assign a unique name. For example, if your company has branch offices in the US cities of New York, Washington, and Boston, you can place them in a group called Eastern branch offices.

In a table, when you group the values of a dimension, they are no longer visible in the table as single entities; they and their data are aggregated into the group until you choose to remove any of the values of a dimension from the group.

The Group option is available in the Design mode in the following locations:
- From the Analysis Display tabs
- From the right-click contextual menu
A variable object for this aggregated group is created in the *Available Objects* tab on the Side Panel and allows you to manage the group configuration.

**Ungrouped values**

Any ungrouped values of a dimension remain separate in the table column unless you activate the *Automatically grouped* option. If you select *Automatically grouped* for ungrouped values, then the values of a dimension are removed from the table and aggregated into the selected group’s data.

**Tips about grouping values of a dimension in a table**

- You can reuse the aggregated group variable in other tables.

  **Note**

  If the original dimension can be used in the same or other tables and is not affected by the group variable.

- A dimension value can only belong to one group.

- A dimension value group is a text data type, even if the original values of a dimension are dates or numbers.

- We recommend that you do not have more than 1,000 values of a dimension in a group. To use more than this amount could cause performance issues.

**4.1.5.1 To group values of a dimension in a table using the Group dropdown list**

The *Group* option allows you to assign two or more selected values of a dimension in a table column to an aggregated group and assign that group a unique name.

1. Open a Web Intelligence document in *Design* mode.
2. Select two or more values of a dimension in a table column and do one of the following:
   - In the *Analysis* tab, in the *Display* subtab, select *Group* from the *Group* dropdown list.
   - Right-click the selection and from the *Group* contextual menu, select *Group*.
3. In the *New Group* dialog box, change the proposed group name if necessary, and click *OK*.

The values are grouped in the dimension column in the table, and the column header name changes to “[dimension name]⁺”. For example, if you group values for dimension “City⁺”, the column header changes to show “City⁺”. A group variable is created in the *Variables* folder in the *Available Objects* tab on the Side Panel. You can change the group variable name in the *Manage Groups* dialog box or using the right-click contextual menu for the group variable in the *Variables* folder.
Related Information

To edit Group variables in the Available Objects tab in the Side Panel [page 325]
You can edit dimension group variables in the Side Panel.

To group values of a dimension in a table using the Manage Groups dialog box [page 320]
The Manage Group dialog box allows you to assign two or more values of a dimension in a table column to an aggregated group and assign that aggregated group a unique name.

To add values of a dimension to an existing group using the Manage Groups dialog box [page 322]
The Manage Group dialog box allows you to add values of a dimension to an existing aggregated group in a table column.

To ungroup values of a dimension from an existing group using the Manage Groups dialog box [page 321]
The “Manage Group” dialog box allows you to remove values of a dimension from an aggregated group.

To ungroup values of a dimension from an existing group using the Group dropdown list [page 321]
The Manage Group dialog box allows you to rename an existing aggregated group of dimension values.

To rename a dimension value group using the Manage Groups dialog box [page 325]
The “Manage Group” dialog box allows you to rename an existing aggregated group of dimension values.

To rename a dimension value group using the Group dropdown list [page 324]
The Rename Group option in the Group dropdown list allows you to rename a dimension value group.

4.1.5.2 To ungroup values of a dimension from an existing group using the Group dropdown list

The Ungroup option in the Group dropdown list allows you to ungroup the values of a dimension in a table column.

1. Open a Web Intelligence document in Design mode.
2. Select at least one dimension value group of a group variable in a table column and do one of the following:
   ○ In the Analysis tab, in the Display subtab, from the Group dropdown list, select Ungroup.
   ○ Right-click the table and from the Group contextual menu, select Ungroup.

The values of the dimension reappear in the table column.

Caution
If you have selected Automatically grouped for ungrouped values, then the values of the dimension do not appear singly in the table column because they are aggregated into the “ungrouped” group data.

Related Information

To edit Group variables in the Available Objects tab in the Side Panel [page 325]
You can edit dimension group variables in the Side Panel.

To add values of a dimension to an existing group using the Manage Groups dialog box [page 322]
The Manage Group dialog box allows you to add values of a dimension to an existing aggregated group in a table column.

To ungroup values of a dimension from an existing group using the Manage Groups dialog box [page 321]
The “Manage Group” dialog box allows you to remove values of a dimension from an aggregated group.

To add values of a dimension to an existing group using the Group dropdown list [page 322]

The Move to Group option in the Group dropdown list allows you to add selected values of a dimension in a table to an aggregated group.

4.1.5.3 To group values of a dimension in a table using the Manage Groups dialog box

The Manage Group dialog box allows you to assign two or more values of a dimension in a table column to an aggregated group and assign that aggregated group a unique name.

1. Open a Web Intelligence document in Design mode.
2. Click a dimension column in the table and do one of the following:
   ○ In the Analysis tab, in the Display subtab, select Manage Groups from the Group dropdown list.
   ○ Right-click the dimension column in the table and from the Group contextual menu, select Manage Groups.
   ○ Right-click the group variable in the Available Objects tab on the Side Panel and select Manage Groups.
3. In the Manage Groups dialog box, select the checkboxes for the dimension value categories that you want to group.
4. Click Group.
5. In the New Group dialog box, type a name for the group and click OK.
The groups of values appear in the Groups column.
6. To have any ungrouped values of a dimension automatically grouped:
   a) From the Ungrouped Values dropdown list, select Automatically Grouped.
   b) In the Automatically grouped values dialog box, enter a name for the group in the Name text box if you prefer a name different from Others.
   c) Click OK.
7. Click OK to close the Manage Groups dialog box.
The values are grouped in the dimension column in the table, and the column header name changes to ")[dimension name]++". For example, if you group values for dimension "City", the column header changes to show "City++. A group variable is created in the Variables folder in the Available Objects tab on the Side Panel. You can change the group variable name in the Manage Groups dialog box or using the right-click contextual menu for the group variable in the Variables folder.

Related Information

To edit Group variables in the Available Objects tab in the Side Panel [page 325]
You can edit dimension group variables in the Side Panel.

To group values of a dimension in a table using the Group dropdown list [page 318]
The Group option allows you to assign two or more selected values of a dimension in a table column to an aggregated group and assign that group a unique name.

To ungroup values of a dimension from an existing group using the Manage Groups dialog box [page 321]
The “Manage Group” dialog box allows you to remove values of a dimension from an aggregated group.

4.1.5.4 To ungroup values of a dimension from an existing group using the Manage Groups dialog box

1. Open a Web Intelligence document in Design mode.
2. Click a dimension column in the table and do one of the following:
   - In the Analysis tab, in the Display subtab, select Manage Groups from the Group dropdown list.
   - Right-click the dimension column in the table and from the Group contextual menu, select Manage Groups.
3. In the Manage Groups dialog box, select the checkbox next to the values that you want to remove from a group.
4. Click Ungroup.
   - The group name disappears in the “Groups” column next to the values that you selected.
5. Click OK to close the Manage Groups dialog box.
   - The values you removed from a group reappear in the table.

⚠️ Caution
If you have selected Automatically grouped for ungrouped values, then the values of a dimension are aggregated into this group data.

Related Information

To ungroup values of a dimension from an existing group using the Group dropdown list [page 319]

The Ungroup option in the Group dropdown list allows you to ungroup the values of a dimension in a table column.

To group values of a dimension in a table using the Manage Groups dialog box [page 320]

The Manage Group dialog box allows you to assign two or more values of a dimension in a table column to an aggregated group and assign that aggregated group a unique name.

To group values of a dimension in a table using the Group dropdown list [page 318]

The Group option allows you to assign two or more selected values of a dimension in a table column to an aggregated group and assign that group a unique name.
4.1.5.5  To add values of a dimension to an existing group using the Group dropdown list

The Move to Group option in the Group dropdown list allows you to add selected values of a dimension in a table to an aggregated group.

1. Open a Web Intelligence document in Design mode.
2. Select one or more dimension value in a table column and do one of the following:
   ○ In the Analysis tab, in the Display subtab, select Group from the Group dropdown list.
   ○ Right-click the selection and from the Group contextual menu, select Group.

The selected values of the dimension disappear from the dimension column and are aggregated into the selected group.

Related Information

To add values of a dimension to an existing group using the Manage Groups dialog box [page 322]

The Manage Group dialog box allows you to add values of a dimension to an existing aggregated group in a table column.

To add a group of dimension values to another group of dimension values using the Manage Groups dialog box [page 323]

The Manage Group dialog box allows you to add one or more groups to an existing aggregated value group in a table column.

To ungroup values of a dimension from an existing group using the Group dropdown list [page 319]

The Ungroup option in the Group dropdown list allows you to ungroup the values of a dimension in a table column.

To ungroup values of a dimension from an existing group using the Manage Groups dialog box [page 321]

The "Manage Group" dialog box allows you to remove values of a dimension from an aggregated group.

4.1.5.6  To add values of a dimension to an existing group using the Manage Groups dialog box

The Manage Group dialog box allows you to add values of a dimension to an existing aggregated group in a table column.

1. Open a Web Intelligence document in Design mode.
2. Click a dimension column in the table and do one of the following:
   ○ In the Analysis tab, in the Display subtab, select Manage Groups from the Group dropdown list.
   ○ Right-click the dimension column in the table and from the Group contextual menu, select Manage Groups.
   ○ Right-click the group variable in the Available Objects tab on the Side Panel and select Manage Groups.
3. In the Manage Groups dialog box, select the checkbox next to the dimension value that you want to add to a group.
4. Select a group from the Move to dropdown list. The group name appears in the Groups column next to the variables that you have selected.

5. Click OK to close the Manage Groups dialog box. The selected values of the dimension disappear from the table column and are aggregated into the selected group.

Related Information

To add values of a dimension to an existing group using the Group dropdown list [page 322]  
The Move to Group option in the Group dropdown list allows you to add selected values of a dimension in a table to an aggregated group.

To add a group of dimension values to another group of dimension values using the Manage Groups dialog box [page 323]  
The Manage Group dialog box allows you to add one or more groups to an existing aggregated value group in a table column.

4.1.5.7 To add a group of dimension values to another group of dimension values using the Manage Groups dialog box

The Manage Group dialog box allows you to add one or more groups to an existing aggregated value group in a table column.

1. Open a Web Intelligence document in Design mode.

2. Click a dimension column in the table and do one of the following:
   ○ In the Analysis tab, in the Display subtab, select Manage Groups from the Group dropdown list.
   ○ Right-click the dimension column in the table and from the Group contextual menu, select Manage Groups.
   ○ Right-click the group variable in the Available Objects tab on the Side Panel and select Manage Groups.

3. In the Manage Groups dialog box, select the checkbox next to the grouped values of a dimension that you want to add to another group.

4. Select a group from the Move to dropdown list. The group name in the Groups column next to the values you selected is changed to reflect the group change.

5. Click OK to close the Manage Groups dialog box.

Related Information

To add values of a dimension to an existing group using the Group dropdown list [page 322]  
The Move to Group option in the Group dropdown list allows you to add selected values of a dimension in a table to an aggregated group.

To add values of a dimension to an existing group using the Manage Groups dialog box [page 322]
The Manage Group dialog box allows you to add values of a dimension to an existing aggregated group in a table column.

To ungroup values of a dimension from an existing group using the Manage Groups dialog box [page 321]
The “Manage Group” dialog box allows you to remove values of a dimension from an aggregated group.

To ungroup values of a dimension from an existing group using the Group dropdown list [page 319]
The Ungroup option in the Group dropdown list allows you to ungroup the values of a dimension in a table column.

4.1.5.8 To rename a dimension value group using the Group dropdown list

The Rename Group option in the Group dropdown list allows you to rename a dimension value group.

1. Open a Web Intelligence document in Design mode.
2. Select a dimension value group in a table column and do one of the following:
   ○ In the Analysis tab, in the Display subtab, from the Group dropdown list, select Rename Group.
   ○ Right-click the table and from the Group contextual menu, select Rename Group.
3. In the Rename Group dialog box, enter a new name and click OK.

The selected dimension value group name is changed in the table column.

Tip
You can also rename the group by renaming its variable in the Available Objects tab on the Side Panel.

Related Information

To edit Group variables in the Available Objects tab in the Side Panel [page 325]
You can edit dimension group variables in the Side Panel.

To rename a dimension group variable name using the Manage Groups dialog [page 326]
The Manage Group dialog box allows you to rename the group variable name. This name appears in the column header of the table and in the Variables folder in the Available Objects tab on the Side Panel.

To rename a dimension value group using the Manage Groups dialog box [page 325]
The Manage Group dialog box allows you to rename an existing aggregated group of dimension values.
4.1.5.9 To rename a dimension value group using the Manage Groups dialog box

The Manage Group dialog box allows you to rename an existing aggregated group of dimension values.

1. Open a Web Intelligence document in Design mode.
2. Click a dimension column in the table and do one of the following:
   - In the Analysis tab, in the Display subtab, select Manage Groups from the Group dropdown list.
   - Right-click the dimension column in the table and from the Group contextual menu, select Manage Groups.
   - Right-click the group variable in the Available Objects tab on the Side Panel and select Manage Groups.
3. From the dropdown list at the bottom of the Manage Groups dialog box, select the value group that you want to rename.
4. Click the Rename the selected group icon.
5. In the Rename Group dialog box, enter a new name and click OK.
6. Click OK to close the Manage Groups dialog box.

The selected dimension value group name is changed in the table column.

Related Information

To rename a dimension value group using the Group dropdown list [page 324]
The Rename Group option in the Group dropdown list allows you to rename a dimension value group.

To rename a dimension group variable name using the Manage Groups dialog [page 326]
The Manage Group dialog box allows you to rename the group variable name. This name appears in the column header of the table and in the Variables folder in the Available Objects tab on the Side Panel.

4.1.5.10 Dimension group variables

4.1.5.10.1 To edit Group variables in the Available Objects tab in the Side Panel

You can edit dimension group variables in the Side Panel.

1. Open a Web Intelligence document in Design mode.
2. In the Available Objects tab on the Side Panel, right-click a group variable object in the Variables folder.
3. Do one of the following:
   - To edit the values for a group, click Edit. In the Manage Group dialog box, edit the group as required.
   - To rename the group variable, click Rename. In the Rename Variable dialog box, enter a new name and click OK.
Note

You can also rename the group variable in the Manage Group dialog box.

○ To copy the variable, click Copy.
○ To delete the variable, click Remove. The group variable is deleted from the Variables folder and the group column is deleted from any tables in which the variable is used.

Related Information

To group values of a dimension in a table using the Manage Groups dialog box [page 320]

The Manage Group dialog box allows you to assign two or more values of a dimension in a table column to an aggregated group and assign that aggregated group a unique name.

To add values of a dimension to an existing group using the Manage Groups dialog box [page 322]

The Manage Group dialog box allows you to add values of a dimension to an existing aggregated group in a table column.

To rename a dimension group variable name using the Manage Groups dialog [page 325]

The Manage Group dialog box allows you to rename the group variable name. This name appears in the column header of the table and in the Variables folder in the Available Objects tab on the Side Panel.

To rename a dimension group variable using the Manage Groups dialog box [page 326]

The Manage Group dialog box allows you to rename an existing aggregated group of dimension values.

To add a group of dimension values to another group of dimension values using the Manage Groups dialog box [page 323]

The Manage Group dialog box allows you to add one or more groups to an existing aggregated value group in a table column.

4.1.5.10.2 To rename a dimension group variable name using the Manage Groups dialog

The Manage Group dialog box allows you to rename the group variable name. This name appears in the column header of the table and in the Variables folder in the Available Objects tab on the Side Panel.

1. Open a Web Intelligence document in Design mode.

2. Click a dimension column in the table and do one of the following:
   ○ In the Analysis tab, in the Display subtab, select Manage Groups from the Group dropdown list.
   ○ Right-click the dimension column in the table and from the Group contextual menu, select Manage Groups.
   ○ Right-click the group variable in the Available Objects tab on the Side Panel and select Manage Groups.

3. From the dropdown list at the bottom of the Manage Groups dialog box, select the group that you want to rename.

4. Click the Rename the selected group icon.

5. In the Rename Group dialog box, enter a new name and click OK.
6. Click OK to close the **Manage Groups** dialog box.

The selected dimension group name is changed for the table column and in any other table in which it is used.

**Tip**

You can also change the dimension group variable name directly in the **Available Objects** tab on the Side Panel.

**Related Information**

- To edit Group variables in the Available Objects tab in the Side Panel [page 325]
  
  You can edit dimension group variables in the Side Panel.

- To rename a dimension value group using the Group dropdown list [page 324]
  
  The Rename Group option in the Group dropdown list allows you to rename a dimension value group.

- To rename a dimension value group using the Manage Groups dialog box [page 325]
  
  The Manage Group dialog box allows you to rename an existing aggregated group of dimension values.

### 4.2 Displaying data in free-standing cells

Free-standing cells are single cells that stand alone in a report.

You can place any text or formula in a blank free-standing cell, or you can use pre-defined free standing cells that display specific information.

For more information on the functions used in free-standing cells, see the *Using Functions, Formulas and Calculations in Web Intelligence* guide, or see the Web Intelligence online help.

**Formula and text cell functions in free-standing cells**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank Cell</td>
<td>Empty cell in which you can enter any text or formula.</td>
</tr>
<tr>
<td>Drill Filters</td>
<td>Uses the <code>DrillFilters</code> function to display details of the drill filters applied to the report.</td>
</tr>
<tr>
<td>Last Refresh Date</td>
<td>Uses the <code>LastExecutionDate</code> function to display the last date when the document was refreshed.</td>
</tr>
<tr>
<td>Document Name</td>
<td>Uses the <code>DocumentName</code> function to display the document name.</td>
</tr>
<tr>
<td>Query Summary</td>
<td>Uses the <code>QuerySummary</code> function to display details of the queries in the document.</td>
</tr>
</tbody>
</table>
### Function Description

**Prompt**

From the *Prompt* dropdown list, you can select one of the following cell options:

- **PromptSummary**: This cell uses the `PromptSummary` function to display the complete details of the user prompt selections in the document.
- **<name of query prompt>**: The name of each query prompt is listed in the *Prompt* list. A pre-defined cell based on a query prompt displays the user prompt selections at the last refresh or *Run Query* action.

**Report Filter Summary**

Uses the `ReportFilterSummary` function to display the report filters applied to the report.

### Page number cell functions in free-standing cells

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Number</td>
<td>Uses the <code>Page</code> function to display the number of pages in the report.</td>
</tr>
<tr>
<td>Page Number/Total Pages</td>
<td>Uses the <code>Page</code> and <code>NumberOfPages</code> functions to display the current page number and the total number of pages in the report.</td>
</tr>
<tr>
<td>Total Number of Pages</td>
<td>Uses the <code>NumberOfPages</code> function to display the total number of pages in the report.</td>
</tr>
</tbody>
</table>

### 4.2.1 To insert a free-standing cell in a report

You can insert a free-standing cell in a table.

1. In a Web Intelligence document in **Design** mode, select the **Report Element** tab.
2. In the **Cell** subtab, do one of the following:
   - Click **Blank** to insert a blank cell.
   - From the **Pre-Defined** dropdown list, select a pre-defined cell to insert.
3. Place your mouse over the part of the report where you want to insert the cell and click the left mouse button.
4. If you have inserted a blank cell, type the text or formula of the cell in the **Formula Bar**.
   
   **Note**
   To activate the **Formula Bar**, click the **Formula Bar** icon in the **Analysis** tab.

5. To delete the cell, select it and press the `Delete` key on your keyboard.
4.2.2 To hide free-standing cells

You can hide free-standing cells unconditionally, when they are empty, or based on the result of a formula.

1. In a Web Intelligence document in Design mode, right-click the free-standing cell and select Format Cell in the contextual menu.

2. In the Format Cell dialog box, in the General tab, select any of the following:
   ○ To hide the cell unconditionally, select Hide always.
   ○ To hide the cell when it is empty, select Hide when empty.
   ○ To hide the cell based on the result of a formula, click Hide when the following formula is true and type the formula in the box.

3. Click OK to return to the document.

Related Information

To redisplay hidden tables, cells or sections [page 314]
   You can redisplay hidden objects in a Web Intelligence document in Design mode.

4.2.3 To copy a free-standing cell

You can copy and paste free-standing cells within a report or into external applications such as Microsoft Word and Excel.

1. Open a Web Intelligence document in Design mode.

2. Right-click the free-standing cell and select Copy in the contextual menu.

3. To paste the free-standing cell to another part of the report, right-click where you want the free-standing cell to appear and click Paste on the menu.

4. To paste the free-standing cell into another application, paste the contents of the clipboard from within the application.
   You can also copy a free-standing cell into another application by dragging and dropping the free-standing cell directly into the open document in the target application. When you drag and drop a free-standing cell into a Microsoft Office application, the text in the cell is pasted into the application.
4.3 Organizing data with sections, breaks and sorts

4.3.1 Using sections to group data

Sections allow you to split report information into smaller, more comprehensible parts.

**Example**

**Grouping quarterly revenue results into sections on a report**

You are the regional sales manager in Texas. You receive a report showing 2003 annual revenue for stores in your region, broken down by cities and quarters.

<table>
<thead>
<tr>
<th>City</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>Q1</td>
<td>314430</td>
</tr>
<tr>
<td>Austin</td>
<td>Q2</td>
<td>273608</td>
</tr>
<tr>
<td>Austin</td>
<td>Q3</td>
<td>294798</td>
</tr>
<tr>
<td>Austin</td>
<td>Q4</td>
<td>252644</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q1</td>
<td>215874</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q2</td>
<td>194689</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q3</td>
<td>204066</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q4</td>
<td>188791</td>
</tr>
<tr>
<td>Houston</td>
<td>Q1</td>
<td>572177</td>
</tr>
<tr>
<td>Houston</td>
<td>Q2</td>
<td>619924</td>
</tr>
<tr>
<td>Houston</td>
<td>Q3</td>
<td>533765</td>
</tr>
<tr>
<td>Houston</td>
<td>Q4</td>
<td>520332</td>
</tr>
</tbody>
</table>

To make a comparison of the results for each city per quarter, you set [Quarter] as a section value. The report is broken up into four separate sections by quarter.

Q1

<table>
<thead>
<tr>
<th>City</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>314430</td>
</tr>
<tr>
<td>Dallas</td>
<td>215874</td>
</tr>
<tr>
<td>Houston</td>
<td>572177</td>
</tr>
</tbody>
</table>

Q2

<table>
<thead>
<tr>
<th>City</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>273608</td>
</tr>
<tr>
<td>Dallas</td>
<td>194689</td>
</tr>
</tbody>
</table>
You can create a single section or include multiple sections with subsections in a report. You can also remove and reposition sections within a report.

You can create a section from one of two sources:
- on a dimension already displayed on a table or chart: right-click the dimension and select Set as section.
- on a dimension included in the document but not displayed on a table or chart

You cannot create a section with a measure object.

### Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]

You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

### 4.3.1.1 To create a section from a column

You can create a section based on a table column in a Web Intelligence report in Design mode.

1. Open a Web Intelligence document in Design mode.
2. Right-click the column you want to define as a section and click Set as Section.
### 4.3.1.2 To create a section from a dimension

You can create a section in a Web Intelligence document in *Design* mode.

1. In a Web Intelligence document in *Design* mode, select the *Report Elements* tab.
2. In the *Section* subtab, click *Insert Section*.
3. Click in the report at the position where you want to insert the section.
4. Select the dimension in the dialog box that appears and click *OK* to insert the section.

### 4.3.1.3 Using report filters in report sections

You can apply report filters to sections using values in the section header or that appear within the section.

#### Filters on a section header

If you have a report with section *[Country]*, you can use in the filter syntax *[Country] = "US"* to filter out all sections on countries that are not "US".

#### Filters on section data

If you have a report with section *[Region]* and you use in the filter syntax *[Product]="Drinks"* in the section, the report contains all sections that contain the product "Drinks".

The filter is based on the data in the section, but applied indirectly to the data in the section header.

### Related Information

*To create, edit, and delete standard report filters* [page 271]

You can work with report filters in the *Report Filter* dialog box.

### 4.3.1.4 Sections based on a hierarchy

If you create a section on a hierarchy, each member of the hierarchy becomes a section header.

You can expand sections in the same way as you expand members in a column in a table.

You have a report that displays the following data:
<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>Male</td>
<td>235,243</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>254,342</td>
</tr>
<tr>
<td>Australia</td>
<td>Male</td>
<td>34,342</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>45,464</td>
</tr>
<tr>
<td>Canada</td>
<td>Male</td>
<td>12,232</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>14,242</td>
</tr>
<tr>
<td>France</td>
<td>Male</td>
<td>17,343</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>18,001</td>
</tr>
</tbody>
</table>

If you create a section on [Customer Geography], the report initially appears as follows:

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>235,243</td>
</tr>
<tr>
<td>Female</td>
<td>254,342</td>
</tr>
</tbody>
</table>

If you expand the section header, the report appears as follows:

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>34,342</td>
</tr>
<tr>
<td>Female</td>
<td>45,464</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>12,232</td>
</tr>
<tr>
<td>Female</td>
<td>14,242</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td></td>
</tr>
<tr>
<td>Female</td>
<td></td>
</tr>
<tr>
<td>Gender</td>
<td>Internet Sales Amount</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Male</td>
<td>17.343</td>
</tr>
<tr>
<td>Female</td>
<td>18.001</td>
</tr>
</tbody>
</table>

### 4.3.1.5 To remove a section cell or section

You can remove a section or section cell in a Web Intelligence report in **Design** mode.

1. Open a Web Intelligence document in **Design** mode.
2. Right-click a section cell and do one of the following:
   - Select **Delete** ➤ **Cell Only** to delete the section cell.
   - Select **Delete** ➤ **Section and Cell** to delete the section and the cell.

### 4.3.1.6 To set the page layout of a section

You can set the page layout of a section in a Web Intelligence report in **Design** mode.

1. In a Web Intelligence document in **Design** mode, right-click a section and select **Format Section** from the menu.
2. In the **Layout** tab, select any of the following:
   - Select **Start on a new page** to start each section on a new page.
   - Select **Avoid page breaks** to avoid page breaks in the section.
   - Select **Repeat on every page** to repeat the section header on every page.
3. Click **OK** to return to the document.

### 4.3.1.7 To hide sections

You can hide sections in a Web Intelligence report in **Design** mode.

1. In a Web Intelligence document in **Design** mode, select a section.
2. In the **Report Elements** tab, in the **Behaviors** subtab, click the arrow next to the **Hide** button and select one of the following:
   - To hide the section, select **Hide**.
   - To hide the section when it is empty, select **Hide When Empty**.
   - To hide the section when a specified formula is true, select **Hide When** ➤ **Hide when the following formula is true**, and type a formula in the box. The formula must return a Boolean value (True or False).
Related Information

To redisplay hidden tables, cells or sections [page 314]
You can redisplay hidden objects in a Web Intelligence document in Design mode.

4.3.1.8 To define colors and images in a section

You can define section colors and images in a Web Intelligence report in Design mode.

1. In a Web Intelligence document in Design mode, right-click the section and select Format Section.
2. In the Appearance tab, define the colors and images.
3. Click OK to return to the document.

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

4.3.2 Using breaks

A break is a division within a block in which data is grouped according to a selected dimension, detail, or measure into self-contained sections.

Break sections are represented as smaller tables within the same block of data.

You use breaks to display all the data for each unique value of an object in separate parts.

Breaks offer the following advantages:

- You can more efficiently organize how your data is represented.
- You can display subtotals.
- You can display sub-aggregations.

4.3.2.1 Breaks compared to sections

Breaks and sections separate data differently in Web Intelligence.

A section distributes the data into multiple free-standing cells called section headers. Each section header contains one value for a dimension, with a block of data that corresponds to the dimension value.

A break divides the data up within one block. One column contains the values for a dimension, detail, or measure, which are repeated for each other row of values in the block.
### 4.3.2.2 Applying breaks to hierarchies

When you apply a break to a hierarchy, the break occurs on all hierarchy members at all levels.

#### Example

**A break applied to a hierarchy**

You have a report displaying the following data:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Gender</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
<tr>
<td>USA</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
<tr>
<td>CA</td>
<td>F</td>
<td>36,759</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>37,989</td>
</tr>
</tbody>
</table>

If you apply a break to the [Customer] hierarchy, the display appears as follows. The break is applied on each member of [Customer].

<table>
<thead>
<tr>
<th>Customer</th>
<th>Gender</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>269,802</strong></td>
</tr>
<tr>
<td>USA</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>269,802</strong></td>
</tr>
<tr>
<td>CA</td>
<td>F</td>
<td>36,759</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>37,989</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>74,748</strong></td>
</tr>
</tbody>
</table>
4.3.2.3 Default sort order in breaks

When you apply a break in a report, a default sort order is applied.

When you insert a break on an object, the values for the object are automatically sorted in ascending order as follows:

- If the values are numeric, the lowest value appears in the first row of the table, the highest in the last row.
- If the values are alphabetical characters, then the values are sorted in alphabetical order from A to Z.

You can set multiple breaks across several dimensions details or measures and set a sort priority on each break.

4.3.2.4 To insert a break

You can insert a break in any table in a Web Intelligence report, except for in form tables.

1. In a Web Intelligence document in Design mode, in a table, select a column on which you want to apply a break.
2. In the Analysis tab, in the Display subtab, select Add Break from the Break dropdown list. The table is divided into as many mini tables as there are unique values in the column. Each mini table has a footer.

Related Information

To manage breaks [page 338]
You can manage table column breaks in the Manage Breaks dialog box.

4.3.2.5 To remove a break

You can remove the break in a table in the Manage Breaks dialog box.

1. In a Web Intelligence document in Design mode, select the table column on which the break is defined.
2. In the Analysis tab, in the Display subtab, select Remove Break from the Break dropdown list.

Note

If the column does not have a break defined, the Remove Break menu item is not available.

3. To remove all breaks, select any column in the table and select Remove All Breaks from the Break dropdown list. The Remove All Breaks menu item is not available if the table has no breaks defined.
4.3.2.6 To manage breaks

You can manage table column breaks in the Manage Breaks dialog box.

1. In a Web Intelligence document in Design mode, select any column in a table.
2. In the Analysis tab, in the Display subtab, select Manage Breaks from the Break dropdown list.

   The Manage Breaks dialog box shows the breaks defined in the table. If the table is a crosstab, the dialog box shows the breaks on both the horizontal and vertical axes. Each break is represented by the dimension on which it is defined. The order in which the dimensions appear indicates the order in which the breaks are applied.

3. To change the priority of a break, select the dimension and click the Up or Down arrow to move the dimension in the break priority.
4. To add a break, click Add and select the dimension on which you want to apply the break.
5. To remove a break, select the dimension and click Remove.
6. To set the properties of a break, select the dimension and select the properties in the opposite section in the dialog box. See the link at the bottom of this topic for more information on the break properties you can set.
7. Click OK.

Related Information

Break properties [page 338]
A table break has several customizable properties.

4.3.2.7 Break properties

A table break has several customizable properties.

You can set the following properties of a break:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break header</td>
<td>Displays a header for each part of the table, crosstab, or form when you insert a break.</td>
</tr>
<tr>
<td>Break footer</td>
<td>This displays a footer for each break in a section, including a footer after the last row for a table or column for a crosstab when you insert a break. When you apply a calculation to the data, the result is shown in the footer.</td>
</tr>
<tr>
<td>Apply Sort</td>
<td>Applies the default sort order to the values in the break.</td>
</tr>
<tr>
<td>Duplicate values: Display all</td>
<td>Displays all values in the break, even when they are duplicated.</td>
</tr>
<tr>
<td>Duplicate values: Display first</td>
<td>Displays the first value only when values are duplicated.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Duplicate values: Merge</strong></td>
<td>Merges cells containing duplicate values and displays a single value over the merged cells.</td>
</tr>
<tr>
<td><strong>Duplicate values: Repeat first on new page</strong></td>
<td>Displays the first value in a group of duplicate values at the beginning of the break and on each new page.</td>
</tr>
<tr>
<td><strong>Start on a new page</strong></td>
<td>Displays each part of the table or form created by a break on a new page.</td>
</tr>
<tr>
<td><strong>Avoid page breaks in block</strong></td>
<td>Where possible, keeps each break section on the same page. This option is not taken into account when a block is larger than one page.</td>
</tr>
<tr>
<td><strong>Repeat header on every page</strong></td>
<td>Repeats the header at the top of the table on every new page when a table goes over onto a new page.</td>
</tr>
<tr>
<td><strong>Repeat footer on every page</strong></td>
<td>Repeats the footer at the bottom of the table on every new page when a table goes over onto a new page.</td>
</tr>
</tbody>
</table>

### 4.3.3 Using sorts to organize data in reports

You can apply sorts to the values displayed in tables, sections and charts to organize the order in which values are displayed in a report.

By default, the sort starts from the first column.

**Note**

- By default, each individual dimension is sorted ascending, in alphabetic order, when displayed in the report. If you do not set the order explicitly, then the priority is given to the dimensions going from left to right. A dimension or hierarchy from an OLAP source (.unx) is ordered according to the underlying source order, if this source provides an order.
- When the Preferred viewing locale is different from and incompatible with the Document locale (different character sets), sorting in document tables may not work. In order to sort in documents that use a different locale to your Preferred viewing locale, contact your administrator and request the either a change to the registry key for Windows, or to the boconfig.cfg file for UNIX in the following way:
  
  In Windows, on the server machines and client machines, change the following registry key declaration: 
  
  $HKEY_LOCAL_MACHINE\SOFTWARE\SAP BusinessObjects\Suite XI 4.0...\WebIntelligence\Calculator : SortLocale = PVL$, then close and reopen any Web Intelligence documents that are open.

  In UNIX, on the client and server machines, open the boconfig.cfg file (in $installdir/setup/boconfig.cfg), and add the registry key declaration: 
  
  $HKEY_LOCAL_MACHINE\SOFTWARE\SAP BusinessObjects\Suite XI 4.0...\WebIntelligence\Calculator : SortLocale = PVL$, then close and reopen any Web Intelligence documents that are open.

When you perform sorts, the following sort orders are available:
<table>
<thead>
<tr>
<th>Sort order</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default     | Depending on the type of data in the column or row, the results are sorted as follows:  
  ● ascending numeric order for numeric data  
  ● ascending chronological order for date  
  ● alphabetical order for alphanumeric data |
| Ascending   | When selected, results are arranged in ascending order, starting with the smallest value at the top of the column.  
  For example: 100, 200, 300 or California, Colorado, Florida. |
| Descending  | When selected, results are arranged in descending order, starting with the highest value at the top of the column.  
  For example: 300, 200, 100 or Florida, Colorado, California. |
| Custom Order| You define your own sort order. Custom Order is available on dimensions and attributes. |

**Note**
- Custom Order is not available on hierarchies, levels, and measures. It is not possible to manually add values to the Custom Order list if the dimension detail contains an internal key (in data sources like OLAP and BEx).
- By default, the maximum number of values for dimensions are set to different values on the client and server. To avoid conflicts, we recommend that you set both to the same value.

**Caution**
You cannot manually add values for a Custom Order if the dimension has an internal key.

Server default value: 100 items (MaximumCustomSortSize parameter in the WebIntelligenceProcessingServer properties in the CMC)

Client default value: 1000 items (WebiParamCustomSortMaxSize parameter in WebIContainer_ClientDescriptor.xml)

---

**Related Information**

*Interface and document locales* [page 38]
Locales determine the appearance of the application interface (for example, menu items and button text) and data (for example, date and number formatting) in relation to local preferences.
4.3.3.1 Sorting hierarchical data

Sorts apply on hierarchical data within each parent item in the hierarchy. Sorts do not break links between parent and child items.

**Example**

*Sorting hierarchical data*

The following table contains the [Product] hierarchy in an unsorted state:

<table>
<thead>
<tr>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
</tr>
<tr>
<td>Baking Goods</td>
</tr>
<tr>
<td>Beverages</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Soft Drinks</td>
</tr>
<tr>
<td>Milk</td>
</tr>
<tr>
<td>Soda</td>
</tr>
<tr>
<td>Breads</td>
</tr>
</tbody>
</table>

After a descending sort is applied, the hierarchy appears as follows:

<table>
<thead>
<tr>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
</tr>
<tr>
<td>Breads</td>
</tr>
<tr>
<td>Beverages</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Soft Drinks</td>
</tr>
<tr>
<td>Soda</td>
</tr>
<tr>
<td>Milk</td>
</tr>
<tr>
<td>Baking Goods</td>
</tr>
</tbody>
</table>

The sort places grocery types in descending order and beverages in descending order in their parent item. The sorted beverages retain their hierarchical link with their parent item.

4.3.3.2 To insert a sort

You can insert a table sort in a Web Intelligence document in *Design* mode.

1. Open a Web Intelligence document in *Design* mode.
2. Select the column you want to sort.
3. In the *Analysis* tab, in the *Display* subtab, select *Ascending* or *Descending* from the *Sort* list to sort the column in ascending or descending order.
To remove a sort

You can remove a column sort in a Web Intelligence document in **Design** mode.

1. In a Web Intelligence document in **Design** mode, select a sorted column.
2. In the **Analysis** tab, in the **Display** subtab, select *None* from the **Sort** list.

   To remove all sorts from the table, select a column and select **Remove All Sorts**.

To manage sorts

The **Manage Sorts** dialog box displays the sorts applied to the table or chart.

In a cross table, the sorts on both the horizontal and vertical axes are displayed. Each sort is represented by the name of the sorted dimension, and an arrow indicates the sort direction (ascending or descending). The order in which the sorted dimensions appear indicates the order in which the sorts are applied.

1. In a Web Intelligence document in **Design** mode, select the table or chart in which you want to manage sorts.
2. In the **Analysis** tab, in the **Display** subtab, select **Advanced** from the **Sort** dropdown list.
3. In the **Manage Sorts** dialog box, do any of the following:

   - **Note**
     You cannot change the priority of a sort if a sorted break is defined on the dimension.

   ○ To change the priority of a sort, select the dimension and click the **Up** or **Down** arrow to move the dimension in the sort priority.

   ○ To change the direction of a sort, double-click the dimension, or select it and select **Ascending** or **Descending** from the **Order** list.

   ○ To add a sort, click **Add** and select the dimension you want to sort from the list.

   ○ To remove a sort, select the dimension and click **Remove**.

   ○ To customize a sort by choosing your own sort order or adding values to the list of values to sort, click **Values** beneath **Custom Order** and define your custom sort.

   - **Note**
     The **Values** button is disabled if the custom sort is not applicable.

   - **Note**
     The custom order is applied to the entire document and not just the dimension in the selected block.

   ○ To reset a custom sort order to the standard sort order, select the dimension and click **Reset**.

   - **Note**
     The **Reset** button is disabled if the sort on the selected dimension is not customized.
4. Click OK to save your changes and close the Manage Sorts dialog box.

Related Information

Using sorts to organize data in reports [page 339]
You can apply sorts to the values displayed in tables, sections and charts to organize the order in which values are displayed in a report.

4.4 Formatting numbers and dates

You can change how values appear in specific cells or on chart axes using predefined formats available in the application, or by creating your own custom formats.

You can save your custom formats for reuse in more than one block and report in the same document.

4.4.1 Predefined formats

This topic describes the predefined formats available in Web Intelligence for table cells.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>The format defined for the object on the universe.</td>
</tr>
<tr>
<td>Number</td>
<td>Formats for decimal or integer values.</td>
</tr>
<tr>
<td>Currency</td>
<td>Formats for currency values.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time formats.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Formats for true and false values.</td>
</tr>
</tbody>
</table>

Related Information

To apply a custom number format to a cell [page 348]
You can apply an existing custom number format to data in a cell in a table.

To define a custom format [page 347]
You can define custom number formats to use in cells in tables.
4.4.1.1 To apply a predefined format to a cell

You can apply a predefined number format to data in a cell in a table.

1. In a Web Intelligence document in Design mode, select a cell.
2. To select a predefined format:
   ○ In the Web Intelligence HTML interface, in the Formatting tab, select the Numbers subtab, and select a format from the Number Format dropdown list.
   ○ In the Web Intelligence Rich Client, in the Format tab, in the Numbers subtab, and select a format from the DEFAULT dropdown list.
3. Save the document.

4.4.2 Custom formats

In tables, you can use the Custom format type to define a customized format for any cell.

In Web Intelligence functions, the day/date, calendar and time of day character definitions below apply.

---

**Note**

You cannot apply custom formats to numbers and dates in tables in the Web Intelligence HTML interface.

---

The following table lists the strings you can use to create custom formats:

<table>
<thead>
<tr>
<th>Character(s)</th>
<th>Display(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>The correspoding digit. If the number has less digits than the number of # characters used to specify the format, no leading zeros are inserted.</td>
<td>‘12345’ with the format #, ##0 gives ‘12,345’ (if your locale defines the grouping separator as a comma) or ’12 345’ (if your locale defines the grouping separator as a space)</td>
</tr>
<tr>
<td>0</td>
<td>The corresponding digit. If the number has less digits than the number of 0 characters used to specify the format, a leading zero(s) is inserted before the number.</td>
<td>’123’ with the format #0,000 gives ’0.123’</td>
</tr>
<tr>
<td>,</td>
<td>The grouping separator as defined by your locale.</td>
<td>’1234567’ with the format #, #0 gives ’1,234,567’ (if you locale defines the grouping separator as a comma) or ’1 234 567’ (if your locale defines the grouping separator as a non-breaking space)</td>
</tr>
<tr>
<td>.</td>
<td>The decimal separator as defined by your locale.</td>
<td>’12.34’ with the format #.0 gives ’12.34’ (if your locale defines the decimal separator as a period) or ’12,34’ (if your locale defines the decimal separator as a comma)</td>
</tr>
<tr>
<td>Character(s)</td>
<td>Display(s)</td>
<td>Example</td>
</tr>
<tr>
<td>-------------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>[%] %</td>
<td>Displays a percentage sign (%) after the result and multiplies the result by 100.</td>
<td>0.50 becomes 50%.</td>
</tr>
<tr>
<td>%</td>
<td>The % sign after the result, but does not multiply the result by 100.</td>
<td>0.50 becomes 0.50%</td>
</tr>
<tr>
<td>1, 2, 3, a, b, c, $, £, € (and so on)</td>
<td>The alphanumerical character.</td>
<td>‘705.15’ with the format $#.##0 gives ‘$705.15’ or with the format #,.0 € gives ‘705,15 €’</td>
</tr>
<tr>
<td>[Red], [Blue], [Green], [Yellow], [Gray], [White], [Dark Red], [Dark Blue], [Dark Green]</td>
<td>The value in the specified color.</td>
<td>‘150’ with the format #,##0[Red] gives ‘150’ in red text, #,##0[Blue] gives ‘150’ in blue text.</td>
</tr>
<tr>
<td>Day/date characters</td>
<td>(day, date)</td>
<td>The first day of a month with the format d gives ‘1’</td>
</tr>
<tr>
<td>d</td>
<td>The number of the day in the month with no leading zeros. If the date for day is less than two characters, the date displays without a zero before it.</td>
<td>The first day of a month with the format dd gives ‘01’</td>
</tr>
<tr>
<td>dd</td>
<td>The number of the day with leading zeros. If the date for day is less than two characters, the date displays with a zero before it.</td>
<td>‘Monday’ with the format ddd gives ‘Mon’ in English, in French, lundi gives lun.</td>
</tr>
<tr>
<td>ddd</td>
<td>The name of the day abbreviated. The first letter is capitalized if the selected locale uses capitalized day names.</td>
<td>‘Monday’ with the format Dddd gives ‘Mon’ in English, in French, lundi gives Lun.</td>
</tr>
</tbody>
</table>

**Note**
Alphanumeric characters should be delimited by single quotes, otherwise they can be interpreted as formatting characters. For example, # # will result in ‘123 4’. # # will result in ‘# 1234’.
<table>
<thead>
<tr>
<th>Character(s)</th>
<th>Display(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>dddd</td>
<td>The name of the day in full. The first letter is capitalized if the selected locale uses capitalized day names.</td>
<td>‘Monday’ with the format dddd gives ‘Monday’ in English. In French, the day is lundi.</td>
</tr>
<tr>
<td>DDDD</td>
<td>The name of the day in full, in uppercase.</td>
<td>‘Monday’ with the format DDDD gives ‘MONDAY’ in English. In French, the day is LUNDI.</td>
</tr>
<tr>
<td>dddd dd</td>
<td>The day of the week followed by a space and the number of the day.</td>
<td>‘Monday’ with the format dddd dd gives ‘Monday 01’</td>
</tr>
<tr>
<td>Calendar characters</td>
<td>(month, year)</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>The number of the month with no leading zeros. If the number for month is less than two characters, the number displays without a zero before it.</td>
<td>‘January’ with the format M gives ‘1’</td>
</tr>
<tr>
<td>MMM</td>
<td>The number of the month with leading zeros. If the number for month is less than two characters, the number displays with a zero before it.</td>
<td>‘January’ with the format MMM gives 01</td>
</tr>
<tr>
<td>mmm</td>
<td>The name of the month abbreviated. The first letter is capitalized if the selected locale uses capitalization.</td>
<td>‘January’ with the format mmm gives Jan in English. In French, this is ‘jan’.</td>
</tr>
<tr>
<td>MMMM</td>
<td>The name of the month in full. The first letter is capitalized if the selected locale used capitalization.</td>
<td>‘January’ with the format MMMM gives January in English, janvier in French</td>
</tr>
<tr>
<td>yyyy</td>
<td>All four digits for year.</td>
<td>‘2003’ with the format yyyy gives ‘2003’</td>
</tr>
<tr>
<td>Time of day characters</td>
<td>(hours, minutes, seconds, am/pm)</td>
<td>‘2003’ with the format yyyy gives ‘2003’</td>
</tr>
<tr>
<td>hh:mm:ss a</td>
<td>The hour with no leading zeros and the minutes and seconds with leading zeros. The “a” character displays AM or PM after the time when available.</td>
<td>‘21:05:03’ with the format hh:mm:ss a gives ‘9:05:03 PM’ for English locale</td>
</tr>
</tbody>
</table>
The hour according to the 24-hour clock, starting at 0. No leading zero for single figure hours.

'21:00' with the format H gives '21'. Possible values are 0-23.

The hour according to the 24-hour clock, starting at 0.

'21:00' with the format HH gives '21'. Possible values are 00-23.

The hour according to the 24-hour clock, starting at 1. No leading zero for single figure hours.

'21:00' with the format k gives '21'. Possible values are 1-24.

The hour according to the 12-hour clock.

'21:00' with the format hh gives '09'

The hour and minutes with a zero in front of a single-digit hour.

'7:15 am' with the format HH:mm gives '07:15'

The hour, minutes, and seconds with a zero in front of a single-digit hour.

'7:15 am' with the format HH:mm:ss gives '07:15:00'

The minutes, and seconds with a zero in front of a single-digit hour.

'07:15:03' with the format mm:ss gives '15:03'

### 4.4.2.1 To define a custom format

You can define custom number formats to use in cells in tables.

1. In a Web Intelligence document in Design mode, select the Format tab, then the Numbers subtab.
2. Click Custom to display the Custom Format panel.

   ![Note](image)

   Custom formats to numbers are not available in the Web Intelligence HTML interface.

3. Select a format listed in the Samples pane, and then click Custom.
4. Edit the selected format by typing additional characters in one or more text boxes.
   
   For example, if you want to create a custom format for a number value, type the custom format you want in the Positive, Negative, and Equal to zero text boxes. If you want to create a custom format for Boolean values, type the custom format you want in the True and False boxes.
5. Click Add.

   You cannot delete or edit custom formats. To change a custom format, you need to create a new custom format and apply the new format to the selected cells. Any custom formats not applied to cells in a document are deleted automatically when you end your session.

   The custom format appears in the Custom tab of the Format Number panel.

---

<table>
<thead>
<tr>
<th>Character(s)</th>
<th>Display(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>H</strong></td>
<td>The hour according to the 24-hour clock, starting at 0. No leading zero for single figure hours.</td>
<td>'21:00' with the format H gives '21'. Possible values are 0-23.</td>
</tr>
<tr>
<td><strong>HH</strong></td>
<td>The hour according to the 24-hour clock, starting at 0.</td>
<td>'21:00' with the format HH gives '21'. Possible values are 00-23.</td>
</tr>
<tr>
<td><strong>k</strong></td>
<td>The hour according to the 24-hour clock, starting at 1. No leading zero for single figure hours.</td>
<td>'21:00' with the format k gives '21'. Possible values are 1-24.</td>
</tr>
<tr>
<td><strong>hh</strong></td>
<td>The hour according to the 12-hour clock.</td>
<td>'21:00' with the format hh gives '09'</td>
</tr>
<tr>
<td><strong>HH:mm</strong></td>
<td>The hour and minutes with a zero in front of a single-digit hour.</td>
<td>'7:15 am' with the format HH:mm gives '07:15'</td>
</tr>
<tr>
<td><strong>HH:mm:ss</strong></td>
<td>The hour, minutes, and seconds with a zero in front of a single-digit hour.</td>
<td>'7:15 am' with the format HH:mm:ss gives '07:15:00'</td>
</tr>
<tr>
<td><strong>mm:ss</strong></td>
<td>The minutes, and seconds with a zero in front of a single-digit hour.</td>
<td>'07:15:03' with the format mm:ss gives '15:03'</td>
</tr>
</tbody>
</table>
6. Click OK to return to the document.

### 4.4.2.2 To apply a custom number format to a cell

You can apply an existing custom number format to data in a cell in a table.

1. In a Web Intelligence document in **Design** mode, select the cells to which you want to apply a custom format.

   **Note**
   
   Custom formats to numbers are not available in the Web Intelligence HTML interface.

2. Do one of the following:
   - In the **Format** tab, select the **Numbers** subtab. Select the custom formula from the dropdown list.
   - Right-click the selected cells, and select **Format Number** in the **Format Number** panel. In the **Custom** tab, select the custom format. Click OK to return to the document.

### 4.4.3 To format a number as a currency in a table cell

You can format the currency format in a cell in a table.

1. In a Web Intelligence document in **Design** mode, select a cell.

2. In the **Format** or **Formatting** tab, select the **Numbers** subtab.

   **Note**
   
   Custom formats to numbers are not available in the Web Intelligence HTML interface.

3. From the **Currency** icon dropdown list, select the currency symbol.

4. To select a number format, do one of the following:
   - Select a format from the **Default** dropdown list.
   - If you require a format that is not in the dropdown list, click **Custom**. Refer to the To define a custom format topic for more information.

   **Note**
   
   Custom formats to numbers are not available in the Web Intelligence HTML interface.

### Related Information

*To define a custom format* [page 347]

You can define custom number formats to use in cells in tables.
4.4.4  To apply a percentage format to a cell number

In a table in a Web Intelligence document, you can apply the percentage format in more than one way.

1. Open a Web Intelligence document in Design mode.
2. Select one or more cells.
3. Do one of the following:

   ○ In the Format or Formatting tab:
     1. Select the Numbers subtab.
     2. Click the Percentage icon.
     3. From the Default dropdown list, select 123,456.70%.

   ○ Right-click the selection and choose one of the following:
     ○ If you are in the Web Intelligence Rich Client or Web Intelligence Applet interface, select Format Number. In the Format Number dialog box, select the Percentage tab, then 123,456.70%. Click OK.
     ○ If you are in the Web Intelligence HTML interface, select Format Cell. In the Format Cell dialog box, select the Number tab, then 123,456.70%. Click OK.

The cell or cells change to the selected number format.
Working with charts in reports

Charts allows you to visualize the data.

You can include one or multiple charts in a Web Intelligence report.

Note

When you export a document that contains a chart to Excel format, the chart is converted into an image.

Related Information

To add a chart to a report

You can add a chart to a Web Intelligence report.

5.1 Opening charts created with XI Web Intelligence 3.x

This version of the software supports backward compatibility with Web Intelligence XI 3.x.

Existing charts are converted automatically when you open them; however if you open an existing 3D chart, other than a 3D bar chart, it will be converted into a 3D bar chart.

5.2 Chart types

Web Intelligence offers many types of charts that you can use to display your data.

Note

3D line, 3D area, and 3D surface charts, available in XI 3.1, are not available in BI 4.x. When Web Intelligence documents are migrated to BI 4.x, any of these charts in the XI 3.1 version of the document are transformed into 3D bar charts.
### 5.2.1 Choosing the correct Web Intelligence chart for your data

Web Intelligence offers various charts for viewing and analyzing data.

<table>
<thead>
<tr>
<th>Analysis type</th>
<th>Description</th>
<th>Available charts</th>
</tr>
</thead>
</table>
| **Comparison** | Use to view the differences between values. It provides the simple comparison of categorical divisions of measures. It is the default analysis type. For example, you could use a bar chart to compare the differences in your sales revenue between different countries. | If you have only a few categories:  
- 3D column chart  
- Bar chart, vertical or horizontal  
- Column chart  
- Heat map  
- Pie with variable slice depth chart  
- Tag cloud chart  
For statistical analysis:  
- Box plot chart |
| **Distribution** | Use one of these charts to show a summarized group of unorganized data. You can also use these charts for qualitative and quantitative data. | For single variables:  
- 3D column chart  
- Area chart  
- Bar chart  
- Column chart  
- Line chart  
If you have more than one variable:  
- Polar scatter chart  
- Scatter chart |
| **Correlation** | Use for viewing the relationship between values. It is useful for comparing multiple measure values. For example, you can view the correlation of two measures, and understand the impact of the first measure on the second measure. | For two variables:  
- Polar bubble chart  
- Polar scatter chart  
- Scatter plot chart  
For three variables:  
- Bubble chart (The size of bubbles within the chart is determined by a third measure) |
<table>
<thead>
<tr>
<th>Analysis type</th>
<th>Description</th>
<th>Available charts</th>
</tr>
</thead>
</table>
| Trend        | Use to show a trend in the data values. This analysis type is particularly useful for dimensions that are time based such as Year. It is useful for seeing progression of your data and possible patterns. For example, you can use a line chart to view sales revenue trends of a product throughout a range of years. | If you have several periods to compare over time:  
- Line chart  
- Radar chart  
If you only have a few periods to compare over time:  
- 3D column chart  
- Column chart  
- Column or line chart with dual axes  
- Combined column and line chart  
- Combined column and line chart with dual axes  
- Waterfall chart |
| Composite    | Use these charts to show cumulative differences in data over time or to show the effect of a measure on values. For example, use a pie chart to see who had the highest sales as part of a total sales value directly: Total sales = $200, Paul had 10% ($20), David had 65% ($130), and Susan had 25% ($50). | For data changing over time:  
- Area chart  
- 100% stacked bar or column chart  
- Stacked bar or column chart  
For static data:  
- Pie with variable slice depth chart  
- Pie or donut chart  
- Tree map  
- Waterfall chart |
| Geography    | Use to show a map of the country object on a mobile device. The data for dimensions sorted by country are shown on the map. This is useful to see the geographical spread of data. | Geo analysis |

**Note**

The Geo map is actually a data table in reports that is configured for use only on mobile devices. For more information on this chart, refer to the *Mobile BI Report Designer’s Guide*.

**Related Information**

*To add a chart to a report* [page 360]
You can add a chart to a Web Intelligence report.

To assign data to a chart [page 361]
You can assign data to a chart in a report via the Side Panel or from an option in the contextual menu.

To change the chart type by using Turn Into [page 364]
You can change the chart type using Turn Into in the chart contextual menu.

5.2.2 Bar charts

Bar charts display data in rectangular form horizontally.

Bar charts are useful if you want to compare similar groups of data; for example, revenue from one time period to another.

Table 27: Types of bar charts

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Chart</td>
<td>A chart constructed of horizontally-oriented rectangles. The lengths of rectan­gles are proportional to the values associated to different category items.</td>
</tr>
<tr>
<td>Stacked Bar Chart</td>
<td>A chart constructed of horizontally-oriented stacked colored rectangles. The heights of the rectangles are proportional to the values associated to different category items. Rectangles are colored according to legend entries.</td>
</tr>
<tr>
<td>100% Stacked Bar</td>
<td>A chart with data displayed as parts of a whole (as percentages). A whole being a rectangle and a series being a subdivision of the rectangle.</td>
</tr>
</tbody>
</table>

5.2.3 Box plot charts

A Box Plot Chart (also called a stock chart) displays a five-number summary based on the distribution of a dataset: the maximum, the minimum, the first quartile, the third quartile, and the median.

A Box Plot Chart can also show abnormal values called outliers.
## 5.2.4 Column charts

Column charts display a series as a set of vertical bars that are grouped by category.

Column charts are useful for showing data changes over a period of time or for illustrating comparisons among items.

Web Intelligence offers the following column charts.

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column Chart</strong></td>
<td>A chart constructed of vertically-oriented rectangles. The heights of the rectangles are proportional to the values associated to different category items.</td>
</tr>
<tr>
<td><strong>Column Chart with Dual Value Axes</strong></td>
<td>A chart with two value axes. It allows a part of a data series to be plotted against one axis and a part of the data series to be plotted against the other axis.</td>
</tr>
<tr>
<td><strong>Combined Column and Line Chart</strong></td>
<td>A chart displaying a combination of a column chart and a line chart. The chart types share the same value axis.</td>
</tr>
<tr>
<td><strong>Combined Column and Line Chart with Dual Value Axes</strong></td>
<td>A chart displaying a combination of a column chart and a line chart. The chart types each have their own value axis.</td>
</tr>
<tr>
<td><strong>Stacked Column Chart</strong></td>
<td>A chart constructed of vertically-oriented stacked colored rectangles. The heights of rectangles are proportional to the values associated to different category items. Rectangles are colored according to legend entries.</td>
</tr>
</tbody>
</table>
### Chart type

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>100% Stacked Column</strong></td>
<td>A chart with data displayed as parts of a whole (as percentages) with a whole being a column and a series being a subdivision of the column. If there is only one series in your chart, all the column bars will fit to 100% of the chart area.</td>
</tr>
<tr>
<td><strong>3D Column Chart</strong></td>
<td>A chart similar to a column chart with an added 3D dimension.</td>
</tr>
</tbody>
</table>

## 5.2.5 Line charts

Line charts connect specific data values with lines, either horizontally or vertically. Line charts are useful if you want to show trends or changes in data over time.

<table>
<thead>
<tr>
<th>Table 28: Types of line charts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart type</strong></td>
</tr>
<tr>
<td><strong>Line Chart</strong></td>
</tr>
<tr>
<td><strong>Line Chart with Dual Axes</strong></td>
</tr>
</tbody>
</table>
### 5.2.6 Map charts

Web Intelligence offers two types of Map chart.

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tree Map</strong></td>
<td>Charts that display values within nested rectangles that can be colored. The levels of nesting correspond to the level of hierarchical breakdown. The size of the rectangles and their color both express a set of values.</td>
</tr>
<tr>
<td><strong>Heat Map</strong></td>
<td>Charts that display values that are represented by colors in a map using a category axis and optionally a second category axis. The colors of the rectangles are determined by a measure value.</td>
</tr>
</tbody>
</table>

### 5.2.7 Pie charts

Pie charts display data as segments of a whole.

Pie charts are useful if you want to show how each part of your report data contributes to the total. You can only include one measure object in a simple pie chart or two in a pie chart with depth. If you have several measures in your report, you should choose another chart type.

Data labels on pie charts can be wrapped for a better layout. In the **Data Values** pane of the **Format Chart** tab, the **Text Policy** option **Wrap** can be used.
### Table 29: Types of pie charts available

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pie Chart</strong></td>
<td>A circular chart made up of sectors. The area of the circle represents a whole, and the sectors of the circle represent the parts of a whole. Additionally, a <strong>Donut Chart</strong> can be displayed from a pie chart. It is similar to a pie chart, but with an empty center; it is ring shaped.</td>
</tr>
<tr>
<td><strong>Pie Chart with Variable Slice Depth</strong></td>
<td>A circular chart made up of sectors. The area of the circle represents a whole, and the sectors of the circle represent the parts of a whole. The sectors may have some depth expressing a third value.</td>
</tr>
</tbody>
</table>

### 5.2.8 Point charts

The Point chart category includes scatter, polar and bubble charts.

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scatter Plot Chart</strong></td>
<td>An XY chart displaying plots. Plots are positioned with coordinates given by a pair of values. Each plot may have colored symbols representing the analysis category item associated with the values. Scatter Charts are similar to line graphs, except that the data points are plotted without a line connecting them. Scatter Charts are useful if you want to make a comparison between specific data points.</td>
</tr>
<tr>
<td>Chart type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bubble Chart</td>
<td>A two-dimensional chart of points representing a collection of data. Extra variables are represented by the size of the points.</td>
</tr>
<tr>
<td>Polar Scatter Plot</td>
<td>An XY chart displaying plots. Plots are positioned with coordinates given by a pair of values. Each plot may be sized according to extra values.</td>
</tr>
<tr>
<td></td>
<td>A chart with one radial axis and one angular axis, where each data point is represented with a symbol. Similar to a Bubble Chart, but without the sizing of points.</td>
</tr>
<tr>
<td>Polar Bubble Chart</td>
<td>An XY chart displaying plots. Plots are positioned with coordinates given by a pair of values. Each plot may be sized according to extra values.</td>
</tr>
<tr>
<td></td>
<td>A two-dimensional chart with one radial axis and one angular axis of points representing a collection of data. Extra variables are represented by the size of the points.</td>
</tr>
</tbody>
</table>

### 5.2.9 Radar charts

The *Radar Chart* (also known as a Spider chart) displays several axes starting from a unique origin and with a common scale.

Each axis represents an analysis category item. Plots are directly placed on an axis according to the associated values. Plots can be linked by lines.

Radar charts are useful if you want to look at several different factors related to one item. For example, you could use a radar chart to display revenue data for different services within a hotel. On one axis, you could display revenue for the rooms. On another you could display revenue for the restaurant, and so on.
5.2.10 Tag cloud charts

A Tag Cloud Chart is a mono-dimensional visualization representing data as words where the word font size represents its relative weight in the dataset.

5.2.11 Waterfall charts

A Waterfall Chart (also known as a Bridge chart) displays vertical bars.

Each one of these bars starts at the level where the preceding bar ends, making the bars look as if they are floating. This type of chart is useful for showing how a measure increases or decreases, for representing positive or negative changes or for illustrating up and down effects.

Types of waterfall charts

- A chart generated from a flat dimension gives a simple waterfall chart.
- A chart generated from hierarchical data gives a complex waterfall chart.

Subtotal management

- Intermediate totals are only generated from hierarchical tree nodes. To generate intermediate totals from a flat dimension, you have to use grouping.
- Intermediate totals (tree nodes) are displayed as a waterfall.

Feeding restrictions

- The category axis is limited to one dimension (or hierarchy).
- The value axis is limited to one measure.
Color management

You can assign specific colors to initial values, totals, subtotals or positive/negative variations.

Related Information

To configure the value colors in a waterfall chart [page 380]
You can configure the start, total, negative and positive values in a waterfall chart.

5.3 Adding, copying and removing charts

5.3.1 To add a chart to a report

You can add a chart to a Web Intelligence report.

1. Open a Web Intelligence document in Design mode.

   Note
   
   If you are in Structure Only Design mode, all the charts will appear grayed out.

2. Do one of the following:
   ○ In the Reports Elements tab, in the Chart subtab, click a chart icon, then click in your report. Drag and drop the dimensions and measures you want into it from the Available Objects pane.
   ○ Right-click in the report and select Insert and do one of the following:
     ○ Select a column, line, pie or scatter plot chart.
     ○ To insert a different sort of chart from those listed above, click Insert a Report Element.
     
     The chart appears empty in light gray. This is sometimes called a ghost chart.
   ○ Select a table you want to turn into a chart and do one of the following:
     ○ Select Turn Into from the Tools subtab.
     ○ Right-click the table and select Turn Into, then select a chart type.

Related Information

To assign data to a chart [page 361]
You can assign data to a chart in a report via the Side Panel or from an option in the contextual menu.
5.3.2 Assigning data to a chart

Depending on the chart, you assign objects, also called feeding, to different drivers.

Some dimensions and measures generate axis labels or values and some drive the series color.

The table explains the different elements for assigning data a chart.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Feeds</th>
<th>Object type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binding object to axes</td>
<td>Value axes</td>
<td>Measures</td>
</tr>
<tr>
<td></td>
<td>Category axes</td>
<td>Dimensions, Details or Measure Names</td>
</tr>
<tr>
<td>Defining series (*)</td>
<td>• Region Color</td>
<td>Dimensions, Details or Measure Names</td>
</tr>
<tr>
<td></td>
<td>• Region Shape (Radar &amp; Point charts)</td>
<td></td>
</tr>
<tr>
<td>Defining series size</td>
<td>• Pie sector size / sector height</td>
<td>Measures</td>
</tr>
<tr>
<td></td>
<td>• TreeMap rectangle weight</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Bubble height / Bubble width</td>
<td></td>
</tr>
<tr>
<td>Conditional coloring (*)</td>
<td>• Map rectangles</td>
<td>Measures</td>
</tr>
<tr>
<td></td>
<td>• TagCloud text zones</td>
<td></td>
</tr>
</tbody>
</table>

(*) Optional

5.3.2.1 To assign data to a chart

You can assign data to a chart in a report via the Side Panel or from an option in the contextual menu.

1. Open a Web Intelligence document in Design mode.

2. Do one of the following:

   ○ In the Side Panel, select Available Objects. From the Available Objects pane, drag and drop the measures, dimensions, and/or details into the chart. They will automatically be dispatched to the relevant area.

   ○ Right-click in the chart and select Assign Data from the contextual menu. The Assign Data dialog box appears displaying the dimensions that require data. You can add, delete, reorder (move up, down, to the top, or to the bottom), or hide the values plus edit or create a formula.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.
5.3.3 To apply a chart style

A chart style is a group of settings stored within a source file.

The chart style is used to manipulate a chart (at several levels - graphic, region, and property) before it is rendered. Chart styles allow charts to assembled using a set of predefined settings which include modern chart styles (such as anti-alias, gloss, and emboss). Adapted chart styles offer straightforward chart output customization with pre-settings and themes. They contain the group of settings for a chart including:

- layout - the settings that determine how each chart is displayed
- chart items (such as the title, the legend, the axes)
- theme - the settings that determine how the chart looks
- color palettes, etc.
- textures (such as the texture of the background)
- shadows
- fonts

**Note**
You can choose among pre-defined color palettes.

When creating a chart, we recommend that you feed it with all needed dimensions; apply the style, then change the settings to refine the chart format. If you modify a setting before applying a template, you may alter your modifications if these settings are included in the template definition. If that happens, the only way to get them back is to do an **Undo** action.

1. Open a Web Intelligence document in **Design** mode.
2. Select an existing chart or create one.
3. With the chart selected, in the **Formatting** tab, in the **Chart Style** subtab, select a style from the **Format Chart Style** icon dropdown list:
   - **Flashy Style**
   - **Normal Style**
   - **High Contrast**

**Related Information**

*To format a chart* [page 367]

You can format a chart in a report using options in the **Format Chart** dialog box.

5.3.4 To copy a chart

You can copy a chart dynamically to another report or as a picture in other applications.

1. In a Web Intelligence document in **Design** mode, right-click the chart frame and select **Copy**.
The chart is copied to the clipboard.

2. To paste the chart to another part of the report, right-click where you want the chart to appear then select Paste.

3. To paste the chart into another application, paste the contents of the clipboard from within the other application.

You can also copy a chart into another application by dragging and dropping it directly into the open document in the target application.

Within the same application, your copied chart will be dynamic. However, if the chart is pasted into another application, the chart appears as a picture.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.

5.3.5 To remove a chart

The following task describes how to remove a chart from a report.

1. Open a Web Intelligence document in Design mode.

2. Do one of the following:
   ○ Right-click the chart frame and click Delete.
   ○ Select the Document Structure and Filters tab in the Side Panel. Right-click the chart name and select Delete.
   ○ Select the chart, and in the Side Panel toolbar, click the Delete icon.

The chart has been deleted.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.
5.4 Changing the chart type

5.4.1 To change the chart type by using Turn Into

You can change the chart type using *Turn Into* in the chart contextual menu.

1. In a Web Intelligence document in *Design* mode, right-click the table or chart.

2. Select *Turn Into* from the contextual menu, then *More Transformations*.
   The *Turn Into* dialog box appears.

3. Click the chart category you want, then click a chart icon.
   Edit the chart values as necessary.

4. Click *OK*.
   The selected template is applied to the block and displays the data in the chart type you chose.

Related Information

*To format a chart* [page 367]
You can format a chart in a report using options in the *Format Chart* dialog box.

*Line charts* [page 355]
Line charts connect specific data values with lines, either horizontally or vertically.

5.4.2 Turning hierarchical queries into charts

You can turn a hierarchical query into a chart.

**Tip**
Hierarchical totals should not be displayed in Pie charts or a Tag Cloud. Displaying the totals may generate scale distortions, especially if the measure type is aggregative. To hide hierarchical totals, use levels for feeding or navigate within the table with the *Drill Focus* option or uncheck the option *Show parent nodes* in the *Format Chart* dialog box (Global > General).

**Note**
Use only one hierarchy to feed a Tree Map.

Related Information

*Hierarchical queries* [page 51]
A hierarchical query contains at least one hierarchy object.

To change the chart type by using Turn Into [page 364]
You can change the chart type using Turn Into in the chart contextual menu.

5.4.3 To switch between bars, lines and surfaces

You can change the region type for measures in charts.

1. In a Web Intelligence document in Design mode, right-click the chart, and select Format Chart.
2. Select the Global chart area, then the Measure Properties tab.
3. For each measure, select the appropriate region type: Bars, Lines, or Surfaces.
4. Click OK to return to the document.

5.5 Positioning and sizing charts

5.5.1 To set the position of a table or chart on the report page

You can set the position of a table or chart in a report.

1. In a Web Intelligence document in Design mode, right-click the border of the table or chart, and select Format Table or Format Chart.
2. In the Global section of the table or chart format panel, use the controls in the Relative Position section to set the position of the table or chart in relation to other report elements.

Tip
You can also reach the Layout tab in the table or chart format panel by one of the following ways:
- In the Report Elements tab, in the Position subtab, click Align, then an alignment option.
- Right-click the table or chart and select Align, then an alignment option.

3. Click OK.

Related Information

To format the appearance of reports and their headers, footers, sections, tables, and table cells [page 194]
You can define the background color and pattern of a report, or its headers, footers, sections, tables, and even specific cells in tables. The pattern can be a skin, also known as a theme, an image from a URL address or a file.

To select a background color for the table or cells [page 300]
You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color.
To define alternate row and column colors for a table [page 302]
You can define row colors in a table in a Web Intelligence document in Design mode.

To format table or cell borders [page 303]
You can format the border of a table or cell in a table in a Web Intelligence document in Design mode.

To format text in table cells [page 304]
You can format text in tables in a Web Intelligence document in Design mode.

To set cell height and width [page 306]
You can define the height and width of cells by using drag and drop or specifying the size of cells in the Format Cell dialog box.

To copy formatting using the Format Painter tool [page 308]
You use the Format Painter tool to quickly apply the formatting from a report, table or cell to other reports, tables or cells.

To layer tables and cells [page 310]
Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

To merge table cells [page 312]
You can merge table cells in a Web Intelligence document in Design mode.

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Creating a corporate palette for charts [page 381]
You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

5.5.2 To position a chart in relation to another chart or table

If you have more than one block (table, chart, or form) in your report, you can use relative positioning.
Relative positioning allows you to position a selected block (for example, a chart) in relation to other blocks in the report.

If new data on the database modifies the size of the tables or charts, relative positioning ensures that the different tables and charts display correctly without overlapping each other.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you position a chart in relation to another block (that is, a chart, table, or form), the position of the related block changes automatically, if you reposition the chart.</td>
</tr>
</tbody>
</table>

1. In a Web Intelligence document in Design mode, right-click the chart and click Format Chart.
2. Select the Global chart area, then the Layout tab.
3. In the Relative Position area, configure the left and right edge position of the chart in proximity of a report object you specify.
For example, to align with the left edge of the report title, select *Left edge*, then *Report title*.

**Tip**

You can also reach the *Layout* dialog box by doing one of the following:

- In the *Report Elements* tab, in the *Position* subtab, click *Align* > *Relative Position*.
- Right-click the table or chart and selecting *Align* > *Relative Position*.

5.5.3 **To resize a chart**

You can resize the chart using the mouse or in the *Format Chart* dialog box.

1. In a Web Intelligence document in *Design* mode, right-click the chart frame and click *Format Chart*.
2. In the *Global* chart area, select the *General* tab.
3. Enter or set the chart width and height in the *Width* and *Height* boxes.
4. Click *OK* to return to the document.

**Related Information**

*To format a chart* [page 367]

*You can format a chart in a report using options in the *Format Chart* dialog box.*

5.6 **Formatting charts**

You can format a chart area or a selected chart area (title, legend, axes, plot area, area title) in Web Intelligence.

You can find chart format options in the *Format* or *Formatting* toolbar in the *Design* mode.

5.6.1 **To format a chart**

You can format a chart in a report using options in the *Format Chart* dialog box.

1. In a Web Intelligence document in *Design* mode, right-click the chart frame and select *Format Chart*.
2. In the *Format Chart* dialog box, select the chart area that you want to format.

**Note**

If you have preselected a chart area before calling the dialog box, this area is displayed automatically without you having to navigate.
3. Do one of the following:
   ○ In Web Intelligence Rich Client, select the functional tab that you want to change in the Side Panel.
   ○ In the Web Intelligence HTML interface, expand the tab of the chart area you want to format, then select the functional tab.

4. When you have made your changes, click **Apply** if you want to see the changes before you close the dialog box or if you want to make some other changes before you close the dialog box. Otherwise, click **OK** to save the changes and close the dialog box.

   Another way to access the **Format Chart** dialog box is to select the chart. In the **Formatting** tab, in the **Chart Style** subtab, click **Format Chart**.

---

### 5.6.2 Formulas in chart elements

You can use the **Formula Editor** (the **fx** icon) to define and edit formulas in chart elements.

The following chart elements can use a formula:

- Chart title
- Legend title
- Axis titles
- Maximum and minimum values for axis scaling

For more information on the functions used in free-standing cells, see the *Using Functions, Formulas and Calculations in Web Intelligence* guide or the online help.

### 5.6.3 Data intervals in Tree Maps, Heat Maps and Tag Cloud charts

Data intervals are based on colors in Tree Map, Heat Map, and Tag Cloud charts that use intervals.

You can use one of the following shape coloring methods:

<table>
<thead>
<tr>
<th>Coloring method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Custom Range Coloring</strong></td>
<td>The <strong>Custom Range Coloring</strong> method uses ranges that you set based on an increment or percentage, and you select the color that applies to each range.</td>
</tr>
<tr>
<td><strong>Gradient-based Palette Coloring</strong></td>
<td>The <strong>Gradient-based Palette Coloring</strong> method uses a 2 or 3 color gradient definition, and you select the color that applies to each gradient.</td>
</tr>
<tr>
<td><strong>Gradient-based Palette Coloring Using Measure Polarity</strong></td>
<td>The <strong>Gradient-based Palette Coloring Using Measure Polarity</strong> method not only uses a 2 or 3 color gradient definition, it also uses a 2 or 3 color neutral polarity definition.</td>
</tr>
</tbody>
</table>
Palette Coloring

The Palette Coloring method applies a different color from the selected palette to each legend interval.

**Note**

You should not use these charts with hierarchical nodes for aggregative measures because the color scale can be distorted. To deactivate these nodes, deactivate the Show Parent Node option in the Global General section of the Format Chart dialog box.

## Palette coloring methods

In all of the palette coloring methods, the data range is defined in the Range Definition setting. This range defines the set of data that is distributed in the intervals.

You can define the number of intervals which will be created within the data range, using the Number of Intervals setting.

You can set the way data is distributed in chart intervals using the Data Distribution Mode setting.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Distribution by Values</strong></td>
<td>The range of attribute values is divided into equal-sized ranges. This method emphasizes the amount of an attribute value relative to other values.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong> If the data values are clustered instead of being evenly distributed, then most of the data can exist in one or two ranges and some ranges can have no data.</td>
</tr>
<tr>
<td><strong>Distribution by Quartiles</strong></td>
<td>The quartile distribution works well with linearly-distributed data. Because data is grouped by the number in each range, the resulting chart can be misleading. Similar data can be placed in adjacent ranges, or data with widely different values can be put in the same range. This distortion can be minimized by increasing the number of ranges.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong> Data with close values may end up in different ranges, thus exaggerating the differences between them.</td>
</tr>
</tbody>
</table>
Shapes with values out of range

By default, coloring applies to all values, but you can restrict coloring to a range of values. This is done by default with the Custom Range Coloring. You can specify a color to values out of range.

Shapes with null or empty values

You can specify a color for shapes with null or empty values to, for example, define the color of states without any point of sales.

Data Interval Syntax

In Measure-based Coloring, the chart legend displays a range of data using bracket. You select the preferred syntax in the Data Interval Syntax.

To declare an interval, you can use the ISO31-11 syntax setting, which uses an inverse bracket to exclude a value:

\[-2..-1[\]
\[-1..3[\]
\[[3..5]\]

However, in the United States, you use the US Syntax setting to replace that bracket by a parenthesis when excluding values:

\[-2..-1)\]
\[-1..3)\]
\[[3..5]\]

If you prefer syntax less mathematic, then you use the Basic Syntax setting:

\[-2..1\]
\[1..3\]
\[[3..5]\]

Measure polarity

Measure-based coloring charts are driven by measure values. The Gradient-based Palette Coloring Using Measure Polarity coloring method is based on the polarity associated to the measure driving the color and determines if high values are good, bad or neutral.
The following palettes exist:

<table>
<thead>
<tr>
<th>Palettes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ascending polarity</strong></td>
<td>The colors indicate that low is bad and high is good, with the first palette from the <strong>Start Color</strong> to the <strong>End Color</strong>, which is red to green by default.</td>
</tr>
<tr>
<td><strong>Descending polarity</strong></td>
<td>The colors indicate that low is good and high is bad, with the first palette from the <strong>End Color</strong> to the <strong>Start Color</strong>, which is green to red by default.</td>
</tr>
<tr>
<td><strong>Neutral polarity</strong></td>
<td>With this palette, neither low nor high is bad or good. The second palette is from <strong>Start Color</strong> to <strong>End Color</strong>, which are blue to yellow by default.</td>
</tr>
</tbody>
</table>

The default setting, found in the **Measure Properties** section of the Global chart area settings, for measure polarity is **Automatic**, which applies descending polarity.

**Related Information**

- [Tag cloud charts](page 359)
- [Waterfall charts](page 359)
  
  A Waterfall Chart (also known as a Bridge chart) displays vertical bars.

### 5.6.3.1 To configure the measure polarity for Tree Map, Heat Map, and Tag Cloud charts

You can configure the measure polarity for data interval charts in the **Format Chart** dialog box.

1. In a Web Intelligence document in "Design" mode, right-click the chart and select **Format Chart**.
2. In the **Global** section, select **Measure Properties**.
3. Select a polarity palette for your chart type:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Type</td>
<td>Measures to configure</td>
</tr>
</tbody>
</table>
| Tree Map     | Rectangle Weight
              Rectangle Color |
| Heat Map     | Rectangle Color                                  |
| Tag Cloud    | Tags Weight
              Tags Family |

4. Click **OK** to close the **Format Chart** dialog box.

**Note**

You can configure other aspects of the Tree Map, Tree Map or Tag Cloud chart in the **Palette and Style** tab of the **Global** section.
Related Information

To manage measure-based coloring in Tree maps, Heat maps and Tag Cloud charts [page 394]
The coloring method determines the color of rectangles or tags based on the value of a reference measure.

To configure the data interval for Tree Map, Heat Map, and Tag Cloud charts [page 372]
You can configure the data interval for Tree Map, Heat Map, and Tag Cloud charts in the Format Chart dialog box.

5.6.3.2 To configure the data interval for Tree Map, Heat Map, and Tag Cloud charts

You can configure the data interval for Tree Map, Heat Map, and Tag Cloud charts in the Format Chart dialog box.

1. In a Web Intelligence document in "Design" mode, right-click the chart and select Format Chart.
2. In the Global section, select Palette and Style.
3. Select a Color Palette.
4. If you wish the plot area to have a color, select Use Internal Palette.
5. Select a method from the Coloring Method for Shapes dropdown list.
6. If you are using the either of the gradient-based palette coloring methods, configure the Gradient Definition.
   a. Select one of the following:

<table>
<thead>
<tr>
<th>Gradient</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 Colors</td>
<td>Allows you to have starting color, a midpoint color and an ending color.</td>
</tr>
<tr>
<td>2 Colors</td>
<td>Allows you to have starting color and an ending color.</td>
</tr>
</tbody>
</table>

b) Select the colors and their gradient.
7. To define the number of intervals within the defined data range, specify a Number of Ranges.

Tip
The best number of ranges is typically 4 or 5. This amount can reveal data patterns without being confusing. If you have more than 7 colors, data with similar values can be hard to distinguish, and fewer than four ranges will not reveal much variation and therefore may reveal no clear pattern.

8. To define a specific range of data to appear in the chart, select the Range Definition checkbox, then enter the From and To numbers.

Note
This setting does not apply to the Custom Range Coloring method.
9. To set the way data is distributed in chart intervals, select a Data Distribution Mode.

   i Note
   This setting does not apply to the Custom Range Coloring method.

10. To set colors for out-of range value shapes, for the Shapes with Values Out of Range option configure the following settings:
    a) Select either RGBA Color or Gradient.
    b) Select a color from the color picker dropdown list and set the opacity.

11. To set colors for null and empty value shapes, for the “Shapes with NULL or Empty Value” option, configure the following settings:
    a) Select either RGBA Color or Gradient.
    b) Select a color from the color picker dropdown list and set the opacity.

12. Select a Data Interval Syntax.

13. If you are using the Gradient-based Palette Coloring Using Measure Polarity method, then you need to configure the Gradient Definitions for Measures with Neutral Polarity option.
    a. Select one of the following:

    | Gradient | Description                                    |
    |----------|-----------------------------------------------|
    | 3 Colors | Allows you to have starting color, a midpoint color and an ending color. |
    | 2 Colors | Allows you to have starting color and an ending color.               |

    b) Select the colors and their gradient.

14. If you are using the Custom Range Coloring method, configure the Color zones option.
    a) To have the ranges colored by percent instead of increments, select Percent.
    b) Enter the minimum and maximum zone parameters.
    c) Select a color from the color picker dropdown list and set the opacity.

   i Note
   In Heat Maps, if you are using the Emboss Effect, you should disable the Light and Shadow Effects in the Palette and Style subsection.

Related Information

To configure the measure polarity for Tree Map, Heat Map, and Tag Cloud charts [page 371]
You can configure the measure polarity for data interval charts in the Format Chart dialog box.

Map charts [page 356]
Web Intelligence offers two types of Map chart.

Tag cloud charts [page 359]

5.6.4 Warning icons in charts

Warning icons in charts can alert you when there are chart and data object errors.

The warning icons available are:

- General Warnings, icons displayed on the top left corner of the chart.
  
  Red X in a white background: impossible to generate the chart. (This could be due to a cache problem - try clearing temporary objects from cache.
  
  White X in a red circle: cannot find the image, the BI administrator should check load balancing settings and enable service monitoring as described in the Business Intelligence Platform Administrator Guide.
  
  Yellow warning: for example dataset too large (technical limit of the server), need to refresh the dataset, other cube errors.
  
  Blue alert: limit for optimal rendering

  The display of the General Warning icons is controlled by the *Hide warning icons in chart* setting in the Web Intelligence document properties. If this setting is deactivated, then no General Warning icons appear in the charts.

- An incompatible chart data warning, small yellow warning icon displayed on the data point.
  
  These occur if *Show alert when the data is incompatible with the chart* is activated in the chart format options and the dataset is inconsistent with the chart parameters. For example, a warning can appear in a pie chart with negative values, negative values for a logarithmic scale, or inconsistent hierarchical values for a treemap.

<table>
<thead>
<tr>
<th>Restriction</th>
<th>Definition</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical limits of the data received from the server</td>
<td>Max number of rows defined by the BI administrator Default value = 50,000</td>
<td>Only part of the dataset is rendered and a warning icon appears, as well as an informational tooltip.</td>
</tr>
<tr>
<td>Data restricted for optimal rendering</td>
<td>The data is restricted by the chart type and size for optimal appearance.</td>
<td>An alert icon appears, as well as a tooltip showing optimization guidelines.</td>
</tr>
</tbody>
</table>

Related Information

*Viewing document properties* [page 169]

You can view in the *Document Summary* pane in the Side Panel or set in the *Document Summary* dialog box.
5.6.4.1  To display warning icons in charts

You can allow warning icons to appear in charts and on data points.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Global chart area, select the General tab.
3. Select Show alert when the data is incompatible with the chart.
4. Click OK to return to the document.

5.6.5  To insert and format a chart title

You can activate and set titles in charts in the Format Chart dialog box.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Format Chart dialog box, select one of the following:
   ○ Global Area Display to edit the chart title.
   ○ Title Design to edit the chart title.
3. Click OK to return to the document.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.

5.6.6  To display a chart with a 3D look

You can apply a 3D look to a chart.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Global chart area, select the Palette and Style tab.
3. Select 3D look or 3D.

⚠️ Caution

Some types of bar charts using bar display effects do not look very attractive if they also use the 3D look or 3D setting.

4. Click OK to return to the document.
5.6.7 Assigning colors to charts

You can personalize the appearance of charts in Web Intelligence reports by assigning colors to dimension objects manually or by using built-in or customized color palettes. You can retain this color assignment to keep a color assigned to a dimension object.

When you create a chart in a Web Intelligence report, colors from the default color palette are automatically assigned to dimension objects in a top-to-bottom order. This order remains the same across sections and pages. However, the colors you assign using color palettes are not retained when the report is refreshed when opened, or when you change the number of objects displayed in a chart by filtering or using drill snapshots.

If you want to consistently display a specific object, such as a [Product Line] or [Sales Region], in a specific color, you can either assign a specific color to the object manually, or assign an in-built or custom color palette and set the color assignment as default.

When you set the color assignment as default, colors assigned to dimension objects do not change when you use filters or drill snapshots, or when the report is refreshed when opened. You can reset all colors by applying a new palette to the chart or by using a dedicated option.

Note

When you turn a chart into another type of chart, the color mapping is maintained only if the following conditions are respected:

- The legend color for the primary dimension (assigned to Region Type color or Pie color) must be the same.
- The legend items must be the same (no adding or removing a primary dimension for the Region Shape).

Note

You cannot assign colors to dual value axis charts or to charts using Measured-Based Coloring (like Heat Map, Tree Map and Tag Cloud).

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.

To create a custom palette style for charts [page 377]
You can create a custom palette style based on an existing palette style.

To assign a color to an object in chart [page 380]
You can assign custom colors to dimension objects in charts in Web Intelligence reports.

To assign colors to objects in charts using color palettes [page 380]
You can assign default or custom color palettes to dimension objects in charts in Web Intelligence reports. You can retain this color assignment when the report is refreshed when opened, and when you use filters, input controls, or drill snapshots.

5.6.7.1 To select a palette for a chart

You can select a palette for a chart in the Format chart dialog box.

1. Open a Web Intelligence document in Design mode.
2. Select or insert a chart.
3. Do one of the following:
   - Right-click the chart area and select Format Chart from the contextual menu. The Format chart dialog box appears. Select the Palette and Style tab. From the Color Palette dropdown list ( ), select a palette style.
   - In the Format tab, in the Chart Style subtab, from the Palette Style dropdown list ( ), select a palette style.

The chart is displayed with the colors from the selected palette. If the colors are not as you prefer, you can either select another palette style from the dropdown list, or you can create a custom palette.

Note

In waterfall charts, settings other than Automatic in the Custom Format section of the Format chart dialog box can override any custom Color Palette settings. To use the Color Palette settings in the waterfall chart, change all Custom Format settings to Automatic.

Related Information

To edit a custom palette chart style [page 379]
You can edit custom chart styles.

To create a custom palette style for charts [page 377]
You can create a custom palette style based on an existing palette style.

To configure the value colors in a waterfall chart [page 380]
You can configure the start, total, negative and positive values in a waterfall chart.

5.6.7.2 To create a custom palette style for charts

You can create a custom palette style based on an existing palette style.

1. Open a Web Intelligence document in Design mode.
2. Select or insert a chart.

3. Do one of the following:
   - Right-click the chart area and select Format Chart from the contextual menu. The Format chart dialog box appears. Select the Palette and Style tab. From the Color Palette dropdown list ( ), select Custom.
   - In the Format tab, in the Chart Style subtab, from the Palette Style dropdown list ( ), select Custom.

   The Manage Palettes dialog box appears, with either the default palette or the last palette applied to the chart selected.

4. Do one of the following:
   - If the currently selected palette is the one from which you want to create a custom palette, click New.
   - If you want to create a palette based on another built-in palette, select that palette and click New.

   The Create palette dialog box appears.

5. Enter a palette name.

6. Click a cell in the Color settings area and then select a different color from the Color dropdown palette.

7. Set the opacity if necessary.

8. When you have customized the cells, click OK.

   The custom palette appears in the Custom section of the Manage Palettes dialog box.

   The custom palette you have created will appear in the following places when it is selected for a chart:
   - From the Color Palette dropdown list in the Format chart dialog box.
   - From the Palette Style dropdown list in the Chart Style subtab.

   When it is not selected for a chart, you can access it in the Manage Palettes dialog box.

Note

In waterfall charts, settings other than Automatic in the Custom Format section of the Format chart dialog box can override any custom Color Palette settings. To use the Color Palette settings in the waterfall chart, change all Custom Format settings to Automatic.

Related Information

To edit a custom palette chart style [page 379]
   You can edit custom chart styles.

To select a palette for a chart [page 377]
   You can select a palette for a chart in the Format chart dialog box.

To configure the value colors in a waterfall chart [page 380]
   You can configure the start, total, negative and positive values in a waterfall chart.
5.6.7.3 To edit a custom palette chart style

You can edit custom chart styles.

1. Open a Web Intelligence document in Design mode.
2. Select or insert a chart.
3. Do one of the following:
   - Right-click the chart area and select Format Chart from the contextual menu. The Format chart dialog box appears. Select the Palette and Style tab. From the Color Palette dropdown list, select Custom.
   - In the Format tab, in the Chart Style subtab, from the Palette Style dropdown list, select Custom.

   The Manage Palettes dialog box appears, with either the default palette or the last palette applied to the chart selected.
4. Select the custom palette style that you want to edit and click Edit.

   i Note

   Built-in chart styles cannot be changed, however you can create a palette chart style from a built-in chart style.

5. Edit the palette settings as necessary.
6. When you have completed your changes, click OK.

   i Note

   In waterfall charts, settings other than Automatic in the Custom Format section of the Format chart dialog box can override any custom Color Palette settings. To use the Color Palette settings in the waterfall chart, change all Custom Format settings to Automatic.

Related Information

To create a custom palette style for charts [page 377]
You can create a custom palette style based on an existing palette style.

To select a palette for a chart [page 377]
You can select a palette for a chart in the Format chart dialog box.

To configure the value colors in a waterfall chart [page 380]
You can configure the start, total, negative and positive values in a waterfall chart.
5.6.7.4  To assign a color to an object in chart

You can assign custom colors to dimension objects in charts in Web Intelligence reports.

1. Open a Web Intelligence document in Design mode.
2. Select a dimension object or a legend item on a chart.
3. In the Formatting tab, in the Style subtab, click the arrow next to the Background Color icon.
4. From the Background Color dropdown list, do one of the following:
   - To assign a pre-defined color, select a color.
   - To assign a custom color, click More Colors, set a color and click OK.

The color is assigned to the dimension object.

5.6.7.5  To assign colors to objects in charts using color palettes

You can assign default or custom color palettes to dimension objects in charts in Web Intelligence reports. You can retain this color assignment when the report is refreshed when opened, and when you use filters, input controls, or drill snapshots.

1. Open a Web Intelligence document in Design mode.
2. Select a chart.
3. In the Formatting tab, in the Chart Style subtab, from the Palette Style dropdown list, select a palette or click Custom to create a custom palette.
   Colors from the palette are assigned to the dimension objects.
4. If you want to retain this color assignment, right-click the chart.
5. Select Series Colors ➤ Set as Default Colors

If you want to clear the color assignment, right-click the chart and select Series Colors ➤ Clear Color Assignment

Related Information

To create a custom palette style for charts [page 377]
   You can create a custom palette style based on an existing palette style.

5.6.7.6  To configure the value colors in a waterfall chart

You can configure the start, total, negative and positive values in a waterfall chart.

1. Open a Web Intelligence document in Design mode.
2. Select or insert a waterfall chart.
3. Right-click the chart area and select Format Chart from the contextual menu.
4. In the Format chart dialog box, select the Palette and Style tab.
5. In the Custom Format section, configure the Fixed Value for any of the following on the waterfall chart:
   ○ The Start Value Color affects the starting value bar.
   ○ The Total Value Color affects the final value bar.
   ○ The Negative Value Color affects any bars that reflect negative values.
   ○ The Positive Value Color affects any bars that reflect positive values.

   Note
   Settings other than Automatic in the Custom Format section can override the Color Palette settings. To return to the Color Palette settings, change all of the Custom Format settings to Automatic.

6. When you have completed your changes, click OK.

Related Information

To edit a custom palette chart style [page 379]
You can edit custom chart styles.

5.6.7.7 Creating a corporate palette for charts

You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette, and the palette ID must not be changed.

The default palette contains 32 defined colors. You can define more colors, but you must define at least two colors. You define a color by defining the strengths of red (R), green (G), blue (B), and the transparency (A).

Example

```
<COLOR R="200" G="0" B="0" A="255" />
```

Related Information

Formatting the report layout [page 192]
You can format your report and report elements in order to present the report with a company style.

Formatting your reports using Cascading Style Sheets [page 256]
Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents.

Formatting tables and table cells [page 299]
In Web Intelligence, you can define several visual aspects of tables and cells in reports.

5.6.7.7.1 Corporate palette configuration file syntax

You can define a default corporate chart palette.

The corporate chart palette configuration file VisualizationConfig.xml is by default located in the following location:

C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\images

This file contains the following elements:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<CONFIG>

<!-- Rename this file to VisualizationConfig.xml which will activate a custom default palette. -->
<!-- The following section allows to define a corporate palette which will be used by default in all new visualization. -->
<!-- TOMCAT must be restarted after each modification of this file -->

<PALETTES>

  <PALETTE ID="corporate">

  <!-- Add a list of colors so as to define your palette (default palettes contains 32 colors): R for Red, G for Green, B for Blue and A for managing the transparency -->
  <!-- Each attributes must take an integer value from 0 to 255 -->

  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />
  <COLOR R="200" G="200" B="200" A="255" />
  <COLOR R="125" G="125" B="0" A="255" />
  <COLOR R="0" G="125" B="125" A="255" />
  <COLOR R="125" G="0" B="125" A="255" />
  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />
  <COLOR R="200" G="200" B="200" A="255" />
  <COLOR R="125" G="125" B="0" A="255" />
  <COLOR R="0" G="125" B="125" A="255" />
  <COLOR R="125" G="0" B="125" A="255" />
  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />
  <COLOR R="200" G="200" B="200" A="255" />
  <COLOR R="125" G="125" B="0" A="255" />
  <COLOR R="0" G="125" B="125" A="255" />
  <COLOR R="125" G="0" B="125" A="255" />
  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />
  <COLOR R="200" G="200" B="200" A="255" />
  <COLOR R="125" G="125" B="0" A="255" />
  <COLOR R="0" G="125" B="125" A="255" />
  <COLOR R="125" G="0" B="125" A="255" />
  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />
  <COLOR R="200" G="200" B="200" A="255" />
  <COLOR R="125" G="125" B="0" A="255" />
  <COLOR R="0" G="125" B="125" A="255" />
  <COLOR R="125" G="0" B="125" A="255" />
  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />
  <COLOR R="200" G="200" B="200" A="255" />
  <COLOR R="125" G="125" B="0" A="255" />
  <COLOR R="0" G="125" B="125" A="255" />
  <COLOR R="125" G="0" B="125" A="255" />
  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />
  <COLOR R="200" G="200" B="200" A="255" />
  <COLOR R="125" G="125" B="0" A="255" />
  <COLOR R="0" G="125" B="125" A="255" />
  <COLOR R="125" G="0" B="125" A="255" />
  <COLOR R="200" G="0" B="0" A="255" />
  <COLOR R="0" G="200" B="0" A="255" />
  <COLOR R="0" G="0" B="200" A="255" />
  <COLOR R="0" G="0" B="0" A="255" />

  </PALETTE>

</CONFIG>
```

© 2014 SAP SE or an SAP affiliate company. All rights reserved.
SAP BusinessObjects Web Intelligence User's Guide
Working with charts in reports
5.6.7.7.2 To define a corporate palette for charts

The BI administrator can use the following steps to define a corporate palette using the VisualizationConfig.xml configuration file. This corporate palette will then be used as default for all new charts.

1. In the following directory open the template file: VisualizationConfig.template.xml:
   C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\images
2. Define at least two colors or edit the ones present in the template file.
3. Rename the file: VisualizationConfig.xml and save it in the same directory.
4. Restart Tomcat.

This corporate palette will be used as default for all new charts. Make sure there are no errors in the configuration file, otherwise the standard palette will be applied.

Remember

Restart Tomcat each time you modify this file.

5.6.8 To modify chart borders

You can modify the borders of a chart in the Format Chart dialog box.

1. In a Web Intelligence document in Design mode, right-click the chart and select Format Chart.
2. In the Global chart area, select the Border tab.
3. Use the settings to format the borders.
4. Click OK to return to the document.
5.6.9 To format the chart background

You can format the background colors, grid colors, opacity, line type and transparency of charts.

Note
The Tree Map, Tag Cloud, and Heat Map charts do not have background configuration options.

The options available vary depending on the type of chart.

1. In a Web Intelligence document in Design mode, right-click the plot area and select Format Chart Plot Area or Format Chart.

2. In the Plot Area chart area, select the Background tab.

3. In a 3D chart, you can show or hide the grid floor and edges.

4. Select a Grid and Background style:
   - Plain background
     - Background Color (refers to the background of the plot area)
     - Category Axis Grid Color (refers to the lines that are parallel to the category axis)
     - Value Axis Grid Color (refers to the lines that are parallel to the value axis)
     - Depth Grid Color (in a 3D chart, it refers to the lines parallel to the Value Axis Grid Color)
   - Striped Background (it shows alternate colors, instead a grid. The striped background option may not be available depending on the chart type, as in the case of Pie and 3D charts.
   - If you want the plot area lines to be dashed, select Dashed Lines.

Note
Grid options slightly differ depending on the chart type.

5. Click OK to return to the document.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.
5.6.10  To modify plot area settings in Waterfall charts

You can activate or deactivate a reference line and set the spacing between objects in the Waterfall chart plot area.

1. Right-click in the Waterfall chart.
2. Select Format Chart.
3. In the Format Chart dialog box, select the Plot Area chart area.
4. In the Design tab, select Reference Line.
5. To set the spacing between plot area items, enter or select a number for the Relative Spacing between Items.
6. Click OK or Apply.

Related Information

To format the chart background [page 384]
You can format the background colors, grid colors, opacity, line type and transparency of charts.

5.6.11  To show and format chart legend

You can format the chart legend in a report.

1. In a Web Intelligence document in Design mode, right-click the chart legend and select Format Legend.
2. In the Format Chart dialog box, for the Legend chart area, select the Design tab.
3. You can make the legend visible or not, adjust the symbol size, position and layout, group by dimension, adjust the text settings and border and background settings.
4. In the Title tab, you set the legend title settings, such as: Automatic Title or Custom Title. Custom Title allows you to define a formula to be used for the Legend title.
5. Click OK to return to the document.

Tip
In the Global chart area, in the Area Display tab, you can display or hide the legend and legend title.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.

Formulas in chart elements [page 368]
You can use the Formula Editor (the fx icon) to define and edit formulas in chart elements.
5.6.12 To avoid page breaks in charts

You can restrict page breaks in charts.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Global chart area, select the Layout tab.
3. Select Avoid page breaks in chart or Avoid page break. These options can be selected for both horizontal and vertical breaks.
4. Click OK to return to the document.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.

5.6.13 To configure a stacked bar or column chart

In a stacked chart, the measure data is stacked in bars or columns. Stacking is done axis by axis and you can choose which data to stack. In a 100% stacked chart, the data is displayed as percentage parts of a whole, or 100%, of a bar or column.

Note
Only charts with value axes can be stacked.

1. In a Web Intelligence document in Design mode, add a stacked bar or column chart.
2. Right-click the chart and select Format Chart from the contextual menu.
3. In the Value Axis chart area:
   ○ Select the Design tab. Under Stacking, select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unstacked</td>
<td>Select this option to unstack all dimensions and measures in the chart.</td>
</tr>
<tr>
<td>Stacked Chart</td>
<td>Select this option if you only want to slice one dimension by another. For example, in a chart containing revenue per state and year. Measures are not stacked.</td>
</tr>
<tr>
<td>Globally Stacked Chart</td>
<td>Select this option stacks the dimensions and measures in one stack per bar or column.</td>
</tr>
</tbody>
</table>
Select **100% Stacked Chart** if you want to measure multiple series as a proportion vs. time, or if you have three or more data series and want to compare distributions within categories, and at the same time display the differences between categories. Each bar represents 100% of the amounts for that category.

4. In the **Plot Area** chart area, if you are configuring a 100% stacked chart, and want bars or columns with zero values to be flat against the value axis, select **Flatten zero values**.

5. Click **OK** to close the **Format Chart** dialog box.

### Related Information

- **To format the category or value axis title** [page 388]
  You can format the title of a category or value axis in a chart.

- **To format the chart background** [page 384]
  You can format the background colors, grid colors, opacity, line type and transparency of charts.

- **To format axis grid values, numbers and text** [page 388]
  You can format the value and category axis settings.

- **To show a specific range of axis values** [page 390]
  You can specify a range of values in a chart axis.

- **To display the Value Axis logarithmically** [page 391]
  You can change the Value Axis to appear logarithmically in a chart.

- **Linear and logarithmic axis scales** [page 391]
  Linear scales are based on addition. Logarithmic scales allow you to examine values that span many orders of magnitude without losing information on the smaller scales.

- **To show and format chart legend** [page 385]
  You can format the chart legend in a report.

### 5.6.14 To assign axis labels to data values

You can assign labels to an axis in charts.

1. In a Web Intelligence document in **Design** mode, right-click the chart frame and select **Format Chart**.

2. In the **Global** chart area, select the **Data Values** tab.

3. Select **Data label displaying mode**.

4. Select the appropriate **Data Type**.

5. You can also change the other data value settings on this page, like **Automatic Hiding Mode** and font, border, line and background settings as necessary.

6. Click **OK** to return to the document.
5.6.15  To format the category or value axis title

You can format the title of a category or value axis in a chart.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Category Axis or Value Axis chart area, select the Title tab.
3. Edit the title settings, which include:
   ○ Title label and visibility
   ○ Layout spacing
   ○ Text formatting
   ○ Borders and the background
4. Click OK to return to the document.

5.6.16  To format axis grid values, numbers and text

You can format the value and category axis settings.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Category Axis or Value Axis chart area, select the Design tab and format settings in the following sections:
   ○ Under General, you can select that the axis is visible.
   ○ Under Layout, you can display the axis, show labels, change the orientation, adjust the legend layout, automatically reduce the font size of labels displayed in grid, reverse order on the category axis, set the axis label delete mode and show continuous axis layout.
Note

By default the Value axis is the Y axis and the Category axis is the X axis. If you reverse the order of the chart, the X,Y relationship is broken. The horizontal line remains the X axis and the vertical axis remains the Y axis.

To set the legend layout, select Adjust Layout and configure the following options for the layout width and height:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>Select <strong>Automatic</strong> so that the legend width or height is automatically adjusted to the size of the legend contents.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>&lt;br&gt;The width adjusts as much as possible, however if the legend items are long, they can disappear from the legend cell.</td>
</tr>
<tr>
<td>Fixed</td>
<td>Select <strong>Fixed</strong> to manually set the height or width of the legend cell.</td>
</tr>
<tr>
<td>Proportional</td>
<td>Select <strong>Proportional</strong> to have the legend cell height or width appear relative to the size of the chart. You express this size as a 0.x value, where 0.2 means that the legend cell height will appear as 20% of the actual chart.</td>
</tr>
</tbody>
</table>

- Under **Color Options**, you can set the **Axis Color** (the category axis line), **Grid Color** (the grid around the category axis labels) and **Grid Background Color** (which refers to the category axis labels).
- Under **Text**, you can choose the font settings, text alignment, and the text policy (**Wrap**, **No Wrap** or **Truncate**).

- Under **Number**, select the pattern you want for chart numbers.

3. Click **OK** to return to the document.
5.6.17 To show a specific range of axis values

You can specify a range of values in a chart axis.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Value Axis chart area, select the Design tab.
3. Under Scaling, to set the Minimum Value and the Maximum Value, select Fixed Value, then enter a value.

   **Note**
   
   Overscaling is a specific display that indicates that a bar is incomplete. Its value is out of the axis Max/Min values.

4. Click OK to return to the document.

5.6.18 To unlock a value axis in a dual axis chart

In a chart that uses dual axes, the chart normally has axes that are locked and synchronized to the same origin.

In some data series where one axis has positive values and another data series has both negative and positive values, the chart results can appear flat. In this case, you can unlock the axes so that each has its own grid and origin, and the minimum and maximum values share one axis, each according to its data context.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Value Axis 2 chart area, select the Design tab.
3. Under Scaling, select Unlock the Axis.

When the axes are unlocked, the second value axis is freed from the grid.

   **Note**
   
   In a XI 3.1 document migrated to BI 4.1 SP 4 or greater, this setting is automatically activated.
Linear and logarithmic axis scales

Linear scales are based on addition. Logarithmic scales allow you to examine values that span many orders of magnitude without losing information on the smaller scales.

To format axis grid values, numbers and text

You can format the value and category axis settings.

To assign axis labels to data values

You can assign labels to an axis in charts.

To show a specific range of axis values

You can specify a range of values in a chart axis.

5.6.19   Linear and logarithmic axis scales

Linear scales are based on addition. Logarithmic scales allow you to examine values that span many orders of magnitude without losing information on the smaller scales.

By default, the application displays the Value axis on charts as a linear scale. In a linear scale, the axis markers are evenly spaced. Consider, for example, the linear sequence: 1, 3, 5, 7, 9. To get the next number in the sequence, you add 2 to the previous number.

You can set the axis to a logarithmic scale. Logarithmic scales are based on multiplication rather than addition. In a logarithmic scale, the steps increase or decrease in size. Logarithmic scales are based on multiplication (or division). Consider, for example, the logarithmic sequence: 2, 4, 8, 16, 32. To get the next number in the sequence, you multiply the previous number by 2. We can say that this sequence represents “base 2.”

Consider the following sequence: 1, 10, 100, 1000, 10000. This sequence represents “base 10,” because you get the next term in the sequence by multiplying the previous term by 10.

5.6.19.1   To display the Value Axis logarithmically

You can change the Value Axis to appear logarithmically in a chart.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Value Axis chart area, select the Design tab.
4. Click OK to return to the document.
Note

If you have a negative data value and you have activated the warning icons, a warning icon appears.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.

Linear and logarithmic axis scales [page 391]
Linear scales are based on addition. Logarithmic scales allow you to examine values that span many orders of magnitude without losing information on the smaller scales.

5.6.20 Displaying and formatting chart data

5.6.20.1 To hide an empty chart

Sometimes charts display no values. For example, if sales of a specific product are discontinued, a chart that normally displays results for that product will appear empty. By default, the application displays such empty charts on reports. If wished, you set the application to hide charts whenever they are empty.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Global chart area, select the General tab.
3. In the Display section, select one of the following:
   ○ Select Hide always to hide the chart.
   ○ Select Hide when empty to hide the chart when it is empty.
   ○ Select Hide when following formula is true and type a formula in the box to hide the chart when the formula is true.
4. Click OK to return to the document.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.
5.6.20.2 To exclude zero values in charts and tables

In charts and tables, you can exclude zero values from the displayed data.

If a chart or table has zero values, you can choose to remove them from the visible output. You can also have hidden items that have zero values.

If you deactivate either of the zero value options:

- In a chart, there are no items.
- In a table, if the values in a column or row for an item equal zero, the column or row does not appear.

1. In a Web Intelligence document in Design mode, right-click the chart or table frame and select Format Chart or Format Table.

2. Do one of the following:
   - For a chart, in the Global chart area, select the General tab.
   - For a table, select the General tab.

3. Select the following Display options as required:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show rows for which all measure values = 0</td>
<td>In vertical and cross tables, to suppress rows where all measure values are equal to zero.</td>
</tr>
<tr>
<td>Show rows for which the sum of measure values = 0</td>
<td>In vertical and cross tables, to suppress rows where the sum of the measure values is equal to zero.</td>
</tr>
<tr>
<td>Show columns for which all measure values = 0</td>
<td>In horizontal and cross tables, to suppress columns where all measure values are equal to zero.</td>
</tr>
<tr>
<td>Show columns for the sum of measure values = 0</td>
<td>In horizontal and cross tables, to suppress columns where the sum of the measure values is equal to zero.</td>
</tr>
<tr>
<td>Show measure values where values = 0</td>
<td>In charts, to suppress a chart item if its measure values are equal to zero.</td>
</tr>
<tr>
<td>Show measure values for which the sum of values = 0</td>
<td>In charts, to suppress a chart item where the sum of its measure values is equal to zero.</td>
</tr>
</tbody>
</table>

4. Click OK to close the dialog box.

5.6.20.3 To specify styles, shadow effects and data markers for the chart data

You can specify palette and style effects in line, bar, column, line, point, and radar charts.

Note: Dual axis charts use two color palettes.
1. In a Web Intelligence document in **Design** mode, right-click the chart frame and select **Format Chart**.

2. In the **Global** chart area, select the **Palette and Style** tab.

3. Configure the following as necessary:
   - In **Chart Series Style**, select an effect.
   - Select the **Color Palette** and the percent of transparency.
   - Under **Marker**, choose symbols, symbol size, symbol palettes, border, border color.
   - Under **Light and Shadow Effects**, select many light and shadow effects: offset, color, shadow, and 1-sided shadow.

4. Click **OK** to return to the document.

**Related Information**

*To format a chart* [page 367]
You can format a chart in a report using options in the **Format Chart** dialog box.

---

**5.6.20.4 To manage measure-based coloring in Tree maps, Heat maps and Tag Cloud charts**

The coloring method determines the color of rectangles or tags based on the value of a reference measure.

1. In a Web Intelligence document in **Design** mode, right-click the chart frame and select **Format Chart**.

2. In the **Global** chart area, select the **Palette and Style** tab.

3. Select a coloring method from the **Coloring Method for Shapes** dropdown list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Palette Coloring</td>
<td>You can define the number of ranges and the colors are associated automatically based on the selected palette. You can also define range definition and the color for null or empty values.</td>
</tr>
<tr>
<td>Gradient-based Palette Coloring</td>
<td>You can define a 2 or 3 color gradient associated to the ranges.</td>
</tr>
<tr>
<td>Gradient-based Palette Coloring using Measure Polarity</td>
<td>You can define a 2 or 3 color gradient associated to Measure with Neutral Polarity.</td>
</tr>
<tr>
<td>Custom Range Coloring</td>
<td>You can define the ranges manually and associate the colors by either percentage or absolute value.</td>
</tr>
</tbody>
</table>

4. If needed, define a range for the measure values and associate a color to out of range values.

5. Select a color for null or empty values.

6. Define the gradient for gradient methods or associate a color to each range for the custom method. For custom range coloring, define the **Maximum** and **Minimum** values of the color ranges. (It is automatic for other methods)

7. Click **OK** to return to the document.
5.6.20.5 To format a series of data in a chart

You can adjust the color, color opacity and data label position of pieces or points in Bar, Column, Line, Pie, Scatter, Bubble, and Point charts.

1. Right-click the piece, point, or legend item in a chart that you want to configure and select **Format Data Series** from the contextual menu.

   **Note**
   This feature is not available for Box plot, Map, Tag cloud or Waterfall charts.

2. In the **Format Data Series** dialog box, select **Custom**.

   **Note**
   At any time you can reset the settings in this dialog box to the application default by selecting **Automatic**.

3. Select a color for the data piece or point from the color picker dropdown panel and adjust the opacity setting as necessary.

4. If you are formatting a Line chart and want to have a thicker line, select a **Line Width** number.

5. To have a data label appear, in the case where a data label was hidden, or to customize the data label position, select **Show Data Labels**.

   **Note**
   Unselect this option if you want the data label hidden in the chart.

6. Select one of the following data position options:
   For all charts:
   - Select **Outside** if you want the label outside of the selected chart piece.
   - Select **Inside** if you want the label inside the selected chart piece.

   **Note**
   Data label positioning is not available for Polar, stacked Bar or Column charts.

   For all charts except the Pie chart the following options are also available:
   - Select **Inside First, Outside Otherwise** if you prefer the label inside the selected chart item, but can allow it to be outside the chart piece if there is not enough room for the label in the item.
   - Select **Outside First, Inside Otherwise** if you prefer the label outside the selected chart piece, but can allow it to be inside the chart piece if there is not enough room for the label in the item.

7. Depending on your chart type, you can set the data label alignment when the data position is set to **Outside**:
   - If you are working with a Donut or Pie chart, select one of the following data label alignments:
     - Select **Side Layout** for the data label to appear at the side of the chart block.
     - Select **Circular Layout** for the data label to appear right next to the chart piece.
   - If you are working with a Line or Point chart, select one of the following data label alignments: **Top, Below, Left, Right**.

8. Click **Apply** to apply your changes and continue to modify the data label changes.
9. Click OK to apply your changes and close the panel.

5.6.20.6 To show or hide data values

You can show and hide data values in a chart.

1. In a Web Intelligence document in Design mode, right-click the chart frame and select Format Chart.
2. In the Global chart area, select the Data Values tab.
3. Select Data label displaying mode to show the data.
4. You can adjust the settings for various parameters, depending on the chart type. For instance for a pie chart, select the data type, the data position, border size, background color, etc.
5. Click OK to return to the document.

Related Information

To format a chart [page 367]
You can format a chart in a report using options in the Format Chart dialog box.
6 Publishing, formatting, and sharing reports

6.1 Linking to other documents

Document cells can be defined as hyperlinks.

Hyperlinks in cells are similar to the hyperlinks found on the World Wide Web that allow you to open a different web page from the page you are currently viewing.

⚠️ Restriction

In a Web Intelligence report, if you construct a hyperlink that refers to a web site that cannot be opened in other websites, you can encounter browser errors.

When you click a cell that contains a hyperlink, the target document specified in the link opens. The target document can be another Web Intelligence document, a site on the world wide web, a PDF, Excel or Word document, or any resource accessible through a hyperlink.

Hyperlinks can be either static or dynamic. A static hyperlink always links to the same document in the same way. A dynamic hyperlink can link differently depending on the data in the document containing the hyperlink.

You can create different types of hyperlink:

- A cell where the cell text is the hyperlink text.
- A cell with an associated hyperlink.
- A link to another document in the CMS. Use the Web Intelligence HTML interface for this action. For target documents that refer to BEx queries or .unx or .unv universes that contain prompts that use Index Awareness, there are additional parameters to set.

When you create a link using the Web Intelligence HTML interface, the link is defined using the OpenDocument syntax. If you wish, you can build links manually using OpenDocument. For detailed information on OpenDocument syntax, see the Viewing Documents using OpenDocument guide.

As well as linking between documents, you can also link report elements in the same report by defining elements as input controls that filter the values in other report elements.

6.1.1 Cells defined as a hyperlink

When you define a cell as a hyperlink, the cell text becomes active hyperlink text.

For example, if you define a free-standing cell containing the text http://www.sap.com as a hyperlink, clicking the cell takes you to the SAP web page.

This method is best suited for static hyperlinks, where the text in the cell always remains the same and links to the same resource in the same way.
6.1.1.1 To define a cell as a hyperlink

You define a cell as a hyperlink in a document in Web Intelligence.

1. Open a Web Intelligence document in **Design** mode.
2. Select or type hyperlink text in a cell.
3. Right-click the cell and select **Linking > Read Contents as Hyperlink**.

6.1.2 A hyperlink associated with a cell

When you associate a hyperlink with a cell, you define a hyperlink that links to the source document when the cell is clicked.

The cell text itself is not the hyperlink.

This is the recommended method for creating dynamic hyperlinks, for the following reasons:

- It is specially tailored for working with the parameters in dynamic hyperlinks.
- It shields you from the complexity of hyperlink syntax. You define your hyperlink using a graphical interface and the hyperlink syntax is generated and managed behind the scenes.
- It allows you to define hyperlink text that is different from the cell text.

6.1.2.1 To add a hyperlink to a cell

You configure a cell hyperlink in the **Create Hyperlink or Hyperlinks** dialog box.

1. Open a Web Intelligence document in **Design** mode.
2. Right-click a cell and select **Linking > Add Hyperlink** to display the **Create Hyperlink or Hyperlinks** dialog box.
3. If you are in the Web Intelligence HTML interface, select the **Link to web page** tab.
4. Type or paste the hyperlink text into the box.
5. Click **Parse**.

Any hyperlink parameters appear in the **Customize URL parameters** area.
Dynamic hyperlinks contain parameters whose values can change. Parameters appear as `name=value` parts at the end of the hyperlink after the question mark. For example, the following URL contains one parameter, `reportname`, whose value is “products”:

```
http://salesandproductreport/default.asp?reportname=products
```

Each parameter appears on a separate line with the parameter name on the left and the parameter value on the right. The static part of the hyperlink, the part without the parameters, appears in the Main section.

6. To supply data from formulas or variables as parameter values, click the arrow next to each parameter value and select an option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build formula</td>
<td>You build a formula in the Formula Editor to supply the formula output as the parameter value.</td>
</tr>
<tr>
<td>Select object</td>
<td>You choose the object from the list in the Available Objects dialog box to supply its value as the parameter value.</td>
</tr>
</tbody>
</table>

**i Note**

When you modify a parameter, the full hyperlink syntax changes to reflect the modification in the box at the top of the screen.

7. To add or remove a parameter, modify the hyperlink syntax, then click Parse.

**i Note**

You cannot add or remove parameters directly in the parameter list in the Customize URL parameters area. You must modify the URL syntax directly.

8. Type the tooltip text in the Tooltip box or build a dynamic tooltip by using the Build formula or Select variable options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build formula</td>
<td>You build a formula in the Formula Editor to supply the formula output as the tooltip.</td>
</tr>
<tr>
<td>Select object</td>
<td>You choose the object from the list in the Available Objects dialog box to supply its value as the tooltip.</td>
</tr>
</tbody>
</table>

The tooltip appears when you hover your mouse pointer over the cell containing the hyperlink.

9. Click the arrow next to Target window to define how the target URL appears.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current window</td>
<td>The target URL replaces the document containing the hyperlink in the current window.</td>
</tr>
<tr>
<td>New window</td>
<td>The target URL opens in a new browser window.</td>
</tr>
</tbody>
</table>

10. Click OK to close the Create Hyperlink or Hyperlinks dialog box.
6.1.3 Linking to another document in the CMS

In the Web Intelligence HTML interface, you can link to another document in the CMS using the Create Hyperlink dialog box.

The link uses the OpenDocument function. The parameters passed to the function are determined by the choices you make in the dialog box.

You can also work with the OpenDocument function directly by typing the syntax into a cell.

Document instances and values passed to prompts

Hyperlinks supply values to prompts in the target document in two ways:

- Passing values directly to prompts.
- Opening a document instance based on passed values.

In the first case, the hyperlink feeds values directly to the prompts in the target document. In the second case, the link opens the document instance whose stored prompt values correspond to the values passed by the hyperlink. When you click on the url, the target document is automatically refreshed, even if the Refresh on open option is deactivated.

It is more efficient to choose a document instance based on passed parameters if the target document is large.

Linking to large documents

When the target document contains a large amount of data, it is more efficient to link to an instance than to open and retrieve the document with a passed parameter value. You can schedule and pre-retrieve multiple instances with different parameter values. This allows the document to be scheduled and pre-retrieved in advance with different parameter values.

When you click the hyperlink, the link opens the appropriate pre-retrieved instance rather than using the passed value to open the document and retrieve the data.

Example

Linking to a large sales report

In this example you link to a large sales report that retrieves sales by region. The report has a parameter that allows the user to select the region. There are four regions - North, South, East, and West.

Your source document has a [Region] dimension. You do the following:

- Configure the hyperlink to pass the value of [Region] as a parameter.
- Create four instances of the sales report, one for each value of [Region].
- Schedule these instances for pre-retrieval.
- Configure the hyperlink to open the latest instance whose parameter value matches the value passed by the hyperlink.

Assuming that the document has a [Region] dimension, the settings are as follows:
6.1.3.1 To link to another document in the CMS

You can set in a document one or more links to other documents in the same CMS.

**Note**
When the target document refers to a `.unx` or `.unv` universe containing an Index Awareness Prompt, or to a BEx query, there are additional objects to select.

1. Open a Web Intelligence document in **Design** mode.
2. Do one of the following:

   - Right-click the cell where you want to create the link and select **Linking** > **Add Document Link**.
   - In the **Report Elements** tab, in the **Linking** subtab, select **Add Document Link** from the **Document** dropdown list.

3. In the **Create Hyperlink** dialog box, Select the **Link to a document** tab.
4. Click **Browse** and in the **Choose Document** dialog box, select the target document, or type the document ID in the **Document ID** box.
   
   If there are prompts on the document to which you are linking, the **Select Prompts** panel appears.
5. In the **Select Prompts** panel, select the prompts that you want to appear and click **OK**, or if you have no selections to make, click **Cancel**.
6. In the **Hyperlink Properties** section:

   - To ensure that the link uses the full URL path rather than a relative path from the current document, select **Use complete URL path to create hyperlink**.
   - To refresh the data of the target document when the hyperlink is selected, select **Refresh on open**.
   - To link to an instance of the selected document, select **Link to document instance**, then select an option from the dropdown list.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Most recent</strong></td>
<td>The hyperlink opens the most recent instance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>You cannot specify parameter values in the hyperlink when you choose this</td>
</tr>
<tr>
<td></td>
<td>option. The hyperlink does not pass parameter values. All parameters are</td>
</tr>
<tr>
<td></td>
<td>set to <em>Use document default</em> and cannot be modified.</td>
</tr>
<tr>
<td><strong>Most recent - current user</strong></td>
<td>The hyperlink opens the most recent instance owned by the current user.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>You cannot specify parameter values in the hyperlink when you choose this</td>
</tr>
<tr>
<td></td>
<td>option. The hyperlink does not pass parameter values. All parameters are</td>
</tr>
<tr>
<td></td>
<td>set to <em>Use document default</em> and cannot be modified.</td>
</tr>
<tr>
<td><strong>Most recent - matching prompt values</strong></td>
<td>The hyperlink opens the most recent instance whose prompt values correspond to the values passed by the hyperlink.</td>
</tr>
<tr>
<td></td>
<td>This option is useful when you want to link to a large document that</td>
</tr>
<tr>
<td></td>
<td>contains prompts.</td>
</tr>
<tr>
<td></td>
<td>You must specify at least one parameter value. Without at least one</td>
</tr>
<tr>
<td></td>
<td>specified value, the hyperlink returns an error when clicked. The error</td>
</tr>
<tr>
<td></td>
<td>occurs because the hyperlink is designed to retrieve an instance based on</td>
</tr>
<tr>
<td></td>
<td>parameter values, but no value is provided for comparison against the</td>
</tr>
<tr>
<td></td>
<td>instance.</td>
</tr>
</tbody>
</table>

- If you are linking to a Web Intelligence document, select *Report name* and then the name of the report to link to a specific report.
- To link to a specific part of a report:
  1. Select *Report part*.
  2. Click *Select*.
  3. Right-click the report part (for example a table) and select *Select this report part*.
  4. To display only the report part, select *Display report part only*.
  5. To focus on the report part but display the whole report in the target document, select *Position at report part (full document available)*.

**Note**

You can create links between report elements by defining a report element as an *input control* that filters the values in other report elements. For example, if you have a report containing two tables, you can filter the values in one table depending on the values selected in the other.
7. In the **Customize the look and behavior of the hyperlink** section, do one of the following:
   
   - Select the format of the target document from the **Document format** dropdown list. The format of the document determines which options are available when defining the link. For example, you cannot link to a report part in a PDF document. For a document referring to a BEx query or a .unx or .unv universe with a prompt that uses index awareness:
     
     1. Select the **key**.
     2. Click the key dropdown box and select **Build formula** and type `=objectname().key()`. The object must not be a variable and the object must have a key.
     3. Test that the `objectname().key()` returns the expected results. If the result does not return the key, ask the universe designer to provide help on how to obtain the key.

   - To define how the target document opens, select **New window** or **Current window** from the **Target window** dropdown list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New window</strong></td>
<td>The document opens in a new browser window.</td>
</tr>
<tr>
<td><strong>Current window</strong></td>
<td>The document opens in the current browser window and replaces the document containing the hyperlink.</td>
</tr>
</tbody>
</table>

   - Type text in the **Tooltip** box, or build a dynamic tooltip by using the **Build formula** or **Select object** options. The tooltip will appear when you hover your mouse pointer over the cell containing the hyperlink.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Build formula</strong></td>
<td>You build a formula in the <strong>Formula Editor</strong> to supply the formula output as the tooltip.</td>
</tr>
<tr>
<td><strong>Select object</strong></td>
<td>You choose the variable from the list in the <strong>Available Objects</strong> dialog box to supply its value as the tooltip.</td>
</tr>
</tbody>
</table>

8. In the **Document prompts** section, for each prompt existing in the document, select one of the following options from the dropdown list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Build formula</strong></td>
<td>You use the <strong>Formula Editor</strong> to build a formula to pass a value to the prompt.</td>
</tr>
<tr>
<td><strong>Select object</strong></td>
<td>You select an object whose value is passed to the prompt.</td>
</tr>
<tr>
<td><strong>Prompt user at runtime</strong></td>
<td>The user specifies a value for the prompt when they click the hyperlink.</td>
</tr>
<tr>
<td><strong>Use document default</strong></td>
<td>You configure the hyperlink to not pass a parameter to the target document, and the target document opens with the default value for the prompt. The default value is either the last value specified for the prompt, or the default specified in the document.</td>
</tr>
<tr>
<td><strong>Enter a constant</strong></td>
<td>You enter a constant alphanumeric string that is entered for the prompt.</td>
</tr>
</tbody>
</table>

### 6.1.4 To open a document from a hyperlink

You can set hyperlinks between documents in the Web Intelligence HTML interface.

1. Open a Web Intelligence document in **Design** mode.
2. Hover your mouse pointer over a cell with a hyperlink to display the tooltip, if a tooltip is defined.

   Note
   The generated syntax of the hyperlink appears in the Formula Bar. Do not modify this syntax directly. Use the Create Hyperlink dialog box if you need to update it.

3. Click the hyperlink to open the target document. Depending on how the hyperlink is configured, the target document opens in a new browser window, or it replaces the current document in the current browser window.

6.1.5 To edit a hyperlink in a cell

You can set hyperlinks in table cells in the Web Intelligence HTML interface.

1. Open a Web Intelligence document in Design mode.
2. Right-click the cell containing the hyperlink and select Hyperlink Edit.
3. In the Create Hyperlink dialog box, edit the hyperlink.
4. Click OK to close the Create Hyperlink dialog box.

6.1.6 To delete a hyperlink

You can delete hyperlinks in documents in the Web Intelligence.

1. Open a Web Intelligence document in Design mode.
2. Select the cell containing the hyperlink and select Linking Remove.

6.1.7 Formatting hyperlink colors

You can define the colors used to display hyperlinks that have already been clicked (visited hyperlinks). You can also define the colors for hyperlinks that have not been clicked (unvisited hyperlinks).

6.1.7.1 To set hyperlink colors

You can set the colors of hyperlinks in documents in Web Intelligence.

1. Open a Web Intelligence document in Design mode.
2. Right-click a blank area on the report that contains hyperlinks and select Format Report.
3. In the Format Report dialog box, click the Appearance tab.
4. In the Hyperlink color section, click the arrows next to Visited and Unvisited, then either select a predefined color or click More colors to define a custom color.
5. Click OK to close the *Format Report* dialog box.

### 6.2 Sharing content with other applications

You can make Web Intelligence content available outside Web Intelligence documents by publishing report blocks (tables, charts or forms) as web services known as BI Services.

**Note**

You can only publish content as a web service in the Web Intelligence Applet interface and Web Intelligence Rich Client. This feature is not available for the Web Intelligence HTML interface.

Web services provide a standardized mechanism for sharing data between applications. You publish content to a server where other applications can access the web services that supply the content.

Each web service can publish multiple blocks which are made available to web applications through functions that correspond to the blocks. For example, a table published as a web service can be included in a dashboard which can perform filtering and drilling operations on the table through the web service functions.

The structure of a BI service is defined using using WSDL (Web Service Definition Language), the standard format for describing web services. Web applications interact with BI services (by passing parameters to them and receiving data in return) using SOAP, a standard protocol for exchanging structured information.

**Related Information**

*BI service structure* [page 410]

Applications use the SOAP protocol to call the functions and receive the function output which they can then parse.

### 6.2.1 Making data available for filtering in a web service

When you publish a report block as a web service, you can make report objects available that web applications can use to filter the data returned by the web service.

For example, if you publish a table containing [Country], [Region] and [Revenue], you can make the [Country] dimension available as a filter. Web applications accessing the web service can then filter on the [Country] dimension.

Filtering objects appear as *FilterCondition* parameters in the `GetReportBlock_<block_name>` function in the web service.

You make objects available for filtering in the *Define published content* screen of the *Publish Content* wizard. The screen lists all the objects in the report and selects the objects in the block you are publishing by default. You can deselect these objects and select any object in the report to make it available as a filter. For example, you can...
make the [Country] dimension available as a filter when you publish a table containing the [Region] and [Revenue] objects if the [Country] dimension appears in the report. You can also choose not to make the [Region] and [Revenue] objects available as filters.

You do not have to include any report objects as filters except for objects that appear in section headers. These appear selected and you cannot unselect them.

If you publish a block in a section, by default the web service filters on the value of the section object corresponding to the block you selected. For example, if you have a report containing [Country], [Region] and [Revenue] with [Country] as the section header, and you publish the block in the section where [Country]="France", the web service uses “France” as the default value of [Country]. A web application accessing the web service can supply a different value for [Country] and the data returned by the web service changes to correspond with the filter.

If you publish a block in a report containing report filters, the objects on which report filters are defined are selected by default in the screen. You can unselect these objects. If you publish the block without making the objects available as filters, the web service filters data according to the values of the report filters. If you make the objects available, web applications can apply the report filters using different values.

Related Information

GetReportBlock_<blockname> [page 411]

6.2.2 To publish a report block as a web service

You use the Publish Content wizard to publish a report block as a web service.

1. Open a Web Intelligence document in Design mode.
2. Select the table, chart or form you want to publish, right-click and select Publish as Web Service to display the Publish Content wizard.
3. Click Next to move to the first publishing step. If the report block you are publishing as a web service has already been published, the Identify Duplicate Content screen highlights the duplicated blocks. The duplicate block appears in bold beneath the web services that publish it.
4. Click Next to move to the next step.
5. In the Choose Prompt screen:
   a) Select or unselect the prompts you want to include or exclude in the list of prompts. Click Select all to select all prompts or Clear all to clear all prompts.
   b) Click Next to move to the next step.

Note

For web services, to use multiple values in prompts, you must reproduce the prompt as many times as different responses are expected, and the user will be prompted for each response.
If you do not publish a prompt, the web service uses the prompt value supplied when the document was last refreshed and saved. For example, if a user answers "US" to a prompt on [Country], then saves the document, the web service filters data on [Country]="US" the next time it is called with the refresh=true parameter.

If a web service publishes prompts, web applications must supply values for the prompts in the custom data provider web service window if they call the web service with the refresh=true parameter. If the user does not enter values for the prompts, the last values entered are used.

6. In the Define Published Content screen:
   a) Type the name and description under which you want to publish the table.
   b) Select Share report content for all consumers when you want all web service consumers (sessions) get the report block content from the same (and single) instance of document.

   The Share report content for all consumers option below all web service consumers (sessions) to get the report block content from the same (and single) instance of document. This option reduces memory load on the processing server, and should be enabled when content is to be consumed by many concurrent users. Technically, the document is opened by the first consumer who sends a request for it, and is then consumed by any other consumer sending same request after `on behalf` of first user (i.e. using his authorization). Document security cannot therefore be applied with web service calls designed with this option. To avoid any conflicts, all consumers should be granted the permission to open the corresponding document. Users should also be granted permission to view/access data from the underlying data sources.

   i Note
   Filtering and drilling from a web service are not compatible with the Share report content for all consumers option. The only way to filter Web Intelligence document data from web services is to use report sections exposed as filters in the corresponding web service.

   c) Click Set Filters and select the objects you want to make available for filtering in the web service. When Share report content for all consumers is selected, the Set Filters option is disabled because consumers will not be able to use report filters, section filters being the only available way to filter content through mandatory input parameters.
   d) Select the server where you want to publish the content beneath Host server.
   e) To add, remove or edit servers in the list of host servers, click Manage servers, then click Add, Edit or Remove and update the list of servers.
   f) Click Next to move to the next step.

7. In the Publish new content or re-publish existing content as Web Service screen:
   a) To re-publish an existing web service, select the web service, click Publish.
   b) To publish a new web service, select the folder where you want to publish the content and click Create to display the Publish Web Service dialog box.

   i Note
   Folders are optional, you publish to an existing web service or a new web service, and you can create folders in order to organize your work. Click New Folder to add a folder.

   c) Type the name of the web service in the Web service name box and the service description in the Description box.
   d) Select the authentication method for the web service from the Authentication list.
   e) Click OK to close the dialog box and save and publish the web service.
Choose the web service where you want to publish to and click **Finish**.

### 6.2.3 Viewing and managing published content

You can browse the content published on different Web servers by using the **Web Service Publisher** pane. The **Web Service Publisher** pane also allows you to edit published Web services and import QaaWS (Query as a Web Service) queries, which you can then republish as Web Intelligence content.

#### 6.2.3.1 To view and manage published content

You can view and manage published Web Service content in the **Web Service Publisher** pane of the Side Panel.

1. Open a Web Intelligence document in **Design** mode.
2. Click the **Web Service Publisher** icon of the Side Panel.
3. In the **Web Service Publisher** pane, select the server from the **Host server** list.
4. Do one of the following:
   - To add, remove or edit servers in the list of host servers, click **Manage servers**, then click **Add**, **Edit** or **Remove** and update the list of servers.
   - From the **Views** dropdown list, select the way you want the content to be organized from the menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View by web service</strong></td>
<td>Published content is organized as web service &gt; block</td>
</tr>
<tr>
<td><strong>View by document and web service</strong></td>
<td>Published content is organized as a document &gt; web service &gt; block</td>
</tr>
<tr>
<td><strong>View by document and block</strong></td>
<td>Published content is organized as a document &gt; block &gt; web service</td>
</tr>
<tr>
<td><strong>Show Web Services queries</strong></td>
<td>QaaWS (Query as a Web Service) queries appear below the published content.</td>
</tr>
<tr>
<td></td>
<td>(QaaWS queries are stored in the same repository folder as BI services.)</td>
</tr>
</tbody>
</table>

- To edit a published block, right-click the block and select **Edit** to launch the **Publish Content** wizard.
- To delete published content, right-click the published block or the web service and select **Delete**.
- To rename a web service, right-click the web service, select **Rename** and type the new name.
- To refresh the list of published content, click the **Refresh** icon, or right-click on a folder or web service and select **Refresh list**.
- To search the list of web services, type the text you want to search for in the search box and select your search options from the search box dropdown list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Case sensitive</strong></td>
<td>Match case when searching</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Case insensitive</td>
<td>Ignore case when searching</td>
</tr>
<tr>
<td>Match from start</td>
<td>Return only those web services or blocks whose name starts with the search text</td>
</tr>
<tr>
<td>Match anywhere</td>
<td>Return only those web services or blocks whose name contains the search text</td>
</tr>
</tbody>
</table>

**Related Information**

Importing and using QaaWS queries as a BI service [page 409]  
You can import QaaWS (Query as a Web Service) queries and run them to produce a block that is inserted in a new report.

To publish a report block as a web service [page 406]  
You use the Publish Content wizard to publish a report block as a web service.

### 6.2.3.2 To test published content

You can test published content and examine the structure of the web service that publishes it.

1. Open a Web Intelligence document in Design mode.
2. Click the Web Service Publisher icon of the Side Panel.
3. Select the web service you want to test and click the Test icon.
4. Select the web service function you want to test from the Operation dropdown list.
5. Select the parameters and operators for which you want to specify values in the Input pane and type their values beneath Value.
6. Click Send to call the web service with the values you specified. The data returned by the web service appears in the Server Response pane.
7. Click Change to tree view or Change to table view to toggle the web service data between a tree view and table format.

### 6.2.4 Importing and using QaaWS queries as a BI service

You can import QaaWS (Query as a Web Service) queries and run them to produce a block that is inserted in a new report.

When you import a QaaWS query, the application builds a query based on the structure of the QaaWS query, then runs this query and inserts the resulting block in a new report. The original QaaWS query is not modified.

Because Web Intelligence does not support the publication of QaaWS queries directly, you can publish QaaWS queries as BI services by publishing the resulting block as a BI service.
6.2.4.1 To publish a QaaWS query

You can publish a QaaWS query in the Publish Content wizard.

1. Open a Web Intelligence document in Design mode.
2. Click the Web Service Publisher icon of the Side Panel.
3. Select Publish on the main toolbar to go to the Publish new content or re-publish existing content as Web Service screen in the Publish Content wizard.
4. Select View ➤ Display QaaWS queries to display QaaWS queries.
5. Select the QaaWS query you want to import and click Import Web Service query.
   The QaaWS query is added to the document as a Web Intelligence query. A report tab is added with the same name as the QaaWS query. The report tab contains a table corresponding to the query objects.
6. Refresh the added query to display the web service query data.
7. Right-click the added table and select Publish as Web Service to publish the table as a web service.

Related Information

To publish a report block as a web service [page 406]
You use the Publish Content wizard to publish a report block as a web service.

6.2.5 BI service structure

Applications use the SOAP protocol to call the functions and receive the function output which they can then parse.

External web applications access Web Intelligence content published as web services by calling two functions:

- GetReportBlock_<blockname>
- Drill_<blockname>

In both these function calls, <blockname> is the name of the block as defined in the web service.
**6.2.5.1 GetReportBlock_<blockname>**

**Function name**

GetReportBlock_<blockname>

**Input parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Mandatory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>login</td>
<td>CMS login</td>
<td>Yes, unless sessionID or serializedSession is specified.</td>
</tr>
<tr>
<td>password</td>
<td>CMS password</td>
<td>Yes, unless sessionID or serializedSession is specified.</td>
</tr>
<tr>
<td>reportfilter</td>
<td>One or more report filters. See the reportfilter table below for more information.</td>
<td>Yes when the report block contains section entries; no otherwise. Blocks with sections therefore have a mix of mandatory and optional reportfilter parameters.</td>
</tr>
<tr>
<td>prompt</td>
<td>Prompt values. See below for more information on LovIndexValue parameters</td>
<td>Yes when refresh = true and the prompt is mandatory. No otherwise (refresh = false). If you don’t enter a prompt value, then the prompt takes the values previously defined values. The consumption of web services having prompts in Web Intelligence does not mean that you will be prompted, you must enter prompt values in the Custom Data Provider - Web Service window.</td>
</tr>
<tr>
<td>closeDocument</td>
<td>Forc...</td>
<td>Boolean, default value: false (by default document is kept open, when web service is replied). Values: false or true.</td>
</tr>
<tr>
<td>endRow</td>
<td>Defines the last row number retrieved from the source. This parameter is used with the startRow parameter to define the chunk size to retrieve in table output parameter. For example, startRow = 10 / endRow = 55, will retrieve 46 rows between row 10 and row 55 included. The last row of a table has rank set equal to table size; any</td>
<td>Optional. If not declared, the entire table contents are retrieved. By default, the entire table contents are retrieved.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Mandatory?</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>startRow</td>
<td>Defines the first row number retrieved from the source. This parameter is used with the endRow parameter to define the chunk size to retrieve in table output parameter. For example, startRow = 10 / endRow = 55, will retrieve 46 rows between row 10 and row 55 included. If the first row of a table is 1, any lower value is internally corrected to 1.</td>
<td>Optional. If not declared, the entire table contents are retrieved. By default, the entire table contents are retrieved.</td>
</tr>
<tr>
<td>resetState</td>
<td>Re-opens the document when the web service is called, resetting drills and filters.</td>
<td>No. The default value is false.</td>
</tr>
<tr>
<td>refresh</td>
<td>Forces a document refresh.</td>
<td>No. The default value is false.</td>
</tr>
<tr>
<td>getFromLatestDocumentInstance</td>
<td>Retrieves data from the latest document instance.</td>
<td>No. The default value is true.</td>
</tr>
<tr>
<td>getFromUserInstance</td>
<td>Retrieves data from the user inbox if the document has been published.</td>
<td>No. The default value is false.</td>
</tr>
<tr>
<td>turnOutputToVTable</td>
<td>Turns the output to a vertical table.</td>
<td>No. The default value is false.</td>
</tr>
<tr>
<td>sessionID</td>
<td>Session token to avoid submitting the login or password. Increases the session count when submitted.</td>
<td>No.</td>
</tr>
<tr>
<td>serializedSession</td>
<td>Serialized session to avoid submitting the login or password. Does not increase the session count when submitted.</td>
<td>No.</td>
</tr>
</tbody>
</table>

**The reportfilter parameter**

The reportfilter parameters contain two elements:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>filtering_value</td>
<td>The value used to filter the data</td>
<td>Any</td>
</tr>
</tbody>
</table>
### Example of reportFilter parameter

The filter `[Country]`="US" is specified as follows:

```xml
<Country>
    <value>US</value>
    <operator>EQUAL</operator>
</Country>
```

### Output parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>TTable</td>
<td>Table cells</td>
</tr>
<tr>
<td>headers</td>
<td>THeader</td>
<td>Table headers</td>
</tr>
<tr>
<td>footers</td>
<td>TFooter</td>
<td>Table footers</td>
</tr>
<tr>
<td>user</td>
<td>string</td>
<td>Login used by the web service call</td>
</tr>
<tr>
<td>documentation</td>
<td>string</td>
<td>The web service description supplied by the service designer</td>
</tr>
<tr>
<td>lastrefreshdate</td>
<td>dateTime</td>
<td>The date of the last document refresh</td>
</tr>
<tr>
<td>creationdate</td>
<td>dateTime</td>
<td>The date the web service was created</td>
</tr>
<tr>
<td>creator</td>
<td>string</td>
<td>User name of the web service creator</td>
</tr>
<tr>
<td>isScheduled</td>
<td>boolean</td>
<td>Specifies if document is scheduled</td>
</tr>
<tr>
<td>scheduleStartTime</td>
<td>dateTime</td>
<td>The schedule start time if the document is scheduled</td>
</tr>
<tr>
<td>scheduleEndTime</td>
<td>dateTime</td>
<td>The schedule end time if the document is scheduled</td>
</tr>
<tr>
<td>tableType</td>
<td>string</td>
<td>The table type</td>
</tr>
<tr>
<td>nbColumns</td>
<td>int</td>
<td>The number of columns in the output table</td>
</tr>
<tr>
<td>nbLines</td>
<td>int</td>
<td>The number of rows in the output table</td>
</tr>
</tbody>
</table>
Related Information

*Drill_<blockname>* [page 414]
*Sample BI service return data* [page 417]

Web services return data using SOAP. The following is a sample SOAP file returned by a web service.

### 6.2.5.2 Drill_<blockname>

#### Function name

<table>
<thead>
<tr>
<th>Drill_&lt;blockname&gt;</th>
</tr>
</thead>
</table>

**i Note**

This web service call cannot be used when the document sharing option (*Share report content for all consumers* in the Publish Content wizard) is enabled because such methods will not be specified in web service WSDL file. An error will be returned to the consumer if the document is called when this option is enabled.

#### Input parameters

The syntax of the *Drill_<blockname>* function is similar to *GetReportBlock_<blockname>*. with the following differences:

- there are no reportfilter parameters
- there are additional drillpath parameters
- there are additional drillfilter parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Mandatory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>drillpath</td>
<td>Specifies a drill instruction</td>
<td>Yes</td>
</tr>
<tr>
<td>drillfilter</td>
<td>Specifies a filter to apply when drilling</td>
<td>No</td>
</tr>
</tbody>
</table>

#### The drillpath parameter

The drillpath parameters are of DrillPath type. They contain three elements:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>from</td>
<td>The dimension to drill</td>
<td>Any</td>
</tr>
<tr>
<td>value</td>
<td>The value to drill on</td>
<td>Any</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Values</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>drilloperation</td>
<td>The type of drill operation</td>
<td>UP</td>
</tr>
</tbody>
</table>

**Note**

- As well as single values (for example "Los Angeles"), `value` can pass definitions such as "All Cities".
- If the drill instruction is invalid, the web service returns the original table data.
- At the end of the drill hierarchy, the web services returns the last available values in the drill hierarchy.
- You can supply more than one `drillpath` parameter, providing that the parameters do not refer to different levels in the same drill hierarchy.

### The drillfilter parameter

The `drillpath` parameters allow you to apply drill filters at the same time as drilling:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>dimension</td>
<td>The dimension to filter</td>
<td>Any</td>
</tr>
<tr>
<td>value</td>
<td>The value to filter on</td>
<td>Any</td>
</tr>
<tr>
<td>operator</td>
<td>The filter operator</td>
<td>EQUAL</td>
</tr>
</tbody>
</table>

**Note**

- As well as single values (for example "Los Angeles"), `value` can pass definitions such as "All Cities".
- If the drill instruction is invalid, the web service returns the original table data.
- At the end of the drill hierarchy, the web services returns the last available values in the drill hierarchy.
- You can supply more than one `drillpath` parameter, providing that the parameters do not refer to different levels in the same drill hierarchy.

**Related Information**

`GetReportBlock_<blockname>` [page 411]
## BI Services output parameters

There are many output parameters that can be returned by a BI service.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>TTable</td>
<td>Table cells</td>
</tr>
<tr>
<td>headers</td>
<td>THeader</td>
<td>Table headers cells</td>
</tr>
<tr>
<td>footers</td>
<td>TFooter</td>
<td>Table footers cells</td>
</tr>
<tr>
<td>user</td>
<td>string</td>
<td>Login used by the web service call</td>
</tr>
<tr>
<td>documentation</td>
<td>string</td>
<td>The web service description supplied by the service designer</td>
</tr>
<tr>
<td>documentname</td>
<td>string</td>
<td>The document name</td>
</tr>
<tr>
<td>lastrefreshdate</td>
<td>dateTime</td>
<td>The date of the last document refresh</td>
</tr>
<tr>
<td>creationdate</td>
<td>dateTime</td>
<td>The date the web service was created</td>
</tr>
<tr>
<td>creator</td>
<td>string</td>
<td>User name of the web service creator</td>
</tr>
<tr>
<td>isScheduled</td>
<td>boolean</td>
<td>Specifies if document is scheduled</td>
</tr>
<tr>
<td>scheduleStartTime</td>
<td>dateTime</td>
<td>The schedule start time if the document is scheduled</td>
</tr>
<tr>
<td>scheduleEndTime</td>
<td>dateTime</td>
<td>The schedule end time if the document is scheduled</td>
</tr>
<tr>
<td>tableType</td>
<td>string</td>
<td>The table type</td>
</tr>
<tr>
<td>nbColumns</td>
<td>int</td>
<td>The number of columns in the output table</td>
</tr>
<tr>
<td>nbLines</td>
<td>int</td>
<td>The number of rows in the output table</td>
</tr>
</tbody>
</table>

### Example of table parameter

```
<table>
  <row>
    <cell xsi:type="xsd:string">Australia</cell>
    <cell xsi:type="xsd:string">Accommodation</cell>
    <cell xsi:type="xsd:string">Bungalow</cell>
    <cell xsi:type="xsd:double">172980</cell>
  </row>
  <row>
    <cell xsi:type="xsd:string">Australia</cell>
    <cell xsi:type="xsd:string">Accommodation</cell>
    <cell xsi:type="xsd:string">Hotel Room</cell>
    <cell xsi:type="xsd:double">345510</cell>
  </row>
  ...
</table>
```
Example of headers parameter

```
<headers>
  <row>
    <cell xsi:type="xsd:string">Country</cell>
    <cell xsi:type="xsd:string">Service Line</cell>
    <cell xsi:type="xsd:string">Service</cell>
    <cell xsi:type="xsd:string">Revenue</cell>
  </row>
</headers>
```

Related Information

**Sample BI service return data** [page 417]

Web services return data using SOAP. The following is a sample SOAP file returned by a web service.

6.2.5.4 Sample BI service return data

Web services return data using SOAP. The following is a sample SOAP file returned by a web service.

```
<soap:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance..."
  xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
  xmlns:GetReportBlock_Block1BeachResponse="multidocmultiuniversesmultiuniverse">
  <GetReportBlock_Block1BeachResponse xmlns="multidocmultiuniversesmultiuniverse">
    <table>
      <row>
        <cell xsi:type="xsd:string">Australia</cell>
        <cell xsi:type="xsd:string">Accommodation</cell>
        <cell xsi:type="xsd:string">Bungalow</cell>
        <cell xsi:type="xsd:double">172980</cell>
      </row>
      <row>
        <cell xsi:type="xsd:string">Australia</cell>
        <cell xsi:type="xsd:string">Accommodation</cell>
        <cell xsi:type="xsd:string">Hotel Room</cell>
        <cell xsi:type="xsd:double">345510</cell>
      </row>
      <row>
        <cell xsi:type="xsd:string">Australia</cell>
        <cell xsi:type="xsd:string">Accommodation</cell>
        <cell xsi:type="xsd:string">Hotel Suite</cell>
        <cell xsi:type="xsd:double">464850</cell>
      </row>
      <row>
        <cell xsi:type="xsd:string">Australia</cell>
        <cell xsi:type="xsd:string">Food &amp; Drinks</cell>
        <cell xsi:type="xsd:string">Fast Food</cell>
        <cell xsi:type="xsd:double">19530</cell>
      </row>
      <row>
        <cell xsi:type="xsd:string">Australia</cell>
        <cell xsi:type="xsd:string">Food &amp; Drinks</cell>
        <cell xsi:type="xsd:string">Poolside Bar</cell>
        <cell xsi:type="xsd:double">27073</cell>
      </row>
    </table>
  </GetReportBlock_Block1BeachResponse>
</soap:Envelope>
```
<table>
<thead>
<tr>
<th>Country</th>
<th>Category</th>
<th>Subcategory</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>Food &amp; Drinks</td>
<td>Restaurant</td>
<td>41,160</td>
</tr>
<tr>
<td>Australia</td>
<td>Recreation</td>
<td>Activities</td>
<td>5,982</td>
</tr>
<tr>
<td>Australia</td>
<td>Recreation</td>
<td>Excursion</td>
<td>113,170</td>
</tr>
<tr>
<td>Australia</td>
<td>Recreation</td>
<td>Sports</td>
<td>69,575</td>
</tr>
<tr>
<td>Australia</td>
<td>Travels</td>
<td>Car Rent</td>
<td>49,160</td>
</tr>
<tr>
<td>Australia</td>
<td>Travels</td>
<td>Travel Reservation</td>
<td>63,300</td>
</tr>
<tr>
<td>France</td>
<td>Accommodation</td>
<td>Bungalow</td>
<td>126,240</td>
</tr>
<tr>
<td>France</td>
<td>Accommodation</td>
<td>Hotel Room</td>
<td>116,790</td>
</tr>
<tr>
<td>France</td>
<td>Accommodation</td>
<td>Hotel Suite</td>
<td>320,220</td>
</tr>
<tr>
<td>France</td>
<td>Food &amp; Drinks</td>
<td>Fast Food</td>
<td>28,440</td>
</tr>
<tr>
<td>France</td>
<td>Food &amp; Drinks</td>
<td>Poolside Bar</td>
<td>46,320</td>
</tr>
<tr>
<td>Country</td>
<td>Category</td>
<td>Subcategory</td>
<td>Value</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>--------</td>
</tr>
<tr>
<td>France</td>
<td>Recreation</td>
<td>Activities</td>
<td>9000</td>
</tr>
<tr>
<td></td>
<td>Recreation</td>
<td>Excursion</td>
<td>120050</td>
</tr>
<tr>
<td></td>
<td>Recreation</td>
<td>Sports</td>
<td>35720</td>
</tr>
<tr>
<td>Nepal</td>
<td>Accommodation</td>
<td>Bungalow</td>
<td>323231</td>
</tr>
<tr>
<td></td>
<td>Accommodation</td>
<td>Hotel Room</td>
<td>330240</td>
</tr>
<tr>
<td></td>
<td>Accommodation</td>
<td>Hotel Suite</td>
<td>320754</td>
</tr>
<tr>
<td>Nepal</td>
<td>Food &amp; Drinks</td>
<td>Fast Food</td>
<td>32960</td>
</tr>
<tr>
<td></td>
<td>Food &amp; Drinks</td>
<td>Poolside Bar</td>
<td>37915</td>
</tr>
<tr>
<td></td>
<td>Food &amp; Drinks</td>
<td>Restaurant</td>
<td>32980</td>
</tr>
<tr>
<td>Nepal</td>
<td>Recreation</td>
<td>Activities</td>
<td>78200</td>
</tr>
<tr>
<td></td>
<td>Recreation</td>
<td>Excursion</td>
<td>96440</td>
</tr>
<tr>
<td>Country</td>
<td>Department</td>
<td>Category</td>
<td>Value</td>
</tr>
<tr>
<td>---------</td>
<td>--------------</td>
<td>-----------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Nepal</td>
<td>Recreation</td>
<td>Sports</td>
<td>102720</td>
</tr>
<tr>
<td>Nepal</td>
<td>Travels</td>
<td>Car Rent</td>
<td>56370</td>
</tr>
<tr>
<td>Nepal</td>
<td>Travels</td>
<td>Travel Reservation</td>
<td>74495</td>
</tr>
<tr>
<td>US</td>
<td>Accommodation</td>
<td>Bungalow</td>
<td>368870</td>
</tr>
<tr>
<td>US</td>
<td>Accommodation</td>
<td>Hotel Room</td>
<td>746828</td>
</tr>
<tr>
<td>US</td>
<td>Accommodation</td>
<td>Hotel Suite</td>
<td>842046</td>
</tr>
<tr>
<td>US</td>
<td>Food &amp; Drinks</td>
<td>Fast Food</td>
<td>66330</td>
</tr>
<tr>
<td>US</td>
<td>Food &amp; Drinks</td>
<td>Poolside Bar</td>
<td>88508</td>
</tr>
<tr>
<td>US</td>
<td>Food &amp; Drinks</td>
<td>Restaurant</td>
<td>331860</td>
</tr>
<tr>
<td>US</td>
<td>Recreation</td>
<td>Activities</td>
<td>207950</td>
</tr>
<tr>
<td>US</td>
<td>Recreation</td>
<td>Excursion</td>
<td>170305</td>
</tr>
</tbody>
</table>
6.2.5.5 BI service WSDL definition

```xml
<?xml version="1.0" encoding="utf-16"?>
xmlns:s="http://www.w3.org/2001/XMLSchema"
xmlns:s0="zozo2" xmlns:tns1="dsws.businessobjects.com" targetNamespace="zozo2"
xmlns=http://schemas.xmlsoap.org/wsdl/" name="BIServices">
<types>
<s:schema elementFormDefault="qualified" targetNamespace="zozo2">
<s:complexType name="FilterCondition">
<s:sequence>
<s:simpleType name="Operator">
<s:restriction base="s:string">
<s:enumeration value="EQUAL" />
<s:enumeration value="GREATER" />
<s:enumeration value="GREATER_OR_EQUAL" />
<s:enumeration value="LESS" />
<s:enumeration value="LESS_OR_EQUAL" />
<s:enumeration value="NOT_EQUAL" />
<s:enumeration value="INLIST" />
<s:enumeration value="NOT_INLIST" />
</s:restriction>
</s:complexType>
</s:sequence>
</s:schema>
</types>
</definitions>
```
<s:element name="GetReportBlock_Block1">
<complexType>
<sequence>
<s:element name="login" type="string" minOccurs="0" nillable="true" />
<s:element name="password" type="string" minOccurs="0" nillable="true" />
<s:element name="Country" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Resort" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Service_Line" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Revenue" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Enter_value_s__for_Country_" type="s0:LovValueIndex" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="resetState" type="boolean" minOccurs="0" nillable="true" />
<s:element name="refresh" type="boolean" minOccurs="0" nillable="true" />
<s:element name="getFromLatestDocumentInstance" type="boolean" minOccurs="0" nillable="true" />
<s:element name="getFromUserInstance" type="boolean" minOccurs="0" nillable="true" />
<s:element name="turnOutputToVTable" type="boolean" minOccurs="0" nillable="true" />
</sequence>
</complexType>
</s:element>
</complexType>
<s:element name="GetReportBlock_Block1ff">
<complexType>
<sequence>
<s:element name="login" type="string" minOccurs="0" nillable="true" />
<s:element name="password" type="string" minOccurs="0" nillable="true" />
<s:element name="Country" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Resort" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Service_Line" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Revenue" type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Enter_value_s__for_Country_" type="s0:LovValueIndex" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="resetState" type="boolean" minOccurs="0" nillable="true" />
<s:element name="refresh" type="boolean" minOccurs="0" nillable="true" />
<s:element name="getFromLatestDocumentInstance" type="boolean" minOccurs="0" nillable="true" />
<s:element name="getFromUserInstance" type="boolean" minOccurs="0" nillable="true" />
<s:element name="turnOutputToVTable" type="boolean" minOccurs="0" nillable="true" />
</sequence>
</complexType>
</s:element>
<s:complexType name="GetReportBlock_Bloc1">
  
  <s:sequence>
    
  </s:sequence>
</s:complexType>

<s:simpleType name="DrillOperation">
  
  <s:restriction base="s:string">
    
  </s:restriction>
</s:simpleType>

<s:complexType name="DrillPath">
  
  <s:sequence>
    
  </s:sequence>
</s:complexType>

<s:element name="Drill_Block1">
  
  <s:complexType>
    
  </s:complexType>
</s:element>
<s:element name="turnOutputToVTable" type="s:boolean" minOccurs="0" nillable="true" />
</s:sequence>
</s:complexType>
</s:element>
<s:element name="Drill_Block1ff">
<s:complexType>
<s:sequence>
<s:element name="login" type="s:string" minOccurs="0" nillable="true" />
<s:element name="password" type="s:string" minOccurs="0" nillable="true" />
<s:element name="drillPath" type="s0:DrillPath" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="filter" type="s0:DrillFilter" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="Enter_value_s__for_Country_" type="s0:LovValueIndex" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="resetState" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="refresh" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="getFromLatestDocumentInstance" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="getFromUserInstance" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="turnOutputToVTable" type="s:boolean" minOccurs="0" nillable="true" />
</s:sequence>
</s:complexType>
</s:element>
<s:element name="Drill_Bloc1">
<s:complexType>
<s:sequence>
<s:element name="login" type="s:string" minOccurs="0" nillable="true" />
<s:element name="password" type="s:string" minOccurs="0" nillable="true" />
<s:element name="drillPath" type="s0:DrillPath" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="filter" type="s0:DrillFilter" minOccurs="0" maxOccurs="unbounded" nillable="true" />
<s:element name="resetState" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="refresh" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="getFromLatestDocumentInstance" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="getFromUserInstance" type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="turnOutputToVTable" type="s:boolean" minOccurs="0" nillable="true" />
</s:sequence>
</s:complexType>
</s:element>
<s:complexType name="TRow">
<s:sequence>
<s:element name="cell" type="s:anyType" maxOccurs="unbounded" nillable="true" />
</s:sequence>
</s:complexType>
</s:element>
<s:complexType name="TTable">
<s:sequence>
<s:element name="row" maxOccurs="unbounded" type="s0:TRow" />
</s:sequence>
</s:complexType>
</s:element>
<s:complexType name="THeader">
<s:sequence>
</s:sequence>
</s:complexType>
SAP BusinessObjects Web Intelligence User's Guide
Publishing, formatting, and sharing reports

© 2014 SAP SE or an SAP affiliate company. All rights reserved. 425
<s:complexContent>
  <s:complexType>
    <s:sequence>
      <s:element name="table" type="s0:TTable" />
      <s:element name="headers" type="s0:THeader" />
      <s:element name="footers" type="s0:TFooter" />
      <s:element name="user" type="s:string" />
      <s:element name="documentation" type="s:string" />
      <s:element name="documentname" type="s:string" />
      <s:element name="lastrefreshdate" type="s:dateTime" />
      <s:element name="creationdate" type="s:dateTime" />
      <s:element name="creator" type="s:string" />
      <s:element name="isScheduled" type="s:boolean" />
      <s:element name="scheduleStartTime" type="s:dateTime" />
      <s:element name="scheduleEndTime" type="s:dateTime" />
      <s:element name="tableType" type="s:string" />
      <s:element name="nbColumns" type="s:int" />
      <s:element name="nbLines" type="s:int" />
    </s:sequence>
  </s:complexType>
</s:element>
</s:complexType>
<s:sequence>
  <s:element name="sessionID" type="s:string" minOccurs="0" maxOccurs="1" nillable="true" />
  <s:element name="serializedSession" type="s:string" minOccurs="0" maxOccurs="1" nillable="true" />
</s:sequence>
</s:complexType>
</s:schema>
</types>
<message name="GetReportBlock_Block1SoapIn">
  <part name="parameters" element="s0:GetReportBlock_Block1" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Block1SoapOut">
  <part name="parameters" element="s0:GetReportBlock_Block1Response" />
</message>
<message name="Drill_Block1SoapIn">
  <part name="parameters" element="s0:Drill_Block1" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="Drill_Block1SoapOut">
  <part name="parameters" element="s0:Drill_Block1Response" />
</message>
<message name="GetReportBlock_Block1ffSoapIn">
  <part name="parameters" element="s0:GetReportBlock_Block1ff" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Block1ffSoapOut">
  <part name="parameters" element="s0:GetReportBlock_Block1ffResponse" />
</message>
<message name="Drill_Block1ffSoapIn">
  <part name="parameters" element="s0:Drill_Block1ff" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="Drill_Block1ffSoapOut">
  <part name="parameters" element="s0:Drill_Block1ffResponse" />
</message>
<message name="GetReportBlock_Block1SoapIn">
  <part name="parameters" element="s0:GetReportBlock_Block1" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Block1SoapOut">
  <part name="parameters" element="s0:GetReportBlock_Block1Response" />
</message>
<message name="Drill_Block1SoapIn">
  <part name="parameters" element="s0:Drill_Block1" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="Drill_Block1SoapOut">
  <part name="parameters" element="s0:Drill_Block1Response" />
</message>
<message name="GetReportBlock_Block1ffSoapIn">
  <part name="parameters" element="s0:GetReportBlock_Block1ff" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Block1ffSoapOut">
  <part name="parameters" element="s0:GetReportBlock_Block1ffResponse" />
</message>
<message name="Drill_Block1ffSoapIn">
  <part name="parameters" element="s0:Drill_Block1ff" />
  <part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="Drill_Block1ffSoapOut">
  <part name="parameters" element="s0:Drill_Block1ffResponse" />
</message>
</portType>
<operation name="GetReportBlock_Block1">
  <documentation />
  <input message="s0:GetReportBlock_Block1SoapIn" />
  <output message="s0:GetReportBlock_Block1SoapOut" />
</operation>
<operation name="Drill_Block1">
  <documentation />
  <input message="s0:Drill_Block1SoapIn" />
  <output message="s0:Drill_Block1SoapOut" />
</operation>
<operation name="GetReportBlock_Block1ff">
  <documentation />
  <input message="s0:GetReportBlock_Block1ffSoapIn" />
  <output message="s0:GetReportBlock_Block1ffSoapOut" />
</operation>

<soap:operation soapAction="zozo2/Drill_Block1ff" style="document"/>
</input>
<soap:header message="s0:Drill_Block1ffSoapIn" part="request_header" use="literal"/>
<soap:headerfault message="s0:Drill_Block1ffSoapIn" part="request_header" use="literal"/>
</soap:header>
</input>
<output>
<soap:body use="literal"/>
</output>
</operation>
<operation name="GetReportBlock_Bloc1">
<documentation/>
<soap:operation soapAction="zozo2/GetReportBlock_Bloc1" style="document"/>
</input>
<soap:header message="s0:GetReportBlock_Bloc1SoapIn" part="request_header" use="literal"/>
<soap:headerfault message="s0:GetReportBlock_Bloc1SoapIn" part="request_header" use="literal"/>
</soap:header>
</input>
<output>
<soap:body use="literal"/>
</output>
</operation>
<operation name="Drill_Bloc1">
<documentation/>
<soap:operation soapAction="zozo2/Drill_Bloc1" style="document"/>
</input>
<soap:header message="s0:Drill_Bloc1SoapIn" part="request_header" use="literal"/>
<soap:headerfault message="s0:Drill_Bloc1SoapIn" part="request_header" use="literal"/>
</soap:header>
</input>
<output>
<soap:body use="literal"/>
</output>
</operation>
</binding>
<service name="zozo2">
<documentation/>
<port name="BIServicesSoap" binding="s0:BIServicesSoap">
<soap:address location="http://noux:8080/dswwbobje/qaawsservices/queryasaservice?&cuid=AduDHmyVezRnnJM_FDS4S0&authType=secEnterprise&locale=en_US&timeout=60"/>
</port>
</service>
</definitions>
6.3 Sending documents

6.3.1 To send a document by email

You can send a Web Intelligence document as an email attachment.

1. Open a Web Intelligence document.
2. Depending on the Web Intelligence interface you are using, do the following tasks:
   ○ In the Web Intelligence HTML interface:
     ○ In Reading mode, select Send to Mail from the Send to icon dropdown list.
     ○ In the Design mode, in the File tab, select Send to Mail from the Send to icon dropdown list.
   ○ In the Web Intelligence Applet interface:
     ○ In Reading mode, select Send to email from the Send document icon dropdown list.
     ○ In the Design or Data mode, in the File tab, select Send to email from the Send document icon dropdown list.
   ○ In Web Intelligence Rich Client:
     ○ In Reading mode, select a document format from the Send by E-mail attachment icon dropdown list.
     ○ In the Design or Data mode, in the File tab, select a document format from the Send by E-mail attachment icon dropdown list.
3. Enter the addressees, any email text required, and send the email.

6.3.2 To send a document to another user or group in the CMS

You can send a Web Intelligence document to another user in the CMS from the Web Intelligence HTML or Web Intelligence Applet interface.

1. Open a Web Intelligence document in the Web Intelligence HTML or Web Intelligence Applet interface.
2. Do one of the following:
   ○ If you are in Reading mode, select Send to User from the Send to icon dropdown list.
   ○ If you are in Design or Data mode, in the File tab toolbar, select Send to User from the Send to icon dropdown list.
3. Select the users or groups to which you want to send the document from the list of users and groups.
4. Click Use Automatically Generated Name to send the document with an automatically-generated name.
5. Click Use Specific Name and type the name in the box to send if you want to name the document.
6. Click Shortcut to send a shortcut to the document or Copy to send a copy of the document.
7. Click Send.

Note
This option is not available in the Web Intelligence Rich Client.
6.3.3 To send a document by FTP

You can send a Web Intelligence document by FTP in the Web Intelligence HTML or Web Intelligence Applet interface.

1. Open a Web Intelligence document in the Web Intelligence HTML or Web Intelligence Applet interface.

   i Note
   This option is not available in Web Intelligence Rich Client.

   i Note
   Save any document changes before sending it.

2. Do one of the following:
   ○ If you are in Reading mode, from the Send to icon dropdown list, select Send to Ftp.
   ○ If you are in Design or Data mode, in the File tab, select Save to Enterprise from the Save Menu icon dropdown list.

   i Note
   You must have the required permissions to send files via FTP. If you do not have the permissions, the Send to FTP dialog box does not appear, or appears with an error message.

3. Type the host name in the Host box.
4. Type the port in the Port box.
5. Type the username and password in the User Name and Password boxes.
6. Type the account in the Account box.
7. Type the directory in the Directory box.
8. Click Use Automatically Generated Name to send the document with an automatically-generated name.
9. Click Use Specific Name and type the name in the box to send if you want to name the document.
10. Click Send.
7 Saving and exporting documents, reports and data in Web Intelligence

Web Intelligence allows you to save or export your documents in a variety of formats.

You can perform the following save and export actions, depending on the version of Web Intelligence you are using.

<table>
<thead>
<tr>
<th>Application</th>
<th>Export as</th>
<th>Save as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Intelligence HTML interface</td>
<td>CSV</td>
<td>Web Intelligence</td>
</tr>
<tr>
<td></td>
<td>CSV archive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Excel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Excel 2007</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PDF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Web Intelligence Applet interface</td>
<td>CSV</td>
<td>CSV archive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Excel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Excel 2007</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Web Intelligence</td>
</tr>
<tr>
<td>Web Intelligence Rich Client</td>
<td>CSV</td>
<td>CSV archive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Excel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Excel 2007</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Web Intelligence</td>
</tr>
</tbody>
</table>

Refer to the appropriate topics in this document for instructions on how to save the different formats in the interface you are using.

**Related Information**

- [Saving data in a document in a CSV archive zip file] (page 445)

  In Web Intelligence Rich Client and the Web Intelligence Applet interface, you can save document data to the CSV archive format which generates an archive file (.zip) that contains one CSV file per report.

- To save a document in the corporate repository in the Web Intelligence Applet interface [page 441]
You can save a document to the corporate repository using the Web Intelligence Applet interface.

To save a document in the corporate repository in the Web Intelligence HTML interface [page 441]
You can save a document to the corporate repository using the Web Intelligence HTML interface.

To save a document as an Excel spreadsheet in the Web Intelligence Applet interface [page 435]
You can use the Web Intelligence Applet interface to save a document as an Excel spreadsheet.

To set preferences for saving documents as Excel [page 433]
You can configure Web Intelligence so that documents are saved to Excel in the BI launch pad preferences.

To export a document or report as an Excel spreadsheet in the Web Intelligence HTML interface [page 436]
You can use the Web Intelligence HTML interface to save a document as an Excel spreadsheet.

To save a document as a PDF file in the Web Intelligence Applet interface [page 438]
You can use the Web Intelligence Applet interface to save a document as a PDF file.

To export a document or report as a PDF file in the Web Intelligence HTML interface [page 439]
You can use the Web Intelligence HTML interface to save the current document or the current active report as a PDF file.

To save a document as a text file in the Web Intelligence Applet interface [page 442]
You can use the Web Intelligence Applet interface to save a document as a text file.

To export a document or report as a text file in the Web Intelligence HTML interface [page 443]
You can use the Web Intelligence HTML interface to save the current document or the current active report.

To export or save document data in a CSV file in the Web Intelligence Applet or Rich Client interface [page 444]
You can use the Web Intelligence Applet interface or Web Intelligence Rich Client to export and save document data in a CSV file.

To export document data as a CSV file in the Web Intelligence HTML interface [page 444]
In the Web Intelligence HTML interface, you can export raw data from the cube to a CSV file, as well as the data from the report, whereas a CSV Archive file is a ZIP file containing only the data in the document.

To save a document in the corporate repository in Web Intelligence Rich Client [page 440]
You can save a document in the corporate repository using the Web Intelligence Rich Client.

To save a document as an Excel spreadsheet in Web Intelligence Rich Client [page 434]
You can use the Web Intelligence Rich Client to save a document as an Excel spreadsheet.

To save a document as a PDF file in Web Intelligence Rich Client [page 437]
You can use the Web Intelligence Rich Client to save a document as a PDF file.

7.1 To set preferences for saving documents as Excel

You can configure Web Intelligence so that documents are saved to Excel in the BI launch pad preferences.

1. In the BI launch pad, in the Header panel, click Preferences.
2. Click Web Intelligence.
3. Under Select a priority for saving to MS Excel, select the option that best fits your needs:
   a) Choose Prioritize the formatting of the documents to display the data in a format that is similar to working in Web Intelligence.
   b) Choose Prioritize easy data processing in Excel to display the data in a text format.
4. Click **Save and Close**.

7.2 To save a document as an Excel spreadsheet in Web Intelligence Rich Client

You can use the Web Intelligence Rich Client to save a document as a Excel spreadsheet.

To export images with your document, make sure the following changes in the Windows registry, or in the boconfig.cfg file for UNIX, have been made:

- « ResolveHTTPUrl » => value data « yes »
- Ensure the following key has been added: « PROXY » => value data « <customer-proxy>:<portnumber> »

**Note**

When you export a table or chart to Excel 2003 format, this format only uses 56 colors, so Web Intelligence generates only 56 colors. This can have an effect on the final color/shading of the exported document. You can export as a GIF image to Excel 2003 format, and the colors are correctly exported. There is no color/shading restriction when exporting to Excel 2007 format.

1. Launch Web Intelligence Rich Client.
2. Open a document and do one of the following:
   - If you are in **Reading** mode, from the **Save Menu** icon dropdown list, select **Save As**.
   - If you are in **Design or Data** mode, in the **File** tab, select **Save As** from the **Save Menu** icon dropdown list.
3. In the **Save Document** dialog box, select **My Computer**, **My Desktop**, or **My Documents** in the dialog box and navigate to the folder where you want to save the document.
4. From the **Files of Type** dropdown list, select **Excel** or **Excel 2007**.
   - Each Excel 2007 worksheet can contain up to 1 million rows of exported data. If you save to Excel rather than Excel 2007, each 65,000 rows of exported data start in a new worksheet.
5. Select the reports you want to save as Excel or select **Select All** to save all reports.
   - If you chose to save the entire document to Excel, each report within the document is saved as separate worksheet within the Excel file.
6. To match the layout and formatting of the document as closely as possible in the Excel file, select **Prioritize the formatting of the documents**.
7. To avoid merging multiple cells into Excel cells as much as possible to exploit the data processing features of Excel, select **Prioritize easy data processing in Excel**.
8. Click **Save**.

**Note**

All charts are automatically converted to images in the Excel worksheets.

To set formatting preferences when saving as Excel, see the related links below.
7.3 To save a document as an Excel spreadsheet in the Web Intelligence Applet interface

You can use the Web Intelligence Applet interface to save a document as an Excel spreadsheet.

To export images with your document, make sure the following changes in the Windows registry, or in the `boconfig.cfg` file for UNIX, have been made:

- `« ResolveHTTPUrl » => value data « yes »`
- Ensure the following key has been added: `« PROXY » => value data « <customer-proxy>:<portnumber> »`

To set formatting preferences when saving as Excel, see the related links below.

**Note**

When you export a table or chart to Excel 2003 format, this format only uses 56 colors, so Web Intelligence generates only 56 colors. This can have an effect on the final color/shading of the exported document. You can export as a GIF image to Excel 2003 format, and the colors are correctly exported. There is no color/shading restriction when exporting to Excel 2007 format.

**Caution**

The table cell formatting Read content as HTML is not supported when exporting a document or report as PDF. Any table cells with this setting will appear blank in the generated PDF. To obtain the content in PDF, you need to unselect this property. To do this, right-click in the table cell, select Format Cell, and in the Display section of the General tab, change the Read contents as to some other value than HTML. The setting is applied to the entire column.

To save a document as an Excel spreadsheet:

1. Open a Web Intelligence document.
2. Do one of the following:
   - If you are in Reading mode, select Save As from the Save icon dropdown list.
   - If you are in Design or Data mode, click the arrow next to Save on the toolbar in the File tab toolbar and select Save As.
3. Select My Computer, My Desktop, or My Documents in the dialog box and navigate to the folder where you want to save the document.
4. From the Select reports list, select Excel or Excel 2007 from the Files of Type list.
   - Each Excel 2007 worksheet can contain up to 1 million rows of exported data. If you save to Excel rather than Excel 2007, each 65,000 rows of exported data starts on a new worksheet.
5. Select the reports you want to save as Excel or select **Select All** to save all reports.

If you save the entire document to Excel, each report within the document is saved as separate worksheet within the Excel file.

6. To have the layout and formatting of the document matched as closely as possible in the Excel file, select **Prioritize the formatting of the documents**.

   Tip
   This option does not exploit the data processing features of Excel to the same extent.

7. To avoid merging multiple cells into Excel cells as much as possible to exploit the data processing features of Excel, select **Prioritize easy data processing in Excel**.

8. Click **Save**.

   In Web Intelligence, all charts are automatically converted to images in Excel.

### Related Information

To set preferences for saving documents as Excel [page 433]

You can configure Web Intelligence so that documents are saved to Excel in the BI launch pad preferences.

### 7.4 To export a document or report as an Excel spreadsheet in the Web Intelligence HTML interface

You can use the Web Intelligence HTML interface to save a document as a Excel spreadsheet.

To export images with your document, make sure the following changes in the Windows registry (or in the `boconfig.cfg` file for UNIX) have been made:

- `{ResolveHTTPUrl} => value data « yes »`
- Ensure the following key has been added: `{ PROXY } => value data « <customer-proxy>:<portnumber> »`

You cannot use the **Save As** feature to save the document or report as an Excel file in the Web Intelligence HTML interface, however you can export them in Excel format to your computer or another location.

**i Note**
You can set formatting preferences when saving as Excel. This is done separately; see the related links below.

**i Note**
When you export a table or chart to Excel 2003 format, this format only uses 56 colors, so Web Intelligence generates only 56 colors. This can have an effect on the final color/shading of the exported document. You can export as a GIF image to Excel 2003 format, and the colors are correctly exported. There is no color/shading restriction when exporting to Excel 2007 format.
1. Open a Web Intelligence document.

2. Do one of the following:
   - If you are in Reading mode, click the arrow next to the Export icon on the toolbar.
   - If you are in Design mode, click the arrow next to Export on the toolbar in the File tab toolbar.

3. Select one of the following:
   - Export Document As Excel
   - Export Current Report As Excel
   - Export Document As Excel 2007
   - Export Current Report As Excel 2007

4. Click Save in the File Download dialog box that appears and navigate to the folder where you want to save the file.
   All charts are automatically converted to images in Excel. You can use the exported data to create your own chart using the functionality of Excel.

5. Close the file download box.

7.5 To save a document as a PDF file in Web Intelligence Rich Client

You can use the Web Intelligence Rich Client to save a document as a PDF file.

1. Launch Web Intelligence Rich Client.
Caution

The table cell formatting Read content as Hyperlinks is not supported when exporting a document or report as PDF. Any table cells with this setting will appear blank in the generated PDF. To obtain the content in PDF, you need to unselect this property. To do this:

1. Right-click in the table cell.
2. Select Format Cell.
3. In the General tab, change the Read contents as to some other value than HTML.

The setting is applied to the entire column.

2. Open a document and do one of the following:
   - If you are in Reading mode, from the Save Menu icon dropdown list, select Save As.
   - If you are in Design or Data mode, in the File tab, select Save As from the Save Menu icon dropdown list.

3. Select My Computer, My Desktop, or My Documents in the dialog box and navigate to the folder where you want to save the document.

4. From the Files of Type dropdown list, select PDF.

Tip

When a report contains charts and images, you can optimize the size of the exported document by choosing the 96 dpi size. This can be useful for online publishing.

5. Do one of the following:
   - To select specific reports to save, select Select reports, then select the reports from the list.
   - To save the current report and select the pages you want to save, select Current report.

6. Click Save.

7.6 To save a document as a PDF file in the Web Intelligence Applet interface

You can use the Web Intelligence Applet interface to save a document as a PDF file.

Caution

The table cell formatting Read content as HTML is not supported when exporting a document or report as PDF. Any table cells with this setting will appear blank in the generated PDF. To obtain the content in PDF, you need to unselect this property. To do this, right-click in the table cell, select Format Cell, and in the Display section of the General tab, change the Read contents as to some other value than HTML. The setting is applied to the entire column.

1. Open a Web Intelligence document.
2. Do one of the following:
   - If you are in Reading mode, select Save As from the Save icon dropdown list.
3. Select My Computer, My Desktop, or My Documents in the dialog box and navigate to the folder where you want to save the document.

4. In the Files of Type field, select PDF.

5. Do one of the following:
   - To select specific reports to save, select Select reports, then select the reports from the list.
   - To save the current report and select the pages you want to save, select Current report.

6. Click Save.

7.7 To export a document or report as a PDF file in the Web Intelligence HTML interface

You can use the Web Intelligence HTML interface to save the current document or the current active report as a PDF file.

You cannot use the Save As feature to save the document or report as a PDF file in the Web Intelligence HTML interface, however you can export them in PDF format to your computer or another location.

Note
The table cell formatting Read content as HTML is not supported when exporting a document or report as PDF. Any table cells with this setting will appear blank in the generated PDF. To obtain the content in PDF, you need to unselect this property. To do this, right-click in the table cell, select Format Cell, and in the Display section of the General tab, change the Read contents as to some other value than HTML. The setting is applied to the entire column.

1. Open a Web Intelligence document.

2. Do one of the following:
   - If you are in Reading mode, click the arrow next to the Export icon on the toolbar.
   - If you are in Design mode, click the arrow next to Export on the toolbar in the File tab toolbar.

3. Select one of the following:
   - Export Document As PDF
   - Export Current Report As PDF

4. Click Save in the File Download dialog box and navigate to the folder where you want to save the file.
7.8 To save a document in the corporate repository in Web Intelligence Rich Client

You can save a document in the corporate repository using the Web Intelligence Rich Client.

1. Launch Web Intelligence Rich Client.
2. Open a Web Intelligence document in any mode.
3. Do one of the following:
   ○ If you are in Reading mode, from the Save Menu icon dropdown list, select Save to Enterprise.
   ○ If you are in Design or Data mode, in the File tab, select Save to Enterprise from the Save Menu icon dropdown list.
4. Select the corporate repository in the dialog box.
5. To save to an available corporate repository, select My Enterprise in the dialog box, and log in to the repository.
6. Click Folders or Categories to display the repository by folders or categories.
7. In the File Name text box, type the name of the document.
8. To display additional document options, click Advanced.
   The additional options are always displayed.
9. Type a description of the document in the Description text box.
10. Type keywords that you or other users can use to search for the document in the Keywords text box.
11. To refresh the document each time it is opened, select Refresh on open.

   ! Note
   The Refresh on open option is dependent on the following CMS settings:
   ○ In CMC ➔ Application ➔ Webi ➔ Properties ➔ the property Check automatic refresh on open security setting is enabled.
   ○ In CMC ➔ Application ➔ user security ➔ the security right Disable automatic refresh on open is disabled for this user.

12. To preserve the document regional formatting with the document, select Permanent regional formatting.
13. In Web Intelligence Rich Client:
   ○ To remove all document security and make the document accessible in Standalone mode, select Remove document security.
   ○ To ensure the document is not locked by the current user, select Save for all users.
14. Click Save.
7.9  To save a document in the corporate repository in the Web Intelligence Applet interface

You can save a document to the corporate repository using the Web Intelligence Applet interface.

1. Open a Web Intelligence document.
2. Do one of the following:
   ○ If you are in Reading mode, select Save As from the Save icon dropdown list.
   ○ If you are in Design or Data mode, click the arrow next to Save on the toolbar in the File tab toolbar and select Save As.
3. Select the corporate repository in the dialog box.
4. Click Folders or Categories to display the repository by folders or categories.
5. In the Name box, type the name of the document.
6. Click Advanced to display additional document options.
7. Type a description of the document in the Description box.
8. Type keywords that you or other users can use to search for the document in the Keywords box.
9. Select Refresh on open to refresh the document each time it is opened.

   **Note**
   When a document is set to refresh its data on opening (when the Refresh on open document property is selected in the document properties), the document displays the latest information. The Refresh on open option is dependent on the following CMS settings:
   ○ In CMC ➔ Application ➔ Web Intelligence ➔ Properties ➔ the property Automatic Refresh security setting is enabled by the BI administrator.
   ○ In CMC ➔ Application ➔ Web Intelligence ➔ User security ➔ the security right Document - disable automatic refresh on open is disabled for this user by the BI administrator.

10. Select Permanent regional formatting to preserve the document regional formatting with the document.
11. Click Save.

   The document is saved in the corporate repository.

7.10  To save a document in the corporate repository in the Web Intelligence HTML interface

You can save a document to the corporate repository using the Web Intelligence HTML interface.

1. Open a Web Intelligence document.
2. Do one of the following:
   ○ If you are in Reading mode, select Save As from the Save icon dropdown list.
   ○ If you are in Design or Data mode, click the arrow next to Save on the toolbar in the File tab toolbar and select Save As.
3. Select the folder in which you want to save the document.
4. In the Filename box, type the name of the document.
5. Click the expand toggle button to display additional document options.
6. Type a description of the document in the Description box.
7. Type keywords that you or other users can use to search for the document in the Keywords box.
8. Select the categories you want to associate with the document in the Assign Category box.
9. Select Refresh on open to refresh the document each time it is opened.
10. Select Permanent regional formatting to preserve the document regional formatting with the document.
11. Click Save.
   The document is saved in the corporate repository.

### 7.11 To save a document as a text file in the Web Intelligence Applet interface

You can use the Web Intelligence Applet interface to save a document as a text file.

1. Open a Web Intelligence document.
2. Do one of the following:
   ○ If you are in Reading mode, select Save As from the Save icon dropdown list.
   ○ If you are in Design or Data mode, click the arrow next to Save on the toolbar in the File tab toolbar and select Save As.
3. Select My Computer, My Desktop, or My Documents in the dialog box and navigate to the folder where you want to save the document.
4. In the Files of Type field, select TXT File.
5. Select the reports to save from the Select reports list or select Select All to export all reports.

The export of the report elements depends on the Preferred Viewing Locale you have selected in the BI launch pad preferences. Some locales, like the English locale, use the left-to-right (LTR) interface positioning, whereas others, like the Arabic locale, use the right-to-left (RTL) interface positioning.

In an LTR locale, report elements are exported in the following order:
1. Report element position, starting from the upper left corner
2. Left to right, then top to bottom.

In an RTL locale, report elements are exported in the following order:
1. Report element position, starting from the upper right corner
2. Right to left, then top to bottom.

**Note**
- In page mode, report elements are exported page by page.
- The exported file in page mode can be different from the result in draft mode.
- The separator used is a tab space.
- Charts and images are not exported.
○ Export size limit for text file is defined in the CMC. The default value is 5 MB. An error message appears if the size limit is exceeded.
○ If several reports are selected, they are appended one after another in the same text file.

6. Click Save.

Related Information

Interface and document locales [page 38]
Locales determine the appearance of the application interface (for example, menu items and button text) and data (for example, date and number formatting) in relation to local preferences.

7.12 To export a document or report as a text file in the Web Intelligence HTML interface

You can use the Web Intelligence HTML interface to save the current document or the current active report.

You cannot use the Save As feature to save the document or report as a text file in the Web Intelligence HTML interface, however you can export them in text format to your computer or another location.

1. Open a Web Intelligence document.
2. Do one of the following:
   ○ If you are in Reading mode, click the arrow next to the Export icon on the toolbar.
   ○ If you are in Design mode, click the arrow next to Export on the toolbar in the File tab toolbar.
3. Select one of the following:
   ○ Export Document As Text
   ○ Export Current Report As Text

The export of the report elements depends on the Preferred Viewing Locale you have selected in the BI launch pad preferences. Some locales, like the English locale, use the left-to-right (LTR) interface positioning, whereas others, like the Arabic locale, use the right-to-left (RTL) interface positioning.

In an LTR locale, report elements are exported in the following order:
1. Report element position, starting from the upper left corner
2. Left to right, then top to bottom.

In an RTL locale, report elements are exported in the following order:
1. Report element position, starting from the upper right corner
2. Right to left, then top to bottom.

Note
○ In page mode, report elements are exported page by page.
The exported file in page mode can be different from the result in draft mode.
- The separator used is a tab space.
- Charts and images are not exported.
- Export size limit for text file is defined in the CMC. The default value is 5 MB. An error message appears if the size limit is exceeded.
- If several reports are selected, they are appended one after another in the same text file.

4. Click Save in the File Download dialog box and navigate to the folder where you want to save the file.
5. Close the file download box.

7.13 To export document data as a CSV file in the Web Intelligence HTML interface

In the Web Intelligence HTML interface, you can export raw data from the cube to a CSV file, as well as the data from the report, whereas a CSV Archive file is a ZIP file containing only the data in the document.

1. Open a Web Intelligence document.
2. Do one of the following:
   - If you are in Reading mode, click the arrow next to the Export icon on the toolbar.
   - If you are in Design mode, click the arrow next to Export on the toolbar in the File tab toolbar.
3. Do one of the following:
   - To export the raw data in the cube, select Export data to CSV.
   - To export only the data in the document, select Export Document As CSV Archive.
   - To export only the data in the current report, select Export Current Report As CSV Archive.
4. Choose the text qualifier, column delimiter and character set in the dialog box.
5. If you want the options you chose in the previous step to be the default options when you save to CSV, select Set as default values.
6. Click OK, then click Save in the File Download dialog box and navigate to the folder where you want to save the file.

7.14 To export or save document data in a CSV file in the Web Intelligence Applet or Rich Client interface

You can use the Web Intelligence Applet interface or Web Intelligence Rich Client to export and save document data in a CSV file.

To see the data that will be exported, click the Data tab in a Web Intelligence document. You’ll see then if your document still contains any columns that you have deleted from the report table.

When you exporting a document to a CSV file, all of the database content is saved in one file. If you save to a CSV archive file, only the data in the current document is saved into a ZIP file, with each report in a separate CSV file.
1. Open a Web Intelligence document in Design or Data mode.
2. If you are in Data mode, select the query whose data you want to save as a CSV or CSV archive file.
3. Do one of the following:
   - To export all of the database content as a single CSV file, in the Data Access tab, select the Tools subtab and then click Export Data.
   - To save the current document data as a ZIP file, in the menu above the Side Panel, select Save as from the Save dropdown list. Select the CSV archive format.
4. Enter a file name.
5. Choose the text qualifier, column delimiter and character set.

   ➤ Tip
   To make the options you chose the default options when saving to CSV, select Set as default values.

6. If you are creating a CSV archive file, select the reports you want exported.
7. Click Save.

   ➤ Note
   Saving to CSV saves the raw data from the cube, not just the data from the edited tables in your report. To see the data that will be exported, click on the Data tab. You’ll see then that your document still contains any columns that you have deleted from the report table.

### 7.15 Saving data in a document in a CSV archive zip file

In Web Intelligence Rich Client and the Web Intelligence Applet interface, you can save document data to the CSV archive format which generates an archive file (.zip) that contains one CSV file per report.

Each CSV file contains the report data without any headers, footers or charts.

You can configure the following objects:

- Text qualifier
- Column Delimiter
- Charset

You can also have all or only some of the reports saved in the CSV archive file.

#### Example

**Contents of a <Document_Name>.zip archive file**

<Report1_name>.csv
<Report2_name>.csv
<ReportN_name>.csv
7.16 Autosaved documents

If autosave has been activated by the BI administrator in the CMC and if you have the appropriate security rights, then your documents are saved automatically in the My Favorites/ folder as you work.

Autosaved document names consist of the document name prefixed by the document ID and followed by the autosaved document ID. If the document ID is -1, the document was not saved before being autosaved.

**Note**

Web Intelligence Rich Client does not save documents automatically.

The interval at which documents are autosaved is also defined in the CMC. This interval is reset each time you save a document manually, and each time a document is saved automatically. The autosaved document is also deleted when you save a document manually.

In addition to regular autosaving, documents are saved when your session times out.

**Note**

If you lose a document before you can save it, check the folder immediately to see if there is an autosaved version. The My Favorites/ folder retains autosaved documents until you end the BI launch pad session.

More information on the settings and security rights that impact automatic saving, refer to the Business Intelligence Platform Administrator Guide.

**Related Information**

- Management of autosaved documents [page 447]
  - Documents are autosaved in the My Favorites/ folder.
- Recovering autosaved documents [page 446]
  - Check the My Favorites/ folder immediately after restoring the connection for your autosaved document.

### 7.16.1 Recovering autosaved documents

Check the My Favorites/ folder immediately after restoring the connection for your autosaved document.

If your session times out while you are working on a document, your document is saved in the My Favorites/ folder and displays a dialog box explaining that the session has ended.

In this dialog box:

- Select **Restore** to launch a new session and reopen the autosaved document. The next time you save the document manually, it is saved in its original folder.
- Select **Close** to be redirected to the home page of the BI launch pad. The autosaved document is available in the My Favorites/ folder.
It is not always possible to link to the autosaved document after a server timeout or connection loss. When this happens, you do not have the option to restore the autosaved document. Documents are regularly deleted from this folder based on the autosave settings.

Related Information

**Autosaved documents** [page 446]

If autosave has been activated by the BI administrator in the CMC and if you have the appropriate security rights, then your documents are saved automatically in the My Favorites/ folder as you work.

**Management of autosaved documents** [page 447]

Documents are autosaved in the My Favorites/ folder.

### 7.16.2 Management of autosaved documents

Documents are autosaved in the My Favorites/ folder.

As a general rule, autosaving is transparent and you do not access autosaved documents directly.

**Note**

The My Favorites/ folder has a maximum size limit, which is set in the CMC. When the total size of the documents in the folder exceeds this limit, the application deletes as many of the oldest documents in the folder as necessary to make way for the latest document.

If you navigate away from a document in the browser without saving the document, the document is lost and the contents of the My Favorites/ folder are cleared.

Related Information

**Autosaved documents** [page 446]

If autosave has been activated by the BI administrator in the CMC and if you have the appropriate security rights, then your documents are saved automatically in the My Favorites/ folder as you work.

**Recovering autosaved documents** [page 446]

Check the My Favorites/ folder immediately after restoring the connection for your autosaved document.
Interacting with Web Intelligence documents in Reading mode

Web Intelligence shows complex and varied data in reports that you can understand quickly and easily.

Web Intelligence documents, based on queries created in one of several available applications, for example BEx or OLAP, are designed in Design mode to be viewed in Reading mode by any number of general or specific groups or individuals. This section explains or directs you to information on the functions you can perform while in the Reading mode.

Depending on the user security and access rights set for you by the BI administrator, when you open a Web Intelligence document in Reading mode, there are several actions you can perform on reports in the document.

Actions you can perform in a Web Intelligence document include:

- Create, open, save, print, refresh, export, send documents.
- Search for a document in the Corporate or Personal documents or on your computer.
- View the history of a scheduled document or the document outline.
- Track changes in a document.
- Refine the data displayed through filters and drilling.

**Note**

If you plan to open Web Intelligence Rich Client from your computer to view documents, you need to complete certain processes. For more information, consult the Setting up and using Web Intelligence Rich Client section in the SAP BusinessObjects Web Intelligence Rich Client Users Guide.

Related Information

**Features available in Web Intelligence Reading mode** [page 449]

When you view Web Intelligence documents in the Reading mode, there are several buttons, icons and other features that you can use, depending on the user security and access rights set for you by the BI administrator.

**To start Web Intelligence in the BI launch pad** [page 22]

You can launch Web Intelligence in more than one way.

**About Web Intelligence** [page 12]

Get instant answers to your business questions and take action on the fly – with fast, decision-ready insights from any data source.

**Side Panel tabs in Web Intelligence** [page 20]

The tabs available in the Side Panel depend on the Web Intelligence interface you are using and the mode in which you are viewing the document.

**About setting Web Intelligence preferences** [page 24]

You can set options to determine how you view and explore existing documents and how you create documents or edit and analyze existing documents.

**Saving and exporting documents in Reading mode** [page 451]
You use Web Intelligence to save and export the current document or active report in one or more locations or formats.

**Viewing modes** [page 188]

In the **Reading** and **Design** document modes, you can view reports in different modes depending on how you want to work with data and how you want the data to appear.

**Tracking changes in data** [page 196]

To make informed and effective business intelligence decisions, you need to understand how the data on which you base those decisions changes over time.

### 8.1 Features available in Web Intelligence Reading mode

When you view Web Intelligence documents in the **Reading** mode, there are several buttons, icons and other features that you can use, depending on the user security and access rights set for you by the BI administrator.

Table 30: Reading mode features

<table>
<thead>
<tr>
<th>Task</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create documents</td>
<td>![Folder]</td>
<td>Click to create a document based on a universe or that does not require access to a data source.</td>
</tr>
<tr>
<td>Open documents</td>
<td>![Folder]</td>
<td>Click to open documents in the personal folder or from corporate folders to which access has been granted by the BI administrator.</td>
</tr>
<tr>
<td>Save documents</td>
<td>![Folder]</td>
<td>Click to save a document to the personal folder or to a corporate folder to which access has been granted by the BI administrator.</td>
</tr>
<tr>
<td>Print documents</td>
<td>![Print]</td>
<td>Click to print a document.</td>
</tr>
<tr>
<td>Search for a document</td>
<td>![Search]</td>
<td>Click to search for a document in the personal folder or in corporate folders to which access has been granted by the BI administrator.</td>
</tr>
<tr>
<td>View the document history</td>
<td>![View]</td>
<td>Click to view the history of the document.</td>
</tr>
<tr>
<td>Export documents or one of its reports</td>
<td>![Export]</td>
<td>Click to export a document or one of its reports in a variety of formats.</td>
</tr>
<tr>
<td>Send a document</td>
<td>![Send]</td>
<td>Click to send a document or one of its reports in a variety of formats.</td>
</tr>
<tr>
<td>Undo or redo an action</td>
<td>![Undo/Redo]</td>
<td>Click to control an action performed on a report in a document.</td>
</tr>
<tr>
<td>Task</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Refresh a document</td>
<td><img src="image" alt="Refresh" /></td>
<td>Click to refresh a document so that the latest data appears.</td>
</tr>
<tr>
<td>Access help</td>
<td><img src="image" alt="Help" /></td>
<td>Click to access the user help for Web Intelligence.</td>
</tr>
<tr>
<td>Track changes in a document</td>
<td><img src="image" alt="Track" /></td>
<td>Click to activate the change tracking for a document.</td>
</tr>
<tr>
<td>Drill on data</td>
<td><img src="image" alt="Drill" /></td>
<td>Click to activate drilling in the document on any objects with more than one level.</td>
</tr>
<tr>
<td>Filter document data</td>
<td><img src="image" alt="Filter" /></td>
<td>Click to create a simple filter that limits the data shown.</td>
</tr>
<tr>
<td>Freeze table headers, rows and columns</td>
<td><img src="image" alt="Freeze" /></td>
<td>Choose to freeze headers, rows and columns in tables so that they remain displayed you are scrolling through a table.</td>
</tr>
<tr>
<td>Show document outline</td>
<td><img src="image" alt="Outline" /></td>
<td>Click to show the outline of a document and its reports, if one exists.</td>
</tr>
<tr>
<td>Toggle between pages</td>
<td><img src="image" alt="Page" /></td>
<td>You can move forward or backwards one page, enter a specific page number, or toggle to the beginning or end of a report in a document.</td>
</tr>
<tr>
<td>Toggle between page displays</td>
<td><img src="image" alt="Page" /></td>
<td>You can toggle easily and quickly between Quick Display and Page mode.</td>
</tr>
<tr>
<td>Zoom in a report</td>
<td><img src="image" alt="Zoom" /></td>
<td>You can zoom in and out on a displayed report.</td>
</tr>
</tbody>
</table>

### Related Information

**Choosing the viewing and design interfaces** [page 25]

You can set options to determine how you view and explore existing documents and how you create documents or edit and analyze existing documents.
8.2 Saving and exporting documents in Reading mode

You use Web Intelligence to save and export the current document or active report in one or more locations or formats.

Note

You cannot use the Save As feature to save the document or report as a text, Excel or PDF file in the Web Intelligence HTML interface, however you can export documents or reports in those formats to your computer or another location.

Related Information

To save a document in the corporate repository in the Web Intelligence Applet interface [page 441]
You can save a document to the corporate repository using the Web Intelligence Applet interface.

To save a document in the corporate repository in the Web Intelligence HTML interface [page 441]
You can save a document to the corporate repository using the Web Intelligence HTML interface.

To save a document in the corporate repository in Web Intelligence Rich Client [page 440]
You can save a document in the corporate repository using the Web Intelligence Rich Client.

To save a document as an Excel spreadsheet in the Web Intelligence Applet interface [page 435]
You can use the Web Intelligence Applet interface to save a document as a Excel spreadsheet.

To save a document as an Excel spreadsheet in Web Intelligence Rich Client [page 434]
You can use the Web Intelligence Rich Client to save a document as a Excel spreadsheet.

To save a document as a PDF file in the Web Intelligence Applet interface [page 438]
You can use the Web Intelligence Applet interface to save a document as a PDF file.

To save a document as a PDF file in Web Intelligence Rich Client [page 437]
You can use the Web Intelligence Rich Client to save a document as a PDF file.

To export a document or report as a PDF file in the Web Intelligence HTML interface [page 439]
You can use the Web Intelligence HTML interface to save the current document or the current active report as a PDF file.

To export a document or report as a text file in the Web Intelligence Applet interface [page 442]
You can use the Web Intelligence Applet interface to save a document as a text file.

To export a document or report as a text file in the Web Intelligence HTML interface [page 443]
You can use the Web Intelligence HTML interface to save the current document or the current active report.

To export or save document data in a CSV file in the Web Intelligence Applet or Rich Client interface [page 444]
You can use the Web Intelligence Applet interface or Web Intelligence Rich Client to export and save document data in a CSV file.
8.3 Printing reports

You can print one or multiple reports from a Web Intelligence document.

You print documents directly from Web Intelligence Applet interface and Web Intelligence Rich Client. However, when you print from the Web Intelligence HTML interface, you export the document to a PDF file that you can then print.

**Note**
If a report is wider than the width of the paper size defined in the Report Page Layout, page breaks are inserted. The paper size and page orientation for printing can be different from the paper size and page orientation set for the reports when you view them in Web Intelligence Applet interface or Web Intelligence Rich Client.

8.3.1 To print reports in Web Intelligence

A variety of methods are available for printing reports in Web Intelligence.

1. Open a Web Intelligence document.
2. Do one of the following:
   - If you are in **Reading** mode, click the **Print** icon.
   - If you are in **Design or Data** mode, click the **Print** icon in the **File** tab toolbar.
   - If you are using the Web Intelligence HTML interface, the **File Download** dialog box appears. Open the PDF file and print the report.
   - If you are using the Web Intelligence Applet interface or Web Intelligence Rich Client interface, the **Print** dialog box appears. Choose your printing options and print the report.

8.4 Searching for text in a document

8.4.1 Finding text in a report page

You can search for text in a report in a Web Intelligence document in **Reading** or **Design** mode.

1. Open a Web Intelligence document.
2. Do one of the following:
If you are in Reading mode, click the Find icon on the toolbar.
If you are in Design mode, click the Find icon on the toolbar in the File tab toolbar.
The Find bar appears at the bottom of the report panel.

3. Type text in the Find box and press Enter or click the Find text on the current page icon.

   **Note**
   To perform a case-sensitive search, click the arrow next to the box and select Match case.

4. If the text occurs more than once, click the Next or Previous icon to highlight other occurrences of the text.

   **Note**
   If you are using the Web Intelligence Applet interface or Web Intelligence Rich Client, click Highlight all to highlight all occurrences of the text on the page.

To close the Find box, click the X located at the far end of the Find bar.

### 8.5 Sending documents

#### 8.5.1 To send a document by email

You can send a Web Intelligence document as an email attachment.

1. Open a Web Intelligence document.
2. Depending on the Web Intelligence interface you are using, do the following tasks:
   - In the Web Intelligence HTML interface:
     - In Reading mode, select Send to Mail from the Send to icon dropdown list.
     - In the Design mode, in the File tab, select Send to Mail from the Send to icon dropdown list.
   - In the Web Intelligence Applet interface:
     - In Reading mode, select Send to email from the Send document icon dropdown list.
     - In the Design or Data mode, in the File tab, select Send to email from the Send document icon dropdown list.
   - In Web Intelligence Rich Client:
     - In Reading mode, select a document format from the Send by E-mail attachment icon dropdown list.
     - In the Design or Data mode, in the File tab, select a document format from the Send by E-mail attachment icon dropdown list.
3. Enter the addressees, any email text required, and send the email.
8.5.2 To send a document to another user or group in the CMS

You can send a Web Intelligence document to another user in the CMS from the Web Intelligence HTML or Web Intelligence Applet interface.

1. Open a Web Intelligence document in the Web Intelligence HTML or Web Intelligence Applet interface.

2. Do one of the following:
   - If you are in Reading mode, select Send to User from the Send to icon dropdown list.
   - If you are in Design or Data mode, in the File tab toolbar, select Send to User from the Send to icon dropdown list.

   **i Note**
   This option is not available in the Web Intelligence Rich Client.

3. Select the users or groups to which you want to send the document from the list of users and groups.

4. Click Use Automatically Generated Name to send the document with an automatically-generated name.

5. Click Use Specific Name and type the name in the box to send if you want to name the document.

6. Click Shortcut to send a shortcut to the document or Copy to send a copy of the document.

7. Click Send.

8.5.3 To send a document by FTP

You can send a Web Intelligence document by FTP in the Web Intelligence HTML or Web Intelligence Applet interface.

1. Open a Web Intelligence document in the Web Intelligence HTML or Web Intelligence Applet interface.

   **i Note**
   This option is not available in Web Intelligence Rich Client.

2. Do one of the following:
   - If you are in Reading mode, from the Send to icon dropdown list, select Send to Ftp.
   - If you are in Design or Data mode, in the File tab, select Save to Enterprise from the Save Menu icon dropdown list.

   **i Note**
   You must have the required permissions to send files via FTP. If you do not have the permissions, the Send to FTP dialog box does not appear, or appears with an error message.
3. Type the host name in the Host box.
4. Type the port in the Port box.
5. Type the username and password in the User Name and Password boxes.
6. Type the account in the Account box.
7. Type the directory in the Directory box.
8. Click Use Automatically Generated Name to send the document with an automatically-generated name.
9. Click Use Specific Name and type the name in the box to send if you want to name the document.
10. Click Send.

8.6 Viewing modes

In the Reading and Design document modes, you can view reports in different modes depending on how you want to work with data and how you want the data to appear.

The viewing modes are controlled by buttons at the bottom of the Web Intelligence screen, on the status bar.

8.6.1 Page view mode

In the Reading and Design document modes, the Page view mode displays the page layout of reports, including page margins, headers, and footers.

Use Page view mode when you want to fine-tune the formatting of tables and charts and the layout of report pages.

8.6.2 Quick Display view mode

In the Reading and Design document modes, the Quick Display view mode is the default display mode.

It is a pagination mode that is based on the data, rather than the physical size of report pages. The Quick Display view mode displays just the tables, reports, and free standing cells in reports and displays a maximum number of records vertically and horizontally, depending on the Quick Display settings. The Quick Display view mode also specifies the minimum page width and height and the amount of padding around the edges of the report.

Because the Quick Display view mode restricts the number of horizontal and vertical rows, a report might not contain all possible data.

Use the Quick Display view mode when you want to focus on analyzing results, add calculations or formulas, or add breaks or sorts to tables to organize results.

The Quick Display view mode properties are configurable either by the BI administrator, or directly in the application.
<table>
<thead>
<tr>
<th>Property</th>
<th>Configuration</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum vertical records</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Maximum horizontal records</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Minimum page width</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Minimum page height</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Right padding</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Bottom padding</td>
<td>BI administrator</td>
<td></td>
</tr>
<tr>
<td>Vertical records per page</td>
<td>Application</td>
<td>• Impacts horizontal tables and crosstabs only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Horizontal tables are never cut vertically</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The number of rows in a horizontal table is ignored in vertical records calculation</td>
</tr>
<tr>
<td>Horizontal records per page</td>
<td>Application</td>
<td>• Impacts vertical tables, forms and crosstabs only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The number of rows in a vertical table is ignored in horizontal records calculation</td>
</tr>
</tbody>
</table>

Other notes:

- Table headers and footers do not count as rows.
- Free standing cells and charts do not count as rows.
- Section cells do not count as rows when the section is not empty.
- Sections cells count as vertical rows when the section is empty.
- The **Avoid Page Break in Block** option has no effect in **Quick Display** view mode.

### 8.6.3 To switch between viewing modes

You can switch between **Quick Display** and **Page** view modes.

1. Open a Web Intelligence document, in the **Reading or Design** document mode.
2. In the status bar at the bottom of the document, select one of the following icons:
   - To display a report in **Quick Display** view mode, click the **Quick Display** icon.
   - To display a report in **Page** view mode, click the **Page** icon.
8.7 Tracking changes in data

To make informed and effective business intelligence decisions, you need to understand how the data on which you base those decisions changes over time.

You can track and display data changes to help you focus your analysis on key areas and avoid wasting time exploring irrelevant data.

When you track data changes, you select a particular data refresh as a reference point. This data is known as the reference data. When you activate data tracking, you see your data in relation to the reference data.

Here are some examples of data tracking:

- If an outlet no longer appears in a list of the top outlets by sales, it would be interpreted as deleted from the list. You can use this information to investigate why the outlet is no longer a top performer.
- If sales have decreased in a region, data tracking displays the decrease. You can then drill down into the data for the region to understand why revenue is falling.

In both these cases, data tracking makes the current data more meaningful by placing it in context with older data. Without this context it is much more difficult to identify trends.

**Note**

Tracking data changes operates at document level and not report level. If a document contains several reports, the tracking will apply to all of the reports. The information in the Status Bar at the bottom of the report indicates the document level status. An asterisk on a report tab indicates that change tracking is activated on the report.

**Note**

Status “changes” of tracking data changes is only for a detail value when displayed with its associated dimension in the table. When the detail is given without it is associated dimension it is considered as a dimension and does not show the status changes (but only shows when the detail is inserted/deleted).

**Related Information**

- **Types of data change** [page 197]
  
  You configure the display of data changes through the interface or formula language.

- **Automatic update tracking mode** [page 198]
  
  In the *Auto-update* data tracking mode, you always compare the current data with the data before the last refresh.

- **Absolute reference data tracking mode** [page 198]
  
  In the *Fixed data* tracking mode, you manually select the reference data in the *Data Tracking* dialog box.

- **To activate data tracking** [page 198]
  
  You can activate data tracking in the *Data Tracking* dialog box.

- **To display changed data** [page 199]
  
  You can choose whether to display changed data when data tracking is activated.
Configuring the appearance of changed data [page 199]
You can configure the appearance (font style, size and color) of changed data in your document.

To configure the appearance of changed data [page 200]
You can configure the appearance of changed data in the Data Tracking dialog box.

How changed data is displayed in blocks [page 200]
This example uses a document with a block showing [Country], [Year] and [Revenue].

How changed data is displayed in blocks with breaks [page 204]
When a block contains a break and the Merge block property is set, the display of the centered value follows rules similar to those for section headers.

How changed data is displayed in sections [page 202]
In this example you have a document with a block showing [Country], [Year] and [Revenue].

How changed data is displayed in reports with merged dimensions [page 201]
A dimension appears as changed only if all the dimensions that participate in the merge are changed.

How changed data is displayed in charts [page 204]
When the data in a chart has changed, a changed data icon appears above the chart.

8.8 Drilling on report data in Reading mode

Drilling on reports lets you look deeper into your data to discover the details behind a good or bad summary result displayed in tables, charts, or sections.

Example

Why did sales of accessories, outerwear, and overcoats rise in Q3?
You work for a US national fashion retail chain, and are in charge of sales of accessories, outerwear and overcoat clothing lines in western states. You see that revenue is much higher for Q3 than the other quarters. To understand why, you drill down to look at the factors behind the result and you see that jewelry sales were much higher in July.

8.8.1 Setting drill options

Before you begin a drill session, you can set your drill options to specify how reports will change each time you drill.

How you set the drill options depends on the interface you are using:

- BI launch pad, if you are using the Web Intelligence HTML or Web Intelligence Applet interface or Web Intelligence Rich Client.
- Your computer, if you are using Web Intelligence Rich Client from the BI platform deployment on your computer.
Related Information

To set drill options in the BI launch pad [page 239]
You can configure drill options for Web Intelligence in the BI launch pad preferences.

To set drill options in Web Intelligence Rich Client [page 239]
You can configure drill options in a document.

Synchronize drill on report blocks option [page 240]
When you select the Synchronize drill on report blocks option for Web Intelligence in the BI launch pad preferences, the display of all blocks changes to correspond with your drill actions.

Hide Drill toolbar on startup option [page 240]
When you drill on a value displayed on a report, the Drill toolbar appears and displays the value on which you drilled.

Start drill session on existing report option [page 241]
You can activate the ability to drilling in Web Intelligence documents via the BI launch pad preferences.

Start drill session on a duplicate report option [page 241]
You can activate the ability to drilling in duplicate reports in Web Intelligence documents via the BI launch pad preferences.

8.8.2 Drilling on measures in tables and sections

When you drill on a measure value, you drill one level down for each related dimension in the block, and you see the measure calculated for the displayed dimensions.

Example

Drill on annual sales revenue results to see the breakdown by city and quarter

For example, you drill down on the year 2003 sales revenue value for California, which is displayed on a crosstab that shows sales revenue by year and by state.

The drilled report displays sales revenue by quarter (one level below Year) and by city (one level below State) for California.

8.8.3 Drilling on dimensions in tables and sections

When you drill on a dimension to see the more data behind the displayed result, it is calculated according to the values to which you drill.

Dimensions typically represent character data, such as customer or business names, and dates. Calculations are based around the dimensions in a report. For example, a report calculates a region’s total sales revenue for a given year where a Sales Revenue measure is calculated based on the State and Year dimensions.

If you drill on Year, you display sales revenue by state and quarter, because Quarter is the next dimension in the time hierarchy below Year.
8.8.4 Drilling by other dimensions in a report

When you drill down or up, you move through a hierarchy one dimension at a time. However, you can get another view of the data by slicing it in a different way, and then look at the data in other hierarchies. To do this, you drill by the other dimensions that interest you.

**Note**

You can only use *Drill by* with a dimension that is included in the scope of analysis of the document.

**Example**

**Drilling by the Products hierarchy to slice sales revenue results by product**

You work as regional manager for California in a retail clothing store, and have been sent the following report that shows quarterly sales revenue by state:

<table>
<thead>
<tr>
<th>Quarter</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>California</td>
<td>$519,220</td>
</tr>
<tr>
<td></td>
<td>Colorado</td>
<td>$131,797</td>
</tr>
<tr>
<td></td>
<td>DC</td>
<td>$206,324</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>$137,530</td>
</tr>
<tr>
<td></td>
<td>Illinois</td>
<td>$256,464</td>
</tr>
<tr>
<td></td>
<td>Massachusetts</td>
<td>$92,595</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>$555,983</td>
</tr>
<tr>
<td></td>
<td>Texas</td>
<td>$758,796</td>
</tr>
<tr>
<td></td>
<td><strong>Sum:</strong></td>
<td><strong>$2,660,699</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Average:</strong></td>
<td><strong>$332,587</strong></td>
</tr>
</tbody>
</table>

You are only interested in analyzing the results in the state of California. In addition, you want to analyze the sales revenue broken down by each product line you sell. To drill on California data, you place your pointer on the table cell that says California.

If you drilled down now, however, you would drill to results for each city within California, because [City] is the dimension below [State]. Instead, you select *Drill by* from the drill menu and then you navigate through the dimensions on the Products hierarchy by selecting the sub-menus until you reach the [Lines] dimension.
8.8.5 Drilling on charts

Drilling down, up, or by on a chart, provides you with a graphical explanation for why summary results are particularly high or low.

You can drill on:
- dimensions – by drilling on chart axes or the chart legend
- measures – by drilling on the data bars or markers in the body of the chart

You cannot drill by dimensions on chart axes. However, you can drill by dimensions on chart legends.
8.8.6 To take a snapshot of report drill results

You can create a report in the existing document that contains the results of a drill action.

1. Open a Web Intelligence document in Reading or Design mode.
2. Activate the Drill mode:
   ○ If you are in Reading mode, select Start Drill Mode from the Drill dropdown list.
   ○ If you are in Design mode, go to the Analysis tab, and in the Interact subtab, select Start Drill Mode from the Drill dropdown list.
3. Do one of the following:
   ○ If you are in Reading mode, select Snapshot from the Drill dropdown list.
   ○ If you are in Design mode, go to the Analysis tab, and in the Interact subtab, select Snapshot from the Drill dropdown list.

8.9 Freezing table headers, columns and rows

When you view a Web Intelligence report in Reading mode, you can freeze headers, and rows or columns in tables to keep them displayed as you scroll through data.

You can freeze one or several zones of your table, depending on the type of table. The following table lists zones you can freeze according to the type of table:

<table>
<thead>
<tr>
<th>Type of table</th>
<th>Zones you can freeze</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical table</td>
<td>Header or data columns or both.</td>
</tr>
<tr>
<td>Horizontal table</td>
<td>Header or data rows or both.</td>
</tr>
<tr>
<td>Cross table</td>
<td>Vertical header or horizontal header or both.</td>
</tr>
</tbody>
</table>

You can freeze up to 5 data rows or columns.
Related Information

Unfreezing table headers, columns and rows [page 464]

To know which zones are frozen in a table, click the arrow next to the Freeze icon in the main toolbar.

8.9.1 To freeze table headers

You can freeze table headers in a Web Intelligence document in Reading mode.

1. Open a Web Intelligence document in Reading mode.
2. In the Status Bar of the Report Panel, click the Quick Display mode button.
3. Select a cell in a table.
4. In the main toolbar, do one of the following:
   ○ Click the Freeze icon to freeze headers directly.
   ○ Click the arrow next to the Freeze icon and select Freeze Header Rows in vertical or cross tables, or Freeze Header Columns in horizontal or cross tables.

Headers are frozen.

8.9.2 To freeze top rows in a horizontal table

You can freeze the top rows in a table in a Web Intelligence document in Reading mode.

1. Open a Web Intelligence document in Reading mode.
2. In the Status Bar of the Report Panel, click the Quick Display mode button.
3. Select a cell in a horizontal table.
4. In the main toolbar, click the arrow next to the Freeze icon.
5. Under Freeze Top Rows, select the number of rows you want to freeze.

For example, if you select 2, the two first top rows remain displayed while you scroll down in the table.

8.9.3 To freeze left columns in a vertical table

You can freeze columns in a table in a Web Intelligence document in Reading mode.

1. Open a Web Intelligence document in Reading mode.
2. In the Status Bar of the Report Panel, click the Quick Display mode button.
3. Select a cell in a vertical table.
4. In the main toolbar, click the arrow next to the Freeze icon.
5. Under Freeze Left Columns, select the number of columns you want to freeze.

For example, if you select 2, the two first left columns remain displayed while you scroll sideways in the table.
8.10 Unfreezing table headers, columns and rows

To know which zones are frozen in a table, click the arrow next to the Freeze icon in the main toolbar. If an element is selected, this element is frozen in the table.

Related Information

Freezing table headers, columns and rows [page 462]
When you view a Web Intelligence report in Reading mode, you can freeze headers, and rows or columns in tables to keep them displayed as you scroll through data.

8.10.1 To unfreeze table headers

You can unfreeze table headers in a Web Intelligence document in Reading mode.

1. Open a Web Intelligence document in Reading mode.
2. In the Status Bar of the Report Panel, click the Quick Display Mode button.
3. Select a cell in a table that contains frozen headers.
4. In the main toolbar, click the arrow next to the Freeze icon.
5. Select any of the following:
   ○ Freeze Header Rows
   ○ Freeze Header Columns

Headers are no longer frozen.

8.10.2 To unfreeze table rows and columns in vertical and horizontal tables

You can unfreeze rows and columns in a table in a Web Intelligence document in Reading mode.

1. Open a Web Intelligence document in Reading mode.
2. In the Status Bar of the Report Panel, click the Quick Display mode button.
3. Select a cell in a table that contains frozen rows or columns.
4. In the main toolbar, click the arrow next to the Freeze icon.
5. Select 0.

Rows or columns are no longer frozen.
8.11 Using simple report filters

Simple report filters filter information in an open Web Intelligence report, not in the document or in specific objects in the report.

The Report Filter toolbar provides a quick method for adding simple report filters to reports. You can filter on the following objects in a report:

- Dimension or detail objects
- Hierarchies, characteristics or attributes for OLAP universes or BEx queries (but not at the hierarchy level or on measures)

Simple report filters can only use the Equal to operator and can only filter on a single value. They can use the All values operator.

Related Information

To create simple report filters [page 274]

You can filter a report on the object value you select. For example, if you select "US" from the list of values of the Country object, the report is filtered to exclude all rows where Country does not have the value "US".

8.11.1 To create simple report filters

You can filter a report on the object value you select. For example, if you select "US" from the list of values of the Country object, the report is filtered to exclude all rows where Country does not have the value "US".

1. Open a Web Intelligence document.
2. Do one of the following:
   - In the Reading mode, click Filter Bar.
   - In Design mode, in the Analysis tab, select the Interact subtab and click Filter Bar.

The Report Filter toolbar appears.

i Note

When opening the filter bar, filters are automatically inserted when their report scopes are:
- Single value (Equal to operator)
- With the All Values operator

Those filters are no longer displayed in the Filter box.

i Note

When collapsing the Report Filter toolbar, all "simple filters" are put back as Equal to or All values report filters that filter on the entire report. To avoid creating All values filters, remove the object from the filter bar before you collapse it.
3. Click the **add simple report filter** icon on the toolbar and select the object on which you want to filter from the menu.
   
   You can add multiple objects to the toolbar to create multiple filters.

   **Note**
   
   Depending on the data sources and selected objects, the values or objects available in a filter may depend on the values set in another filter object.

4. Select the value on which you want to filter from the dropdown list of values.

   **Note**
   
   For non-hierarchical objects, the list contains all values contained in the report for this object after applying all other report scope filters. For example if you have an **In List** filter reducing this object values, you will have this list of values for the filter bar **Equal to** filter.

   For hierarchical objects, the list contains the flat list of all member values at any level. This list is in tree view order, not alphabetical order.

   **Tip**
   
   In the Web Intelligence Applet interface, or in Web Intelligence Rich Client, you can drag objects from the tree view to the **Report Filter** toolbar.

To remove a filter:

- In the Web Intelligence HTML interface in **Reading or Design** mode, from the dropdown list for the operator in the **Report Filter** toolbar, select **(Remove)**.
- In the Web Intelligence Applet interface or Web Intelligence Rich Client in **Design** mode, select the filter and drag and drop it into the report.

**Related Information**

*To create, edit, and delete standard report filters* [page 271]

You can work with report filters in the **Report Filter** dialog box.

### 8.12 Folding and unfolding report data

You can hide and display report data by folding and unfolding the display of different report elements.

You can fold and unfold sections, breaks and tables. Data is concealed and displayed in different ways depending on the report element.
<table>
<thead>
<tr>
<th>Report element</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section</td>
<td>When a section is folded, section details are hidden and free cells only are displayed. In <strong>Reading</strong> mode, you can fold and unfold sections.</td>
</tr>
<tr>
<td>Table or break</td>
<td>When a table or break is folded, the rows are concealed, and only headers and footers are displayed. Tables must have headers and footers to be folded and unfolded. Vertical tables, horizontal tables and cross tables can be folded and unfolded. In <strong>Reading</strong> mode, you can fold and unfold sections.</td>
</tr>
</tbody>
</table>

### 8.12.1 To fold and unfold report data

You can fold and unfold data in **Reading** and **Design** mode by activating the outline.

1. Open a Web Intelligence document.
2. Select a cell in the table.
3. Do one of the following:
   - In the **Reading** mode, click **Outline**.
   - In the **Design** mode, in the **Analysis** tab, select the **Interact** subtab and click **Outline**.

   The fold and unfold bars appear to the side of and above the report panel, depending on the report structure.
4. Use the +/- or arrow icons on the bars, which correspond to and are aligned with individual report elements, to fold and unfold them.
5. Use the icons at the side or upper part of the bar to fold and unfold all instances of a type of report element.

### 8.13 Warning icons in charts

Warning icons in charts can alert you when there are chart and data object errors.

The warning icons available are:

- General Warnings, icons displayed on the top left corner of the chart.
  - Red X in a white background: impossible to generate the chart. (This could be due to a cache problem - try clearing temporary objects from cache.
  - White X in a red circle: cannot find the image, the BI administrator should check load balancing settings and enable service monitoring as described in the Business Intelligence Platform Administrator Guide.
  - Yellow warning: for example dataset too large (technical limit of the server), need to refresh the dataset, other cube errors.
  - Blue alert: limit for optimal rendering
The display of the General Warning icons is controlled by the *Hide warning icons in chart* setting in the Web Intelligence document properties. If this setting is deactivated, then no General Warning icons appear in the charts.

- An incompatible chart data warning, small yellow warning icon displayed on the data point. These occur if *Show alert when the data is incompatible with the chart* is activated in the chart format options and the dataset is inconsistent with the chart parameters. For example, a warning can appear in a pie chart with negative values, negative values for a logarithmic scale, or inconsistent hierarchical values for a treemap.

<table>
<thead>
<tr>
<th>Restriction</th>
<th>Definition</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical limits of the data received</td>
<td>Max number of rows defined by the BI administrator</td>
<td>Only part of the dataset is rendered and a warning icon appears, as well as an informational tooltip.</td>
</tr>
<tr>
<td>from the server</td>
<td>Default value = 50,000</td>
<td></td>
</tr>
<tr>
<td>Data restricted for optimal rendering</td>
<td>The data is restricted by the chart type and size for optimal appearance.</td>
<td>An alert icon appears, as well as a tooltip showing optimization guidelines.</td>
</tr>
</tbody>
</table>

**Related Information**

*Viewing document properties* [page 169]

You can view in the *Document Summary* pane in the Side Panel or set in the *Document Summary* dialog box.
9 Web Intelligence error messages

9.1 About Web Intelligence Error Messages

Error messages may appear while you are using Web Intelligence.

This chapter contains the messages and their descriptions grouped by the different components that make up Web Intelligence.

9.2 Web Intelligence module error messages

9.2.1 Web Intelligence (WIJ) Error Messages

Web Intelligence Java interface error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIJ 10000 - WIJ 77778</td>
<td>Web Intelligence Java interface</td>
</tr>
</tbody>
</table>

9.2.1.1 You need to use the Formula Editor to create a formula. (Error: WIJ 10000)

**Cause**

You typed a formula into a cell using the Cell Properties panel instead of the Formula Editor.

**Action**

Launch the Formula Editor and define the formula in the Formula Definition pane.
9.2.1.2  You cannot create a variable that has the same name as an existing document object. Give the new variable a different name. (Error: WIJ 10001)

**Cause**

A single document cannot contain multiple objects or variables with the same name.

**Action**

To save a new variable, give the variable a name that is different from the objects and variables already included in the document.

9.2.1.3  You cannot position this report component in relation to a block, cell, or section that is positioned relative to this report component. Select a different block, cell or section in the dropdown list or unselect the Relative To option. (WIJ 10500)

**Cause**

When you position a report component in relation to another report component that references the selected one, you create a circular attachment.

**Action**

Remove relative positioning, or select a different block, cell, or section for relative positioning.

9.2.1.4  Web Intelligence requires the Java Runtime Environment (JRE) 1.4.2_01. The currently installed JRE is {0}. Contact your administrator to upgrade to 1.4.2_01 or select the [default VM] entry in the [Java Plug-in Control Panel], if you already have the required version installed. (WIJ 11111)

**Cause**

When you use the Java interface, a Java applet is installed on your local PC. The Java Runtime Environment 1.4.2_01 (or later version) needs to be installed and selected in order for the report panel to function.
Action

If Java Runtime Environment 1.4.2_01 (or later version) is already installed on your PC, then launch the Java Plugin Control panel. To do this:

- Select the Windows menu:给人Start❯Settings❯Control Panel❯
- Double-click Java Plug-in.
- On the Advanced tab, select Use Java Plug-in Default, then click Apply.

Or Contact your administrator, and request help with installing Java Runtime Environment 1.4.2_01 (or later version).

9.2.1.5 An error occurred while the document was being decoded. Try to open the document in the BI Launch Pad, or contact your administrator for further information. (WIJ 20000)

Cause
Web Intelligence cannot decode and open the document in the Java Report Panel.

Action
Open the document in InfoView by clicking the document title where the document is listed on the InfoView Corporate Documents or Personal Documents page.

If this does not work, see your administrator.

9.2.1.6 An unexpected problem occurred when during document refresh and open. The data source has been modified or deleted, or a prompt on the document has no value selected. (WIJ 20001)

Cause
The document has the Refresh on open option selected. One or more of the following explanations can account for this error:

- The data source has been modified since the document was created.
- The data source has been deleted since the document was created.
- One or more prompts have no values selected.
**Action**

See your administrator.

**9.2.1.7 Unexpected error.** If you cannot reconnect to the server, close your session and start again. (WIJ 20002)

**Cause**

The server may be down or your user session may be closed.

**Action**

See your administrator.

**9.2.1.8 Unable to get the first page of the current report.** Check the validity of your report. (ERR WIJ 20003).

**Cause**

The report cannot be displayed because it contains structural errors.

**Action**

Do one of the following:

- View the report in Structure View and verify the report structure. For example, errors can be caused if report blocks overlap or if the structure of a table contains cells that create an asymmetrical table format. Modify the report structure appropriately.
- Contact your administrator and request them to search for structural anomalies in the report.
The current query contains unresolvable objects. The query will be updated (WIJ 20004).

**Cause**

There are objects that cannot be resolved in the query.

**Action**

Check that the related objects have not been deleted from the data source.

---

The current request has returned corrupted data. Contact your administrator for further information (WIJ 20005).

**Cause**

The returned data is corrupted. This could be due to data source or network issues.

**Action**

Contact your administrator.

---

Unable to contact the application server. Contact your administrator for further information (WIJ 20010).

**Cause**

The application server could be down, or address different to the one expected.

**Action**

Contact your administrator.
9.2.1.12  The \{0,number\} MB report element you want to copy is too large to be exported to an external application. The maximum allowed size is \{1,number\} MB.

(Error: WIJ 30004)

**Cause**

The report element you want to copy is too large to be copied.

**Action**

Do not attempt to copy the report element.

9.2.1.13  Your user profile does not give you access to a document domain to save corporate documents. Save this document as a personal document or contact your administrator (ERR WIJ 40000).

**Cause**

You do not have the rights to save the document to the corporate repository.

**Action**

Save the document as a personal document or ask your administrator for the rights to save the document to the repository.

9.2.1.14  The query in this document is empty. Check that the Result Objects pane on the query tab includes objects before running the query (ERR WIJ 30000).

**Cause**

The query does not contain any result objects.
Action

Edit the query and add result objects.

9.2.1.15 At least one query in this document is empty. Check that the Result Objects pane on each query tab includes objects before running the queries (ERR WIJ 30001).

Cause

A query does not contain any result objects.

Action

Add the result objects to the empty query.

9.2.1.16 Out of memory. Reduce the browser window size or re-launch the report panel. (WIJ 30003).

Cause

Your computer has run out of the memory. This may be because your browser window size is too large.

Action

Do one of the following:

- Reduce the size of the browser window.
- Relaunch the Java interface.
9.2.1.17  Your user profile does not allow you to save personal or corporate documents. Contact your administrator for further details. (WIJ 40001)

**Cause**

Your user profile, defined by your administrator, does not allow you to save personal or corporate documents.

**Action**

If you think you need to be allowed to save personal documents and/or corporate documents to InfoView, contact your administrator to request they modify your security profile.

9.2.1.18  An unexpected error occurred. (WIJ 44444)

**Cause**

An unexpected error was encountered.

**Action**

Please contact your administrator with details of the actions you performed before the error occurred.

9.2.1.19  Your version of Web Intelligence Rich Client is not up-to-date to connect to this system (ERR WIJ 50003). You must upgrade your Web Intelligence Rich Client by clicking `<a href="(0)">here</a>`.

**Cause**

Your version of Web Intelligence Rich Client is not recent enough to connect to the repository.

**Action**

Upgrade your version of Web Intelligence Rich Client by following the link.
9.2.1.20 The information sent to the server contains invalid character(s). Use the Undo button to cancel the latest changes to the document and then retry. (Error: WIJ 55555)

Cause

There is an error in the XML sent to the server by the application.

Action

Use the Undo feature to remove the erroneous modification made to the document, and then run the query or refresh the document again.

9.2.1.21 The session timed out. The document {document_name}.wid has been autosaved in the Favorites\~InteractiveAnalysis folder. Click Restore to retrieve it. (WIJ 60001)

Cause

Due to a server timeout, the current document was autosaved in the Favorites\~InteractiveAnalysis folder.

Action

Click Restore to retrieve the autosaved document.

If you cannot restore the document automatically, retrieve it manually from the folder. The name of the autosaved document is the original document name with an automatically-generated prefix and postfix.

Retrieve the document from the autosave folder as quickly as possible. This folder is not a permanent storage location for autosaved documents.

9.2.1.22 The session timed out, but the document could not be autosaved because the following security rights are not assigned (WIJ 60002): {list_of_rights}

Cause

The document could not be autosaved because you do not have some or all of the following security rights:
Ask your administrator to assign you the appropriate security rights.

9.2.1.23  The document cannot be retrieved due to a server problem (WIJ 77777).

Cause

The document cannot be retrieved because the server is down.

Action

See your administrator.

9.2.1.24  The Central Management System is not functioning. Contact your administrator for further information. (WIJ 77779)

Cause

The Central Management System (CMS) is not running.

Action

Contact your administrator.
Your session timed out. Please close the Java interface and log on again. (WIJ 77778)

**Cause**

You have remained logged in to the Bi launch pad without using the Java interface for longer than the maximum time allowed by the system.

**Action**

Log out and then log back into the BI launch pad to continue using the Java interface (you will lose any unsaved modifications you made previous to timeout).

To increase the length of time you are allowed to remain logged in to the BI launch pad ask your administrator to increase your session timeout parameter.

## 9.2.2 Web Intelligence Desktop HTML Interface (WIH) Error Messages

Web Intelligence Desktop HTML interface error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIH 00000 - WIH 00020</td>
<td>Web Intelligence Desktop HTML interface</td>
</tr>
</tbody>
</table>

### 9.2.2.1 The document could not be saved. (WIH 00014)

**Cause**

The document could not be saved to the repository. This error can occur for a number of reasons. For example: you do not have the security rights to the folder where you tried to save the document.

**Action**

See your administrator to determine why you could not save the document.
9.2.2.2 The session timed out. The document {document_name}.wid has been autosaved in the Favorites\~WebIntelligence folder. Click Restore to retrieve it. (WIH 00015)

**Cause**

Due to a server timeout, the current document was autosaved in the Favorites\~WebIntelligence folder.

**Action**

Click *Restore* to retrieve the autosaved document.

If you cannot restore the document automatically, retrieve it manually from the folder. The name of the autosaved document is the original document name with an automatically-generated prefix and postfix.

Retrieve the document from the autosave folder as quickly as possible. This folder is not a permanent storage location for autosaved documents.

9.2.2.3 The session timed out, but the document could not be autosaved because the following security rights are not assigned (WIH 00016): {list_of_rights}

**Cause**

The document could not be autosaved because you do not have some or all of the following security rights:

- Edit object
- Delete object
- Add object

**Action**

Ask your administrator to assign you the appropriate security rights.

9.2.3 Web Intelligence Desktop (WIO) Error Messages

Web Intelligence Desktop (Rich Client) error messages include the following:
9.2.3.1   Web Intelligence Desktop cannot log in. (WIO 00001)

**Cause**

The browser cache might be full – under certain circumstances this can prevent Web Intelligence Desktop from logging in.

**Action**

Empty the browser cache if it is full. If Web Intelligence Desktop still cannot log in, see your administrator.

9.2.3.2   Cannot open the hyperlink (WIO 00002).

**Cause**

- The URL in the hyperlink is incorrectly constructed.
- The hyperlink references a document in a CMC. Documents in a CMC are not always accessible from Web Intelligence Desktop for two reasons:
  - The hyperlink does not specify the name of the server hosting the document because the *Use complete URL path to build document hyperlink* setting is not selected. Incomplete URLs are invalid when used outside the BI launch pad.
  - The hyperlink builds the complete URL, but the server specified in the URL is not accessible from the computer running Web Intelligence Rich Client.

**Action**

Correct the hyperlink or see your administrator for help.
9.2.3.3  There is no more memory available. (WIS 30280) (WIO 30280)

**Cause**

Your system is out of memory.

**Action**

Close open documents to free memory.

9.2.3.4  Cannot continue because memory is low. Please close documents to free memory. (WIO 30284)

**Cause**

Your system memory is low.

**Action**

Close open documents to free memory.

9.2.4  **Web Intelligence Server (WIS) Error Messages**

Web Intelligence Server error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIS 30000 - WIS 40000</td>
<td>Web Intelligence Server</td>
</tr>
</tbody>
</table>

9.2.4.1  The query in this document is empty. (WIS 30000)

**Cause**

No data is defined for this document.
Action

Add result objects to the query.

9.2.4.2  At least one query in the document is empty. (WIS 30001)

Cause

No data is defined for at least one of the queries in this document.

Action

Add result objects to the query.

9.2.4.3  Your security profile does not include permission to edit queries. (WIS 30251)

Cause

You do not have the right to edit queries.

Action

Contact your administrator to request the ability to edit the queries in documents.

9.2.4.4  Your security profile does not include permission to edit documents. (WIS 30252)

Cause

You do not have the right to edit documents.
Action

Contact your administrator and request the ability to edit documents.

9.2.4.5  Your security profile does not include permission to refresh documents.  
(WIS 30253)

Cause

You do not have the right to refresh documents.

Action

Contact your administrator to request the ability to refresh documents.

9.2.4.6  Your security profile does not include permission to refresh lists of values.  
(WIS 30254)

Cause

You do not have permission to refresh lists of values.

Action

Contact your administrator to request the ability to refresh lists of values in documents.

9.2.4.7  Your security profile does not include permission to use lists of values.  
(WIS 30255)

Cause

You do not have permission to use lists of values.
Action

Contact your administrator to request the ability to use lists of values in documents.

9.2.4.8  Your security profile does not include permission to view the script generated by the query. (WIS 30256)

Cause

You do not have the permission to view the script generated by the query.

Action

Contact your administrator to request the ability to view the script in queries.

9.2.4.9  Your security profile does not include permission to use the formula language. (WIS 30257)

Cause

You do not have permission to use the formula language or create variables.

Action

Contact your administrator to request the ability to use the formula language and create variables in documents.

9.2.4.10  Your security profile does not include permission to perform drill analysis. (WIS 30258)

Cause

You do not have permission to perform drill analysis.
Action

Contact your administrator to request the ability to drill on reports.

9.2.4.11  Your security profile does not include permission to extend the scope of analysis. (WIS 30259)

Cause

You attempted to perform a drill operation outside the defined scope of analysis, and you do not have permission to drill outside the scope of analysis.

Action

Contact your administrator.

9.2.4.12  An internal error occurred while calling the {api_name} API. (WIS 30270)

Cause

Information about the document or the data source is invalid or not available.

Action

Your administrator can trace the problem that caused the error by activating the tracking and verifying the trace associated with the API.

9.2.4.13  The document is too large to be processed by the server. (WIS 30271)

Cause

When you view a document in Portable Document Format (PDF) or Microsoft Excel format, the server generates binary based output, which is then interpreted by your web browser. This error occurs if the size of the binary output is greater than the maximum size specified by your administrator for the server.
Action

Contact your administrator and ask them to increase the maximum size.

9.2.4.14 The document is too large to be processed by the server. (WIS 30272)

Cause

When you view a document in HTML format, the server generates character-based output, which is then interpreted by your web browser. This error occurs if the size of the character output is greater than the maximum size specified by your administrator for the server.

Action

Ask your administrator to increase the maximum document size.

9.2.4.15 The query or report could not be generated. (WIS 30351)

Cause

It was not possible to complete one or more of the steps required to define a query and generate a report. This is due to one of the following reasons:

- the document was not initialized
- the data source is not valid
- the query was not defined
- the query context was not defined at the universe level
- no values were specified for prompts at the universe level

Action

Contact your administrator and ask them to check the connection to the data source, and that the universe does not contain unspecified contexts and prompt values.
9.2.4.16  A query with this name already exists. (WIS 30371)

Cause

Another query used in this document already has this name.

Action

Enter a different name for this query.

9.2.4.17  The Web Intelligence server memory is full. Log off and try to connect later. If the problem persists, contact your administrator. (Error: ERR_WIS_30280) (WIS 30280)

Cause

The server memory is full.

Action

Try again later. If the problem persists, see your administrator.

9.2.4.18  The Web Intelligence server is busy. Save any pending change and try again later. If the problem persists, contact your administrator. (Error: ERR_WIS_30284) (WIS 30284)

Cause

The server is busy.

Action

Save any changes and try again later. If the problem persists, see your administrator.
9.2.4.19  The Web Intelligence server is running out of memory, your document has been closed. If the problem persists, contact your administrator. (Error: ERR_WIS_30285) (WIS 30285)

**Cause**

The server memory is full.

**Action**

Try again later. If the problem persists, see your administrator.

9.2.4.20  You cannot edit this document because the query property option "Allow other users to edit the query" was not enabled when the document was created. (WIS 30381)

**Cause**

The creator of the document did not select the query property option: "Allow other users to edit the query".

**Action**

Do one of the following:

- Ask the document creator to enable the option and re-save the document.
- Save a copy of the document as a personal document and then edit the query in the copy.

9.2.4.21  An internal error has been generated by the WIQT. (WIS 30551)

**Cause**

An unexpected error occurred on the WIQT.
Action

Contact your administrator.

9.2.4.22 Your WIQT session has reached timeout. Log out and log in again to the BI launch pad. (WIS 30553)

Cause

You have remained logged into the BI launch pad without using Web Intelligence for longer than the maximum time allowed by the system.

Action

Log out and then log back into the BI launch pad (you will lose any unsaved modifications you made previous to timeout).

To increase the length of time you are allowed to remain logged in to the BI launch pad, ask your administrator to increase your session timeout parameter.

9.2.4.23 No more WIQT servers are available. The maximum number of concurrent users is already logged in. (WIS 30554)

Cause

The maximum number users are already logged in.

Action

Try again later, or ask your administrator to increase the maximum number of concurrent users.
9.2.4.24 Your security profile does not include permission to save documents as corporate documents or to send documents using the BI launch pad. (WIS 30555)

**Cause**

Your security profile does not allow you to save documents as personal or corporate documents, or to schedule documents.

**Action**

Contact your administrator to request the ability to do the following:

- Save corporate documents
- Send documents to users in own groups
- Send documents to users in other groups

9.2.4.25 A corporate document with this name already exists. Your security profile does not include permission to delete corporate documents created by other users. (WIS 30556)

**Cause**

Your security profile does not allow you to overwrite existing corporate documents.

**Action**

Contact your administrator to request the ability to delete corporate documents saved by other users.

9.2.4.26 There is no document with this name in the repository. Specify a different document name. (WIS 30557)

**Cause**

There is no document with this name in the repository for one of the following reasons:

- You have typed the document name incorrectly
- The document with this name has been deleted from the repository

**Action**

Check that you have entered the document correctly.

**Note**

Deleted documents cannot be retrieved.

**9.2.4.27** Cannot perform the intended action on this document. (WIS 30650)

**Cause**

The server is unable to complete the current task because of lack of resources or access problems.

**Action**

Do one of the following:

- Close your session, log out of the BI launch pad then log in again.
- Ask your administrator to verify that your security profile allows you access to the corporate repository.

**9.2.4.28** The server failed to load the XML document. (WIS 30751)

**Cause**

When you migrate a BusinessObjects document to Web Intelligence 6.x, an XML file is created that can be opened by the Web Intelligence Report Server. (The related module on the Administration Console is called the WIReportServer). In this case an unexpected error occurred on the Web Intelligence Report Server while migrating a document to Web Intelligence 6.x.

**Action**

Your administrator can trace the problem that caused this error by activating the tracking and verifying the trace associated with the WIReportServer. Contact your administrator with this information.
9.2.4.29  The XML file for this document cannot be opened. Contact your administrator.  (WIS 30752)

Cause

When you migrate a Desktop Intelligence document to Web Intelligence 6.x, an XML file is created that can be opened by the server. This error occurs when the XML file cannot be opened by the server, and so migration cannot be completed. There are two common causes:

- The XML is Read Only.
- The file path to the XML file is incorrect.

Action

Contact your administrator with this information.

9.2.4.30  An error occurred while parsing the XML document. Contact your administrator.  (WIS 30753)

Cause

When you migrate a Desktop Intelligence document to Web Intelligence 6.x, an XML file is created that can be opened by the server. This error occurs when the XML file contains structural anomalies that the server cannot interpret, and so migration cannot be completed.

Action

There are two possible actions that an administrator can take to solve this problem:

- Open the XML file with an XML editing tool and verify the structure of the document.
- Activate the tracking and verify the trace associated with the WIReportServer.

9.2.4.31  The Web Intelligence 2.x document could not be migrated.  (WIS 30761)

Cause

An unexpected error occurred when trying to migrate a Web Intelligence 2.x document to the current document format.
Action

An administrator may be able to identify the cause of this error by activating the tracking and verifying the trace associated with the server. Contact your administrator with this information.

9.2.4.32 This document cannot be migrated. The query and report of the original Web Intelligence 2.x document are not synchronized. Try to refresh and save the original document; then attempt migration again. (WIS 30762)

Cause

In the original Web Intelligence 2.x document, there is a discrepancy between the objects included in the query and the objects included in the report. This means that the server is unable to interpret the document correctly to migrate it to the current document format.

Action

To synchronize the data definition in the query and report of the original Web Intelligence 2.x document:

1. Use Web Intelligence 2.x to open the original document again.
2. Either run the query or refresh the document data.
3. Save the refreshed document.
4. Try to migrate the document again using the Migration Tool.

If you do not have access to Web Intelligence 2.x or the Migration Tool, contact your administrator with this information.

9.2.4.33 The Web Intelligence 2.x document could not be migrated, because the WIQT module returned an error. Contact your administrator. (WIS 30763)

Cause

The original Web Intelligence 2.x document could not be migrated to the current document format, due to an error generated by the WIQT process.
**Action**

Your administrator can trace the problem that caused this error by activating the tracking and verifying the trace associated with the WIQT. Contact your administrator with this information.

**9.2.4.34** Your user profile does not provide you with access to a document domain to save corporate documents. Save this document as a personal document or contact your administrator. (WIS 40000)

**Cause**

Your user profile does not include permission to save documents to a corporate document domain in the repository.

**Action**

Do one of the following:
- Save the document as a personal document.
- Contact your administrator and request access to a corporate document domain.

**9.2.5 Information Engine Services (IES) Error Messages**

Information Engine Services error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>IES 00001 - IES 01031</td>
<td>Query execution errors</td>
</tr>
<tr>
<td>IES 01501 - IES 01513</td>
<td>Graph execution errors</td>
</tr>
<tr>
<td>IES 10001 - IES 10903</td>
<td>Query execution errors (specific to Web Intelligence)</td>
</tr>
</tbody>
</table>
9.2.5.1 IES 00001 - IES 01031 Query execution errors

9.2.5.1.1 Query script generation failed. See your administrator. {0} (IES 00013)

Cause

Errors occurred during generation of the query SQL.

Action

Ask your universe designer to verify the SQL.

9.2.5.1.2 Some objects are no longer available in the universe. (IES 00001)

Cause

One or more objects in a universe are no longer available to a document.

Action

Delete the missing objects from the query by comparing the objects in the query with the available objects.

9.2.5.1.3 You do not have sufficient rights to refresh the query. Some objects are not available to your user profile. Contact your administrator to request the necessary rights. (IES 00002)

Cause

You do not have the correct user rights to access the data for one or more objects included in a query. As you are not permitted to access the data for these objects, you cannot refresh the report.
Action

Ask your administrator to change your user profile to make these objects accessible.

9.2.5.1.4  Some pre-defined filters are no longer available in the universe. (IES 00003)

Cause

Compare the available universe objects with query objects. Perhaps the objects are no longer available or you don't have the rights.

Action

Compare universe objects with query objects. If you don't have rights, contact your universe designer or administrator.

9.2.5.1.5  Some database tables are no longer available in the universe. (IES 00004)

Cause

One or more database tables referenced by objects in the universe are no longer available. The tables may have been renamed, or removed from the database.

Action

Ask your universe designer to refresh the universe to remove non-existent tables or update table names.
9.2.5.1.6  Invalid prompt definition. (IES 00005)

Cause

The syntax in a prompt is not valid, or the prompt makes reference to an object that no longer exists in the universe.

Action

Ask your universe designer to verify the prompt.

9.2.5.1.7  Invalid aggregate aware definition. (IES 00006)

Cause

One or more objects in the query use aggregate awareness, and the aggregate awareness syntax in the universe is not valid.

Action

Ask your universe designer to verify the aggregate awareness syntax.

9.2.5.1.8  A filter contains a wrong value. You cannot run this query. (IES 00007)

Cause

A filter has a incorrect operand. For example, a filter has an empty constant, or a filter that expects a numeric value is defined with an alphanumeric value.

Action

Correct the filter.
9.2.5.1.9  The query cannot run because it contains objects that reference incompatible tables. (IES 00008)

Cause

The query contains objects that return data sets that cannot be combined or synchronized, possibly because the universe does not allow multiple SQL statements for each context or measure.

Action

Ask your universe designer to do the following:

- Allow multiple SQL statements for each context and measure.
- Create a new context that includes the incompatible objects.

9.2.5.1.10  You cannot run the query because an advanced filter contains an incompatible object. Try simplifying the filter set and run your query again. (IES 00009)

Cause

An advanced filter uses incompatible objects.

Action

Change the advanced filter to use compatible objects only.

9.2.5.1.11  The universe does not allow using a complex expression in a GROUP BY statement. You cannot run this query. (IES 00010)

Cause

A query contains a GROUP BY clause that uses formulas or aliases. The universe does not allow these expressions in GROUP BY clauses. The behavior is determined by the parameter

```xml
<Parameter Name="GROUPBY_EXCLUDE_COMPLEX">Y</Parameter>
```
in the PRM file for the target RDBMS.

Action

- Modify the query so that objects using formulas or aliases are not included in the query.
- If your RDBMS supports complex GROUP BY expressions, ask your universe designer to change the value of the GROUPBY_EXCLUDE_COMPLEX parameter to N.

9.2.5.1.12  The expression "{0}" contains multiple attributes. This syntax is not supported in this version. (IES 00011)

Cause

One or more objects in the query use a comma (",") instead of a concatenation operator in their definition. This syntax is no longer supported.

Action

Ask your universe designer to perform one of the following actions:

- Redefine the objects that use the comma to concatenate the data for two objects using the standard concatenation operator for the RDBMS.
- Add the following line to the PRM file for the target RDBMS:

  ```xml
  <Parameter Name = "REPLACE_COMMA_BY_SEPARATOR"=Y>
  ```

  This will enable the comma to be accepted syntax for concatenation in object definitions.
- Set the value of REPLACE_COMMA_BY_CONCAT to "Yes" in the universe.

9.2.5.1.13  You cannot run this query because it will produce a Cartesian product. (IES 00012)

Cause

The query will produce a Cartesian product. A Cartesian product returns all possible combinations of rows from the tables referenced by objects in the query and is rarely correct.
Action

Ask your universe designer to perform one of the following actions:

- Prevent Cartesian products by modifying the universe table schema to include appropriate joins and restrictions.
- Allow the universe to return Cartesian products if they are acceptable.

9.2.5.1.14  Aggregate aware resolution failed. (IES 00014)

Cause

The query objects exclude all possible SQL choices for an aggregate aware function.

Action

Ask your universe designer to remove the incompatibility between the objects.

9.2.5.1.15  Multiple Query Filters contain a prompt with the same text, but different operand type or operator count of values. (IES 00015)

Cause

The query has multiple prompts that display the same message. Prompts with the same message are usually combined, but this is not possible if some require you to enter one value and others require multiple values.

Action

Modify the prompts so they all require one or multiple values.
**9.2.5.1.16** The query contains a @script() function, which is not supported. (IES 00016)

**Cause**

The SQL generated by the query for this document includes a @script() function, which is not supported.

**Action**

Ask your universe designer to remove the @script() function.

**9.2.5.1.17** The following objects cannot be used as Result Objects: {0}. See your administrator. (IES 00017)

**Cause**

The query includes objects that cannot be used as result objects in queries.

**Action**

Remove the objects, or ask your universe designer to allow the objects to be included in as result objects in queries.

**9.2.5.1.18** The following objects cannot be used as query filters: {0}. Contact your administrator. (IES 00018)

**Cause**

The query contains objects used as query filters that are not valid as query filters.

**Action**

Remove the objects, or ask your universe designer to allow them as query filters.
9.2.5.1.19  A query filter object contains too many values for the object to be used in a query filter. (IES 00019)

Cause

A query filter contains too many values.

Action

Select fewer values.

9.2.5.1.20  The only authorized SQL statement is SELECT. [0] (IES 00020)

Cause

The SQL generated by the query is invalid.

Action

Ask your universe designer to verify the SQL.

9.2.5.1.21  The combined query cannot run because one of the queries contains incompatible objects. (IES 00021)

Cause

A query in a combined query contains incompatible objects.

Action

Remove the incompatible objects.
9.2.5.1.22 The query does not reference any table when attempting to build the WHERE clause. (IES 00022)

**Cause**

The WHERE clause of the generated SQL does not reference a table.

**Action**

Modify the query to reference a table.

9.2.5.1.23 Invalid sub-query filter. Either data cannot be retrieved (null) or no result objects are defined. (IES 00023)

**Cause**

The query contains an invalid sub-query. Either data cannot be retrieved or no result objects are defined.

**Action**

Modify the sub-query.

9.2.5.1.24 Incompatible object types in the sub-query filter. (IES 00024)

**Cause**

The subquery contains incompatible object types.

**Action**

Remove the incompatible object types.
9.2.5.1.25  The query is too complex to apply a sampling function. When the function is applied, no SQL is generated so query aborts. Try to simplify your query (such as, combined query, or query with JOIN or SYNCHRO operators). (IES 00025)

**Cause**

The query is too complex to apply a sampling function.

**Action**

Try to simplify the query.

9.2.5.1.26  Failed to regenerate SQL for optional prompts, the following required prompts were skipped: {0}.(IES 00026)

**Cause**

The SQL relating to optional prompts could not be regenerated.

**Action**

See your universe designer.

9.2.5.1.27  Removing optional prompts from the query will introduce new prompts. This introduces complexities that cannot be supported. (IES 00027)

**Cause**

The query cannot be processed due to optional prompts.

**Action**

Remove the optional prompts from the query.
9.2.5.1.28  No value specified for the Keydate parameter. (IES 00028)

Cause
No value was specified for the Keydate parameter.

Action
Specify a value for the Keydate.

9.2.5.1.29  The universe is already open with write permission by another user. (IES 00029)

Cause
The universe could not be opened because it is already opened with write permission by another user.

Action
See your administrator.

9.2.5.1.30  Queries that do not contain a measure are not allowed to run on this universe. (IES 00030)

Cause
The query does not contain a measure, and therefore cannot be used with the universe.

Action
Check that the query definition is correct, add the relevant measure if necessary.
9.2.5.1.31  Universe not found. Either the universe was deleted from the repository or you do not have sufficient rights to see the universe in the repository. (IES 00501)

**Cause**

Cannot find the universe.

**Action**

Check with your administrator or universe designer to find out why the universe is not available.

9.2.5.1.32  The appropriate user rights were not found. Contact your administrator. (IES 00502)

**Cause**

You cannot perform this action because your user rights cannot be found.

**Action**

Ensure that you have used the correct login. Check with your CMC administrator that the user rights have not been deleted;

9.2.5.1.33  You are not authorized to access the universe {0}. Contact your administrator to request the appropriate rights. (IES 00503)

**Cause**

Your user rights do not permit this action.

**Action**

Ask your CMC administrator to check that your permissions are correctly defined.
9.2.5.1.34 You do not have the right to access data for this universe. Contact your administrator to request the appropriate rights. (IES 00504)

Cause

Your current user rights do not allow you to access the data.

Action

Ask your CMC administrator to check that your permissions are correctly defined.

9.2.5.1.35 You do not have the right to access data for this universe connection. Contact your administrator to request the appropriate rights. (IES 00505)

Cause

Your current user rights do not allow you to access the connection.

Action

Ask your CMC administrator to check that your permissions are correctly defined.

9.2.5.1.36 Failed to download universe {0} from repository {1}. Check that there is enough memory available and try again. (IES 00506)

Cause

Cannot download the universe.

Action

Contact your administrator to report the problem.
9.2.5.1.37  You do not have the right to access data for this core universe. Contact your administrator to request the appropriate rights. (IES 00507)

**Cause**
Your current user rights do not allow you to access the data.

**Action**
Ask your CMC administrator to check that your permissions are correctly defined.

9.2.5.1.38  Universe data connection could not be found. The connection has been deleted or you do not have the right to use it. (IES 00509)

**Cause**
The connection has been lost.

**Action**
Contact your administrator to report the problem.

9.2.5.1.39  Cannot generate the SQL for this query because one of its objects is based on a derived table (table_name) that contains a loop in its definition. (IES 00510)

**Cause**
When a derived table contains a loop, it is not possible to generate the SQL.

**Action**
Redefine your query, or try to avoid having a loop in the derived table.
9.2.5.1.40 Cannot generate the SQL for this query because one of its objects is based on a derived table (table_name) that is unknown. (IES 00511)

Cause

The SQL cannot be generated.

Action

Check that the derived table is correctly defined and can be used. Check that your query is correct.

9.2.5.1.41 Cannot generate the SQL for this query because one of its objects is based on a derived table (table_name) with an incorrect definition. (IES 00512)

Cause

The derived table is not correctly defined.

Action

Check the definition of the derived table and correct it if necessary.

9.2.5.1.42 The query statement cannot be generated because of a syntax error. Check the syntax of the statement that uses the @Variable function. (IES 00513)

Cause

Your query contains one or more syntax errors.

Action

Check the syntax of the SQL statement that uses the @Variable function. Refer to the @Functions section of the Universe Designer user documentation (pdf document or online help).
9.2.5.1.43 The database SQL generation parameters file could not be loaded \{(database_name), (network_layer)}\ . (IES 00514)

Cause

Cannot find the relevant SQL parameter file.

Action

Contact your administrator.

9.2.5.1.44 Unexpected enumerated type {0}. (IES 01001)

Cause

A new enumerated type has been declared but is not supported.

Action

Contact your administrator.

9.2.5.1.45 Nested @aggregate_aware functions are not supported. (IES 01002)

Cause

The expression contains nested @aggregate_aware functions.

Action

The designer can edit the business layer and remove nested @aggregate_aware functions.
9.2.5.1.46  Circular references: check the references to other business layer objects in the expression. (IES 01003)

**Cause**

The expression contains circular references.

**Action**

The designer can edit the business layer and check for circular references between business layer objects.

9.2.5.1.47  Invalid @Select reference. Check the definition of the @Select declaration. (IES 01004)

**Cause**

The expression contains an invalid reference to the @Select function.

**Action**

The designer can edit the business layer and validate the use of the @Select function in the object expression.

9.2.5.1.48  Invalid @Where reference. Check the definition of the @Where declaration. (IES 01005)

**Cause**

The expression contains an invalid reference to the @Where function.

**Action**

The designer can edit the business layer and validate the use of the @Where function in the object expression.
9.2.5.1.49  Some prompt parameters are no longer available in the universe. (IES 01006)

**Cause**

The expression contains and invalid reference to the @Prompt function.

**Action**

The designer can edit the query or the business layer and validate the use of the @Prompt function in the object expression.

9.2.5.1.50  Bad hierarchy reference. (IES 01007)

**Cause**

The hierarchy declared in the query contains an error.

**Action**

Check the query expression for errors.

9.2.5.1.51  Catalog for source "{0}" cannot be retrieved. Check Data Foundation connection. (IES 01008)

**Cause**

Catalog for source "{0}" cannot be retrieved.

**Action**

Check the connection to the data source in the data foundation.
9.2.5.1.52  The prompt cannot be validated but it may be correct. Associate a list of values or at least one default value to the prompt. (IES 01010)

**Cause**

The prompt cannot be validated but it may be correct.

**Action**

Associate a list of values or at least one default value to the prompt.

9.2.5.1.53  More than 100 levels of nested derived tables is not supported. (IES 01015)

**Cause**

There are more than 100 levels of nested derived tables.

**Action**

Edit the @DerivedTable expression to reduce the number of nested levels.

9.2.5.1.54  The definition of the list of values {0} is invalid. The list or the current column is hidden. (IES 01025)

**Cause**

The list of values is hidden, or the current column is hidden.

**Action**

Check for hidden objects in the universe or business layer. Either make the objects active or redefine the list of values expression.
9.2.5.2 IES 01501 - IES 01513 Graph execution errors

9.2.5.2.1 Detection cannot take place because the data foundation contains cycles. Use the Visualize Loops command to visualize the cycles. Modify the cardinality of the joins involved in the cycles before detecting aliases or contexts. (IES 01501)

**Cause**

The data foundation contains loops.

**Action**

In the information design tool, edit the data foundation and use the Visualize Loops command to find loops in the data foundation. Modify the cardinality of the joins involved in the loops before detecting aliases or contexts.

9.2.5.2.2 Detection cannot take place because some tables have at least two joins with opposite cardinalities: {0}. Modify the joins between these tables. (IES 01502)

**Cause**

Some tables in the data foundation have at least two joins with opposite cardinalities.

**Action**

In the information design tool, edit the data foundation and modify the joins between these tables.

9.2.5.2.3 Detection cannot take place because all join cardinalities have not been set. Set all the join cardinalities. (IES 01504)

**Cause**

All join cardinalities have not been set in the data foundation.
Action

In the information design tool, edit the data foundation and detect or set the cardinalities for all joins.

9.2.5.2.4 Automatic detections will fail as long as some cardinalities are many-to-many. (IES 01505)

Cause

Some joins in the data foundation have cardinality many-to-many.

Action

In the information design tool, edit the data foundation modify the cardinality for these joins.

9.2.5.2.5 Detection cannot take place because no fact table was detected. A fact table is always joined to other tables with a 'many to one' join, with the 'many' side of the join connected to the fact table. The problem could be the cardinalities that are currently set on the data foundation joins, or the way the database schema is built. (IES 01510)

Cause

No fact table was detected. A fact table relates other tables only with many-to-one cardinality joins, with many being on the side of the join connected to the fact table.

Action

In the information design tool, edit the data foundation check the cardinality of the joins. There might be a problem with the cardinalities that are currently set on the data foundation joins or with the way the database schema is built.
9.2.5.2.6 Detection cannot take place because there are loops in the schema. Use the Detect Aliases command to detect the alias tables that will resolve the loops. (IES 01512)

**Cause**

The data foundation contains loops.

**Action**

In the information design tool, edit the data foundation and use the Detect Aliases command to detect the alias tables that will resolve the loops.

9.2.5.3 IES 10001 - IES 10903 Query execution errors (Web Intelligence only)

**9.2.5.3.1** Syntax error in formula '%1%' at position %2%. (IES 10001)

**Cause**

There is a syntax error in your formula at the position indicated.

**Action**

Correct the formula.

**9.2.5.3.2** Problem initializing the dictionary of functions. (IES 10002)

**Cause**

The dictionary of functions could not be initialized.
Action

See your administrator.

9.2.5.3.3  The object '%1%' at position '%2%' is not unique in the report. (IES 10005)

Cause

An object has a name that conflicts with the name of another object in the report

Action

Use the fully-qualified name for the object.

9.2.5.3.4  The object '%1%' at position '%2%' does not exist in the report. (IES 10006)

Cause

The formula refers to an object that no longer exists in the report

Action

Remove the reference to the object from the formula.

9.2.5.3.5  Unexpected empty expression after '='. (IES 10009)

Cause

The expression appears to be incomplete.
Check the syntax of your expression and correct it.

9.2.5.3.6  The integer '%1%' at position '%2%' is too long. (IES 10013)

Cause

An integer in a formula exceeds the maximum limit.

Action

Edit the formula.

9.2.5.3.7  The number '%1%' at position '%2%' has a format that is incompatible with your regional settings. (IES 10014)

Cause

The format of the real number {number} is not compatible with your regional settings.

Action

Change the number format to conform with the format permitted by your regional settings.

9.2.5.3.8  Missing quotation mark after '%1%' at position '%2%'. (IES 10016)

Cause

There is a missing closing quotation mark in the formula.
Action

Add the closing quotation mark.

**9.2.5.3.9** The list of dimensions in the input or output context is empty. (IES 10032)

**Cause**

The list of dimensions in the input or output context is empty.

**Action**

Specify a list of dimensions.

**9.2.5.3.10** The variable '%1%' cannot be deleted because it has dependant formulas or variables linked to: '%2%'. (IES 10033)

**Cause**

The variable cannot be deleted because it is referenced by other variables or formulas.

**Action**

Delete the dependent formulas/variables before deleting the variable.

**9.2.5.3.11** You attempted to create a variable or update a variable name using a variable name that already exists. (IES 10034)

**Cause**

You attempted to create a variable or update a variable name using a variable name that already exists.
**Action**

Choose a variable name that does not already exist.

**9.2.5.3.12** The date or time format '%1%' at position '%2%' is not valid. (IES 10035)

**Cause**

The formula contains an invalid date/time format (for example, "bb/MM/yyyy").

**Action**

Specify a valid date/time format in the formula.

**9.2.5.3.13** The expression or sub-expression at position '%2%' is not valid. (IES 10036)

**Cause**

The formula contains an invalid expression/sub-expression.

**Action**

Specify a valid expression/sub-expression.

**9.2.5.3.14** The expression or sub-expression at position '%2%' in the '%1%' function uses an invalid data type. (IES 10037)

**Cause**

An expression contains an invalid data type. (For example, you have attempted to pass a string to a function that requires a date.)
**Action**

Use a valid data type in the expression.

9.2.5.3.15  Invalid character '%1%' in variable name at position '%2%'. (IES 10038)

**Cause**

The character {character} is not valid in the variable name.

**Action**

Remove {character} from the variable name.

9.2.5.3.16  The formula for variable '%1%' contains a reference to a variable with the same short name. (IES 10040)

**Cause**

The formula of a variable references another variable with the same short name.

9.2.5.3.17  Incorrect use of multiple comparison operators (<,>,<,>,<=,>=,=) at position '%2%'. (IES 10041)

**Cause**

The formula uses multiple comparison operators incorrectly (for example: if(1<2=3;0;-1)).
**Action**

Re-structure the formula to avoid using comparison operators incorrectly.

**9.2.5.3.18** There is a circular reference because the formula for variable '%1%' references a variable whose formula references '%1%' . (IES 10042)

**Cause**

A formula contains a circular reference.

**Action**

Remove the circular reference.

**9.2.5.3.19** There is no opening parenthesis after function '%1%' at position %2%. (IES 10060)

**Cause**

There is no opening parenthesis in the location indicated by the error message.

**Action**

Add an opening parenthesis in the location indicated.

**9.2.5.3.20** The function '%1%' has missing arguments or closing parenthesis at position %2%. (IES 10061)

**Cause**

Arguments or a closing parenthesis are missing from the formula.
Action

Supply the arguments or closing parenthesis.

9.2.5.3.21  Missing ';' before argument in function '%1%' at position %2%. (IES 10062)

Cause

The syntax of your expression is incorrect

Action

Check the syntax and correct the expression.

9.2.5.3.22  Missing ';' or closing parenthesis in function '%1%' at position %2%. (IES 10063)

Cause

The syntax is incorrect

Action

Check the syntax and correct your expression.

9.2.5.3.23  Missing ';' or closing parenthesis in list '%1%' at position %2%. (IES 10064)

Cause

A semicolon or closing parenthesis is missing from the formula.
Action

Supply the semicolon or closing parenthesis.

9.2.5.3.24 Missing closing parenthesis in function '%1%' at position %2%. (IES 10065)

Cause

The syntax is incorrect.

Action

Check the expression and correct the syntax.

9.2.5.3.25 Missing aggregate operator or closing parenthesis in function '%1%' at position %2%. (IES 10066)

Cause

The syntax is incorrect.

Action

Check the expression and correct the syntax.

9.2.5.3.26 Missing operator or closing parenthesis in '%1%' at position %2%. (IES 10067)

Cause

The syntax is incorrect.
Action

Check the expression and correct the syntax.

9.2.5.3.27  Missing list element in '%1%' at position %2%. (IES 10068)

Cause

The syntax is incorrect. An element is missing.

Action

Check the expression and correct the issue.

9.2.5.3.28  Missing object identifier in '%1%' at position %2%. (IES 10069)

Cause

An object identifier is missing from the formula.

Action

Correct the formula.

9.2.5.3.29  Missing or bad operand in '%1%' expression at position %2%. (IES 10070)

Cause

Either the operand is not compatible, or the operand is missing.
Action

Check the syntax and correct the expression.

9.2.5.3.30 Incorrect calculation context %1%' at position %2%. (IES 10071)

Cause

The calculation context is incorrect.

Action

Check the syntax of your expression and correct it.

9.2.5.3.31 Incorrect reset context at position %2%. (IES 10072)

Cause

The formula contains an incorrect reset context.

Action

Correct the reset context.

9.2.5.3.32 Invalid Where clause in function '%1%': a dimension is missing at position %2%. (IES 10073)

Cause

The expression is missing an expression.
Action

Check the syntax of the expression and ensure that there is the expected dimension.

9.2.5.3.33  Incompatible object '%1%' at position %2%. (IES 10076)

Cause

You cannot use this type of object.

Action

Ensure that the correct object has been declared.

9.2.5.3.34  The object '%1%' at position %2% is incompatible. (IES 10077)

Cause

The formula contains an incompatible object.

Action

Correct the formula.

9.2.5.3.35  Invalid character '%1%' at position %2%. (IES 10080)

Cause

There is an invalid character in the expression.

Action

Check the syntax of the expression.
9.2.5.3.36  Invalid string '%1%' at position %2%. (IES 10082)

Cause

The formula contains an invalid string.

Action

Correct the string.

9.2.5.3.37  The qualification of the variable '%1%' cannot be changed. (IES 10083)

Cause

You cannot change the qualification of the variable. (For example, you cannot change a measure to a dimension if its definition includes an aggregate.)

Action

Create a new variable with the appropriate qualification.

9.2.5.3.38  Expecting object member in '%1%' at position %2%. (IES 10084)

Cause

There is no object member.

Action

Check the syntax of the expression and correct it as necessary.
9.2.5.3.39  Invalid member '%1%' at position %2%. (IES 10085)

Cause

You cannot use this type of member in this context.

Action

Correct the expression.

9.2.5.3.40  Invalid set definition. (IES 10086)

Cause

A query contains an invalid set definition.

Action

Verify the query.

9.2.5.3.41  Custom functions could not be loaded. (IES 10100)

Cause

The custom function library could not be loaded because it is not correctly defined. This could be due to invalid XML, a duplicate function name or duplicate function ID.

Action

See the trace log for more details and provide these details to your administrator.
9.2.5.3.42  Your database server does not support the Both and Except operators. (IES 10701)

**Cause**

The database on which this document is based does not support the Both and Except operators. This means that you cannot use the Both operator or the Except operator when you define filters on the query.

**Action**

Remove the operators from the query filters.

9.2.5.3.43  A filter is defined on an object that is incompatible with the result objects. (IES 10702)

**Cause**

One of the query filters is defined on an object which is incompatible with all the result objects returned by the query.

**Action**

Remove the query filter or the result objects.

9.2.5.3.44  The numeric value for the query filter based on '{object}' is invalid. (IES 10703)

**Cause**

You specified an invalid numeric value for a query filter.

**Action**

Edit the query filter and specify a valid numeric value.
9.2.5.3.45  The date for the prompt '{prompt}' is invalid. (IES 1070) (IES 10704)

Cause

You specified an invalid date for a query filter.

Action

Edit the query filter and specify a valid date.

9.2.5.3.46  The prompt '{prompt}' contains an invalid numeric value. (IES 10705)

Cause

You specified an invalid numeric value for a prompt.

Action

Specify a valid numeric value.

9.2.5.3.47  The date for the prompt '{prompt}' is invalid. (IES 10706)

Cause

You specified an invalid date for a prompt.

Action

Edit the prompt and specify a valid date.
**9.2.5.3.48** The server cannot build the SQL for the query. (IES 10707)

**Cause**

Your query cannot be converted to SQL to run against the database.

**Action**

Reformulate the query or see your administrator.

**9.2.5.3.49** The object '{ObjName}' in the prompt '{PromptName}' can no longer display a list of values. Remove the prompt from the query or contact your administrator to clear the "Select only from list" option of the object properties tab. (IES 10708)

**Cause**

The object in the prompt can no longer display a list of values.

**Action**

Remove the prompt, or ask your administrator to allow the prompt to accept values not selected from a list.

**9.2.5.3.50** A class already exists with this name : '{ClassName}'. (IES 10709)

**Cause**

You cannot have two classes with the same name.

**Action**

Use a different name for the class.
9.2.5.3.51 You do not have the right to refresh this document. (IES 10801)

Cause

Your user profile does not permit you to view data for one of the objects included in the query for this document.

Action

Cancel the refresh, or ask your administrator for the security rights necessary to refresh the document.

9.2.5.3.52 The query SQL has {nbHaving} instead of {nbWanted} columns. (IES 10810)

Cause

The SQL generated by the query has an invalid number of columns.

Action

See your administrator.

9.2.5.3.53 The data type of a column in the query is not valid. (IES 10811)

Cause

The data type of a column in the query is not valid.

Action

See your administrator.
9.2.5.3.54  Custom SQL cannot contain optional prompts. (IES 10812)

Cause
Optional prompts are not supported in custom SQL.

Action
Remove the optional prompts.

9.2.5.3.55  Incompatible objects cannot be used in combined queries. (IES 10820)

Cause
A combined query contains incompatible objects.

Action
Edit the combined query and remove the incompatible objects.

9.2.5.3.56  A subquery in the '{dp_name}' data provider has missing objects. (IES 10830)

Cause
Objects necessary to generate query SQL are missing from a subquery in the {dp_name} data provider.

Action
Edit the subquery and add the missing objects.
9.2.5.3.57 The filtered object is missing in a ranking in the '{dp_name}' data provider. (IES 10831)

Cause

The filtered object is missing in a ranking.

Action

Edit the ranking and add the filtered object.

9.2.5.3.58 The rank-based object is missing in a ranking in the '{dp_name}' data provider. (IES 10832)

Cause

The rank-based object is missing in a ranking.

Action

Edit the ranking and add the rank-based object.

9.2.5.3.59 The document cannot be loaded. (IES 10833)

Cause

The interactive analysis document could not be loaded.

Action

See your administrator.
9.2.5.3.60Additional context resolution is not supported with optional prompts. (IES 10834)

Cause

The optional prompts in a query generate additional query context resolution that is not supported.

Action

Remove the optional prompts or make them obligatory.

9.2.5.3.61Invalid data in column "{col_name}". (IES 10840)

Cause

A database column referenced by the query contains invalid data.

Action

See your administrator.

9.2.5.3.62Invalid UTF-8 string in column "{col_name}". (IES 10841)

Cause

A database column referenced by the query contains invalid data.

Action

See your administrator.
9.2.5.3.63 The file that is required to create or update the query cannot be found on the file system. File not found: "{filename}". (IES 10850)

Cause

The file {filename} cannot be found on the file system.

Action

Check the location of {filename} or see your administrator.

9.2.5.3.64 The file that is required to refresh the query cannot be found on the file system. File not found: "{filename}" (IES 10851)

Cause

The file seems to be missing, deleted, or renamed.

Action

Check with your administrator.

9.2.5.3.65 Unable to refresh the query on this file: the structure of file "{filename}" does not match. (IES 10852)

Cause

The file might have been modified since the query was last run.

Action

Check with the administrator or universe designer that the file has not been modified.
9.2.5.3.66  Error originates from the Personal Data Provider: {message}. (IES 10853)

Cause
The file that supplies data to a personal data provider might be corrupt or missing.

Action
Check that the file is present, and that it does not contain errors.

9.2.5.3.67  Unable to create or update the Excel personal data provider: the file path is invalid. (IES 10870)

Cause
The Excel file could not be found on the file system.

Action
See your administrator.

9.2.5.3.68  Unable to create or update the Excel personal data provider: cannot retrieve the named ranges. (IES 10872) (IES 10871)

Cause
The Excel personal data provider could not be created or updated because the workbook is protected.

Action
Remove the protection from the Excel workbook or see your administrator if you do not have access to the Excel file.
Unable to create or update the Excel personal data provider: cannot open the workbook. (IES 10872)

**Cause**

The Excel file could not be opened.

**Action**

Verify the Excel file or see your administrator.

Unable to create or update the Excel personal data provider: cannot retrieve the named ranges. (IES 10873)

**Cause**

Data could not be retrieved from a named range of cells.

**Action**

Check the Excel file or see your administrator.

Unable to create or update the Excel personal data provider: cannot retrieve data from the file. (IES 10874)

**Cause**

Data could not be retrieved from the Excel file.

**Action**

Verify the file or see your administrator.
9.2.5.3.72  Unable to create or update the Excel personal data provider: cannot retrieve data from the file. (IES 10875)

Cause

No data could be retrieved from the Excel file.

Action

Verify the file or see your administrator.

9.2.5.3.73  Unable to create or update the Excel personal data provider: cannot build the iterator on the data set. (IES 10876)

Cause

An error occurred when retrieving data from the Excel file.

Action

Verify the file or see your administrator.

9.2.5.3.74  Unable to create or update the Excel personal data provider: no worksheet available. (IES 10877)

Cause

No worksheet could be found in the Excel file.

Action

Verify the file or see your administrator.
Unable to create or update the Excel personal data provider: unable to retrieve the list of worksheets. (IES 10878)

**Cause**

The list of worksheets could not be retrieved from the Excel file.

**Action**

Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: invalid data retrieved from the selected range. (IES 10879)

**Cause**

The data retrieved from a range in the Excel file is invalid.

**Action**

Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: the selected worksheet is invalid. (IES 10880)

**Cause**

The Excel worksheet is invalid.

**Action**

Verify the Excel file or see your administrator.
**9.2.5.3.78** Unable to create or update the Excel personal data provider: an error occurred while retrieving the data sampling. (IES 10881)

**Cause**

An error occurred during data retrieval from the Excel file.

**Action**

Verify the file or see your administrator.

**9.2.5.3.79** Unable to create or update the Excel personal data provider: an error occurred while creating the data iterator. (IES 10882)

**Cause**

An error occurred during data retrieval from the Excel file.

**Action**

See your administrator.

**9.2.5.3.80** Unable to create or update the Excel personal data provider: an error occurred during data retrieval. (IES 10883)

**Cause**

An error occurred during data retrieval from the Excel file.

**Action**

See your administrator.
Unable to create or update the Excel personal data provider: an internal error occurred. (IES 10884)

**Cause**

An error occurred during data retrieval from the Excel file.

**Action**

See your administrator.

Unable to create or update the Excel personal data provider: the range selection is invalid. (IES 10885)

**Cause**

An error occurred during data retrieval from the Excel file because the range selected was not valid.

**Action**

Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: the range selection does not match the worksheet. (IES 10886)

**Cause**

An error occurred during data retrieval from the Excel file because the range selection does not match the worksheet.

**Action**

Verify the file or see your administrator.
9.2.5.3.84 A condition on an object refers to an object from another query that has a different type. (IES 10887)

**Cause**

The object in the other query has a different data type from the object in the condition.

**Action**

Correct the condition.

9.2.5.3.85 A condition on an object refers to an object in another query that does not exist. (IES 10888)

**Cause**

Either the object or query referred to by the condition does not exist.

**Action**

Correct the condition.

9.2.5.3.86 There is a circular dependency in the query. (IES 10889)

**Cause**

The query has a circular dependency.

**Action**

Edit the query to remove the circular dependency.
9.2.5.3.87 Database error: {error_db}. (IES 10901)

**Cause**

The database returned the error given in the message.

**Action**

See your administrator with the details of the error that occurred.

9.2.5.3.88 Query exceeded fixed time limit: {error_db}. (IES 10902)

**Cause**

The query could not return data because it took too long to run.

**Action**

Run the query again. If the problem persists see your administrator.

9.2.5.3.89 Invalid Database Field Type : {db_fieldname}. (IES 10903)

**Cause**

The database field given in the message contains an invalid data type.

**Action**

See your administrator.
9.3 Report Engine error messages

9.3.1 ReportEngine Web Intelligence (RWI) Error Messages

ReportEngine Web Intelligence error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>RWI 00000 - RWI 00850</td>
<td>ReportEngine Web Intelligence</td>
</tr>
</tbody>
</table>

9.3.1.1 RWI 00000 - RWI 00314

9.3.1.1.1 User input is required for the prompt in the query. (RWI 00000)

Cause

The server requires prompt values in order to fulfill the request.

Action

Enter values for all mandatory prompts.

9.3.1.1.2 User input is required to select an universe context for the query. (RWI 00001)

Cause

The server requires context(s) selection in order to fulfill the request.

Action

Supply context(s) choice.
9.3.1.1.3  The argument cannot be null. (RWI 00010)

Cause

The specified argument is "null".

Action

Enter a non-null value for the argument.

9.3.1.1.4  Invalid value: {0}. (RWI 00011)

Cause

The specified argument value is invalid.

Action

Enter a valid value for the argument.

9.3.1.1.5  The argument is out of range. (RWI 00012)

Cause

The specified argument value is not within the allowed range.

Action

Specify a value within the allowed range.
9.3.1.1.6 Unable to retrieve the requested report part(s). Either the report part references are invalid, or the corresponding data does not exist anymore. (RWI 00013)

**Cause**

One or more report part references are invalid, or the corresponding data is not available.

**Action**

Ensure that you are using valid report part references. Subsequently, ensure that the requested data is available after refreshing the document's data providers.

9.3.1.1.7 Cannot retrieve more than one report part simultaneously in DHTML output format. (RWI 00014)

**Cause**

You cannot retrieve more than one report part in DHTML output format simultaneously.

**Action**

Enter a single report part reference.

9.3.1.1.8 Cannot turn off search mode for delegated search. (RWI 00015)

**Cause**

A list of values defined as "delegated" search cannot have search mode disabled.

**Action**

Before disabling the search mode, check if the list of values is defined as "delegated search".
9.3.1.1.9 One of the supplied OutputCacheEntry instances is invalid or not supported by the Web Intelligence server. (RWI 00016)

Cause

While preloading the server output cache, one or more output formats specified are invalid or unsupported.

Action

Ensure that the requested output formats are valid and supported.

9.3.1.1.10 Could not read (0)bytes from the specified stream. (RWI 00017)

Cause

Upon upload of the resource into a document, the supplied data could not be read.

Action

Ensure that the specified parameters are correct and consistent.

9.3.1.1.11 The Web Intelligence server returned an invalid XML output. Contact your administrator. (RWI 00200)

Cause

The server returned an invalid or incorrect XML output.

Action

Contact your technical support.
9.3.1.1.12  Could not get page number. (RWI 00223)

Cause

The requested page could not be retrieved because of an invalid page number.

Action

Ensure that the requested page number is valid.

9.3.1.1.13  Cannot initialize Report Engine server. (RWI 00226)

Cause

Communication with the server could not be established. This may occur when attempting to create or open a document.

Action

Ensure that the server is installed correctly. Also, check if the server is started and enabled.

9.3.1.1.14  Your Web Intelligence session is no longer valid because of a timeout. (RWI 00235)

Cause

The server session allocated to a particular document has been closed, either explicitly or because of a timeout.

Action

Ensure that the document has not been explicitly closed. Alternatively, increase the `<server session timeout>` value.

To modify the server session timeout value:
1. Log on to the Business Intelligence platform Central Management Console (CMC).
2. Click on Servers.
3. Expand Server Categories, and click on Web Intelligence.
5. In Properties window, under Web Intelligence Processing Service, enter the value for Idle Connection Timeout.

9.3.1.1.15 The Web Intelligence server cannot be reached. Contact your administrator. (RWI 00236)

**Cause**

An error occurred while attempting to communicate with the server.

**Action**

Contact the administrator to ensure that the server is enabled and running. Also, check for network problems.

9.3.1.1.16 Cannot write output stream. Contact your administrator. (RWI 00237)

**Cause**

An I/O error occurred when writing data in response to a view request.

**Action**

Contact the administrator to ensure that the specified destination parameter is valid.

9.3.1.1.17 Connection failed. The server has reached the maximum number of simultaneous connections. (RWI 00239)

**Cause**

The maximum number of server connections allowed has been reached.
Action

Either raise the value of the `<maximum connections>` server parameter, or add another server instance.

To modify the maximum connections value:
1. Log on to the Business Intelligence platform Central Management Console (CMC).
2. Click on Servers.
3. Expand Server Categories, and click on Web Intelligence.
5. In Properties window, under Web Intelligence Processing Service, enter the value for Maximum Connections.

9.3.1.1.18  Your server version is incompatible with this client version. Contact your administrator. (RWI 00240)

Cause

The server does not support this SDK version.

Action

Contact the administrator to ensure that the server version is compatible with the client version.

9.3.1.1.19  Cannot find an XML transformer. (RWI 00301)

Cause

Unable to instantiate the XSLT transformer used for XML to HTML transformation.

Action

Try again later.
9.3.1.1.20  Cannot create translet. (RWI 00309)

Cause
Unable to compile the XSLT stylesheet used for XML to HTML transformation.

Action
Try again later.

9.3.1.1.21  Cannot get an output file for the document. (RWI 00314)

Cause
While serializing a document state, an error occurred. This might be due to insufficient memory or an I/O error.

Action
Ensure that there is sufficient memory available. Also, check for any `<webi.properties>` customization.

9.3.1.2  RWI 00315 - RWI 00605

9.3.1.2.1  Cannot retrieve an XML parser ID. (RWI 00316)

Cause
An error occurred during XSLT transformation. This might be because you are requesting output in XML format using a client supplied stylesheet.

Action
Ensure that the specified XSLT stylesheet is correct.
9.3.1.2.2 Cannot transform XML to HTML. (RWI 00317)

**Cause**

During XSLT transformation, an error occurred while requesting output in HTML.

**Action**

Try again later.

9.3.1.2.3 The Java Runtime Environment does not support UTF-8 encoding. (RWI 00321)

**Cause**

The JRE does not support UTF-8 encoding.

**Action**

Switch to a JRE that supports UTF-8 encoding.

9.3.1.2.4 An error occurred while retrieving the document from the storage token. (RWI 00322)

**Cause**

An error occurred during document state deserialization. This might be due to insufficient memory or an I/O error.

**Action**

Ensure that there is sufficient memory available. Also check for any `<webi.properties>` customization.
9.3.1.2.5 Cannot retrieve the document with the passed obsolete token. (RWI 00323)

**Cause**

An error occurred during document state deserialization. This might be caused by a storage token that identifies a document state, which is no longer available in the storage tokens stack.

**Action**

In the `<webi.properties>` file, increase the value of `<storage tokens stack size>`. Also, ensure that the storage token is valid before using it.

9.3.1.2.6 Cannot retrieve the document with the passed malformed token. (RWI 00324)

**Cause**

An error occurred during document state deserialization. This might be due to an invalid storage token.

**Action**

Specify a valid storage token.

9.3.1.2.7 There are too many operands for the current operator. (RWI 00501)

**Cause**

For the current operator, the condition or filter has too many operands to be able to add a new one.

**Action**

Remove existing operands before attempting to add a new one.
9.3.1.2.8 There are not enough operands for the current operator. (RWI 00502)

Cause

The condition or filter does not have enough operands with respect to the current operator.

Action

Add operand(s) to the condition or filter.

9.3.1.2.9 Prompts are not supported on filters created at the report level. (RWI 00503)

Cause

Report filters do not support prompts. Only query conditions support prompts.

Action

Do not use prompts in report filters.

9.3.1.2.10 You cannot modify operators and operands in predefined filters. (RWI 00504)

Cause

While using a pre-defined condition, you cannot specify an operator for a condition or filter.

Action

Ensure that the operator in the pre-defined condition does not have any filters or conditions.
### 9.3.1.2.11
LIKE and NOT_LIKE operators are allowed only on ObjectType.TEXT objects. (RWI 00506)

**Cause**
You attempted to use "LIKE" or "NOT_LIKE" operators for objects that are not of character type.

**Action**
When the object used in a filter is not of character type, ensure that you do not use the "LIKE" and "NOT_LIKE" operators.

### 9.3.1.2.12
The specified operator cannot be applied to a document filter. (RWI 00507)

**Cause**
The specified operator cannot be used with report filters. It can be used only with query conditions.

**Action**
Do not use this operator when working with report filters.

### 9.3.1.2.13
Web Intelligence is unable to attach a LOV (List of Values) to the prompt because the associated source object does not have a LOV. (RWI 00508)

**Cause**
Cannot use a list of values with the prompt being defined. This is because the object used in this condition does not contain a LOV.
Action

Before requesting the prompt to use the list of values, ensure that the object used within the condition has a defined list of values.

9.3.1.2.14  There are incompatible data source objects in the filter condition comparison.  (RWI 00509)

Cause

You have attempted to compare two objects of different types within a condition.

Action

Use objects of the same type.

9.3.1.2.15  Cannot create a report filter on a formula.  (RWI 00511)

Cause

Formulas cannot be used as report filters. Only data providers and variable expressions can be used.

Action

Use a data provider or variable expression when defining a report filter.

9.3.1.2.16  A percentage rank cannot have values greater than 100.  (RWI 00512)

Cause

When you defined the percentage ranking, you chose a rank size that was greater than 100.
Action

Ensure that the rank size is less than 100.

9.3.1.2.17  The expression is not available in the axis. (RWI 00602)

Cause

You have attempted to create a break, calculation, or sort using an expression that is not in the axis.

Action

Use an expression that is available in the axis.

9.3.1.2.18  Only measure objects can be included on the y-axis. (RWI 00603)

Cause

You have attempted to add an expression to the axis, where the expression is not of `<measure>` type.

Action

Specify an expression of `<measure>` type.

9.3.1.2.19  You cannot base a section on a measure. (RWI 00604)

Cause

A section cannot be based on an expression of `<measure>` type.
Action

Do not use an expression of `<measure>` type as the basis for a section.

9.3.1.2.20  You cannot add more than one expression to a section axis. (RWI 00605)

Cause

A section axis does not support more than one expression.

Action

Do not use several expressions in a section axis.

9.3.1.3  RWI 00606 - RWI 00850

9.3.1.3.1  You cannot include a circular attachment in a document. (RWI 00606)

Cause

You have attempted to define a report attachment that causes a circular attachment.

Action

Define a report that does not generate a circular attachment.

9.3.1.3.2  The expression is different from the table cell expression. (RWI 00607)

Cause

You have attempted to create a calculation on a table cell, specifying an expression different from the one contained in the table cell.
**Action**

Create a calculation table with the expression that is already defined in the table cell.

**9.3.1.3.3** You cannot copy a ReportElement object to an element in a different ReportElementContainer. (RWI 00608)

**Cause**

Report attachments can only be defined between report elements belonging to the same container.

**Action**

Ensure that you are creating report attachments between report elements that belong to the same container.

**9.3.1.3.4** You cannot create a horizontal attachment on a section. (RWI 00609)

**Cause**

You have attempted to create a horizontal attachment in a section.

**Action**

Do not create horizontal attachments in a section, as sections cannot exceed the maximum allowed width.

**9.3.1.3.5** You cannot remove all rows and columns from the table body. The table must contain at least one row and column. (RWI 00610)

**Cause**

You have attempted to remove the last row or column in a table body.
Action

Ensure that the table contains at least one row and column.

9.3.1.3.6 Dimension and detail objects only are allowed on this axis. (RWI 00611)

Cause

You have attempted to add an expression of incompatible type on an axis where only dimension and detail expression types are allowed.

Action

Specify an expression of compatible type.

9.3.1.3.7 Additional objects cannot be added to the block axis based on the block shape. (RWI 00612)

Cause

Cannot add more expressions to the specified block axis.

Action

Do not add more expressions.

9.3.1.3.8 This report element cannot have a double side attachment. (RWI 00613)

Cause

A report element cannot be horizontally and vertically attached to two distinct report elements.
Action

Ensure that the report element is attached (horizontally and vertically) to the same report element.

9.3.1.3.9  The table cell has been removed from its table.  (RWI 00614)

Cause

You have attempted to use a table cell that has been removed from its containing table.

Action

You cannot use a table cell after it has been removed from its containing table.

9.3.1.3.10  Alerter isn't defined in current document.  (RWI 00619)

Cause

Alerter referenced in report doesn't belong to alerter dictionary of document.

Action

Add alerter in dictionary.

9.3.1.3.11  Track data change mode should be active to perform a track data change action.  (RWI 00620)

Cause

Unable to perform track data change action because track data was not activated.
Action

Enable track data changes mode in the Web Intelligence document.

9.3.1.3.12  An exception occurred in the visualization framework. (RWI 00621)

Cause

An exception occurred in the visualization framework.

Action

Check the inner exception.

9.3.1.3.13  Drill mode should be active to perform drill actions (RWI 00624)

Cause

Unable to perform drill action due to drill state.

Action

Activate the drill mode in the Web Intelligence document.

9.3.1.3.14  You cannot run an empty query. (RWI 00701)

Cause

You have attempted to run an empty query.

Action

Before running a query, add result objects to it.
9.3.1.3.15  Cannot delete the last data provider. (RWI 00702)

Cause
You have attempted to delete the last data provider in a document.

Action
A document must contain at least one data provider.

9.3.1.3.16  A data provider with this name already exists. (RWI 00703)

Cause
You have attempted to give a data provider a name that already exists in the document.

Action
Every data provider within a document must have a unique name.

9.3.1.3.17  Combined queries are incompatible with sampling mode activated. (RWI 00706)

Cause
Sampling cannot be used with combined queries.

Action
Do not use sampling with combined queries.
9.3.1.3.18  Processing remove data source objects while there are only two data source expressions. (RWI 00800)

Cause

You have attempted to remove an expression from a synchronized dimension that contains only two expressions.

Action

Ensure that a synchronized dimension always contains at least two expressions.

9.3.1.3.19  Cannot create a Link with a name that already exists ({0}). (RWI 00801)

Cause

You have attempted to create a synchronized dimension with a name that already exists.

Action

Provide a unique name for each synchronized dimension.

9.3.1.3.20  Cannot update CustomSortLov with a new list of values more than the size supported by CustomSortLov. (RWI 00825)

Cause

You have attempted to update the list of values of a custom sort definition with more values than allowed.

Action

Ensure that the number of values in the list is within the specified custom sort range.
9.3.1.3.21 Cannot create CustomSortLov while Report Expression's Lov size is greater than the size supported by CustomSortLov. (RWI 00826)

Cause

You have attempted to create the list of values of a custom sort definition with more values than allowed.

Action

Ensure that the number of values in the list is within the specified custom sort range.

9.3.1.3.22 The provided expression violates one of the feed restrictions. (RWI 00830)

Cause

The provided expression violates one of the feed restrictions.

Action

There is an error in the formula. Check the feed restrictions before adding a formula.

9.3.1.3.23 {0} feature is not supported. (RWI 00850)

Cause

You have attempted to use a particular feature that is not supported in the current context.

Action

Before using this feature, ensure that it is supported.
9.4 Custom Data Source (CDS) Framework Error Messages

Custom Data Source (CDS) Framework error messages include the following categories:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDS 00001 - CDS 00013</td>
<td>Custom Data Source User Interface Framework error messages</td>
</tr>
<tr>
<td>CDS 10100 - CDS 10400</td>
<td>Web Services Custom Data Source Plugin error messages</td>
</tr>
<tr>
<td>CDS 15102 - CDS 15122</td>
<td>Custom Data Source Framework error messages</td>
</tr>
</tbody>
</table>

9.4.1.1 Custom Data Source User Interface Framework error messages

9.4.1.1.1 The selected file extension is not correct. (CDS 00001)

**Cause**

The extension of the file is not as expected or is different from the previously selected file.

**Action**

Check whether the correct file is selected.

9.4.1.1.2 Cannot access the file. (CDS 00002)

**Cause**

You have entered an incorrect file path.
Action

Check whether the correct path is entered.

9.4.1.1.3  The file does not exist.  (CDS 00003)

Cause

The file does not exist at the path specified.

Action

Check whether you have specified valid path and filename.

9.4.1.1.4  The selected file is a directory.  (CDS 00004)

Cause

The path entered points to a directory instead of a file.

Action

Enter the correct filename.

9.4.1.1.5  Error in processing data source - There was an invalid operation for the plug-in.  (CDS 00005)

Cause

The plugin is not able to retrieve all the data source parameters.
Action

Check the logs and verify that the plug-in code is working properly.

9.4.1.1.6  An error occurred in the user interface of the plug-in. (CDS 00006)

Cause

An error has occurred in the plug-in user interface.

Action

Check the logs and verify that the plug-in code is working properly.

9.4.1.1.7  An error occurred while accessing the updated inputs. (CDS 00007)

Cause

An error occurred while accessing the data source parameters retrieved from the plug-in.

Action

Check the logs and verify that the plug-in code is working properly.

9.4.1.1.8  An object with this name already exists. (CDS 00008)

Cause

Another object with this name exists.

Action

Change the name of the object to a unique value.
9.4.1.1.9 The query with this name already exists. (CDS 00009)

Cause

Another query with this name exists.

Action

Change the name of the query to a unique value.

9.4.1.1.10 A problem was detected with the install. Please check and try again.
(CDS 00010)

Cause

A problem was detected with the install.

Action

Check the installation setup. Refer to the documentation for more details.

9.4.1.1.11 Error in processing data source. (CDS 00011)

Cause

A problem was detected while identifying the data source.

Action

Check the logs to get the detailed error message.
9.4.1.1.12 The requested action could not be completed. (CDS 00012)

Cause

An error was detected.

Action

Check the logs to get the detailed error message.

9.4.1.1.13 Could not retrieve plug-in display component. (CDS 00013)

Cause

A error occurred while retrieving the plug-in component.

Action

Check the logs to get the detailed error message. Verify that the plugin-in code is correct.

9.4.1.2 Web Services Custom Data Source Plugin error messages

9.4.1.2.1 An error occurred while processing the requested action. (CDS 10100)

Cause

An unexpected error occurred while processing the requested action.

Action

Contact your enterprise administrator.
9.4.1.2.2  No selection made in Output Message panel. (CDS 10101)

**Cause**

User has not selected the field(s) for the query from the Output Message panel.

**Action**

Select the field(s) that need to be displayed in the report from the Output Message panel.

9.4.1.2.3  An error occurred while invoking Web Service. {0}(CDS 10200)

**Cause**

An error occurred while invoking a web service.

**Action**

Contact your enterprise administrator.

9.4.1.2.4  Error executing web service: "{0}" (CDS 10201)

**Cause**

The Web Service Endpoint could not be invoked because of incorrect input parameters.

**Action**

Enter the correct values while invoking the Web Service.
9.4.1.2.5  An error occurred while instantiating the Web Service plugin. (CDS 10202)

Cause

The extension descriptor of the web service plug-in did not return the correct dstype.

Action

Contact your administrator to fix the problem.

9.4.1.2.6  Parsing Exception: The input WSDL type or structure is not supported. (CDS 10203)

Cause

The structure of the WSDL is not supported by Web Services Custom Data Source plug-in.

Action

Refer the documentation for supported WSDLs.

9.4.1.2.7  WSDLs that refer to Microsoft's types namespace are not supported. (CDS 10204)

Cause

WSDLs that refer to http://microsoft.com/wsdl/types/ namespace are not supported.

Action

Modify the WSDL or select the supported WSDL.
9.4.1.2.8  WSDLs that have cyclical references are not supported. (CDS 10205)

Cause

WSDL type definitions contain cyclical references.

Action

Modify the WSDL or select the supported WSDL.

9.4.1.2.9  WSDLs that do not have type definitions are not supported. (CDS 10206)

Cause

WSDL does not contain any type definitions in <types> tags.

Action

Modify the WSDL or select the supported WSDL.

9.4.1.2.10  Unable to send SOAP request as the target URL is malformed. (CDS 10207)

Cause

The SOAP action target URL mentioned for this service in the WSDL is malformed.

Action

Modify the WSDL or select another WSDL that is supported.
9.4.1.2.11 WSDLs that use encoded messages are not supported. (CDS 10208)

**Cause**

The WSDL has operations that expect encoded messages.

**Action**

Modify the WSDL or select another WSDL that is supported.

9.4.1.2.12 An error was detected while parsing the response. (CDS 10400)

**Cause**

An error was detected while parsing the response from server.

**Action**

Check the product logs to get the actual cause of error.

9.4.1.3 Custom Data Source Framework error messages

9.4.1.3.1 Unable to create or update the Custom Data Provider: unable to retrieve information from the provided source. (CDS 15102)

**Cause**

An unexpected error occurred while trying to retrieve information from the provided source.

**Action**

Contact your administrator to resolve the error.
9.4.1.3.2 Unable to create or update the Custom Data Provider: unable to retrieve structure information from the provided source. (CDS 15103)

Cause

An unexpected error occurred while trying to retrieve the structure information from the provided source.

Action

Contact the plug-in support to verify that the plug-in is working properly. If the error is not resolved contact SAP support to resolve the error.

9.4.1.3.3 Unable to create or update the Custom Data Provider: unable to build the iterator on the data set. (CDS 15104)

Cause

An unexpected error occurred while trying to build the iterator on the dataset.

Action

Contact the plug-in support to verify that the plug-in is working properly. If the error is not resolved contact SAP support to resolve the error.

9.4.1.3.4 Unable to create or update the Custom Data Provider: a problem was encountered in Data Source plug-in management and the requested action cannot be completed. (CDS 15106)

Cause

An unexpected error has occurred.
Action
Contact support to resolve the error.

9.4.1.3.5 Unable to create or update the query on this file : the file "{filename}" does not exist in the file system. (CDS 15107)

Cause
The file does not exist at the specified location.

Action
Check whether the file path specified for source file is correct.

9.4.1.3.6 Unable to create or update the Custom Data Provider : the path is invalid. (CDS 15108)

Cause
The file path mentioned is incorrect.

Action
Check that the path specified for the source is correct.

9.4.1.3.7 Unable to create or update the Custom Data Provider : invalid information retrieved while trying to get the structure. (CDS 15109)

Cause
An error occurred while trying to retrieve the structure information from the data provider.
**Action**

Contact the plug-in support to verify that the plug-in is working properly. If the error is not resolved, contact support to resolve the error.

**9.4.1.3.8** Unable to create or update the Custom Data Provider: could not find matching Data Source plug-in for this request. (CDS 15110)

**Cause**

An error occurred while trying to retrieve the plug-in information.

**Action**

Check that plug-in implementation returns required plug-in information correctly. Refer to documentation for information on configuring the plug-in.

**9.4.1.3.9** Unable to create or update the Custom Data Provider: could not instantiate matching Data Source plug-in for this request. (CDS 15111)

**Cause**

An error occurred while trying to instantiate the plug-in.

**Action**

Check that the plug-in details and MODULE-PATH in the plug-in MANIFEST file is correct. Refer to the documentation for information on configuring the plug-in.
Unable to create or update the Custom Data Provider: could not instantiate Data Source plug-in's Data Provider for this request. (CDS 15112)

**Cause**

An error occurred while trying to instantiate the Data Provider component of the plug-in extension.

**Action**

Contact the plug-in support to verify if the plug-in is working properly.

Unable to create or update the Custom Data Provider: an error occurred while retrieving the data sampling. (CDS 15113)

**Cause**

An error occurred in the plug-in while trying to retrieve sample data from the data provider.

**Action**

Contact the plug-in support to verify if the plug-in is working properly.

Unable to retrieve data from the Custom Data Provider: an error occurred while creating the data iterator. (CDS 15114)

**Cause**

An error occurred in the plug-in while trying to retrieve the data iterator.

**Action**

Contact the plug-in support to verify if the plug-in is working properly.
9.4.1.3.13 Unable to retrieve data from the Custom Data Provider: an error occurred while fetching data through the iterator. (CDS 15115)

**Cause**

An error occurred in the plug-in while trying to fetch the data through the iterator.

**Action**

Contact the plug-in support to verify if the plug-in is working properly.

9.4.1.3.14 Unable to create or update the Custom Data Provider: unsupported object type was provided by the Data Source plug-in while trying to get the structure. (CDS 15116)

**Cause**

The plug-in has data types that are not supported.

**Action**

Refer to the documentation for the list of supported data types.

9.4.1.3.15 Unable to create or update the Custom Data Provider: an internal error occurred while trying to open the session. (CDS 15117)

**Cause**

An error occurred in the plug-in while trying to open a session.

**Action**

Contact the plug-in support to verify if the plug-in is working properly.
9.4.1.3.16  Unable to create or update the Custom Data Provider: the source in the provided path is protected. (CDS 15118)

**Cause**

The plug-in could not proceed as the source file provided is a password-protected file.

**Action**

Refer to the plug-in documentation.

9.4.1.3.17  Unable to create or update the Custom Data Provider: the provided URL is invalid. (CDS 15119)

**Cause**

The plug-in could not proceed as the URL is invalid.

**Action**

Refer to the plug-in documentation.

9.4.1.3.18  Unable to create or update the Custom Data Provider: the provided URL cannot be found. (CDS 15120)

**Cause**

The plug-in could not proceed as the provided URL could not be found.

**Action**

Refer to the plug-in documentation.
9.4.1.3.19  Unable to interact with the Custom Data Provider on the provided source. (CDS 15121)

Cause
An unexpected error has occurred.

Action
Contact support to resolve the error.

9.4.1.3.20  A problem was encountered. The requested action cannot be completed. (CDS 15122)

Cause
An unexpected error has occurred.

Action
Contact support to resolve the error.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or wilful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).